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Introduction 
About this Guide 
This guide describes how to install and configure Avaya IP Office VoiceMail Pro. This guide is for Avaya 
professional services staff, business partners, and system integrators but can be used by anyone who has been 
trained to install or configure VoiceMail Pro. These instructions assume that you are familiar with IP Office 
Manager. 

The main sections are: 

 Installing VoiceMail Pro 
Details of the installation requirements for example, PC specification and licences can be found in the 
Installing VoiceMail Pro section. There are also details on how to upgrade from a previous version of 
VoiceMail Pro as well as information about the general installation of VoiceMail Pro, VoiceMail Email, 
Integrated Messaging Service, Networked Messaging (VPNM), Centralised VoiceMail Pro and Text to 
Speech features. 

 Configuring VoiceMail Pro 
The default operation for VoiceMail Pro is to provide voicemail for all users and hunt groups. When 
VoiceMail Pro is customized there can be alternative actions for users and hunt groups who require 
facilities differing from those provided by a standard mailbox. The section covers changing the system 
preferences, IP Office changes and configuring fax servers. 

 Administration 
Details of how to give users access to their voicemail when they are away from the office, mailbox user 
controls and how to receive remote voicemail notification are covered in the administration section. Other 
details include voicemail for groups, recording calls, configuring administrators for the VoiceMail Pro Client 
as well as changes that can be made to support callers with impaired vision or hearing and changing the 
language. 

 Using the VoiceMail Pro Client 
This section describes how you can customize the operation of the VoiceMail Pro server using the 
VoiceMail Pro Client. The VoiceMail Pro Client enables you to work on several servers remotely. You do 
not need to visit each one on site. Call flows are created using the VoiceMail Pro Client. Details of all the 
actions that can be used in a call flow are documented in this section of the guide. 

 Appendix 
In the troubleshooting section you will find details on how to start the VoiceMail Pro Service, using the 
VoiceMail console and User log. There are also details on SMTP errors, voice channel reservations and a 
listing of prompts for both Intuity and non Intuity systems. 

Further information about Avaya IP Office is available from www.avaya.com/support and also from 
www.avaya.com/ipoffice/knowledgebase. Also available on the Knowledge base are the following guides that you 
might find useful when using VoiceMail Pro. 

 IP Office Manager. 

 ContactStore Installation and Administration Guide. 

 IP Office Mailbox User Guide. 

 Intuity Mailbox User Guide. 

 VoiceMail Example Exercises. 
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What's New 
The following features were added to version 4.0 

 Upgrade 
You can now upgrade from 3.2 without having to remove previous versions of the software. For more 
information, see Upgrade from Version 3.2. 

 Outcalling 
When a new voice message is left in a user's mailbox, notification can be automatically sent to a selected 
external number. Notification can be sent for all new messages or only messages marked as priority. If 
there is no response to the first notification there is an escalation capability. A user can configure their 
outcalling settings using their telephone handset. Details on how to configure outcalling for individuals can 
be found in the Intuity Mailbox guide. For more information, see Outcalling:Overview. 

 Personal & Hunt Group Announcements 
Personal announcements can be recorded. A caller will hear the user's personal announcement before 
being transferred to voicemail, if available. For more information, see Personal Announcements. 
 
The announcements and actions provided to a caller to a hunt group can be customized using the Queued 
and Still Queued points for that group. When the announcements are played for the group you can select 
the amount of time before they hear the first announcement. The amount of time between the first and 
second announcement can also be set. For more information, see Configuring Announcements. 

 Channel Reservations 
Specific functions can have voicemail channels reserved for their use. The channels are reserved in IP 
Office Manager. By default there are no reserved channels. For more information, see Voicemail Channel 
Reservations. 

 Automatic Recording 
Incoming call routes can be configured to be automatically recorded. For more information, see Setting 
Automatic Recording Options. 
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Overview of VoiceMail Pro 
The diagram illustrates a VoiceMail Pro system with some of the setup options. Full details on the installation 
options available are covered in the Installing VoiceMail Pro section. 

 

The main components are: 

 IP Office Control Unit 
The IP Office VoiceMail Pro licenses are entered into the configuration of the IP Office system. The 
licenses are required to activate VoiceMail Pro and various other features, for example, Integrated 
Messaging System (IMS). An unlicensed VoiceMail Pro service will run for two hours to allow 
demonstration and testing. A license is required for continuous operation. 

 Licence keys are issued against and validated against the unique serial number of the feature key 
dongle or card installed with the IP Office. 
For USB and parallel port feature key dongles, the dongle must be installed on a PC running the IP 
Office Feature Key Server application. This is not required for a serial port feature key dongle 
which plugs directly into the 9-pin serial port of suitable IP Office control unit. 

 VoiceMail Pro Server 
The Voicemail Pro Service is installed on the VoiceMail Pro server.  

 The VoiceMail Pro Client is an interface installed on either the VoiceMail Pro Server or on a 
separate PC. It is used to configure the VoiceMail Pro Service. If the client is installed on a 
separate PC the client is used to remotely update the VoiceMail Pro service. The diagram 
illustrates the option of installing the VoiceMail Pro client on a separate PC. 

 The Campaign Web Component is installed on the VoiceMail pro server and enables agents to 
access campaign messages through Microsoft Internet Explorer 5 or higher (not Netscape). 

 IMS (Integrated Messaging Service) provides sophisticated voicemail and email integration 
between the VoiceMail Pro Server and Microsoft Exchange. IMS consists of a number of 
components.  
 
The IMS Voice Service and Gateway Service are installed onto the VoiceMail Pro Server PC. 
The IMS Administration Tool is also installed on to the VoiceMail Pro Server PC. It can however, 
be installed on another networked PC if required. For more information, see the Installing IMS 
section. 

 The Microsoft IIS Web Server application is required if web browsing access to campaigns is 
required. The application should be installed before VoiceMail Pro is installed. 
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 The VoiceMail Pro Networked Messaging (VPNM) software is installed on the VoiceMail Pro 
Server if networked messaging is required. For more information, see the Installing Networked 
Messaging (VPNM) section. 

 User's PC 
The following applications can be installed on a user's PC: 

 Each IMS user requires an IMS Client Package installed on their PC if they are going to use IMS. 

 Phone Manager Pro can be used with VoiceMail Pro. For more information about installing Phone 
Manager, see the Applications Installation Guide. 

 ContactStore Server 
The current IP Office Voice Recording Library (VRL) application is Avaya IP Office ContactStore. The 
application can be installed on the VoiceMail Pro Server in a separate hard disk partition or on a separate 
server. The diagram illustrates the option of installing ContactStore on a separate server. 

 

VoiceMail Pro is supplied on two CDs. The first CD contains the VoiceMail Pro software. The second CD contains 
Avaya IP Office ContactStore. 

 The standard VoiceMail Pro CD includes the software components for generic Text To Speech (TTS). 
VoiceMail Pro ScanSoft TTS is supplied on a separate set of 5 CDs. For more information, see the 
Installing Text to Speech section. 
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Features of VoiceMail Pro 
VoiceMail Pro provides voicemail for every telephone on the system. Messages can be retrieved from a user's own 
extension or from another telephone. Voice messages can also be forwarded to other voice mailboxes. Using 
VoiceMail Pro call flows can be created that can, for example, guide a caller to the correct extension. 

Listed below are some of the differences between Embedded VoiceMail, VoiceMail Lite and VoiceMail Pro. For a 
fuller comparison, see the product description. 

Feature Embedded 
VoiceMail 

VoiceMail 
Lite 

VoiceMail 
Pro 

Integration with Phone Manager Pro.    

Create personal greetings. 1 only 1 only 9 max 

Selection of voicemail transfer numbers    

Play a greeting continuously.    

Forward or copy a message to Email.    

Listen to an Email using Text To Speech.    

Send Email Notification.    

Forward a voice message to another mailbox or multiple 
mailboxes. 

   

Forward a voice message to multiple mailboxes using a 
Personal Distribution List. 

   

Forward a voice message with a header    

Rewind Message    

Fast forward a message    

Skip a message    

Pause a message    

Skip Message    

Set message priority    

Control when old messages are automatically deleted.    

Alphanumeric data collection    

Give callers a choice of transfer options.    

Call recording    

Create Campaigns    

Receive message notification at destinations configured by the 
user (known as Outcalling). 

   

Transfer to Fax    

Reply to a message if CLI is available  Internal 
Only 
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VoiceMail Pro is a licensed version of voicemail for IP Office. It builds on VoiceMail Lite in a number of ways: 

 Support for more than 4 simultaneous voicemail users depending on licenses entered. For more 
information, see Number of Simultaneous Voicemail Users. 

 Support for Intuity mode mailbox operation as default. For more information, see Changing Mailbox 
Operation Mode. 

 Customization can be applied to the defaults for all or specific users and hunt groups and to access via 
custom short codes. 

 The maximum recordable length of messages can be changed from the fixed 120 second limit of VoiceMail 
Lite. 

 Automatic call recording (voice recording) for selected users, hunt groups and outgoing call routes can be 
configured through IP Office Manager. 

 Campaigns allow a sequence of messages to be played to a caller and the caller's response to those 
questions (spoken and/or telephone key presses) are recorded. The sets of responses can then be 
accessed. For more information, see Campaigns:Overview. 

 Integrated Messaging System (IMS) adds sophisticated voicemail to email integration. For more 
information, see Installing IMS. 

 Intuity mode mailbox users can create mailbox distribution lists to use when forwarding or sending a 
message. Each mailbox can have up to 20 distribution lists. Each list can contain up to 360 mailbox 
destinations. Lists marked as public can be used by other mailbox users. For more information, see the IP 
Office Intuity Mailbox User Guide. 

 If Group Broadcast Messaging is selected, when a hunt group mailbox receives a new message, that 
message is copied and forwarded to the individual mailbox of all group members. For more information, 
see Configuring Group Broadcast. 

 With VoiceMail Pro, call recordings can be transferred to a third-party Voice Recording Library (VRL) 
application called ContactStore for IP Office. This application maintains a searchable library of recordings 
and can archive recordings onto DVD. Installation and operation of VRL is licensed. For more information, 
see Voice Recording Library. 

 Where the IP Office has been configured to send SNMP Alarms, VoiceMail Pro can inform the IP Office to 
send an alarm when the amount of remaining disk space falls below a set threshold. 

 A .wav file can be played to a group extension number. For more information, see Post Dial Action. 

 Both the Compact Contact Center (CCC) and VoiceMail Pro server can be used on the same server. This 
is for a maximum of 20 CCC agents and 8 voicemail ports only. 
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Supported Languages 
The voicemail system provides prompts to callers and mailbox users based on the Locale that is set in the System 
form of IP Office Manager.  

If the necessary set of language prompts is not available, the nearest available match is used. The list shows the 
first choice language prompts that VoiceMail Pro will try to use, followed by the second choice and so on. For 
example, if prompts for users with their locale set to French Canadian are not available, VoiceMail Pro looks for 
French prompts instead, then English US and finally English UK. The abbreviations shown in the table indicate the 
language prompt folder used in order of precedence. 

Individual users can have their own Locale setting. Voicemail then provides them with the appropriate language 
prompts if they are available. This is set either through the IP Office Manager User form or through the language 
choice on some telephones. For more information, see the appropriate telephone User Guide. 

The availability of a language in voicemail does not necessarily indicate support for IP Office in a country that uses 
that language. Contact your local Avaya office for details of which countries support IP Office. 

 The VoiceMail Pro Server prompts are available in both Chinese Mandarin and Chinese Cantonese. The 
Voicemail installation process, VoiceMail Pro Client and Control panel applet are available in Chinese 
Mandarin only. 

 

VoiceMail Pro server prompts can be installed in the following languages: 

Brazilian Portuguese: ptb > pt > en.  Italian: it > en. 

Chinese PRC: zzh > en > enu. Korean: ko > en. 

Chinese Traditional: ch > en > enu. Latin Spanish: eso > es > enu > en. 

Danish: da > en. Norwegian: no > en. 

Dutch: nl > en. Polish: pl > en. 

English UK: en. Portuguese: pt > ptb > en. 

English US: enu > en. Russian: ru > en. 

Finnish: fi > en. Spanish: es > eso > en. 

French: fr > frc > en. Swedish: sv > en. 

German: de > en.  French Canadian: frc > fr > enu > en. 

Greek: el > en.  

Hungarian: hu > en. TTY (see note) 

 

Note 
TTY is included in the list of installable languages even though it is not a language. TTY is a text-based system that 
is used to provide service to users with impaired hearing or vision. For more information, see Support for Callers 
with Impaired Hearing:Overview. 
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Installing VoiceMail Pro 
Overview 
You can choose one of three voicemail components to install: 

 VoiceMail Pro (Full) 
This option installs the VoiceMail Pro Server and the VoiceMail Pro Client. If you choose this option you 
can further choose a compact, typical or custom  installation. The custom installation lets you select 
additional software features to install, for example IMS or VPNM, or remove any software features that are 
included in a typical installation but are not required. 
 
It is advisable to know the type of installation that you are planning so that you can ensure that the 
appropriate installation requirements are met before you start. For more information, see Installing 
Compact VoiceMail Pro Server and Client, Installing Typical VoiceMail Pro Server and Client or Installing 
Custom VoiceMail Pro Server and Client. 

 VoiceMail Pro (Partial) 
This option installs the VoiceMail Pro Client only. For more information, see Installing the VoiceMail Pro 
Client Only. 

 ACM Gateway 
This is used to provide voicemail support for an Avaya G150 unit being used as a branch office gateway to 
ACM with Modular Messaging. The installation and setup of such a system, including the voicemail 
aspects, are covered in separate Avaya G150 documentation. For more information, see Installing 
VoiceMail Pro as an ACM Gateway. 

Text to Speech (TTS) is installed as a standard feature of VoiceMail Pro Server, although it must be licensed 
before use. For more information, see Text to Speech:Overview. 

 

The following different types of installation are available: 

 Compact 
This option installs the minimum set of components for basic voicemail operation. This means the 
VoiceMail Pro Server or Service, the VoiceMail Pro Client application plus the help files and .wav files for 
the prompts in the language that is selected at installation time. For more information, see Installing 
Compact VoiceMail Pro Server and Client. 

 Typical 
This option installs the components for basic voicemail operation plus those required for web campaigns. It 
requires that Microsoft IIS Web server is pre-installed on the VoiceMail Pro Server PC. For more 
information, see Installing Typical VoiceMail Pro Server and Client. 

 Custom 
This option lets you select additional software features to install, for example IMS or VPNM, or remove any 
software features that are included in a typical installation but which are not required. 

 The only exception is the selection of VoiceMail Pro Server or service which will be overridden to 
match the Windows version. Choose this option for to install the Integrated Messaging Service or 
VPNM. For more information, see Integrated Messaging Service (IMS) or VPNM. 
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System Planning Form 
A Microsoft Word template for a system planning form is available from the IP Office Documentation CD. 
Alternatively, a copy of the form is shown below. 

Completing the details will help to ensure a successful installation and implementation of VoiceMail Pro. It may be 
necessary for both the customer and the installer to go through this form several times before installation. 

A. Contacts 
1. Principle customer contact. 

(This should be someone nominated by the customer and who is able to approve installation decisions and 
choices). 
 
Name:.......................................................................... 
 
Telephone:................................................................... 
 
Fax:............................................................................. 
 
Email:.......................................................................... 
  

2. Customer Technical Contact 
(This should be someone familiar with the existing data/telephony systems and able to arrange or authorize 
items such as PC User accounts, server reboots, etc). 
 
Name:.......................................................................... 
 
Telephone:................................................................... 
 
Fax:............................................................................. 
 
Email:.......................................................................... 
  

3. Target Service Date:................................................................................................... 
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B. General 
1. Site Name:................................................................................................................. 

 
Address:...................................................................................................................... 
 
................................................................................................................................... 
 
Normal Business Hours:................................................................................................. 

2. IP Office System Type:  

  Small Office Edition (10)  IP 406 V2(20) 

  IP412 (30)  IP 500 (30) 

3. Number of simultaneous voicemail accesses required:............................................................ 
(Must not exceed the figure in brackets next to the IP Office system type above). 

4. Mailbox Operation Mode: 

  Intuity Emulation Mode (default)  IP Office Mode 

5. Upgrade from existing VoiceMail Lite?        
 No 
 Yes  - is the existing VoiceMail Lite server PC being re-used for VoiceMail Pro?   No   Yes  
 
 PC Specification: .......................................................................................................... 

6. Internal fax extension number: ............................................... 
(VoiceMail Pro can be set to forward fax calls to this number) 

7. Play advice on call recording:    No   Yes  

 

C. Message Storage Required 
1. Number of users:.............................. 

2. Number of hunt groups:.............................. 

3. Maximum message length in minutes (default is 2 minutes) :......................... 

4. Average number of messages per mailbox: .................................. 

5. Minimum message storage space required: ........................................(MB) 
can be calculated by ((1+2) x 3 x 4) 
((Number of users + number of hunt groups) x Max message length, x Average number of messages per 
mail box).  

 

D. Housekeeping Settings 
1. Delete new messages after:................................Hours (default is 0, never) 

2. Delete old messages after:.......................................Hours (default is 720, 30 days) 

3. Delete saved messages after:.......................................Hours (default is 0, never) 

4. Delete unopened messages after:.......................................Hours (default is 0, never) 
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E. Language Support Required 
By default the software is always installed in either English (UK) or English (US) in addition to the language(s) 
selected during installation. 

 Chinese 
(PRC/Mandarin) 

 Chinese 
(Traditional/Cantonese) 

 Danish  Dutch 

 English (UK)  English (US)   Finnish  French 

 French (Canadian)  German  Greek  Hungarian 

 Italian  Korean  Norwegian  Polish 

 Portuguese  Portuguese Brazilian  Russian  Spanish 

 Spanish (Latin)  Swedish     

 

F. Installation Summary 
IP Office:  Already Installed  New Installation  

IP Office Manager:  Already installed  New Installation  Move to VoiceMail Pro 
server 

Feature Key:  Already installed  Already installed 

 

 Move to VoiceMail Pro 
server 

VoiceMail Pro Components:   

  Upgrade VoiceMail Lite  

  Web Campaigns  install Web Server on VM Pro server PC. 

  VoiceMail Email  MAPI  SMTP 

  IMS   

  Text to Speech (TTS)  

  TTS Email Reading   

  Networked Messaging  Install SMTP server on VMPRo server PC 
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G Server PC Details 
Use existing PC or new PC specific for purpose?       Existing                      New 

1. Processor type and speed:............................................................................... 
  

2. RAM:................................ 
  

3. Hard Disk Size:................................................ 
  

4. Operating System: 
 
 Windows 2000                      Windows 2003            Windows XP Professional         
 
Service pack details:.............................................................. 

5. IP Address:.............................................................. 
(A  fixed IP address is recommended) 
 
Subnet Mask:.............................................................. 
  

6. PC Physical Location:................................................................. 

Is access controlled?  No  Yes 

If Yes, how? ........................................................................................ 

 ........................................................................................ 

Power socket location: ........................................................................................ 

UPS Supply available? 

 

 No  Yes 

7. Will the Server PC be used for other applications:  

 No  Yes    

  IP Office Manager  

  IP Office Feature Key Server  

  IP Office Remote Access: ...................................................................... 

  CCC  

  Others ...................................................................... 
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H. License and Feature Keys 
1. Does the site already have an IP Office Feature Key installed?        No              Yes 

  

2. Feature Key Type:  Serial Port Key        Parallel Port Key         USB Port Key 
  

3. Feature Key Serial Number:...................................................................................... 
  

4. If the feature key is not available before installation, is installation planned to be part of the 
VoiceMail Pro installation?  
 
 No                    Yes 
  

 If not a Serial Port Feature Key, please detail PC for Feature Key Server operation if different from 
planned VoiceMail Pro server PC: 
 
......................................................................................................................... 

5. Licenses: 

 VoiceMail Pro (4 ports): ................................................................................. 

 

 Additional 2 ports: ................................................................................. 

 

 Additional 4 ports: ................................................................................. 

 

 Additional 8 ports: ................................................................................. 

 

 Additional 16 Ports: ................................................................................. 

 

 Integrated Messaging (IMS): ................................................................................. 

 

 VB Scripting: ................................................................................. 

 

 Database Interface: ................................................................................. 

 

 TTS Generic: ................................................................................. 

 

 TTS Scansoft: ................................................................................. 

 

 Networked Messaging: ................................................................................. 

 

 VRL Recording Administrators: ................................................................................. 
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I. Installation/Service Account 
VoiceMail Pro should be installed using an account with full administrator rights to the server PC. It is also 
recommended that the service runs using the same account. A new user account called Voicemail is 
recommended. 

For installations where an Exchange server is involved (MAPI Voicemail Email, IMS) configuration of a matching 
exchange service account is recommended. 

1. Account Verification:        Domain Server        Local PC 

2. Account created:    Yes 

3. User Name:................................................................................. 

4. Password:................................................................................. 

 

J. Web Campaigns 
For some versions of Windows, web campaigns require the Microsoft IIS Web Server to be installed on the 
VoiceMail Pro server PC. 

1. Will Microsoft IIS Web Server need to be installed during the VoiceMail Pro installation?   No    
Yes 
  

2. If not, who is installing the web server? ......................................................................... 

 

K. VoiceMail Email (Not IMS) 
Complete the appropriate section for the email choice below: 

1. Will VoiceMail Email be used?   No (Answer No if IMS is planned)                 Yes 
  

2. Method of Email:   SMTP (default)               MAPI 
  

3. Is there a list of which IP Office users will use Voicemail Email and their email addresses?   Yes 

 

L. SMTP 
SMTP email can be used for VoiceMail Email operation and is the default for a VoiceMail Pro installation. 

1. SMTP Server Address (This must be the fully qualified domain name): 
 
....................................................................................................................... 
  

2. Port Number (default 25)................................................................................... 
  

3. Does the server require sender authentication?    No                  Yes   
 
If Yes, confirm details: 
Account/User name........................................................................................... 
 
Password:........................................................................................................ 
 
Use Challenge Response Authentication?     No                  Yes   
 
Account has been created:  Yes   
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M. MAPI 
1. Method:   via exchange server                 via internet 

  

2. MAPI Client    Outlook                            Outlook Express 

 

N. Integrated Messaging Service (IMS) 
Has a list of IP Office users and Exchange service accounts been supplied?   Yes 

 

O. Text to Speech (TTS) 
1. Is TTS required?  No                  Yes   

2. Which TTS languages are required? 

Generic TTS (These are installed by default as part of VoiceMail Pro). 

 US English  Simplified Chinese 

Avaya ScanSoft TTS  

 Chinese (Traditional/Cantonese)  Chinese (PRC/Mandarin) 

 Dutch  English UK 

 English (US)  French 

 German  Italian 

 Japanese  Korean 

 Norwegian  Portuguese Brazilian 

 Russian  Spanish 

 Spanish (Latin)  

3. Maximum number of simultaneous TTS Usages: ............................................ 
  

4. Do the TTS language choices (Generic or Avaya Scansoft) and the maximum number of simultaneous TTS 
usages match the type and number of licences specified in the Licences section?                             Yes 

P. VoiceMail Pro Networked Messaging (VPNM) 
VPNM requires an SMTP server to be installed on the VoiceMail Pro server PC. 

1. Has a VoiceMail Pro Networked Messaging license key been obtained?   Yes (refer to section H). 

2. SMTP Server Software: ................................................................. 

3. Who will install the SMTP server on to the VoiceMail Pro Server PC? .................................. 

4. What will be the VoiceMail Pro server PC's full qualified domain name? 
................................................................. 

5. Is there a list of the following for each remote site? 
 
The fully qualified domain name of the remote VoiceMail Pro server or Avaya Interchange server. 
                             Yes 
 
The full name of each remote site user, their extension number and the full number to dial to reach that 
user from the local site.        Yes 
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Q. Customization 
Record details of any further customization and setup that the customer requies, for example any auto-attendant 
call flow creation and routing. 
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General Installation Requirements 
Overview 
Here is a list of general requirements for all types of installation. 

 A PC with IP Office Manager and Microsoft .NET Framework versions 1.1 and 2.0 installed on it. IP Office 
uses .NET Framework 2.0 whereas VoiceMail Pro uses .NET Framework 1.1. If version 1.1 is not detected, 
you will be prompted to install it before the VoiceMail Pro installation proceeds. 

 If not already in place, an IP Office feature key server must be installed. This can be installed onto the 
same PC as the VoiceMail Pro server. 

 A license for VoiceMail Pro and any additional ports is required. If VoiceMail Pro Server is installed without 
a license it will run for 2 hours and then shut down. For more information, see VoiceMail Pro Licenses. 

 A license for all components of VoiceMail Pro that you are installing. 

 The IP Office VoiceMail Pro CD. 

 

Tips 

 Installation on the same PC as the one being used for IP Office Manager is recommended. 

 Before you start to install VoiceMail Pro it is advisable to check that the PC that you are using can connect 
to the IP Office unit and that you can load and save a configuration file. 

 Switch off any PC and hard disk sleep, power down, suspend, hibernation modes. 

 The VoiceMail Pro software needs to be installed using an account with full administrator rights on the PC. 
The service subsequently runs under that account. We recommend that a specific account is created for 
this purpose and set so that its password does not expire. 

 



Installing VoiceMail Pro 

VoiceMail Pro Installation and Maintenance Guide Page 19  
IP Office 4.0 15-601063 Issue 16 (12th December 2006)  

PC Specification 
The following configurations are supported: 

 Windows 2000 with Service Pack 4 and Internet Explorer 5.5 or later. 

 Windows XP Professional with Service Pack 2. 
Details of how to configure IP Office applications for operation with SP2 are contained in the IP Office 
Technical Tip Bulletin 49. Technical Tip Bulletins are available from the IP Office knowledge base at 
www.avaya.com/ipoffice/knowledgebase. 

 Windows 2003. 

The table that follows gives the minimum recommended PC specification. Using a PC with a lower specification 
may degrade voicemail operation. 

Applications Minimum PC 
Resources 

Intel 
Pentium 

Intel 
Celeron 

AMD Notes 

VM Pro 256MB RAM 
2GB free disk 
space. 

Any 
1.4GHz. 

Any 
1.7GHz. 

Any 
1.4GHz. 

To avoid replacing the server when adding 
new applications we recommend that a 
Pentium 4 2.8GHz (or equivalent) is used 
when possible. 

VM Pro 
+ IMS 
+ Campaigns 

512MB RAM 
 

Pentium 4 
2.8GHz. 

Not 
tested 

Athlon 
XP 3000+ 
All Athlon 
64 chips. 

If the database being queried is located on 
the VM Pro server the query speed of the 
database will be affected by the amount of 
memory available. Please take into account 
the memory requirements of the database 
being queried. 

VM Pro 
+ IVR 
+ TTS 

512MB RAM 
20GB free 
disk space. 

Pentium 4  
2.8GHz  

Not 
tested 

Athlon 
XP 3000+ 
All Athlon 
64 chips. 

 

VM Pro 
+ 
ContactStore 

512MB RAM 
2GB free disk 
space. 

Pentium 4 
2.8GHz 

Not 
tested 

Athlon 
XP 3000+ 
All Athlon 
64 chips . 

ContactStore requires a separate disk or disk 
partition.  

VM Pro 
+ CCC 

512MB RAM 
10GB free 
disk space. 

Pentium 4 
2.8GHz 

Not 
tested 

Athlon 
XP 3000+ 
All Athlon 
64 chips. 

VM Pro and CCC can be run on the same 
server up to a maximum of 25 agents, 8 ports 
of VM Pro and on Windows server operating 
systems only. 

VM Pro 
+CBC 

512MB RAM 
10GB free 
disk space. 

Pentium 4 
2.8GHz. 

Not 
tested 

Athlon 
XP 3000+ 
All Athlon 
64 chips. 

The client PC needs to be Pentium III, 
800MHz with 128MB RAM minimum. 

VM Pro  
+ CCC  
+ MMM 

512MB RAM 
10GB free 
disk space. 

Pentium4 
2.8GHz. 

Not 
tested 

Athlon 
XP 3000+ 
All Athlon 
64 chips. 

The database must be run with full SQL; 
MSDE is not supported with MMM. 

 

Notes: 

1. Use of the Large Fonts setting is not supported. Use of this option may cause options on some screens to 
become inaccessible. 

2. A 100Mbps network card is strongly recommended. 

3. Free disk space requirements are also subject to the message storage required. For more information, see 
Disk Space Requirements. 

4. IMS and Web Campaigns options within VoiceMail Pro are only supported on Windows Servers. Aspects of 
operation such as Voicemail to Email, Integrated Messaging Pro (IMS), Web Campaigns, etc, are subject 
to further requirements as listed in the relevant sections. 
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Network Requirements 
The PC should be configured and tested for TCP/IP networking. 

We strongly recommend that the voicemail server PC is connected to the IP Office Control Unit directly or via a 
LAN switch. 

If directly connected, changing the settings of the PC network card to match the IP Office control unit can resolve 
some issues. This should be done according to the PC or network card manufacturer's instructions. The options for 
IP Office LAN ports are: 

 IP412: Use LAN1 and half duplex. 

 Small Office Edition, IP406 (V2) and IP500: Full duplex. 

 All IP Office LAN ports are 10Mbps/100Mbps auto sensing. 

If not directly connected, using any of the above settings must be supported and matched by the intervening 
network equipment. 

 The PC should have a fixed IP address. Although PCs in a DHCP network may retain the same IP address 
between reboots this is not guaranteed. 

 If the IP Office is acting as a DHCP server, it defaults to using 192.168.42.2 to 192.168.42.201 for DHCP 
clients. This leaves 192.168.42.202 to 192.168.42.254 for devices that require fixed IP addresses. 

 

Disk Space Requirements 
A compact VoiceMail Pro installation requires 130MB and a typical installation requires approximately 255MB. A 
custom installation, including VPNM and IMS requires up to 2GB of disk space. However, prompts and recorded 
messages consume an additional 1MB of disk space per minute. 

For Avaya IP Office Small Office Edition, you can expect to require at least 200 minutes of message recording 
space, that is 200MB. 

For a busy environment you can expect to require at least 1000 minutes of message recording space, that is 1GB. 

If you are installing the Client only, you can expect to require at least 170MB. 

 

Web Server Operation 
If web browser access to campaigns is required, the Microsoft IIS Web Server must be installed on the server PC 
before VoiceMail Pro is installed: 

 Microsoft web server products run as services and require VoiceMail Pro to also run as a service. This 
applies on Windows 2000, 2003 or XP. 

 Internet Information Server 4.0 or higher is required. 
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Voicemail Email Connection 
VoiceMail Email operation is supported using either MAPI or SMTP. MAPI requires the VoiceMail Pro server PC to 
have a MAPI-compliant email client installed. For information, see Installing Voicemail Email:Overview. 

If Text to Speech is installed, email text to speech is supported using MAPI. For more information, see Setting up 
Text to Speech to Read Email. 

In both of the above cases, full email sending from the server PC to a user PC should be configured and tested 
before VoiceMail Pro is installed. Testing should use the same PC user account under VoiceMail Pro is to be 
installed. 

 

IMS Connection 
IMS (Integrated Messaging Service) connections require: 

 The voicemail server to use MAPI. 

 Microsoft Exchange 5.5, 2000 and 2003 (SP1 and SP4). 

 An Exchange User account for user IMSAdmin. 

 A list equating Exchange User account names with voicemail box users. 

 

ContactStore Requirements 
The current IP Office Voice Recording Library (VRL) application is Avaya IP Office ContactStore. This application 
and its installation are documented separately.  

However: 

 IP Office ContactStore should be installed after VoiceMail Pro has been installed and its operation verified. 

 IP Office ContactStore must use a separate hard disk partition for its message archiving from that used by 
VoiceMail Pro for current mailbox messages. Use of a separate hard disk or installation onto a separate 
server PC are alternatives. 

 The use of RAID 1 or RAID 5 are recommended. 

 The use of a DVD recorder for long-term archiving is recommended. 

 A figure of 7.2MB per hour of archived recordings is given. 

 The archived messages held by IP Office ContactStore are accessed via web browser using the port 
address 8888. This port address is not configurable and so it is necessary to ensure that it does not conflict 
with any other web server service running on the same server PC. 
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VoiceMail Pro Licenses 
The following License Keys can be used with VoiceMail Pro. The license keys are entered into the IP Office 
configuration using the IP Office Manager. If the VoiceMail Pro server is installed without a license, it will run for 2 
hours and then shutdown. 

Port Licenses 
The port licences control the number of ports (simultaneously connected calls into/from the VoiceMail Pro server). 
Note: The maximum number of ports supported for voicemail operation is set by the type of IP Office control unit. 
For more information, see Number of Simultaneous Voicemail Users. Multiple port licenses can be used to achieve 
the number of ports required. 

 VoiceMail Pro (4 ports) - Enables VoiceMail Pro for up to 4 ports. 

 Additional VoiceMail Pro (2 ports) - Enables 2 additional VoiceMail Pro ports. 

 Additional VoiceMail Pro (4 ports) - Enables 4 additional VoiceMail Pro ports. 

 Additional VoiceMail Pro (8 ports) - Enables 8 additional VoiceMail Pro ports. 

 Additional VoiceMail Pro (16 ports) - Enables 16 additional VoiceMail Pro ports. 

 

VoiceMail Pro Feature Licenses 
These licenses enable the use of specific features within VoiceMail Pro. 

 Integrated Messaging - Enables operation of IMS with VoiceMail Pro. 

 VMPro VB Script - Enables use of VB Scripting through the VB Script action 

 VMPro Database Interface - Enables database integration within call flows. 

 VMPro TTS (Generic) - Enables use of text to speech facilities using the default Windows and third party 
TTS engines. One license per simultaneous instance of TTS usage. 

 VMPro TTS (ScanSoft) - Enables use of text to speech facilities using Avaya supplied TTS (ScanSoft) 
engines. One license per simultaneous instance of TTS usage. 

 Networked Messaging - Enables the use of VoiceMail Pro Network Messaging. 

 VMPro Recording Administrators - Allows call recordings to be transferred to a VRL (Voice Recording 
Library) application. 

 XCAPI - For a C300 fax server an XCAPI license is required. The XCAPI license is part of the C3000 
installation. 

 

User and Group Mailbox Names 
The voicemail server creates mailboxes based on the user and hunt group names that are entered in the IP Office 
Manager application. Whenever either the voicemail server or the IP Office control unit restarts, new mailboxes are 
created for any new names that are found. 

This method of operation has the following consequences: 

 Mailboxes are based on names  
For all users and groups, if their name is changed or deleted, they are no longer associated with their 
former mailbox and any associated VoiceMail Pro start points. 

 Voicemail is case sensitive  
If a mailbox or start point name is entered incorrectly in IP Office Manager or VoiceMail Pro, the intended 
operation will not occur and the call may be disconnected. 

 Voicemail removes spaces at the end of mailbox names  
If spaces are left at the end of a mailbox user's name in IP Office Manager, when the mailboxes are 
created, the space at the end of the name is dropped. When this occurs the mailbox cannot be found as 
there is a mismatch between the user name and directory. 
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Installing the VoiceMail Pro Server and Client (Full) 
Overview 
When you complete a full VoiceMail Pro installation you install the VoiceMail Pro Server and Client together. With 
this option you can select some or all VoiceMail Pro features to install. You can choose a compact, typical or 
custom installation. 

Compact Installation: Choose the Compact option to install the minimum set of VoiceMail Pro features. These 
are: 

 The VoiceMail Pro Client. 

 The VoiceMail Pro Server (installed as a Service on Windows 2000/2003/XP Professional). 

 Help files and .wav files for the voicemail prompts in English. 

 Help files and wav files for the voicemail prompts in the Language closest to that of the target machine 
locale. 

Tip 

 If only English language prompts are required, this is the quickest way to install VoiceMail Pro. 

For more information, see Installing Compact VoiceMail Pro Server and Client. 

 

Typical Installation: Choose the Typical option to install the most commonly used VoiceMail Pro features. 

 Everything in the compact installation. 

 VoiceMail Pro Campaign Web Component. 

 All languages. 

This option is recommended for most users. 

 

Custom Installation: Choose the Custom option if you would like to choose the VoiceMail Pro features to install. 
This option is recommended for advanced users only. The following features are pre-selected and will be installed 
unless you choose not to install them: 

 VoiceMail Pro Client. 

 VoiceMail Pro Server (installed as a Service on Windows 2000/2003/XP Professional). 

 VoiceMail Pro Campaign Web Component. 

 Help files and .wav files for the voicemail prompts. 

 Help files and .wav files for the voicemail prompts in the Language closest to that of the target machine 
locale. 

 Other supported language options. 

You can then select additional components to install, for example the Integrated Messaging Service (IMS). 
Alternatively, you can select components to remove if they are not required and would save disk space, for 
example the TTY prompts. 

 

Installation Process 

The overall process for installing VoiceMail Pro consists of the following key steps: 

1. Install the required type of VoiceMail Pro. For more information, see Installing Compact VoiceMail Pro 
Server and Client, Installing Typical VoiceMail Pro Server and Client or Installing Custom VoiceMail Pro 
Server and Client. 

2. Configure Windows 2003. For more information, see Configuring Windows 2003 to Work with Web 
Campaigns. 

3. Start the VoiceMail Pro Server. For more information, see Starting the VoiceMail Pro Service. 

4. For testing and diagnostic purposes it can be useful to run the service as a console. For more information, 
see The VoiceMail Console. 
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Installing Compact VoiceMail Pro Server and Client 
If you are upgrading an existing Voicemail System, see Upgrading a VoiceMail Pro System. 

The compact (basic) installation of VoiceMail Pro provides: 

 The VoiceMail Pro Client. 

 The VoiceMail Pro Server (as either an executable program or service according to the Windows version). 

 Appropriate prompts for the selected installation language. 

 Help files and .wav files for voicemail prompts in English. 

 Help files and .wav files for voicemail prompts in the language closest to that used by the locale of the 
target machine. 

This is the minimum set of components that you need to run VoiceMail Pro. Of all of the setup types, compact 
VoiceMail Pro is likely to take up the smallest amount of space but this depends on the language selections. 

The process for installing a compact VoiceMail Pro Server and Client comprises the following key steps: 

1. Completing the pre-installation steps described in this section. 

2. Installing the VoiceMail Pro software as described in this section. 

 

Before you begin: 

1. Log on to the server PC using the account under which you intend the VoiceMail Pro server or service to 
run. This account must have full administrator rights to the local PC. 
Recommendation 

 Create a new user account called Voicemail and give it full administrator rights on the PC. This will 
help to identify the purpose of the account. Set the account password so that it does not expire. 

3. In IP Office Manager, check that the correct licenses for VoiceMail Pro are installed and show a status of 
Valid. For basic VoiceMail Pro, the licenses required are: 

 VoiceMail Pro (4 ports) plus Additional VoiceMail Pro (X ports) licenses up to the total number 
of ports required or supported by the IP Office. 
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To install compact VoiceMail Pro Server and Client: 

1. Insert the IP Office VoiceMail Pro CD. The installation should auto-start. If it does not auto-start, click 
Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens. 

2. Select the installation language. This language is used for the installation and for the default language 
prompts. 

3. Click OK. Installation preparation begins. 

4. VoiceMail Pro requires Microsoft .NET 1.1 Framework. If this version is not detected, you are prompted to 
install it. Click Yes to install Microsoft .NET 1.1 Framework. 
If the following window opens, VoiceMail Pro is already installed. You need to upgrade rather than install a 
new version. For more information, see Upgrading a VoiceMail Pro System. Otherwise the IP Office 
VoiceMail Pro installation starts and the Welcome window opens. 

 

5. In the Welcome window, click Next. The Customer Information window opens. 

6. In the Customer Information window, type a user name and the company name or use the default names 
that are proposed. These settings do not affect VoiceMail Pro when it is installed. 

7. In the same window, choose the option that determines who should be able to use VoiceMail Pro when it 
has been installed. The recommended option is Anyone who uses this computer (all users). 

8. In the Customer Information window, click Next. The Choose Destination Location window opens. 

9. In the Choose Destination Location window, click Browse and locate the folder where the VoiceMail Pro 
files are to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components 
window opens. 

10. In the Messaging Components window, highlight VoiceMail Pro (Full). 

11. Click Next. The Setup Type window opens. 

12. In the Setup Type window, select Compact. 

13. Click Next. The Service Account Name window opens. Details of the default administrator account are 
already filled in. 

14. In the Service Account Name window, type the User Name and Password for the user account under 
which the VoiceMail Pro service should log on and run. This should be the Voicemail account created 
previously on the domain and Exchange server. Alternatively, click Browse and select from the list of 
available PC or network accounts. 
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15. Click Next. The Select Program Folder window opens. By default, the program folders are created in a 
folder called IP Office. You can specify a different folder or select one from the list of existing folders. To 
specify a different folder, type the folder name in the Program Folders box. Alternatively, to use an existing 
folder, highlight a name in the list of existing folders. 

16. Click Next. The account details that you have entered are verified.  

17. If you entered a new user name, a message is displayed to ask if you want to create a new PC user 
account with the specified name and password. Click Yes. 

18. Click Next. A summary of the components that are about to be installed is shown. Check that this list is as 
expected. If for any reason the details are not what you expect, click Back and make the necessary 
changes. When you are satisfied that the details are correct, click Next to start copying the files. 

19. The Setup Status window opens to keep you informed while the installation takes place. 

20. When the installation is complete you are prompted to restart the computer. Choose Yes I want to restart 
my computer now. 

21. Click Finish to restart now. 

22. When the computer restarts, log back in.  

23. The IP Office VoiceMail Pro - ACM Gateway Settings window opens. In the Mail Server box, type the name 
of the mail server to use. 

24. Choose Message Networking/Interchange to use Interchange or Modular Messaging to use Modular 
Messaging. 

25. Click Next. The IP Office VoiceMail Pro - Email Settings window opens. 

26. Enter the name of the email account to use or click Browse and select an account to use. 

27. Click Next. The IP Office VoiceMail Pro SMTP Email Settings window opens. 

28. In the Mail Server box, type the name of the SMTP mail server or use the name that is proposed. This 
should be the fully qualified domain name. 

29. In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25. 

30. To enforce server authentication, check the Server Requires Authentication box. This is optional. If you 
check it you also need to provide the Account Name and Password that need to be entered. You can also 
choose whether or not to set the Use Challenge Response Authentication option. 

31. Click Finish. An attempt is made to validate the email settings. An error message is displayed when the 
attempt to connect with an SMTP server fails. 

32. Click OK to acknowledge the message. You have now finished installing the Voicemail Pro Server and 
Client software. 
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Installing Typical VoiceMail Pro Server and Client 
If you are upgrading an existing voicemail system, see Upgrading a VoiceMail Pro System. 

This typical installation of VoiceMail Pro provides: 

 The VoiceMail Pro Client. 

 The VoiceMail Pro Server (as either an executable program or a service). 

 Web campaign components, including the IIS web server if it is not already installed. 

 Options to install Help files and .wav files for the voicemail prompts in all supported languages. 

The process for installing a typical VoiceMail Pro comprises the following key steps: 

1. Completing the pre-installation steps described in this section. 

2. Installing the VoiceMail Pro software as described in this section. 

3. Configure Window 2003 to work with Web Campaigns. For more information, see Configuring Windows 
2003 to Work with Web Campaigns. 

 

Before you begin: 

1. Log on to the server PC using the account under which you intend the VoiceMail Pro server or service to 
run. This account must have full administrator rights to the local PC. 

 We recommend that a new user account called Voicemail is created and given full administrator 
rights on the PC. This will help identify the accounts purpose. We also recommend that the 
account is set so that its password does not expire. 

2. Check that the web server has been installed and is operating correctly. Test that its home page can be 
viewed from other PCs on the customer's network, that is the PCs of users who will want to access 
campaign messages. 

3. In IP Office Manager, check that the correct licenses for VoiceMail Pro are installed and show a status of 
Valid. For VoiceMail Pro with Web Campaigns, the licenses required are: 

 VoiceMail Pro (4 ports) plus Additional VoiceMail Pro (X ports) licenses up to the total number 
of port required or supported by the IP Office control unit. 
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To install typical VoiceMail Pro Server and Client: 

1. Insert the IP Office VoiceMail Pro CD. The installation should auto-start. If it does not auto-start, click 
Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens. 

2. Select the installation language. This language is used for the installation and for the default language 
prompts. 

3. Click OK. Installation preparation begins. 

4. VoiceMail Pro requires Microsoft .NET 1.1 Framework. If this version is not detected, you are prompted to 
install it. Click Yes to install Microsoft .NET 1.1 Framework. 
 
If the following window opens, VoiceMail Pro is already installed. You need to upgrade rather than install a 
new version. For more information, see Upgrading a VoiceMail Pro System. Otherwise the IP Office 
VoiceMail Pro installation starts and the Welcome opens. 

 

5. In the Welcome window, click Next. The Customer Information window opens. 

6. In the Customer Information window, type a user name and the company name or use the default names 
that are proposed. These settings do not affect VoiceMail Pro when it is installed. 

7. In the same window choose the option that determines who should be able to use VoiceMail Pro when it 
has been installed. The recommended option is Anyone who uses this computer (all users). 

8. In the Customer Information window, click Next. The Choose Destination Location window opens. 

9. In the Choose Destination Location window, click Browse and choose the folder where the VoiceMail Pro 
files are to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components 
window opens so that you can choose the components that you want to install. 

10. In the Messaging Components window, highlight VoiceMail Pro (Full). 

11. Click Next. The Setup Type window opens. 

12. In the Setup Type window, select Typical.  

13. Click Next. The Select the Web Server root directory window opens so that you can specify the folder 
where the web campaign web pages are to be stored. 

14. The default folder is C:\inetpub\wwwroot. To use the default folder, click Next. To specify a different 
folder, type the path to the preferred folder location. Alternatively, click Browse and locate the folder to 
use. 

15. Click Next. The Destination of the Web Script Directory window opens so that you can specify the folder 
where the web campaign components are to be stored. 
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16. The default folder is C:\inetpub\scripts. To use the default folder, click Next. To specify a different folder, 
type the path to the preferred folder location. Alternatively, click Browse and locate the folder to use. 

17. The Service Account Name window opens. Details of the default administrator account might already be 
filled in. 

18. In the Service Account Name window, type the User Name and Password for the user account under which 
the VoiceMail Pro service should log on and run. This should be the voicemail account created previously 
on the domain and Exchange server. Alternatively, click Browse and select from the list of available PC or 
network accounts or click Next to use the proposed account details. The Select Program Folder window 
opens. 

19. By default the program folders are created in a folder called IP Office. You can specify a different folder or 
select one from the list of existing folders. To specify a different folder, type the folder name in the Program 
Folders box. Alternatively, to use an existing folder, highlight a name in the list of existing folders. 

20. Click Next. The account details that you have entered are verified. If you entered a new user name, a 
message is displayed to ask if you want to create a new PC user account with the specified name and 
password. Click Yes. The Select Program Folder window opens. 

21. Select the program folder where you would like the icons for the VoiceMail Pro components to be added. 
By default the program icons are added to IP Office. 

22. Click Next. A summary of the components that are about to be installed is shown. Check that this list is as 
expected. Check that the required languages are listed. English is always listed in addition to the selected 
installation language. 

23. If for any reason the details are not what you expect, click Back and make the necessary changes. When 
you are satisfied that the details are correct, click Next to start copying the files. The Setup Status window 
opens to keep you informed while the installation takes place. 

24. When the installation is complete you are prompted to restart the computer. Choose Yes, I want to restart 
my computer now. 

25. Click Finish to restart. 

26. When the computer restarts, log back in. 

27. When the server PC has restarted, the IP Office VoiceMail Pro - Email Settings window opens so that you 
can specify the name of the email account to use for outgoing SMTP e-mails from the VoiceMail Pro 
server. In the Accounts Details box, type the name of the email account to use. Alternatively, click Browse 
and select an account to use. 

28. Click Next. IP Office VoiceMail Pro - SMTP Email Settings window opens so that you can specify details of 
the SMTP server to which the VoiceMail Pro server should send messages. A proposed server name might 
already be filled in. 

29. In the Mail Server box, leave the proposed name unchanged or type the name of the server to use. This 
should be the fully qualified domain name. 

30. In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25. 

31. To enforce server authentication, check the Server Requires Authentication box. This is optional. If you 
check it you also need to provide the Account Name and Password that need to be entered. You can also 
choose whether or not to set the Use Challenge Response Authentication option. 

32. Click Finish. An attempt is made to validate the email settings. An error message is displayed when the 
attempt to connect with an SMTP server fails. 

33. Click OK to acknowledge the message. You have now finished installing the VoiceMail Pro Server and 
Client software. 

34. If you are using IIS version 6 under Windows 2003 server, some configuration changes are required. For 
more information, see Configuring Windows 2003 to Work with Web Campaigns. 
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Installing Custom VoiceMail Pro Server and Client 
If you are upgrading an existing voicemail system, see Upgrading a VoiceMail Pro System. 

A custom installation of VoiceMail Pro provides everything that is included in a typical installation plus: 

 The opportunity to install software features in addition to those included in the typical installation, for 
example Integrated Messaging or Networked Messaging. For more information, see: 

 Installing Voicemail Email:Overview. 

 Installing Centralized VoiceMail Pro:Overview. 

 Installing Text to Speech Features:Overview. 

 Installing Integrated Messaging:Overview. 

 Installing Networked Messaging:Overview. 

 The opportunity to choose not to install all of the components that are in a typical installation. For more 
information, see Removing Software Features from a VoiceMail Pro Installation. 

 The opportunity to select the languages to use for the wav and help files. 

 The opportunity to select the TTY prompts and install them. For more information, see Installing VoiceMail 
Pro TTY Prompts. 

 The opportunity to select any languages that are not required and therefore to exclude them from the 
installation or remove them if they have already been installed. This can save disk space. 

If you install the Web campaign component, you need to configure Window 2003 to work with Web Campaigns. For 
more information, see Configuring Windows 2003 to Work with Web Campaigns. 

 

Removing Software Features from a VoiceMail Pro Installation 
When you choose to install a custom version of VoiceMail Pro you can select additional features to install, for 
example IMS. You can also select any features that you do not want to install or actually want to remove. For 
example, if a feature has already been installed, you can select it for removal. 

To remove a software feature from a VoiceMail Pro Installation: 

1. Complete the steps for installing custom VoiceMail Pro Server and Client. For more information, see 
Installing Custom VoiceMail Pro Server and Client. 

2. When the Select Features window opens, uncheck any features that you do not want to install or that you 
want to remove. 

 Important - If you uncheck a feature that is already installed, it will be removed (uninstalled). 

3. Continue the installation process as you would for  installing custom VoiceMail Pro Server and Client. For 
more information, see Installing Custom VoiceMail Pro Server and Client. 
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Configuring Windows 2003 to Work with Web Campaigns 
The following configuration changes are required for IIS version 6 running on a Windows 2003 server. 

To configure Windows 2003: 

1. Open the Windows Control Panel. 

2. Select Administrative Tools > Computer Management. 

3. Go to Services and Applications > IIS Manager > Web Sites > Default Web Site. 

4. Under Web Sites, right-click Default Web Site and select Properties. 

5. Select the Home Directory tab. 

6. Under Application Settings section, set the Execute Permissions to Scripts and Executables. 

7. Press OK twice. 

8. Go to Web Service Extensions section under Web Sites. 

9. Right-click and select Add a new web service extension.... 

10. In new web service extension, set the following values: 

 Extension Name: campaigns. 

 Required files: Click Add. Select the file type as CGI exe files and browse to the campaign.exe 
file location specified during installation. This is usually 
c:\InetPub\wwwroot\scripts\campaign.exe or c:\InetPub\scripts\campaign.exe. 

 Set extension status to Allowed : Enable this option. 

11. Press OK. 
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Starting the VoiceMail Pro Service 
If VoiceMail Pro has been installed successfully, the voicemail service is started automatically. From time to time it 
might be necessary to start the voicemail service manually, for example if you encounter problems during the 
installation or need to investigate problems at a later stage. 

This process consists of two stages: 

1. Ensuring that the VoiceMail Pro server restarts automatically every time the server PC is restarted. 
The VoiceMail Pro server installs a service, using the user name and password of the account specified 
during installation. The service is set to automatically restart each time the PC restarts. 

2. Initializing the default call flow. 

 

The steps that follow apply to Windows NT4, 2000, XP and 2003. 

To start the VoiceMail Pro Service: 

1. Open the Windows Control Panel. 

2. Select Administrative Tools > Services. 

 

3. The VoiceMail Pro Server service should be visible. Its Status should be Started and the Startup Type 
should be set to Automatic. 

4. Close Services. 

 

To Initialize the VoiceMail Pro Call Flow:  

1. Select Start > Programs > IP Office > VoiceMail Pro. The VoiceMail Pro Client starts and the main 
window opens. 

2. Click the  Save and Make Live icon. 

3. Select Yes. The file root.vmp is created and made available to the VoiceMail Pro server. This is the 
compiled version of the editable call flow. 

4. Voicemail operation can now be tested from an extension by dialing *17. 
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Installing the VoiceMail Pro Client Only (Partial) 
Overview 
You can install the VoiceMail Pro Client without the VoiceMail Pro Server. This is known as a partial installation. 

There is only one type of installation for the VoiceMail Pro Client. Therefore you are not offered the choice of 
custom, compact or typical during the installation process. 

For information about Installing the VoiceMail Pro Client only, see Installing the Voicemail Pro Client Only. 

For information about installing the VoiceMail Pro Client and Server together, see Installing Compact VoiceMail Pro 
Server and Client, or Installing Typical VoiceMail Pro Server and Client. 

 

Installing the VoiceMail Pro Client Only 
You can install the VoiceMail Pro Client on its own and use it to connect to a remote VoiceMail Pro server. 

To install the VoiceMail Pro Client only: 

1. Insert the IP Office VoiceMail Pro CD. The installation wizard should auto-start. If it does not auto-start, 
browse to and run Setup.exe on the CD. The Choose Setup Language window opens. 

2. Select the installation language. This language is used for the installation and for the default language 
prompts. 

3. Click OK. Installation preparation begins. 

4. VoiceMail Pro requires Microsoft .NET 1.1 Framework. If this version is not detected, you are prompted to 
install it. Click Yes to install Microsoft .NET 1.1 Framework. 
If the following window opens, VoiceMail Pro is already installed. You need to upgrade rather than install a 
new version. For more information, see Upgrading a VoiceMail Pro System. 

 
Otherwise the IP Office VoiceMail Pro installation starts and the Welcome window opens. 

5. In the Welcome window, click Next. The Customer Information window opens. 

6. In the Customer Information window, type a user name and the company name or use the default names 
that are proposed.  
These settings do not affect VoiceMail Pro when it is installed. 

7. In the same window choose the option that determines who should be able to use VoiceMail Pro when it 
has been installed. The recommended option is Anyone who uses this computer (all users). 

8. In the Customer Information window, click Next. The Choose Destination Location window opens. 



Voicemail Pro Installation and Maintenance Guide 

Page 34 VoiceMail Pro Installation and Maintenance Guide 
15-601063 Issue 16 (12th December 2006) IP Office 4.0 

9. In the Choose Destination Location window, click Browse and choose the folder where the VoiceMail Pro 
software is to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components 
window opens so that you can choose the components that you want to install. 

10. Highlight VoiceMail Pro (Partial). 

11. Click Next. 

12. By default the program folders are created in a folder called IP Office. You can specify a different folder or 
select one from the list of existing folders. To specify a different folder, type the folder name in the Program 
Folders box. Alternatively to use an existing folder, highlight a name in the list of existing folders. 

13. Click Next. The Start Copying Files window opens. Before any copying starts, you are presented with a 
summary of the settings that you have chosen so far. 

14. Review the settings to make sure that they are what you expect. Scroll down if necessary. 

15. If the details are not what you expect, click Back and make the necessary changes. 

16. When you are satisfied that the details are correct, click Next to start copying the files. 
The Setup Status window opens to keep you informed while the installation takes place. 

17. When the installation is complete you are prompted to restart your computer. Click Yes to restart now. 

18. Click Finish. 

19. When the computer restarts, log back in. You have now finished installing the VoiceMail Pro Client 
software. You can now start the Client and log in so that you start configuring remote VoiceMail Pro 
servers. For more information, see Starting the VoiceMail Pro Client. If required, you can then add one or 
more administrator users so that other administrators can work with the VoiceMail Pro Client. 
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Installing VoiceMail Pro as an ACM Gateway 
Overview 
The ACM Gateway option of the VoiceMail Pro Installation installs the VoiceMail Pro Server and Client for use with 
a G150 branch office gateway. For installation instructions, see Installing VoiceMail Pro as an ACM Gateway. For 
information about setting up such a system, including aspects of voicemail, see the separate Avaya G150 
documentation. 

 

Installing VoiceMail Pro as an ACM Gateway 
Complete the steps in this section to install VoiceMail Pro as an ACM Gateway. There is only one type of 
installation for the VoiceMail Pro ACM Gateway. Therefore you are not offered the choice of custom, compact or 
typical during the installation process. 

To install the ACM Gateway: 

1. Insert the IP Office VoiceMail Pro CD. The installation should auto-start. If it does not auto-start, click 
Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens. 

2. Select the installation language. This language is used for the installation and for the default language 
prompts. 

3. Click OK. Installation preparation begins. 

4. Voicemail Pro requires Microsoft .NET 1.1 Framework. If this version is not detected, you are prompted to 
install it. Click Yes to install Microsoft .NET 1.1 Framework and follow the instructions on the screen. 
 
If the following window opens, VoiceMail Pro is already installed. You need to upgrade rather than install a 
new version. For more information, see Upgrading a VoiceMail Pro System. Otherwise the IP Office 
VoiceMail Pro installation starts and the Welcome window opens. 

 

5. In the Welcome window, click Next. The Customer Information window opens. 

6. In the Customer Information window, type a user name and the company name or use the default names 
that are proposed. These settings do not affect VoiceMail Pro when it is installed. 

7. In the same window choose the option that determines who should be able to use VoiceMail Pro when it 
has been installed. The recommended option is Anyone who uses this computer (all users). 

8. In the Customer Information window, click Next. The Choose Destination Location window opens. 
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9. In the Choose Destination Location window, click Browse and locate the folder where the VoiceMail Pro 
files are to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components 
window opens so that you can choose the components that you want to install. 

10. In the Messaging Components window, highlight ACM Gateway. 

11. Click Next. The Service Account Name window opens. Details of the default administrator account may 
already be filled in. 

12. In the Service Account Name window, type the User Name and Password for the user account under 
which the VoiceMail Pro service should log on and run. This should be the Voicemail account created 
previously on the domain and Exchange server. Alternatively, click Browse and select from the list of 
available PC or network accounts or click Next to use the proposed account details. The Select Program 
Folder window opens. 

13. By default, the program folders are created in a folder called IP Office. You can specify a different folder or 
select one from the list of existing folders. To specify a different folder, type the folder name in the Program 
Folders box. Alternatively, to use an existing folder, highlight a name in the list of existing folders. 

14. Click Next. The account details that you have entered are verified. If you entered a new user name, a 
message is displayed to ask if you want to create a new PC user account with the specified name and 
password. Click Yes. The Select Program Folder window opens. 

15. Select the program folder where you would like the icons for the VoiceMail Pro components to be added. 
By default, the program icons are added to IP Office. 

16. Click Next. The Start Copying Files window opens. Before any copying starts, you are presented with a 
summary of the settings that you have chosen so far. 

17. Review the settings to make sure that they are what you expect. Scroll down if necessary. 

18. If for any reason the details are not what you expect, click Back and make the necessary changes. When 
you are satisfied that the details are correct, click Next to start copying the files. The Setup Status window 
opens to keep you informed while the installation takes place. 

19. When the installation is complete you are prompted to restart the computer. Choose Yes I want to restart 
my computer now. 

20. Click Finish to restart now. 

21. When the computer restarts, log back in. The IP Office VoiceMail Pro - ACM Gateway Settings window 
opens. 

22. In the Mail Server box, type the name of the mail server to use. 

23. Choose Message Networking/Interchange to use Interchange or Modular Messaging to use Modular 
Messaging.1. 

24. Click Next. The IP Office VoiceMail Pro SMTP Email Settings window opens. 

 In the Mail Server box, type the name of the SMTP mail server. This should be the fully qualified 
domain name. 

 In the Port Number box, type the number of the receiving port on the SMTP mail server. The 
default is 25. 

 In the Mail Drop box, type the name of the destination folder for outgoing emails on the SMTP 
Server. Alternatively, click the Browse button and select the folder to use. 

 To enforce server authentication, check the Server Requires Authentication box. This is 
optional. If you check this option you also need to provide the Account Name and Password that 
need to be entered. You can also choose whether or not to set the Use Challenge Response 
Authentication option. 

25. Click Finish.  An attempt is made to validate the email settings. If everything has been installed correctly 
and the license requirements are met, you are prompted to start the Voicemail service. If the attempt to 
connect with the SMTP server fails, an error message is displayed. You might need to start the Voicemail 
service manually. For more information, see Starting the VoiceMail Pro Service. 

26. Click OK to acknowledge the message. You have now finished installing the VoiceMail Pro ACM Gateway 
software. 
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Installing VoiceMail Email 
Overview 
VoiceMail Email sends mailbox users who have been configured with an email address, an email whenever their 
mailbox contains a new message. The notification email can contain an alert about the message or an attached 
copy of the message. 

 Although they are similar in concept, VoiceMail Email and Integrated Messaging Service (IMS) are two 
different components of VoiceMail Pro and should not be confused. 

VoiceMail Email requires the voicemail server to be running under a user account that has access to either a MAPI 
enabled email client program on the server PC or access to an SMTP email server. 

SMTP: Simple Mail Transfer Protocol 
This protocol allows the VoiceMail Pro server to send outgoing emails to a specified SMTP server. Microsoft 
Exchange and most commercial email servers support SMTP to receive emails. SMTP for VoiceMail Pro is 
therefore easy to implement in any business that has its own email server. For more information, see Installing 
VoiceMail Pro for SMTP VoiceMail Email. 

MAPI: Microsoft Windows Messaging Application Program Interface 
This is a set of APIs that allow MAPI applications to share information and messages. 

MAPI requires a MAPI compliant email client program to be installed on the VoiceMail Pro server. It also requires 
the VoiceMail Pro service to be run using a user account that is able to send emails via the MAPI client. Supported 
MAPI clients are: 

 Outlook 2000, 2002, 2003 

MAPI VoiceMail Email can be used with VoiceMail Lite and VoiceMail Pro. For VoiceMail Pro installed as a service 
(the default on Windows 2000/2003/XP Professional), emails can be sent without having to open and run the MAPI 
email client program. For VoiceMail Pro installed as a server program, the email client program may have to be left 
open for mail transfers to take place. 

The exact method of integration between the voicemail server and the MAPI email client depends on whether the 
voicemail server is part of a work group or a domain. This guide contains examples for both approaches. 

The MAPI process described in this guide was based on Microsoft Windows 2000 Professional with Microsoft 
Outlook 2000 and Microsoft Outlook Express 5.5. Steps may differ depending on the version of Windows and email 
client used. 

 

Installing VoiceMail Pro for SMTP Voicemail Email 
To install VoiceMail Pro for SMTP Voicemail Email: 

1. Obtain details of an email account that the VoiceMail Pro service can use from whoever administrates the 
customer's email server. The details required are: 

 Email address. 

 Server SMTP address. 

 Account user name and password. 

2. Install the VoiceMail Pro software as required. 

3. After the server PC restart, enter the VoiceMail Pro SMTP email account settings when requested. 

4. Configure the appropriate user accounts with the user's email address. For more information, see 
Configuring Email Users and Groups for Voicemail Email. 
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Domain Member 
Installing VoiceMail Pro for MAPI Voicemail Email as a Domain Member 
Before you start to install the VoiceMail Pro software, you must: 

1. Create a voicemail domain account. For more information, see Creating a Voicemail Domain Account. 

2. Configure Outlook. For more information, see Configuring Outlook for Internet Mail. 

 

You are then ready to install VoiceMail Pro for MAPI VoiceMail Email as a Domain Member. This involves the 
following key stages: 

1. Install the VoiceMail Pro software. For more information, see Installing the VoiceMail Pro Software. 

2. Change the SMTP settings, which are installed by default, to MAPI. For more information, see Switching 
VoiceMail Pro to MAPI. 

 

Creating a Voicemail Domain Account 
To create a Voicemail Domain Account: 

1. Make sure that the PC that will be running the voicemail server is a member of the domain. To join the 
domain you will need the use of a log on account with administrative permissions on the domain as well as 
the server PC, consult the domain administrator. 

 Windows 2000 
Right-click My Computer and select Properties. Select the Network Identification tab. 

2. On the Exchange server: 

 Create an account called Voicemail on the domain and an associated mailbox. 

 Provide a secure password. 

 Check the User Cannot Change Password and Password Never Expires boxes. 

3. Log on to the voicemail server PC using a domain administrator account. 

4. From the Control Panel, select Administrative Tools. 

5. Select Computer Management | Local Users and Groups | Groups. 

6. Double-click Administrators and select Add. 

7. From the Look In list select the domain name. 

8. In the Name window, locate and highlight Voicemail. Click Add followed by OK and OK to close. 
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Configuring Outlook for VoiceMail Email 
To configure Outlook for VoiceMail Pro email: 

1. On the desktop, right-click the Outlook icon and select Properties. 

2. On the General tab, select Add. 

3. Select Microsoft Exchange Server. 

4. Click Next. 

5. In the Server field, enter the name of the Exchange Server. 

6. In the Mailbox field, enter Voicemail. 

7. Click Next. 

8. When you are asked if you travel with this computer, select No. 

9. Click Next. 

10. Click Finish. 

11. Highlight the MS Exchange Settings and click Properties. 

12. Highlight Microsoft Exchange Server and click Properties. 

13. Click Check name and ensure that the name is resolved. 

14. If the name is resolved, select Apply. 

15. Click OK, OK and Close to shut the mail settings. 

16. Do not continue until the name has been resolved correctly with the Exchange Server. If the name is not 
resolved, check the account details with the Exchange Administrator. 

17. Open Outlook and select Yes to register Outlook as the default email application.  

18. Select Tools > Options. 

19. Click the Preferences tab. 

20. Click Email Options. 

21. Uncheck Save copies of messages in Sent Items folder. 

 You might want this option selected during initial setup to aid troubleshooting. However due to the 
size of wav file message attachments you should uncheck it after installation testing is complete. 

22. Log on to the VoiceMail Pro Server PC using the voicemail account.  

23. From Outlook, send a message direct to an extension user. 

24. If this message is received correctly, you can continue installing the VoiceMail Pro software. For more 
information, see Installing the VoiceMail Pro Software. 

 

Installing the VoiceMail Pro Software 
To install the VoiceMail Pro software: 

1. Log off and log back on using the Voicemail account and password. 

2. Install the required VoiceMail Pro software. For more information, see Installing Compact VoiceMail Pro 
Server and Client or Installing Typical VoiceMail Pro Server and Client. 

3. When the installation process requests a User Name and Password for the VoiceMail Pro service, enter 
the Voicemail account details. 

4. Restart the server PC when requested and log on using the Voicemail account. 

5. When SMTP email details are requested, enter no values and ignore the error message following the 
SMTP check. 

6. Start the VoiceMail Pro server service. For more information, see Starting the VoiceMail Pro Service. 

7. Check that the basic voicemail services start and operate correctly. 

8. The next step is to switch the VoiceMail Pro to MAPI operation. For more information, see Switching 
VoiceMail Pro to MAPI. 
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Switching VoiceMail Pro to MAPI 
By default, the VoiceMail Pro installation process assumes that SMTP will be used and requests SMTP email 
account settings during installation setup. VoiceMail Pro uses MAPI and so the VoiceMail Pro must be switched to 
MAPI operation. 

If you are installing IMS, use the IMS account previously created as part of the installation process. For more 
information, see Installing IMS:Overview. 

 Some options are not available if you are working offline. You must be working online to use this feature. 
For more information, see Logging in to the VoiceMail Pro Server and Changing Between Offline and 
Online Mode. 

 

To switch VoiceMail Pro to MAPI: 

1. Start the VoiceMail Pro Client. 

2. Click  Preferences and select General. 

3. Click the MAPI tab. 

 

4. The Use Email Protocol settings allow you to switch VoiceMail Pro between MAPI and SMTP. 

 If MAPI is selected, a valid MAPI profile and password must be entered in the fields above. That 
MAPI profile must exist within the MAPI email client on the server PC and be useable by the 
account under which the VoiceMail Pro service is running. 

 If SMTP is selected, the SMTP email account settings must be entered. 

5. Click OK. 

6. Click  Save and Make Live. 
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Work Group Member 
Installing VoiceMail Pro for MAPI VoiceMail Email as a Work Group Member 
Before you start to install the VoiceMail Pro software, you must: 

1. Create a voicemail user account. For more information, see Creating a Voicemail User Account. 

2. Configure Outlook Express for Internet Mail. For more information, see Configuring Outlook Express for 
Internet Mail. 

3. Configure Outlook for internet mail. For more information, see Configuring Outlook for VoiceMail Email. 

4. Configuring Outlook for exchange server. For more information, see Configuring Outlook for Exchange 
Server. 

The user name and password created are requested as part of the installation of the VoiceMail Pro service. The 
process described here assumes that Outlook is installed but has not been previously used or configured. 

You are then ready to install the VoiceMail Pro software. For more information, see Installing the VoiceMail Pro 
Software. 

By default, VoiceMail Pro is set to use SMTP for emails. You need to change this to MAPI. For more information 
see, Switching VoiceMail Pro to MAPI. 

You also need to set the SMTP Email Account settings on the VoiceMail Pro so that they match those of the 
customer's email server. For more information, see Changing SMTP Email Account Settings. 

 

Creating a Voicemail User Account 
To create a Voicemail User Account: 

1. Log on to the server PC as the local administrator and create a new user. For this example the name of the 
user account created used is Voicemail.  

2. Set a secure password. 

3. Clear User must change password at next logon and check Password never expires. 

4. Click Create and then Close. 

5. Right-click the New Account, and select Properties. 

6. Select the Member Of tab. 

7. Click Add. 

8. In the Select Groups window, highlight Administrators and click Add. Click OK. 

9. Continue with one of the following as appropriate to the installed MAPI client and method for sending email. 
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Configuring Outlook Express for Internet Mail 
To configure Outlook Express for Internet Mail: 

1. Click the Outlook Express icon to start the Configuration wizard. 

2. In the Display name box enter Voicemail. 

3. Click Next. 

4. Select I already have an e-mail address that I'd like to use and enter the address in E-mail address, 
eg. voicemail@your_domain_name. Click Next. 

5. Enter the name or address of the Incoming mail server and the Outgoing mail server. Note, if you enter 
the name, you must ensure that the voicemail PC has the correct IP address of the DNS Server configured. 

6. Click Next. 

7. Enter the email account name and password, for example Voicemail. Select Remember password. 

8. Click Next. 

9. Click Finish to complete the wizard. 

10. Open Outlook Express and select Tools > Options. 

11. Click the General tab. 

 Uncheck Send and Receive messages at Start up. 

 Uncheck Check for new messages every. 

12. Select the Send tab. 

 Uncheck Save copy of sent messages in the 'Sent Items' folder. 

 Check Send messages immediately. 

 Under Mail Sending Format select Plain Text. 

13. Click OK. 

14. Log on to the server PC using the account that will be used for the VoiceMail Pro server. 

15. From Outlook or Outlook Express, send a message direct to an extension user. 

16. If this message is received correctly, continue with installing the VoiceMail Pro software. 
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Configuring Outlook for Internet Mail 
For the installation of Outlook to work correctly, the following setup process must be followed. Outlook can be 
configured in two ways. Using the Wizard, prior to completing the steps below will cause Outlook not to send the 
messages correctly. 

To configure Outlook for Internet Mail: 

1. Right-click the Outlook icon on the desktop and select Properties. 

2. Select Add. 

3. Select Internet Email and click OK. 

4. For the Mail Account, enter Voicemail. 

5. For User Information enter Voicemail as the Name and for the Email address enter your address, for 
example. voicemail@your_domain_name. 

6. Select the Servers tab. Enter the name or IP address of the Outgoing mail server and Incoming mail 
server. 

7. The Incoming Mail Server details can be left blank as Outlook does not need to check for mail. Otherwise, 
enter the account name and password for example, Voicemail. Select Remember password. 

8. Select the Connection tab. Select Connect using my local area network (LAN). Click Next. 

9. Click OK. 

10. Click Next. 

11. Accept the default path for file creation. 

12. Select Next, then Finish and then Close. 

13. Open Outlook. 

14. On the Email Service Option Screen, select Internet Only. 

15. Click Next. 

16. Select Yes to register Outlook as the default email application. 

17. Select Tools > Options. 

18. Click the Preferences tab. 

19. Click Email Options. 

20. Uncheck Save copies of messages in Sent Items folder. 

 You might want this option selected during initial setup and troubleshooting. Due to the size of wav 
file message attachments it is advisable to uncheck it after installation is complete. 

21. Log on to the server PC using the account that will be used for the VoiceMail Pro server. 

22. From Outlook or Outlook Express, send a message direct to an extension user. 

23. If this message is received correctly, continue with installing the VoiceMail Pro software. 
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Configuring Outlook for Exchange Server 
This option may be configured if Outlook is to be configured to connect to the Exchange Server, using a valid user 
name and password, while the Voicemail PC remains a member of a work group. 

To configure Outlook for Exchange Server: 

1. Create a new mailbox on the Exchange Server, for example Voicemail, and assign it the same password 
as has been configured on the voicemail PC. 

2. Clear User must Change password at Next Logon and select Password Never Expires. 

3. On the voicemail PC, logon with the Voicemail account. 

4. Right-click the Outlook icon on the desktop and select Properties. 

5. Select Add. 

6. Highlight Microsoft Exchange Server and click OK. 

7. Type in the Microsoft Exchange Server name and enter Voicemail in the Mailbox field. 

8. Highlight the MS Exchange Settings, Click Properties. 

9. Highlight Microsoft Exchange Server. Click Properties. 

10. Click Check name and ensure the name is resolved. 

11. If the name is resolved, select Apply. Click OK, OK and Close to shut the Mail settings. 

12. Do not continue until the name has been resolved correctly with the Exchange Server. If the name is not 
resolved, check the account details with the exchange administrator. 

13. Open Outlook and select Yes to register Outlook as the default email application. 

14. Select Tools > Options. 

15. Choose the Preferences tab. Click Email Options. 

16. Uncheck Save copies of messages in Sent Items folder. 

 You may want this option selected during initial setup and troubleshooting. Due to the size of wav 
file message attachments deselect it once installation is complete. 

17. Log on to the server PC using the account that will be used for the VoiceMail Pro server. 

18. From Outlook or Outlook Express, send a message direct to an extension user. 

19. If this message is received correctly, continue with installing the VoiceMail Pro software. 

 

Installing the VoiceMail Pro Software 
To install the VoiceMail Pro software: 

1. Log off and log back on using the Voicemail account and password. 

2. Install the required VoiceMail Pro software. For more information, see Installing Compact VoiceMail Pro 
Server and Client or Installing Typical VoiceMail Pro Server and Client. 

3. When the installation process requests a User Name and Password for the VoiceMail Pro service, enter 
the Voicemail account details. 

4. Restart the server PC when requested and log on using the Voicemail account. 

5. When SMTP email details are requested, enter no values and ignore the error message following the 
SMTP check. 

6. Start the VoiceMail Pro server service. For more information, see Starting the VoiceMail Pro Service. 

7. Check that the basic voicemail services start and operate correctly. 

8. The next step is to switch the VoiceMail Pro to MAPI operation. For more information, see Switching 
VoiceMail Pro to MAPI. 
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Switching VoiceMail Pro to MAPI 
By default, the VoiceMail Pro installation process assumes that SMTP will be used and requests SMTP email 
account settings during installation setup. VoiceMail Pro uses MAPI and so the VoiceMail Pro must be switched to 
MAPI operation. 

If you are installing IMS, use the IMS account previously created as part of the installation process. For more 
information, see Installing IMS:Overview. 

 Some options are not available if you are working offline. You must be working online to use this feature. 
For more information, see Logging in to the VoiceMail Pro Server and Changing Between Offline and 
Online Mode. 

 

To switch VoiceMail Pro to MAPI: 

1. Start the VoiceMail Pro Client. 

2. Click  Preferences and select General. 

3. Click the MAPI tab. 

 

4. The Use Email Protocol settings allow you to switch VoiceMail Pro between MAPI and SMTP. 

 If MAPI is selected, a valid MAPI profile and password must be entered in the fields above. That 
MAPI profile must exist within the MAPI email client on the server PC and be useable by the 
account under which the VoiceMail Pro service is running. 

 If SMTP is selected, the SMTP email account settings must be entered. 

5. Click OK. 

6. Click  Save and Make Live. 
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Changing SMTP Email Account Settings 
To change SMTP Email Account Settings: 

1. Open the Windows Control Panel. 

2. Select  IP Office VoiceMail Pro. 

3. Select the SMTP Email Settings tab. 

 

4. Enter the settings to match the customer's email server and the email account configured on that server for 
the VoiceMail Pro service. 

5. Click the Email Settings tab. 

 

6. Enter the email address for the account setup on the customer's email server for the VoiceMail Pro service. 

7. Click Check to test the connection to the specified email account. 

8. Click OK. 
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Configuring Email Users and Groups for VoiceMail Email 
Voicemail Email can be used with user mailboxes and hunt group mailboxes. 

User or group email addresses can be specified only through IP Office Manager. The remaining settings, for 
example email alert, can be set using any of the following methods: 

 Through IP Office Manager.  
For more information, see the IP Office Manager help or user guide. 

 By logging in to the mailbox (for IP Office mode mailboxes). 
VoiceMail Lite or VoiceMail Pro users who are have an IP Office mode mailbox can switch VoiceMail Email 
on/off and select the mode of VoiceMail Email operation. The exact method for doing this depends on the 
type of telephone being used. Mailbox owners can find more information in the IP Office Mailbox User 
Guide. 

 Through a VoiceMail Pro call flow that uses a Play Configuration Menu action. 

For VoiceMail Pro systems, the  Play Configuration Menu action can be used to allow a caller set a user 
or group's Voicemail Email alert mode. Note however that this action is not aware whether the user or 
group has an email address set for the service. For more information, see Play Configuration Menu Action. 

 

Other Phone Types and External Call Access 

If no email address has been set for the user or group, the voicemail server responds with the message "Email is 
not enabled for this mailbox". 

After they log in to their mailbox, mailbox owners have the following options: 

 *01 - Sets the VoiceMail Email mode to Forward. 

 *02 - Sets the VoiceMail Email mode to Alert. 

 *03 - Sets the VoiceMail Email mode to Off. 

Mailbox owners can find out more in the user guide for their type of mailbox. 
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IP Office Manager Settings 
The voicemail email settings are found on the Voicemail tab of the user  

 

The voicemail email settings are also on the voicemail tab of the hunt group  

 

 

Voicemail Email 
The user's or group's email address. 

Voicemail Email 

 Off 
Switches off the use of VoiceMail Email. Note that other services using the email address such as Email 
TTS can still operate. 

 Copy 
Send a copy of each new message as a wav file attachment to the email. The original message remains in 
the mailbox. 

 Forward 
Send a copy of each new message as a wav file attachment to the email and delete the original message 
from the mailbox. Note, this settings overrides all other actions such as message waiting indication and 
voicemail ringback. 

 Alert 
Send an email alert for each new voicemail message but do not attach a copy of the message. 

 Forward and Copy should be used with care. Each 1 minute message will result in a 1MB wav file. 
This may impact on the performance of the network and email connection. 

 Voicemail Email Reading 
This is part of TTS operation but uses the same email address as set for VoiceMail Email. 
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How Voicemail Email Messages Look 
Messages sent by a user or group's voicemail email settings contain the following: 

 To 
The user/group email address. 

 From 
The name and address setting of the email client account. 

 Subject 
Voicemail Message ('calling number' > 'user name') From:'calling number'. 

 Body 
If the user or group's Voicemail Email mode is set to Copy or Forward, the message body will contain "IP 
Office Voicemail redirected message". 

 Attachment 
When using Copy or Forward mode, the message is attached as a wav file. 

The text parts of the message are set through registry settings and so can be changed only at your (the system 
administrator) own risk. Messages sent via a VoiceMail Pro eMail action are configurable, see The Voicemail Pro 
eMail Action. 
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The VoiceMail Pro eMail Action 
The  eMail action in VoiceMail Pro can be used to send messages via email in response to caller actions in the 
voicemail call flow. The action can also attach a wav file. 

 

In the example above, the eMail action follows a Voice Question action. The $ in the eMail action's Attach file to 
email field instructs it to use the file recorded by the preceding Voice Question action. 

The same method can be used with a Leave Mail action. Note however that the Leave Mail action must be set to a 
valid target mailbox which will then have a copy of the message. 

Alternatively, the eMail action can attach a prerecorded wav file by specifying the file name. That named file can be 
created by an Edit Play List action. 
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Installing Networked Messaging (VPNM) 
Overview 
VoiceMail Pro Networked Messaging (VPNM) allows users to forward voicemail to mailboxes on remote voicemail 
systems. This is done by adding a VPNM component to the VoiceMail Pro installation. 

The messages are transferred between systems using an SMTP/MIME mail format to encode both the voice part of 
the message and additional message details. 

Here is a diagram to illustrate VPNM between two IP Office systems. 

 

 

 

Here is a diagram of a sample VPNM configuration between an IP Office and Avaya Interchange. Depending on 
how your IP Network is set up, the configuration will differ slightly. 

 

 

 

Up to 2000 mailboxes are supported per VPNM server and there is no constraint on the number of VPNM servers.  
However, to distinguish between dial plans you might need to allocate a dial pre-fix to each server. A maximum of 
99 pre-fixes are available. 

This section summarizes the steps required for installing VPNM between two IP Office systems and between an IP 
Office system and an Intuity Audix system through Avaya Interchange. 

The instructions provided here should be read in conjunction with the other Avaya guides, for example "Avaya 
Interchange Release 5.4, Adding a VPIM System to Your Network". This is because the setup for Interchange 
VPIM is the same as for VPNM. 
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Requirements for VPNM 
Check that the following requirements have been before attempting to install VPNM: 

 A VoiceMail Pro server with VPNM installed connected to each IP Office system. Each system will need a 
license for both VoiceMail Pro and VPNM. 

 All systems in the VPNM network need to be tested to ensure that they can communicate across the IP 
network. It is suggested that you test the following: 

 Ping the IP Addresses. 

 Ping the computer names. If in a domain, ping the fully qualified domain name. 

 The VMPro Servers must have an SMTP server installed. This can be done using the SMTP component of 
Internet Information Service (IIS). 

 To test type "Telnet <the name of the SMTP server> 25". 

 Server names, where entered, must be fully qualified domain names. 

 VoiceMail Pro should not be installed on the same server as Exchange and/or the domain controller. 
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Installing VoiceMail Pro with VPNM Support 
This section describes how to install the VoiceMail Pro software with its VPNM component onto the VoiceMail Pro 
server PC. 

Before you begin: 

1. Using IP Office Manager, check that the correct licenses for VoiceMail Pro and IMS are installed and show 
a status of Valid. The licenses required are: 

 VoiceMail Pro (4 ports) plus Additional VoiceMail Pro (X ports) licenses up to the total number 
of port required or supported by the IP Office control unit. 

 Networked Messaging - Enables operation of VPNM with VoiceMail Pro. 

To install VoiceMail Pro Software with VPNM support: 

1. Insert the IP Office VoiceMail Pro CD. The installation should auto-start. If it does not auto-start, click 
Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens. 

2. Select the installation language. This language is used for the installation and for the default language 
prompts. 

3. Click OK. Installation preparation begins. 

4. If the following window is displayed, VoiceMail Pro is already installed. You need to upgrade rather than 
install a new version. For more information, see Upgrading a VoiceMail Pro System. 
 
If you have already installed basic VoiceMail Pro on the PC, and now want to install IMS, the instructions 
are the same. The difference is that when prompted to Modify, Repair or Remove, you must select Modify 
and check the Integrated Messaging check box later in the installation process. 

 
Otherwise the IP Office VoiceMail Pro installation starts and the Welcome window opens. 

5. In the Welcome window, click Next. The Customer Information window opens. 

6. In the Customer Information window, type a user name and the company name or use the default names 
that are proposed. These settings do not affect VoiceMail Pro when it is installed. 

7. In the same window choose the option that determines who should be able to use VoiceMail Pro when it 
has been installed. The recommended option is Anyone who uses this computer (all users). 

8. In the Customer Information window, click Next. The Choose Destination Location window opens. 

9. In the Choose Destination Location window, click Browse and choose the folder where the VoiceMail Pro 
files are to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components 
window opens so that you can choose the components that you want to install. 
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10. Unless there are specific reasons for changing the location, the default setting is recommended. 

11. In the Messaging Components window, highlight VoiceMail Pro (Full). 

12. Click Next. The Setup Type window opens. 

13. In the Setup Type window, select Custom. 

14. Click Next. The Select Features window opens so that you can select which additional VoiceMail Pro 
features to install. 

15. Scroll down and check VPNM. 

 

16. Ensure that the following are selected: 

 The VoiceMail Pro Campaign Web Component is not required for VPNM but is installed as part of 
a typical VoiceMail Pro Server installation. If a web server has already been installed but the 
VoiceMail Pro Campaign Web Component is not required, uncheck it to remove it. If VoiceMail Pro 
Campaign Web Component is required for other use, make sure that it is checked so that it is not 
removed. 

 Voicemail Pro and Voicemail Pro Server Service should be already selected. 

 Ensure that Voicemail Pro Client and VoiceMail Pro Service are also checked. 

 Check the boxes for any additional required languages. It is recommended that either English or 
English US is always selected in addition to any languages that are required by the customer. 

 Important 
Do not uncheck any other boxes as this will remove the corresponding software features. 

 Scroll down and check VPNM. 

17. Click Next. If you have chosen not to install the Web Campaign Component, the Service Account Name 
window opens. The Select the Web Server root directory window opens so that you can specify the folder 
where the web campaign web pages are to be stored. 

18. The default folder is C:\inetpub\wwwroot. To use the default folder, click Next. To specify a different 
folder, type the path to the preferred folder location. Alternatively, click Browse and locate the folder to 
use. 

19. Click Next. The Destination of the Web Script Directory window opens so that you can specify the folder 
where the web campaign components are to be stored. 

20. The default folder is C:\inetpub\scripts. To use the default folder, click Next. To specify a different folder, 
type the path to the preferred folder location. Alternatively, click Browse and locate the folder to use. 
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21. The Service Account Name window opens. Details of the default administrator account might already be 
filled in. 

22. In the Service Account Name window, type the User Name and Password for the user account under 
which the VoiceMail Pro service should log on and run. This should be the IMS account created previously 
on the domain and Exchange server. Alternatively, click Browse and select from the list of available PC or 
network accounts. 

23. Click Next. The Select Program Folder window opens. 

24. By default, the program folders are created in a folder called IP Office. You can specify a different folder or 
select one from the list of existing folders. To specify a different folder, type the folder name in the Program 
Folders box. Alternatively, to use an existing folder, highlight a name in the list of existing folders. 

25. Click Next. The Start Copying Files window opens. Before any copying starts you are presented with a 
summary of the settings that you have chosen so far. 

26. Review the settings to make sure that they are what you expect. In particular, check that the required 
languages are listed. Scroll down if necessary. When you are satisfied that the details are correct, click 
Next to start copying the files. The Setup Status window opens to keep you informed while the installation 
takes place. 

 If for any reason the details are not what you expect, click Back and make the necessary changes. 

27. When the installation is complete you are prompted to restart your computer. Choose Yes I want to restart 
my computer now. 

28. Click Finish to restart now. 

29. When the server PC has restarted, the IP Office VoiceMail Pro - Email Settings window is displayed so that 
you can specify the name of the email account to use for outgoing SMTP e-mails from the VoiceMail Pro 
server. 

30. In the Account Details box, type the name of the email account to use. Alternatively, click Browse and 
select an account to use. 

31. Click Next. IP Office VoiceMail Pro - SMTP Email Settings window opens so that you can specify details of 
the SMTP server to which the VoiceMail Pro server should send messages. A proposed server name might 
already be filled in. 

 In the Mail Server box, leave the proposed name unchanged or type the name of the server to 
use. This should be the fully qualified domain name. 

 In the Port Number box, type the number of the receiving port on the SMTP mail server. The 
default is 25. 

 To enforce server authentication, check the Server Requires Authentication box. This is 
optional. If you check it you also need to provide the Account Name and Password that need to be 
entered. You can also choose whether or not to set the Use Challenge Response Authentication 
option. 

32. Click Finish. An attempt is made to validate the email settings. An error message is displayed when the 
attempt to connect with an SMTP server fails. 

33. Click OK to acknowledge the message. You have now finished installing the VoiceMail Pro Server and 
VPNM software. The next step is to configure the VPNM accounts. 
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Configuring VPNM Preferences 
This option is active only if VPNM was selected during installation and is licensed. VPNM servers can be added 
and then users added to the servers. 

To open the VPN window: 

1. Start the VoiceMail Pro Client. 

2. From the Administration menu, select Preferences > VPNM. The VPNM window opens. 

 

 

To add a VPNM server: 

1. In the VPNM Server(s) section, click Add. 

2. Enter the  fully qualified domain name of the remote VPNM destination (the remote VoiceMail Pro server 
PC or Avaya Interchange). 

3. Enter the two digit access prefix, if these are being used. 

4. Click OK. 

 

To delete a VPNM server: 

1. In the VPNM Server(s) section, select the server that you need to delete. 

2. Click Delete. When a server is deleted, all of the users associated with that server are also deleted. 
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To add a user to VPNM server: 

1. In the Users for VPNM Server(s) section, click Add. The Adding a new user window opens. 

 
  

2. Enter details for the user. All of these details MUST be completed before the user can be added. 

 Select the VPIM server from the listing. 

 Enter the user's full name. The user's full name is used by the local VoiceMail Pro's dial by name 
feature. 

 Enter the user's extension. The local extension number is used as the local mailbox number and 
so should not conflict with any existing local number. 

 Enter the user's remote extension. The remote extension number should be the user's real 
extension number. Typically this and the 'local extension number' are kept the same using a 
unique extension number dial plan for the linked systems. 

 Enter the user's full telephone number. The full telephone number should be a dialable number 
that is routed to the user's extension or mailbox. 

3. Click OK to save the details and return to the VPNM configuration window. 
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To add a group of users: 

1. (Optional) Check the option Enable WildCard. When this option is selected you can use the question mark 
symbol (?) to represent any number. 

2. In the Users for VPNM Server(s) section, click Add Range. The Adding a range of users window opens. 

 
  

3. Enter details for the users. All of these details MUST be completed before the users can be added. 

 Select the VPNM server to which you want to add the users. 

 Enter the start number of the extension range. 

 Enter the local prefix. 

 Enter remote prefix. 

4. Click OK to save the details and return to the VPNM configuration window. 

 

To change details of a VPNM user: 

1. In the Users for VPNM Server(s) section, select the name of the user whose details need to be changed. 

2. Click Modify. You can change the user's full name, the local extension number and the full telephone 
number. 

 

Testing a VPNM Setup 
It is advisable to test the VPNM setup. 

To test the VPNM setup: 

1. Dial into voicemail from one of the systems and record a message. 

2. When selecting the target extension, enter an extension from the other system as specified in the VPNM 
Preferences screen. 

3. The message should be delivered to the other systems VoiceMail Pro server into C:\\Inetpub\mailroot\Drop. 

4. The VPNMreceiver Service checks the Drop directory approximately every 30 seconds.  When it finds a 
message in the Drop directory, it will send the message to the relevant extension's voicemail box on the 
remote system. 
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IP Office to Avaya Interchange 
Configuring the Avaya Intuity Audix 
This section is based upon the S8100/G600 Intuity Audix. It is assumed that the IP address of the S8100 processor 
is known. A browser should be available and the Avaya Terminal Emulator or the equivalent to do the necessary 
configuration. 

To configure the Avaya Intuity Audix: 

1. Issue a telnet command to the S8100/G600, log in and enter "audix" to reach the audix command prompt. 

2. Enter list configuration and verify that the TCP/IP value is set to at least 1. If not, these ports must be 
activated through the license process before proceeding. 

3. From a PC browser, access the S8100 processor IP address and login. 

 At the S8100 main page, select Administer System > Audix Networking > Administrative 
Menu > Network Channel Administration. 

 Enable each channel in the Channel Configuration Column. 

 Select Save when finished. 

4. Return to the Audix command prompt screen. Inspect the system for the list of mailboxes that will be 
eligible to receive messages. 

 Type change machine. Note the range of local extensions. List subscribers will provide a more 
specific list. It is best to distinguish mailboxes that are eligible to receive messages for example, 
call answer mailboxes. 

 On page 2 of the change machine form, ensure that all the update settings are set to y. 

 Make sure that Network Turnaround is set to y. Select Enter. 

5. To administer the password for message exchange: 

 From the S8100 home page select Administer System > Audix Networking > Administrative 
Menu > Local Machine Administration. 

 Enter the password to be used for transfer of messages between this system and the Avaya 
interchange. Select Change. 

6. To enter the information for connecting to the Interchange: 

 From the S8100 home page select Administer System > Audix Networking > Administrative 
Menu > Remote Machine Administration > Digital Machine Administration. 

 Select Add New Machine. 

 Enter the Avaya interchange name, IP address and networking password. 

 Define the schedule for exchanging messages. 

 Select Add to complete. 

7. To administer the parameters associated with the Interchange: 

 Type change machine <machine name> from the AUDIX command prompt. 

 If all extensions that are not on the Intuity Audix are configured to be on the Interchange 
and "Send to non-Administered Recipients" is set to yes, errant messages may be 
sent. This will waste bandwidth and processing time. 

 The extension Length setting is the dial plan length that has been configured in the Avaya 
Interchange. 

 Set all the parameters of page 2 to y. (Send to non-administered recipients, Updates In, Updates 
Out and Network Turnaround). 

 Select F3 to Add the remote machine. 
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Configuring the Avaya Interchange Interface 
For more information about the options that are mentioned in this section, refer to the Interchange documentation 
which is available from www.support.avaya.com. 

To configure the Interchange Intuity interface: 

1. Log in to the Intuity interchange. 

 To verify that the system is optioned for TCP/IP digital ports, select Customer/Service 
Administration from the Interchange Main Menu. 

 The VPNM ports will also be required for interfacing to the VoiceMail Pro. 

2. Ensure that the TCP/IP networking is set up so that the machine can communicate to and from the Intuity 
Audix. 

 From the Main Menu, select Networking Administration > TCP/IP Administration. 

 Make a note of the IP Address, Subnet Mask and default Gateway IP Address. The information will 
be required later in the setup. 

3. Make sure that an entry exists with the data that corresponds to the information entered for connecting to 
the Interchange. 

 From the Main Menu, select Networking Administration > Local Machine Administration. 

4. To verify that there are equipped TCP/IP ports for the networking to Intuity Audix and to VoiceMail Pro: 

 From the Main Menu, select Networking Administration > Networking Channel 
Administration. The status should be Idle. 

5. Information corresponding to the Intuity Audix information entered in Step 4 when configuring the Audix 
needs to be entered under Digital Networking Machine Administration. 

 From the Main Menu, select Networking Administration > Remote Machine Administration > 
Audix Digital networking Machine Administration. 

 Enter the transmission schedule for sending messages to the Audix System. Select Chg-Keys and 
then the Add key to enter the form. 

6. Administer The Intuity Audix parameters in the Interchange. 

 Select Interchange Administration > Remote Machine Administration > Remote Machine 
Parameters. 

 Select Choices, then the system to be updated. 

 Ensure that the address range corresponds to the mailboxes on the Intuity Audix system that are 
eligible to receive messages. Set the parameters as shown. 

 Avaya Interchange? = n. 

 Mailbox ID Length = 5. 

 Default Language = us-eng. 

 Failed Msg. Notification Priority = n. 

 Msg ID? = y. 

 Send Message for Warning? = n. 

 Default NameNet type = u. 
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 Select the Details key to enter the following details: 

 Subscriber Updates Type = dynamic. 

 Updates In? = y. 

 Updates Out? = y. 

 Voiced Names for Dynamic? = y. 

 Network Turnaround? = y. 

 Provide Local Mapped Addresses = n. 

 Dynamic Sub Expiration Days = 90. 

 Select Save, Continue and then Save again. 

7. If both systems are set for 5 digit dialing this step can be omitted. If both systems are not then Dial Plan 
Mapping needs to be used to map the mailbox identification from the Interchange Dial Plan to the Intuity Audix Dial 
Plan. 

 Select Interchange Administration > Remote Machine > Administration > Dial Plan 
Mapping. Update the form as required. 
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Configure the Interchange VPIM Interface to Voicemail Pro 

These steps follow the instructions in Avaya Interchange Release 5.4 Adding a VPIM System to Your Network 
which should be referenced for greater detail on Interchange configuration steps and options. 

1. Check that Interchange has available VPNM ports. 

 From the Interchange Main Menu, select Customer/Service Administration > Feature 
Options. Check that there are sufficient current entries for the Maximum Number of Digital Nodes 
and VPNM ports. 

2. Set the Interchange General Parameters. 

 From the Interchange Main Menu, select System Parameters > General Parameters. Ensure that 
the VPNM Port Field is set to 25. 

3. Identify the Avaya VoiceMail Pro to the interchange system. 

 From the Interchange Main Menu, select Networking Administration > Remote Machine 
Administration > VPIM Machine Administration. 

 Select the name of the machine by telnet to the SMTP port of the VoiceMail Pro to see how it 
identifies itself. 

4. Set the IP Office parameters. 

 From the Interchange Main Menu, select Interchange Administration > Remote Machine 
Administration > Remote Machine Parameters. 

 Select Choices. Select the VoiceMail Pro name as the Remote Machine Name then enter the 
values as shown. 

 Machine Type = VPIM. 

 Avaya Interchange? = n. 

 Mailbox ID Length = 5. 

 Failed Msg. Notification Priority = n. 

 Msg ID? = y. 

 Send Message for Warning? = n. 

 Select the Details key to enter the following details: 

 Subscriber Updates Type = dynamic. 

 Voiced Names for Dynamic? = y. 

 Use DNS? = n. 

 Domain Name = Enter the domain name. 

5. If the VoiceMail Pro Dial Plan length is shorter than the Interchange Dial Plan, select Interchange 
Administration > Remote Machine Administration > Dial Plan Mapping. Follow the instructions in 
Avaya Interchange Release 5.4 Adding a VPIM System to Your Network to map from the shorter length to 
the longer length dial plan. 

6. Add the subscribers for VoiceMail Pro. The following is one of several ways that this can be done. 

 Select Interchange Administration > Remote Machine Administration > Dial Plan Mapping. 

 Select the VoiceMail Pro as the Remote Machine and then select Options. 

 Select Add Subscribers from range. Only mailboxes that are eligible to receive messages should 
be included. 

 Subscriber entries can be checked from interchange Administration > Subscriber 
Administration > Subscriber Lists > By Remote Machine Name. From Choices select the 
VoiceMail Pro PC name to see the list of known subscribers. 
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Directory View in Interchange for Intuity Audix and VoiceMail Pro 

Setting the directory view specifies which other messaging machines can provide subscriber updates to a particular 
messaging machine. Each machine listed is associated with a range of mailboxes from which updates can be 
accepted and whether a voiced name can be accepted. 

1. Select Interchange Administration > Remote Machine Administration > Directory Views. 

2. At the Machine Name prompt, select the VoiceMail Pro. 

3. Select the Options key and then Add all entries. 

4. Select Save. 

5. Repeat these steps for the Avaya Intuity Audix. 

 

Avaya Interchange Enterprise List Administration 

This section describes how to configure a list of endpoints in the Interchange. Interchange-based lists are an 
efficient way to send messages to stable lists of mailboxes. Only one copy of the message is sent from the 
originating system to the interchange, which takes care of distributing that message to the destination machines 
and mailboxes. 

1. From the Interchange Main Menu, select Interchange Administration > Enterprise List Administration 
> System Parameters. Set or check the address range of the interchange Dial Plan that can be used for 
lists. 

2. From the Interchange Main Menu, select Interchange Administration > Enterprise List Administration 
> List Definition. 

 Choose a unique list id from the list range and assign an owner. 

 In the 'Network Address' grid, enter the list of destination addresses from the Interchange Dial 
Plan. 

 The 'Remote Address' grid should contain the systems where those destinations reside. 

 The range of mailboxes that have permissions to send through the list is set in the 'permissions' 
grid. 

 

Configuring a DNS Server 
A Domain Name Service Server is not required for the messaging systems, but may be a highly desirable way to 
centralize the mapping of names to IP addresses. This section briefly describes the setup of  DNS server used in 
this type of configuration. 

To configure a DNS Server: 

1. From the Start menu of the PC running Microsoft Exchange Server, select Programs > Administrative 
Tools > DNS. If DNS is not available, DNS needs to be installed from the Operating System CD. 

2. Check that there is an entry within the domain for each messaging hosts involved. 

3. Configure each PC to use the DNS server to resolve names. This is done in the Internet protocol (TCP/IP 
Properties form of each LAN interface). 
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Verification and Troubleshooting 
The configuration can be tested by creating a message and forwarding it to the far end of the system. Check that 
the message is received at the correct destination. If the test fails, one of the following procedures may isolate the 
problem. 

 

Ping Test 

Make sure that you can ping all end points. If DNS is used, ping using the machine name. 

 

SMTP Service Test and Name Determination 

Test that the SMTP service of a messaging system is working by using telnet command as follows. 

1. From a DOS or UNIX prompt, type telnet ip-address 25. 

2. At the response, type Helo. 

3. At the response, type Quit. 

4. If the response is not as shown below, then the SMTP service is not running on the machine and incoming 
VPNM messages will not be processed. Check that the required PC services are running. 

telnet 172.16.254.197 25 
220 avaya-8ccy2i4d3 Microsoft ESMTP MAIL Service, Version 5.0.2195.6713 
ready a 
t, Wed, 22 Oct 2003 08:45:03 -0400 
Helo 
250 avaya-8ccy2i4d3 Hello [172.16.254.197] 
Quit 
221 2.0.0 avaya-8ccy2i4d3 Service closing transmission channel 
Connection t 

 

Check That the Required PC Services are Running 

From the Control Panel, select Administrative Tools > Services. Check that the following services are Started 
with a Startup type of Automatic. 

 SMTP. 

 VoiceMail Pro Service. 

 VPNM Database Service. 

 VPNM Server. 

 VPNM Receiver. 

 

Check the VoiceMail Pro SMTP Settings 

From the PC Control Panel, select the Avaya VoiceMail Pro icon. 

1. Select the SMTP name. 

2. Ensure that the Mail Server name is exactly the name of the VoiceMail Pro server PC. 

3. Select Check to make sure that a successful connection to the SMTP service can be made. 
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Interchange Basic Tests 

From the Interchange Main Menu, select Customer/Services Administration > Diagnostics. Perform the 
following basic checks. 

 TCP/IP Diagnostics. 
Send and receive Test Packets - ping the IP address. 
View Packet Statistics - look for any interface issues for example. collisions. 

 Display Message Queue - monitors the contents of the outgoing message queue. If messages cannot be 
sent e.g. due to administrative errors, then this queue is likely to contain the unsent messages. 

 Remote Connection Test - test the basic connection to a remote Audix system. 

 

Audix Browser Status Test 

 From the Browser interface to the S8100, select System Administration > AUDIX Networking > 
Maintenance Menu > Network Snapshot. See the status of connectivity to the Interchange. 

 

S8100 Ping Test 

 From the Avaya Terminal Emulator interface to the S8100, select cmd at the Enter Command prompt. 

 At the DOS prompt, enter ipconfig to verify the IP address and gateway. 

 Ping to test the connection. 

 

Check the Status Through the Intuity Audix Command Line Interface 

 To update the Audix with reachable subscribers through the interchange, from the audix command line 
prompt type get remote-updates machine and Enter where the machine is the name of the interchange 
system. 

 Repeat the command periodically (and cancel out) until the 'Status of Last Update' entry is completed. 

 From the command line prompt type display administrator's-log where message delivery failures and 
reasons can be found. 

 

Message Exchange Test 

In general the following capabilities are supported and can be verified. 

 Sending Messages to lists or individuals, preserving any combination of Priority and Privacy. 

 Replying to the sender. 

 Forwarding. 

 

Couldn't Send Message! Warning 

The following warning is normally associated with not having specified a fully qualified domain name for the local 
SMTP server address. 

" <CVPIM::bSendMessage>Couldn't send message!Response:550 5.7.1 Unable to relay for 
210@avaya2k.test.avaya.com " 
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Installing Centralized VoiceMail Pro 
Overview 
A single VoiceMail Pro server on a central IP Office system can be used to provide voicemail services for other 
remote IP Office systems. This is called Centralized VoiceMail Pro. 

Centralized VoiceMail Pro requires the IP Office systems to be linked by an IP Office Small Community Network 
(SCN). To avoid the likelihood of two VoiceMail Pro servers answering for the same user, only one centralized 
VoiceMail Pro server can be installed on a single Small Community Network (SCN). For more information about 
restrictions that need to be considered before installing Centralized Voicemail, see Restrictions. 

 

Notes 

 For information about small community networking and setting up VoIP lines, see the IP Office Manager 
User Guide. 

 By default each IP Office is set to use a broadcast IP address to locate a voicemail server. It can therefore 
appear that centralized voicemail is operating before the remote system is set to the Voicemail Type of 
Line. 

 Leaving the systems in this arrangement rather than setting the remote system's Voicemail Type to Line 
can cause problems and is not supported. 

 

Planning Requirements 
The following factors must be remembered during planning of the Centralized VoiceMail Pro system: 

 The voicemail Server PC is attached to the central system. 

 A Feature key and VoiceMail Pro license key are required for the central system hosting the VoiceMail Pro. 

 Small Community Networking (SCN) is required between the central system and remote systems. This 
document assumes that this has already been set up and tested. 

 On networked IP Office systems, it is possible for centralized voicemail to appear operational without Small 
Community Networking. However, this operation tends to be unpredictable and so we support Centralized 
VoiceMail Pro only when using Small Community Networking. 

 VCM modules or VoIP channels are required in the remote and central systems. 

 The extension and group numbering on all systems must be unique. 

 The extension and group names on all systems must be unique. 

 We also recommend that all names and numbers (groups, line, services, etc) on the separate IP Office 
systems are kept as unique as possible. This will reduce potential maintenance confusion. 
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Restrictions 
 Only one VoiceMail Pro server can be installed on a single Small Community Network (SCN). 

 Centralized VoiceMail Pro is the only type of voicemail service that can run on a Small Community Network 
(SCN). 

 The number of simultaneous voicemail users is restricted by the VoiceMail Pro license on the central 
system, up to the maximum number of data channels for voicemail supported by the central system's 
control unit. 

 For extensions on the remote system, access is also restricted by the number of available 
VoIP and VCM channels on that system. 

 VoiceMail Lite and Embedded VoiceMail cannot be used with Centralized VoiceMail Pro. 

 Supported Remote IP Office VoiceMail Features:  
Not all VoiceMail Pro features are available on the remote IP Office systems, for example hunt group 
queuing messages are not supported. Currently, the only features supported for remote sites are: 

 Automated Attendant. 

 Voice Messaging (leaving and collecting messages). 

 Call Recording. 

 Dial by Name Directory. 

 

Licensing 
The most commonly seen problem in Centralized VoiceMail Pro is misunderstanding the licensing requirements. 

 The voicemail licenses are entered on the central IP Office and validated against its Feature Key. 

 The remote IP Office systems do not need any voicemail licenses. 

 By default each IP Office uses a broadcast address to locate a Feature Key Server PC and validate its 
licenses. 

 Once a Feature Key Server has validated licenses with one IP Office it will not do validation for another IP 
Office unless rebooted. 

Given the above, we strongly recommend that in any multiple IP Office network, the License Server IP Address 
(System form > System tab) on each IP Office is set to the specific address of its Feature Key server or blank if 
using a serial port Feature Key. If a remote IP Office does not have a Feature Key Server (because it is not using 
any licenses) enter 0.0.0.0. 

It is important to note also that the VoiceMail Pro server will operate for 2 hours without license validation. This can 
cause VoiceMail Pro and Centralized VoiceMail Pro to appear operational following installation and to then stop. 
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Installing Centralized VoiceMail Pro 
Before you start to install a centralized Voicemail Pro system, make sure that you have considered the planning 
requirements, restrictions and licensing arrangements. For more information, see Planning Requirements, 
Restrictions, and Licensing. 

To install VoiceMail Pro at the central system: 

1. Install the central and remote IP Office systems. 

2. Install and test IP Office Small Community Networking. Refer to the Job Aid "Small Community 
Networking". Job Aids are available from the IP Office knowledge base at 
www.avaya.com/ipoffice/knowledgebase. 

3. Start IP Office Manager and receive the configuration of the central system. 

4. Set the License Server IP Address to the address of the PC acting as the central system's Feature Key 
Server PC. For more information, see the IP Office Manager help. 

5. Install VoiceMail Pro on the Voicemail Server PC that is attached to the central system. 
The installation process is the same as for normal non-centralized voicemail operation. Fore more 
information see Installing the VoiceMail Pro Software. 

6. Test and confirm the voicemail installation by dialing *17 at an extension on the central system. 

7. Configure the Remote System Voicemail Settings in IP Office Manager. For information, see Configuring 
the Remote System Voicemail Settings. 

 

Configuring the Remote System Voicemail Settings 
After you have installed the centralized VoiceMail Pro, you are ready to configure the remote system settings. 

To configure the remote system Voicemail settings: 

1. Start IP Office Manager and receive the configuration of the remote system. 

2. Set the License Server IP Address to the address of the PC acting as the remote system's Feature Key 
Server PC. 

 This cannot be the same PC as the central system's Feature Key Server PC. 

 If the remote system does not use any licenses, enter 0.0.0.0. 

3. Double-click the System icon. 

4. Select the Voicemail tab and set the following: 

 Set the Voicemail Type to Line. 

 Set the Voicemail Destination to the Outgoing Group ID set on the VPN line to the central 
system. 

5. Load the configuration and reboot the remote IP Office. 

6. Dial *17 at an extension on the remote IP Office. The call should ring the VoiceMail Pro server and then 
access the extensions mailbox. 

 

Fax Configuration 
When fax detection is required in a small community network (SCN) there are some specific settings required in IP 
Office Manager. 

To setup fax detection for a small community network: 

1. Open IP Office Manager. 

2. In the Navigation pane click  Line and select the IP Line. 

3. View the VoIP Settings tab. 
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Installing Text to Speech 
Overview 
The VoiceMail Pro server is able to use the Text to Speech (TTS) feature to: 

 Speak text in call flows using the Speak Text action. The text can include variables passed from other 
actions including database actions. 

 Support Email Text to Speech. This requires MAPI based Voicemail Email to have been set up and tested. 

VoiceMail Pro TTS requires the server PC to have a Microsoft SAPI 5 compatible TTS engine installed and a valid 
license entry. Two IP Office licenses exist to enable VoiceMail Pro support for TTS operation. These are: 

 VM Pro Generic TTS 
This license enables the VoiceMail Pro server to use either Microsoft's own SAPI5 TTS engines or third-
party SAPI 5 compatible TTS engines. The Microsoft TTS engines (Microsoft Sam, Mike, Mary and 
Simplified Chinese) are installed by default as part of the Microsoft Windows installation. One license is 
required for each simultaneous instance of TTS usage. 

 VM Pro ScanSoft TTS 
This license enables the VoiceMail Pro server to use Avaya supplied TTS engines. These engines 
currently provide better voice quality than the Microsoft TTS engines and support a wider range of 
languages. They are supplied on a set of 5 CDs separate from the VoiceMail Pro software CD. One license 
is required for each simultaneous instance of TTS usage. 

Tip 

 For a customer demonstration, sales staff can use the Microsoft Speech SDK 5.1 which includes a TTS 
playback application that enables you to play and compare different TTS engines without requiring 
VoiceMail Pro. For example you can compare the Avaya-Scansoft TTS engine with the Microsoft TTS 
engine. If you install the application on a sales laptop PC that has the Scansoft TTS installed on it, you can 
then choose a TTS engine and produce a WAV file for the specified TTS engine. The Microsoft Speech 
SDK is available from http://www.microsoft.com/speech/download/sdk51/. 

The following languages are supported by the Avaya TTS engines:  

 Chinese 

 Dutch 

 English (UK) 

 English (US) 

 French 

 German 

 Italian 

 Korean 

 Norwegian 

 Brazilian Portuguese 

 Russian 

 Spanish 

 Latin Spanish. 

 

 Multiple Language TTS Support 
More than one language can be installed. A Select System Prompt Language action can then be used to 
switch TTS to a different language from the selected default. 

 Email Reading 
When installed in parallel with VoiceMail Email, VoiceMail Pro TTS can be used to provide email reading to 
selected mailbox users. For more information, see Voicemail Email:Overview and Setting Up Text To 
Speech to Read Email. 
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Installing Generic Text to Speech 
To install Text to Speech: 

1. Install and test VoiceMail Pro as normal. 

2. Using IP Office Manager, add the VMPro TTS (Generic) license into the IP Office configuration. Send the 
new configuration to the IP Office system. 

3. Reload the IP Office configuration into IP Office Manager and check that the status of the license has 
changed to Valid. 

4. The VoiceMail Pro installation includes the default Microsoft TTS engines (Microsoft Sam, Mike, Mary and 
Simplified Chinese) as standard. If another third-party SAPI 5 compatible TTS engine is going to be used, 
install that software. 

5. Open the Control Panel and click  Speech. 

6. Select the Text to Speech tab. The installed TTS engines should be listed. 

7. Adjust and test the setting to obtain the speech required. 

 

Installing Avaya Text to Speech 
The Avaya TTS engine for VoiceMail Pro is supplied on a set of CDs. Each CD contains a different set of 
languages. However, in each case CD 1 is required to start the TTS engine installation process. 

To install Avaya Text to Speech: 

1. Install and test VoiceMail Pro as normal. 

2. Using IP Office Manager, add the VM Pro TTS (ScanSoft) license into the IP Office configuration. Send 
the new configuration to the IP Office system. 

3. Reload the IP Office configuration into IP Office Manager and check that the status of the license has 
changed to Valid. 

4. Insert the first Avaya TTS CD. The installation should auto-start. 

5. Follow the prompts and install the required languages. Depending on the languages that you select, 
instructions to insert the other CDs in the set may follow. 

6. Open the Windows Control Panel and click  Speech. 

7. Click the Text to Speech tab. The installed TTS engines should be listed. 

8. Adjust and test the setting to obtain the required speech. 

 

Configuring Text to Speech 
To configure TTS Speech: 

1. Start the Windows Control Panel. 

2. Select  Speech. 

3. Select the Text to Speech tab. 

4. The Voice Selection box shows which TTS engine is currently being used by Windows. This is the same 
TTS engine that will be used by the VoiceMail Pro server. 
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Using the Speak Text Action 
One method of employing TTS is through adding a Speak Text action to a call flow. The text to be spoken is 
entered in the action's Specific tab. This text can include combinations of: 

 Typed text sentences. 

 VoiceMail Pro System Variables. For example: 

 Entering $KEY would be replaced when spoken by the last digits dialed within the call flow by the 
caller. 

 If using database interaction, entering $DBD[x] would be replaced by the current value of that 
database field. 

 Entering $CLI would speak the caller's CLI, if available, back to them. 

 SAPI 5 XML tags can be added to alter how the text is spoken. For example: 

 When 123 needs to be spoken as one two three rather than "one hundred and twenty-three", enter 
<spell>123</spell>. 
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Text to Speech SAPI Controls 
Windows TTS engines use Microsoft's SAPI (Speech Application Program Interface). This includes the use of XML 
tags in the text to change how the text is spoken. For example, in the text This is the <volume 
level="90">text</volume> to speak the items within < > brackets are XML tags used to change how the speech 
is spoken. 

The following are samples of the SAPI XML controls supported by VoiceMail Pro TTS. Further information on SAPI 
5 can be obtained from Microsoft support websites. 

 Volume - Change the speech volume. 

 Rate - Change the speech rate. 

 Pitch - Change the speech pitch. 

 Emph - Add emphasis to words. 

 Spell - Spell out words and numbers literally. 

 Silence - Add a period of silence. 

 Partofsp - Change the usage of words. 

 

Entering XML Tags 

XML tags can be used in two ways, either nested or empty. 

 Nest Tags: Example = <volume level="90">text</volume> 
Nested tags consist of: 

 An opening XML tag, in the example above <volume level="90">. 

 The text to which the opening tag command should be applied. 

 A closing XML tag. The closing tag use the same command as the opening tag, prefixed with / and 
no other settings. In the example above this is </volume>. 

 Empty Tags: Example = <volume level="90"/>All following text 
An empty tag is not nested, its command and settings apply to all the following text. Empty tags are 
recognizable by the / before the tags closing >. 

 

Example SAPI XML Tags 

Volume 
Controls the volume of the speech. This tag can be nested or empty. 

 Attributes:  

 level=  
Supports values between 0 and 100, being percentages of the system's set volume. 

 Examples: 

 <volume level="50"/>Speak allow following text at level 50. 

 <volume level="50">Speak this text at level 50</volume> and this as normal. 
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Rate 
Controls the speed at which the text is spoken.  This tag can be empty or nested. 

 Attributes: 
Only one attribute may be applied within a tag. 

 absspeed= 
Sets the absolute speed for the speech in a range between -10 and 10 with 0 being normal 
speech. 

 speed= 
Sets a speed change that is added to the current speed. 

 Examples: 

 <rate absspeed="5">Speak this text at rate 5</rate> and this text as normal. 

 <rate absspeed="5"/>Speak all following text at rate 5. 

 <rate speed="-5"/>Drop the current speech speed by 5. 

Pitch 
Controls the pitch at which the text is spoken.  This tag can be empty or nested. 

 Attributes:  
Only one attribute may be applied within a tag. 

 absmiddle= 
Sets the absolute pitch for the speech in a range between -10 and 10 with 0 being normal speech. 

 middle= 
Sets a pitch change that is added to the current speed. 

 Examples: 

 <rate absmiddle="5">Speak this text at pitch 5</rate> and this text as normal. 

 <rate absmiddle="5"/>Speak all following text at pitch 5. 

 <rate middle="-5"/>Drop the current speech pitch by 5. 

Emph 
Applies emphasis to a word or section of text. This tag must be nested. 

 Attributes: 
This tag has no attributes. 

 Example: 

 Say <emph>boo</emph>. 

Spell 
Spell forces the engine to speak any nested text literally rather than applying any speech rules. This is useful for 
numbers where rather that than saying 3001 as three thousand and one for 3001, the speech required is three zero 
zero one. This tag must be nested. 

 Attributes: 
This tag has no attributes. 

 Example: 

 The telephone number is <spell>555 3468</spell>. 
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Silence 
Inserts a period of silence. This tag must be empty. 

 Attributes: 

 msec= Sets the duration in milliseconds. 

 Example: 

 A short silence <silence msec="500"/> of half a second. 

Partofsp 
Forces the pronunciation of a word according to it usage if not correctly determined by the TTS speech engine or to 
override the engine. This tag must be nested. 

 Attributes: 

 part= Takes a value from noun, verb, modifier, function or interjection. 

 Example: 

 To <partofsp part="verb">record</partofsp> that <partofsp part="noun">record</partofsp> press 1. 
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Setting Up Text To Speech to Read Email 
It is not possible to parse email without a license for TTS. Therefore, it is not possible to forward emails without a 
valid TTS license. 

In conjunction with MAPI email clients and Exchange server, TTS can be used to read new e-mails in a user's 
email inbox when they access their voicemail mailbox. 

This feature is supported only for Intuity mode. Users hear their new voicemail messages and then the number of 
"Messages with text". Before each email is spoken, details of who it is from, when the message was sent and the 
size are given. This allows large or non-urgent e-mails to be skipped. 

 Email reading cannot be used for e-mails in HTML format. If HTML messages are received, all of the code 
will be read out as a message. 

 

To set up text to speech to read email: 

1. Install and test VoiceMail Pro for MAPI-based VoiceMail Email operation with an Exchange Server. 

2. To perform email reading, the Voicemail account created on the Exchange server for VoiceMail Email 
must able to access the individual users email mailboxes. This can be achieved by either: 

 On the Exchange Server, ensure that Voicemail user account is granted rights to access all user 
email boxes, or; 

 Within each user's Outlook: 

1. Select Tools > Options. 

2. Select Delegates. 

3. Add the voicemail account as a delegate. 

3. If you have not already done so, install and test TTS operation using a Speak Text action. 

4. Using IP Office Manager, load the IP Office configuration and open the settings for each user. 

 

5. In Voicemail Email, enter the user's email address. The same address is used for both Voicemail Email 
and Email Reading services. 

6. Select Voicemail Email Reading. 

 For systems upgraded from 2.0, where a + sign was used in front of the users email address to 
indicate Email TTS usage, the + sign is automatically removed and the Voicemail Email Reading 
box is selected. 

7. Click OK and merge the new configuration back to the IP Office system. 

8. Send the user a test email. Then log into the user's voicemail mailbox and check whether following the 
voice messages a new "message with text" is announced. 
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Installing IMS 
Overview 
Integrated Messaging Service (IMS) allows users to deal with voicemails through their normal email interface 
(Microsoft Outlook or Exchange). Voicemails can still be handled conventionally using the telephone. 

 

Voicemails are presented with a special icon in the user's email inbox. When a voicemail is opened, a special form 
appears which enables the user to play back the message on their telephone. The voicemail itself remains on the 
voicemail server. 

When a voicemail is read, forwarded or deleted, either from the email or by using the phone, its status is reflected 
in both the mailbox and the email inbox. 

Playing Messages Through the PC  
Normally IMS plays the voicemail messages through the PC user's telephone. IMS can be set up to send the 
voicemail messages as wav files which are played using the PC's sound capabilities. However, this creates a 
heavy load on the network and servers and so is not recommended. Typically, one minute of speech requires the 
transfer of a 1MB file across the network. 

Required Network and Exchange Server Knowledge  
Installation of IMS requires access to the customer's Exchange server and to other critical components of their 
network. The installation should be performed only by an installer with good knowledge of Exchange Server and 
Microsoft network setup. The installation should also be performed only in conjunction with the customer's network 
manager. 

Important 

 To ensure the successful installation of VoiceMail Pro with IMS, the steps in the following sections should 
be followed. Particular attention should be paid to the Permissions specified. 

 Installation of the IMS components on the VoiceMail Pro server PC is part of the VoiceMail Pro installation. 
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IMS Limitations 
IMS is designed to work in a system that comprises one IP Office and one Microsoft Exchange Server. It can be 
used in a system with more than one telephone system as long as that system has centralized voicemail using just 
one voicemail server. 

IMS cannot be used to: 

 Save a voicemail. 

 Compose a new voicemail. 

 Reply to a voicemail. 

 Add comments to a forwarded voicemail. 

 Mark a voicemail as urgent. 

Voicemails should not be placed in Public Folders. 

Windows 98 client PCs must connect to the IMS Server PC using TCP/IP. Clients that do not use TCP/IP are not 
supported. 

To reduce startup time, IMS scans only the root inbox for new messages when it starts up. 

 

IMS Components 
IMS consists of the following components. 

 VoiceMail Pro  
Provides voicemail services to the IP Office extension users. 

 IMS Server  
This consists of two services installed on the VoiceMail Pro Server PC: 

 IMS Voice Service 

 IMS Gateway Service  
Interacts with the VoiceMail Pro Server, the Exchange Server and the IMS Clients. Stores the 
current known status of voicemail messages and mirrors that status in both user's email and 
voicemail mailboxes. 

 Microsoft Exchange Server 
The customer's MS Exchange server. 

 IMS Administration Tool 
This tool is used to maintain the association of voicemail mailboxes to email mailboxes. 

The following additional components are required on the user PCs. 

 Microsoft Exchange or Outlook  
Microsoft Exchange Client or Outlook 97 or higher. 

 IMS Client  
Installed on each email user's PC. This provides a voicemail interface within the user's Microsoft Exchange 
or Outlook program. 
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IMS Installation Alternatives 
The IMS Server actually consists of two components:  

 IMS Gateway Service. 

 IMS Voice Service. 

These components can be installed separately if required. However the following rules must be followed: 

 The IMS Voice Service must be installed on the VoiceMail Pro server PC. 

 The IMS Gateway Service can be installed on either the VoiceMail Pro server PC or the Exchange Server 
PC. Installation of the IMS Gateway Service onto the Exchange Server PC requires more installation steps 
but may improve performance in some systems. 

 

Before Installing IMS 
Before you start to install IMS you must check that: 

 Microsoft IIS Web Server is installed. 

 In the IP Office Manager the IMS license has the status of Valid and Unlimited. This is because IMS 
operation requires a license in IP Office in addition to the VoiceMail Pro licenses. The required licenses 
are: 

 VoiceMail Pro (4 ports) plus Additional VoiceMail Pro (X ports) licenses up to the total number 
of port required or supported by the IP Office control unit. 

 Integrated Messaging - Enables operation of IMS with VoiceMail Pro. 

For more information, see the IP Office Manager help. 

 In the IP Office Manager, the Voicemail Email settings are switched off. This is because the IP Office 
configuration settings for each user do not apply to IMS. They are usually switched off by default but it is 
advisable to check before you start the installation. For more information, see the IP Office Manager help. 

 A domain user and mailbox account exists called IMS. For information about creating this account, see 
Creating and Configuring the IMS Account. 

 The Outlook or Exchange client on the server PC is configured to use the same account. For information 
about creating this account, see Creating and Configuring the IMS Account. 

Important 

 Only when these checks have been completed, are you ready to start installing the IMS and VoiceMail Pro 
software. For more information, see Installing the IMS and VoiceMail Pro Software. 

 

Integrated Messaging Service (IMS) connections require: 

 The voicemail server to use MAPI. 

 As part of the IMS installation an Exchange User account for user IMSAdmin will be required. 

 The account must be a member of the same domain as the VoiceMail Pro Server. 

 A list equating Exchange User account names with voicemail box users is required. 

 Integrated Messaging Pro (IMS) is supported on Microsoft Exchange 5.5, 2000 and 2003 (SP1 and SP4). 

 



Installing VoiceMail Pro 

VoiceMail Pro Installation and Maintenance Guide Page 79  
IP Office 4.0 15-601063 Issue 16 (12th December 2006)  

Creating and Configuring the IMS Account 
Complete the steps in this section to: 

 Create a domain user and mailbox account called IMS. 

 Configure the Outlook or Exchange client on the server PC to use the account that you have created. 

 

To create and configure a domain user and mailbox account called IMS: 

1. Make sure that the PC that will be running the Integrated Messaging Server, normally the VoiceMail Pro 
server PC, is a member of the same domain as the Exchange server. 

 Right-click My Computer. Select Properties and select the Network Identification Tab. To join 
the domain you will need to use a log on account with administrative permissions on the domain. 

2. Create an account called IMS on the domain and an associated Mailbox. Provide a secure password and 
ensure User Cannot Change Password and Password Never Expires are checked. 

3. On the VoiceMail Pro PC, select Administrative Tools > Computer Management > Groups. 

4. Select Add. From the Look In list select the domain name. 

5. In the Name window, highlight the IMS account and click Add. Click OK twice. 

6. On the desktop, right-click the Outlook icon and select Properties to configure the IMS Account. 

7. On the Mail Properties > General Screen, click Add. 

8. Check the Microsoft Exchange checkbox and click Next. 

9. Type in the Exchange servers name in the Server field, and IMS account in the Mailbox field. Click Next. 

10. Select No when asked if you travel with this computer. Click Next. 

11. Click Finish. 

12. Highlight the MS Exchange Settings and click Properties. 

13. Highlight Microsoft Exchange Server and click Properties. 

14. Click Check name and ensure the name is resolved. 

15. If the name is resolved, select Apply. Click OK twice and then click Close.  

16. Do not continue until the name has been correctly resolved with the Exchange Server. If the name is not 
correctly resolved, check the Exchange and Mail account details with the Exchange Administrator. 

17. Open Outlook and select Yes to register Outlook as the Default eMail application. 

 



Voicemail Pro Installation and Maintenance Guide 

Page 80 VoiceMail Pro Installation and Maintenance Guide 
15-601063 Issue 16 (12th December 2006) IP Office 4.0 

Installing the IMS and VoiceMail Pro Software 
Do not start to install the IMS software before you have completed the necessary pre-installation checks. For more 
information, see Before Installing IMS. 

To install the IMS and VoiceMail Pro Software: 

1. Insert the IP Office VoiceMail Pro CD. The installation should auto-start. If it does not auto-start, click 
Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens. 

2. Select the installation language. This language is used for the installation and for the default language 
prompts. 

3. Click OK. Installation preparation begins. 

4. If the following window opens, VoiceMail Pro is already installed. You need to upgrade rather than install a 
new version. For more information, see Upgrading a VoiceMail Pro System. 
 
If you have already installed basic VoiceMail Pro onto the PC, and now want to install IMS, the instructions 
are the same. The difference is that when prompted to Modify, Repair or Remove, you must select Modify 
and check the Integrated Messaging box later in the installation process. 
 

 
Otherwise the IP Office VoiceMail Pro installation starts and the Welcome window opens. 

5. In the Welcome window, click Next. The Customer Information window opens. 

6. In the Customer Information window, type a user name and the company name or use the default names 
that are proposed. These settings do not affect VoiceMail Pro when it is installed. 

7. In the same window choose the option that determines who should be able to use VoiceMail Pro when it 
has been installed. The recommended option is Anyone who uses this computer (all users). 

8. In the Customer Information window, click Next. The Choose Destination Location window opens. 

9. In the Choose Destination Location window, click Browse and choose the folder where the VoiceMail Pro 
files are to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components 
window opens so that you can choose the components that you want to install. 

10. Unless there are specific reasons for changing the location, the default setting is recommended. 

11. In the Messaging Components window, highlight VoiceMail Pro (Full). 

12. Click Next. The Setup Type window opens. 

13. In the Setup Type window, select Custom. 



Installing VoiceMail Pro 

VoiceMail Pro Installation and Maintenance Guide Page 81  
IP Office 4.0 15-601063 Issue 16 (12th December 2006)  

14. Click Next. The Select Features window opens so that you can select which additional VoiceMail Pro 
features to install. 

15. For IMS ensure that the settings are as follows: 

 VoiceMail Pro Campaign Web Component is not required for IMS but is installed as part of a 
typical VoiceMail Pro Server installation. If a web server has already been installed but the 
VoiceMail Pro Campaign Web Component is not required, uncheck it to remove it. If VoiceMail Pro 
Campaign Web Component is required for other use, make sure that it is checked so that it is not 
removed. 

 Ensure that Voicemail Pro Client and VoiceMail Pro Service are checked. 

 Check any additional languages that are required. It is recommended that either English or 
English US is always selected (installed by default) in addition to any languages that are required 
by the customer. 

 Important 
Do not uncheck any other boxes as this will remove the corresponding software features. 

 Scroll down and check Integrated Messaging Service.  

 

16. Click Next. If you have chosen to install the VoiceMail Pro Campaign Web Component, the Select the Web 
Server root directory window opens. 

17. Type the path to the folder where you would like to save the web campaign web pages. Alternatively, use 
the default location or click Browse and select a folder to use. 

18. Click Next. The Select the Destination of the Script directory of Your Web window opens. 

19. Type the path to the folder where the web campaign components are to be installed. Alternatively, use the 
default location or click Browse and select a folder to use. 

20. Click Next. The Service Account Name window opens. Details of the default administrator account are 
already filled in. 

21. In the Service Account Name window, type the User Name and Password for the user account under 
which the VoiceMail Pro service should log on and run. This should be the IMS account created previously 
on the domain and Exchange server. Alternatively, click Browse and select from the list of available PC or 
network accounts. 

22. Click Next. The Select Program Folder window opens. 

23. By default the program folders are created in a folder called IP Office. You can specify a different folder or 
select one from the list of existing folders. To specify a different folder, type the folder name in the Program 
Folders box. Alternatively, to use an existing folder, highlight a name in the list of existing folders. 
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24. Click Next. The Start Copying Files window opens. Before any copying starts, you are presented with a 
summary of the settings that you have chosen so far. 

25. Review the settings to make sure that they are what you expect. In particular, check that the required 
languages are listed. Scroll down if necessary. 

 If for any reason the details are not what you expect, click Back and make the necessary changes.  

26. When you are satisfied that the details are correct, click Next to start copying the files. The Setup Status 
window opens to keep you informed while the installation takes place. 

27. When the installation is complete, click Finish to restart now. 

28. An attempt is made to start all services associated with VoiceMail Pro and IMS. 

 Important - This step fails if the licenses are not valid on the IP Office. 

 

29. After the services have started, the installation process continues. The IP Office VoiceMail Pro - System 
Settings window opens. 

30. Select the required logging levels. Logging may be useful for fault diagnostics. You can switch logging off 
after you have verified that IMS is working correctly. 

31. Click Next. The IP Office VoiceMail Pro - Path Settings window opens. 

32. Enter the name of the server PC on which VoiceMail Pro and IMS have been installed. In most cases the 
name is detected automatically and filled in for you. If not, click Browse and provide the name of the 
Integrated Message Voice Server. 

33. In the IP Office VoiceMail Pro - Path Settings window click Next. The IP Office VoiceMail Pro - Email 
Settings window opens. This window is where you set user names and passwords for applications that can 
access the VoiceMail Pro server. 

 In the Account Details field, type the name of the email account to use IMS email messages. 
Alternatively, click Browse and provide the name of the email account to use. 

34. If wav files of voicemail messages are to be sent in emails, check Transmit Wave Files. 

 Sending .wav files across a network creates a high loading on the network and network servers. A 
one minute message requires a 1MB .wav file. 

35. Choose the preferred option for transmitting the wav files. Choose either: 

 Attach wave file to message to allow a recipient to copy a .wav file for use elsewhere. 

 Embed wave file in message to allow a recipient to embed a file in a message. 
Tip - An embedded file is compressed and therefore smaller than an attached file. 

36. Click Next. The IP Office VoiceMail Pro - SMTP Email Settings window opens so that you can enter details 
of the SMTP server to which the VoiceMail Pro should send messages.  
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37. Click Finish. An attempt is made to validate the email settings. If everything has been installed correctly 
and the license requirements are met, you are prompted to start the voicemail service. If the attempt to 
connect with the SMTP server fails, an error message is displayed. You might need to start the voicemail 
service manually. For more information, see Starting the VoiceMail Pro Service. 

38. Click OK to acknowledge the message if you see it. The software installation stage is now complete. The 
next step is to switch on to MAPI settings, if they are not already set. For information, see Switching 
VoiceMail Pro to MAPI. If MAPI is already configured, the next step is to associate an email address with 
each user voice mailbox. For more information, see Associating Voice Mailboxes with Email Addresses. 
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Starting the VoiceMail Pro Service 
If VoiceMail Pro has been installed successfully, the voicemail service is started automatically. From time to time it 
might be necessary to start the voicemail service manually, for example if you encounter problems during the 
installation or need to investigate problems at a later stage. 

This process consists of two stages: 

1. Ensuring that the VoiceMail Pro server restarts automatically every time the server PC is restarted. 
The VoiceMail Pro server installs a service, using the user name and password of the account specified 
during installation. The service is set to automatically restart each time the PC restarts. 

2. Initializing the default call flow. 

 

The steps that follow apply to Windows NT4, 2000, XP and 2003. 

To start the VoiceMail Pro Service: 

1. Open the Windows Control Panel. 

2. Select Administrative Tools > Services. 

 

3. The VoiceMail Pro Server service should be visible. Its Status should be Started and the Startup Type 
should be set to Automatic. 

4. Close Services. 

 

To Initialize the VoiceMail Pro Call Flow:  

1. Select Start > Programs > IP Office > VoiceMail Pro. The VoiceMail Pro Client starts and the main 
window opens. 

2. Click the  Save and Make Live icon. 

3. Select Yes. The file root.vmp is created and made available to the VoiceMail Pro server. This is the 
compiled version of the editable call flow. 

4. Voicemail operation can now be tested from an extension by dialing *17. 
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Switching VoiceMail Pro to MAPI 
By default, the VoiceMail Pro installation process assumes that SMTP will be used and requests SMTP email 
account settings during installation setup. VoiceMail Pro uses MAPI and so the VoiceMail Pro must be switched to 
MAPI operation. 

If you are installing IMS, use the IMS account previously created as part of the installation process. For more 
information, see Installing IMS:Overview. 

 Some options are not available if you are working offline. You must be working online to use this feature. 
For more information, see Logging in to the VoiceMail Pro Server and Changing Between Offline and 
Online Mode. 

 

To switch VoiceMail Pro to MAPI: 

1. Start the VoiceMail Pro Client. 

2. Click  Preferences and select General. 

3. Click the MAPI tab. 

 

4. The Use Email Protocol settings allow you to switch VoiceMail Pro between MAPI and SMTP. 

 If MAPI is selected, a valid MAPI profile and password must be entered in the fields above. That 
MAPI profile must exist within the MAPI email client on the server PC and be useable by the 
account under which the VoiceMail Pro service is running. 

 If SMTP is selected, the SMTP email account settings must be entered. 

5. Click OK. 

6. Click  Save and Make Live. 
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Associating Voice Mailboxes with Email Addresses 
When you have installed IMS, started the VoiceMail Pro server and switched from SMTP to MAPI, you are ready to 
associate the user voicemail mailboxes with email mailboxes on the Exchange Server. This is done using the IMS 
Administration tool. 

To associate a voice mailbox with an email address: 

1. From the Start menu, select Programs > IP Office > IMS Administration Tool. 

2. From the Server menu, select Add. The New Integrated Messaging Server window opens. 

3. In the Server field, type the name of the IMS Server or click Browse and select a server. When the server 
has been added, the name is displayed with a [+] plus icon next to it in the left-hand pane. 

4. Expand the [+] icon to show configurable options. 

5. Highlight Integrated Messaging Associations. After a few moments the voice mailboxes are displayed in 
the right-hand window. 

6. Select a voice mailbox to configure and double-click it to see its properties. 

7. In the Associated Email Address field, select Change and select the relevant email address of the 
associated user. 

8. If the mail settings need to be different from the default settings, select the User Properties tab and 
configure as applicable and select OK. 

9. When complete, click the Synchronize Mailboxes icon to synchronize the mailboxes. Alternatively, click 
Selecting Mailboxes and Synchronize on the menu bar. 

10. Close the IMS Administration tool. 

11. Make a call to one of the users that you have just associated and leave a message in their voicemail 
mailbox. A short while after hanging up a message should arrive in the user’s mailbox. 

12. The next step is to install the IMS Client on the PC of each IMS user. For more information, see Installing 
the IMS Client Software. 
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Installing the IMS Client Software 
During installation of the IMS Server, the IMS Client Installer package is copied to C:\Program Files\Avaya\IP 
Office\Voicemail Pro\IMS\Client and is automatically shared as IMSClient. The installer, called IMSClient.exe is 
approximately 10.1MB is size. You need to install the IMS Client on the PC of each user who want to use IMS. 

Minimum PC specification for an IMS Client PC: 

RAM HD Pentium Celeron AMD XP Pro 2000 Pro 2003  

64MB 160Mb 800MHz Celeron 3 
800MHz 

Althon B 
650Mhz 

   

 Clients must use TCP/IP networking. 

 Users must be members of an Domain. 

 The supported email services are MS Exchange 2000 and 2003. 

 

Before you start to install the IMS client you must note the following important points: 

Important 

 The IMS client is supported with Microsoft Outlook 2000/2003. 

 Do not install the IMS Client on the same PC as the VoiceMail Pro / IMS Server. 

 If you are the installer or system administrator, you must log on to the Client PC as the person who is going 
to be using the IMS software and you must have Administrator rights for that PC. 

 Outlook must already be installed and configured on the user's PC. Test this by using Outlook to send a 
test message. 

 The Integrated Messaging Server must already be installed and running. For more information, see 
Installing the IMS and VoiceMail Pro Software. 

 The IMS PC requirements must be met. For more information, see IMS Client PC Requirements. 

 

To install the IMS Client software:  

1. Copy the IMS Client installer package to a CD or map a network drive to the folder as follows 
\\servername\imsclient. 

2. Log on to the user's PC using an account that has local administrative rights. 

3. Save and close all other applications prior to installing as a reboot will be required. 

4. Depending on where it is located, double-click the IMSClient.exe file. 

5. Choose the preferred Language and select OK. 

6. Click Next until you see the IMS Connection Information window. 

7. Enter the following information: 

 Voicemail Mailbox 
This is the entry as it appears in the Username field of the IP Office User Profile Screen. This is 
case-sensitive. If this information is entered incorrectly, the IMS client will not connect to the IMS 
Server. 

 IMS Server 
This is the name of the IMS / VoiceMail Pro Server. For maximum reliability, use of a fully qualified 
domain name is recommended. 

8. Click Next. The IMS Playback Parameters window opens. 

9. Type the extension number of the handset to be used for playing back messages. 

10. If required, check Pick Up Automatically for the option to collect messages without the need to pick up 
the handset. 
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11. When prompted to Restart the PC, click Finish to restart the PC. 

 If you attempt to open Outlook without restarting the computer, you will receive an error to tell you 
a component has not been installed correctly. It is therefore recommended that you restart the 
computer when prompted. 

 

Testing Installation of the IMS Client 

If the above details have been followed, after the end user has logged back onto their PC workstation and opened 
Outlook, complete the following steps to verify that the IMS Client has correctly connected to the IMS Server . 

Typically, when starting Outlook if there is a connection error, a message should be received while Outlook is 
starting, asking for a user name and password. 

1. In Outlook, select Tools > Integrated Messaging.  
If the IMS Client has connected you should only have the option to Disconnect. If this is the case you have 
successfully installed the IMS Client on the workstation. 

2. A further indication will be a Telephone Icon in the mail message. If the Client has not been installed, this 
icon will not be displayed. 

 

Checking and Observing IMS Operation 
It is useful to check that the IMS Account has logged onto the Exchange Server correctly. 

To check and observe IMS operation: 

1. On the Exchange server, open the Exchange Administration Manager. 

2. Expand the Server Name and Mailbox Store. 

3. Select Logons and locate the IMS account name. Only logged on accounts are displayed. 

4. Select Mailboxes to view IMS messages being received and sent. 

5. Leave a voicemail message in an IMS user’s voice mailbox. 

6. After hanging up you should notice that for a brief time the Total Items field for the IMS mailbox increases 
by 1. The message is then sent from the IMS mailbox to the user’s mailbox, whose Total Items increases 
by 1. By default, there should be no messages left in the IMS mailbox. 
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Upgrading VoiceMail Pro 
Overview 
This section describes how to upgrade VoiceMail Pro. The options available are: 

 Upgrading from VoiceMail Lite to VoiceMail Pro. For information, see Upgrading from VoiceMail Lite. 

 Upgrading a VoiceMail Pro version below 3.2 with the new version of software. For information, see 
Upgrading a VoiceMail Pro System. 

 Upgrading a VoiceMail Pro version 3.2 or higher with the new version of the software. For more 
information, see Upgrade from 3.2 or higher. 

 

Upgrade to VoiceMail Pro 
You can upgrade from VoiceMail Lite to VoiceMail pro. The process described here assumes that VoiceMail Pro is 
being installed onto the same PC that previously hosted VoiceMail Lite. The steps described here will remove 
VoiceMail Lite but will not remove the existing mailbox messages and greetings.  

To upgrade from VoiceMail Lite to VoiceMail Pro: 

1. Remove VoiceMail Lite 

1. Make sure that VoiceMail Lite is not running. It might be necessary to close the VoiceMail Lite 
server program. 

2. Open the Windows Control Panel and select Add/Remove Programs. 

3. Select IP Office Admin Suite and click Change. The Welcome to the Installshield Wizard for IP 
Office Admin Suite window opens. 

4. Click Next. The Program Maintenance window opens. 

5. Select Modify and click Next. 

6. In the list of selected Features, click the option VoiceMail Lite and select This feature will not be 

available. The feature VoiceMail Lite will have a red cross by the name. .  

 Important - Do not uncheck any other boxes as this will also remove those features. 

7. Click Next. the Ready to Modify the Program window opens. 

8. Click Install. The VoiceMail Lite program will be removed, which may take several minutes. 

9. Click Finish to exit the InstallShield Wizard. 

10. Click Close to close the Add/Remove Programs window. 

11. Remove any shortcuts to VMLite.exe from Start > Programs > Startup. 

2. Install the New Software 
The next step is to install the VoiceMail Pro software. For more information see Installing VoiceMail 
Pro:Overview and then refer to the sections that relate to the  type of VoiceMail Pro that you intend to 
install. 

3. Move the VoiceMail Lite Folders 
This must be done before users start to use VoiceMail Pro. 
As part of the upgrade procedure you need to move the VoiceMail Lite folders that contain any existing 
voicemail messages and mailbox greetings. This stage copies the existing VoiceMail Lite messages and 
greetings over the newly installed VoiceMail Pro set.  

1. Using Windows Explorer or My Computer, locate the folder C:\Program Files\Avaya\IP 
Office\Voicemail Server. 

2. Copy all sub-folders and files in that folder. 

3. Paste the sub-folders and files in the folder C:\Program Files\Avaya\IP Office\Voicemail Pro\VM. 
Replace any existing folders. 
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4. Select the Mailbox Mode. 
VoiceMail Lite runs in IP Office mailbox mode. By default VoiceMail Pro installs in Intuity mailbox mode. If 
required by your users, you can set VoiceMail Pro back to IP Office mailbox mode. 

1. Start the VoiceMail Pro Client. 

2. Click the Preferences  icon and select General. 

3. On the General tab, change the Default Telephony Interface from Intuity to IP Office. 

4. Click OK. 

5. Click  Save & Make Live. 

The new version of VoiceMail Pro has been installed. Test that the system is running by dialing *17 from any 
extension. You should hear the mailbox announcement. 
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Upgrade from VoiceMail Pro below version 3.2 
It is important that the settings of an existing VoiceMail Pro are exported before any upgrade. Although folders that 
contain prompts and messages are not affected by the upgrade process, the editable version of a customer call 
flow is lost. 

To upgrade from below version 3.2 to version 4.0: 

1. Export the Database 
Before removing VoiceMail Pro as part of an upgrade, you must create a backup copy of the call flow 
database. This will contain any customizations made to the default call flow.  

1. Start the VoiceMail Pro Client. 

2. From the File menu, select the option Import or Export. 

3. Select the option Export call flows and click Next. 

4. Enter a file path and file name ending in .mdb, for example C:\temp\backup.mdb. Click Next. 

5. Click Finish to start the export then click Close to complete the export procedure. 

6. Close the VoiceMail Pro Client. 
The next step is to back up the registry so that you do not lose any VoiceMail Pro settings from the 
previous version. 

2. Back up the Registry 
Any registry settings that are associated with VoiceMail Pro need to be backed up. 

1. Insert the VoiceMail Pro CD for the new VoiceMail Pro and cancel the install wizard that auto runs. 

2. Right-click the CD drive and select Open. 

3. Locate the file backupreg.bat and double-click it to run the application. The registry settings are 
backed up. 
The next step is to remove VoiceMail Pro.  

3. Remove VoiceMail Pro 
Any previous versions of VoiceMail Pro must be removed before you start to install the new version. 

1. Open the Windows Control Panel. 

2. Select Add/Remove Programs. 

3. Select IP Office VoiceMail Pro and click Add/Remove. 

4. From the options offered, select Remove and click Next. 

5. Follow the prompts that you see on the screen during the removal process. 

6. When the process has been completed, select the option Yes, I want to restart my computer 
now and click Finish. 

4. Restore the Registry 
The VoiceMail Pro registry that was backed up in step 2 needs to be restored. 

1. Right-click the CD drive that contains the VoiceMail Pro CD and select Open (reinsert the CD if 
necessary and cancel the install wizard). 

2. Locate the file restorereg.bat and double-click it to run the application. This restores the registry 
settings previously associated with VoiceMail Pro. 

3. Start the Voicemail Pro GUI. 

4. From the File menu, select the option Import or Export. 

5. Select the option Import Call Flows and click Next. 

6. Use the Browse button to locate the backup file then click Next. 

7. Click Finish to start the import then click Close to complete the import procedure. 

5. Install the New Software 
The next step is to install the upgrade software. For more information see Installing VoiceMail 
Pro:Overview and then refer to the sections that relate to the  type of VoiceMail Pro that you intend to 
install. 
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6. Restore the Database 
The copy of the call flow database that contained any customizations made to the default call flow needs to 
be restored. 

1. Start VoiceMail Pro. 

2. From the File menu, select Import or Export. The Import or Export Call Flows window opens. 

3. Select Import Call Flows. 

4. Click Next. 

5. Click the Browse button and locate the file that contains the backed up call flows. 

6. Select the file and click Open. 

7. In the Import or Export Call Flows window, click Next. 

8. Click Finish to start importing the database. 

9. Click Close to complete the import process. 

The new version of VoiceMail Pro has been installed. Test that the system is running by dialing *17 from any 
extension. You should hear the mailbox announcement. 
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Upgrade from Version 3.2 
You can upgrade from IP Office VoiceMail Pro 3.2 to IP Office 4.0. If you upgrade you can still use a 3.2 VoiceMail 
Client to update VoiceMail Pro 4.0. However, if you want to change any of the new features, for example the 
Outcalling preferences or to use the start points for Personal Announcements, you will need to use the latest Client 
version of IP Office VoiceMail Pro. 

To upgrade from version 3.2: 

1. Insert the new IP Office VoiceMail Pro CD. The installation should auto-start. If it does not auto-start, click 
Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens. 

2. Select the installation language. The language selected is used for the installation. 

3. Click OK. You are asked 'This setup will perform an upgrade of IP Office VoiceMail Pro'. Do you want to 
continue?  

4. Click Yes. The Upgrading the IP Office VoiceMail Pro window opens.  

5. Click Next to start the upgrade. The setup status window opens. The progress of the upgrade is indicated 
by a time bar. When the InstallShield Wizard complete window opens.  

6. Click Finish. The Email settings window opens.  

7. Enter your email account details and click Next. The SMTP Email settings window opens. 

8. Enter your SMTP Email details and click Finish.  he SMTP settings entered will be validated. If an error 
occurs, the validating configuration window opens containing the error . For more information, see SMTP 
Errors. 

9. Click Yes when asked if you want to start the VoiceMail Pro service. 

The new version of VoiceMail Pro has been installed. Test that the system is running by dialing *17 from any 
extension. You should hear the mailbox announcement. 
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Configuring VoiceMail Pro 
Changing Preferences 
There are two main areas through which VoiceMail Pro system preferences are set and configured. These are 
within the VoiceMail Pro Client and through the server PC's Windows Control Panel. 

To change the VoiceMail Pro Client preferences: 

1. Click the Preferences  icon and then choose General or VPNM. 
Alternatively, from the Administration menu, select Preferences and then choose General or VPNM. 

2. Select the System Preferences tab required. 

 General - For more information, see Changing the General System Preferences. 

 Directories - For more information, see Setting the Location of Voicemail System Folders. 

 Housekeeping - For more information, see Setting the Message Deletion Times. 

 MAPI - For more information, see Setting MAPI Email Preferences. 

 SNMP Alarm - For more information, see Setting the SNMP Alarm. 

 Outcalling - For more information, see Changing the Outcalling Preferences. 

 VPNM - For more information, see Configuring VPNM Preferences. 

 

A number of VoiceMail Pro server options are set through the Windows Control Panel. 

To change the VoiceMail Pro Server preferences: 

1. Open the Windows Control Panel. 

2. Select  IP Office VoiceMail Pro. 

3. The tabs and options within the tabs will vary according to the installed VoiceMail Pro components. 
Possible tabs are: 

 Email Settings - For more information, see Configuring Email Settings. 

 Path Setting - For more information, see Specifying the Name of the Host Server PC for IMS. 

 SMTP Email Settings - For more information, see Configuring SMTP Email Settings. 

 System Settings - For more information, see Specifying the Level of IMS Service Logging. 
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System Preferences 
Changing the General System Preferences 
Although the default IP Office configuration settings allow voicemail to start operating almost immediately, as soon 
as a voicemail server is running on the LAN, there are some general system preferences that you can set or 
change. 

To set up general system preferences: 

1. Display the main VoiceMail Pro window. 

2. From the Administration menu, select Preferences > General. The System Preferences window opens. 

 

3. In the Client/Server Connection Timeout (mins) box, type the number of minutes for the inactivity 
timeout. Alternatively use the increment or decrement buttons. After the number of minutes that you 
specify, an inactive administrator user of the VoiceMail Pro Client will receive a message to warn them that 
they might be automatically logged out if they remain inactive. This enables another administrator user to 
log in and use the VoiceMail Pro Client instead. 

4. From the Default Telephony Interface select IP Office or Intuity to control the way in which mailbox 
access works for mailbox owners. For more information, see Changing Mailbox Operation Mode. 

5. In the Voicemail Password box, type the password to use for protecting voicemail access. A Voicemail 
Password is optional. If you leave it blank, no password is required for voicemail access. If you set a 
password here, it must match the Voicemail Password configured on the IP Office. For more information, 
see Identifying the Voicemail Server PC. Beware that problems can arise if the voicemail passwords in IP 
Office Manager and VoiceMail Pro become unsynchronized for any reason. 

6. In the Max. Message Length (secs) box, type the maximum length in seconds of any 
messages/recordings taken by VoiceMail Pro. The default message length is 120 seconds. The maximum 
message length is 3600 seconds (60 minutes). 1 minute equals approximately 1MB of disk space. 

7. In the Max. VRL Record Length (secs), type the maximum recording time for calls that are being 
recorded for VRL (Calls recorded to a third party call archiving system). The default length is 3600 seconds 
(60 minutes). This is also the maximum. 

8. If voice calls are to be recorded, check the Play Advice on Call Recording box so that callers hear a 
message to advise them that their call is being recorded. This is a legal requirement in some countries. 

9. In the System Fax Number box, type the number of the general fax machine to which all incoming faxes 
are to be directed. If a fax board is being used, this number must match the number of the extension that is 
connected to the fax board of the fax server PC. For more information, see Setting the VoiceMail Pro 
System Fax Number. 
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Intuity mailbox owners have the additional option to define their own personal fax number instead of the 
system fax number. As the system administrator, you still need to set a system fax number to enable 
mailbox owners to override it with their preferred personal fax number. Incoming calls are directed to 
VoiceMail Pro and then VoiceMail Pro redirects fax calls to the mailbox owner's personal fax number, if one 
has been set. For information mailbox owners should read the Intuity Mailbox User Guide. 
 
If your fax system requires prefix addressing, for example the C3000 fax server, do not type a fax number 
in the System Fax Number box. Instead type the number to use as a prefix so that a fax message can be 
identified and forwarded to the extension number of the intended recipient. For example, if the prefix were 
55, a fax message for extension 201 would have the prefix of 55 automatically added so that the complete 
number would become 55201. 
 
The System Fax Number box, is used to: 

 Enable fax detection. 
By default fax detection is not enabled when VoiceMail Pro is first installed. When fax detection is 
enabled, any fax calls that are left in a voicemail mailbox, are redirected to the defined system fax 
number. 

 Define the default destination for fax calls that arrive in a voicemail mailbox and which are to be 
redirected to a fax machine. 

10. To use the specified prefix, check the Use as a Prefix box so that the number that you typed in to the 
System Fax Number box is used. If your fax system does not use prefix addressing, leave this box 
unchecked. 

11. For this feature to work, you also need to set up a short code. For more information, see Setting Up a Short 
Code for Routing Faxes to Prefixed Numbers. See also the section Configuring a C3000 Fax Server which 
describes a supported fax server that uses this capability. 

 Most fax servers perform fax forwarding based on DTMF signalling received with the fax call. 
Check the Enable Fax Sub-Addressing box so that the DTMF signal is passed to the fax server 
after the call has been answered so that the fax can be forwarded to the email address of the 
intended recipient. 

12. Click OK. 

13. Click  Save and Make Live and select Yes. 

 



Voicemail Pro Installation and Maintenance Guide 

Page 98 VoiceMail Pro Installation and Maintenance Guide 
15-601063 Issue 16 (12th December 2006) IP Office 4.0 

Setting the Location of Voicemail System Files 
When VoiceMail Pro is installed some default folder locations are used. You can change these if required. 

To set the location of Voicemail system folders: 

1. Display the main VoiceMail Pro window. 

2. From the Administration menu, select Preferences > General. 

3. Click the Directories tab. 

 

4. In the Voicemail Server Directory box, type the path to the folder where the voicemail server program is 
to be stored. This is the folder where the file Root.vmp is saved when the Save & Make Live option is 
used. Alternatively click the Browse button and select a folder to use. 

5. In the Voicemail Server Speech Directory box, type the path to the folder where the libraries of speech 
prompts are to be stored. Alternatively click the Browse button and select a folder to use. 

6. In the Remote Campaign Directory box, type the path to the folder where the campaign files are to be 
stored. Alternatively click the Browse button and select a folder to use. 

7. Click OK. 

8. Click  Save and Make Live and select Yes. 
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Setting MAPI Email Preferences 
Email services are used for voicemail email, IMS and email text to speech. Therefore, these settings should not be 
adjusted without first confirming that all other steps appropriate to whichever of those services is being used have 
been followed. 

To set MAPI email preferences: 

1. Display the main VoiceMail Pro window. 

2. From the Administration menu, select Preferences > General. 

3. Click the MAPI tab. 

 

4. In the MAPI Profile box, type the name of a particular MAPI profile name to use if necessary. 

5. If you specify a MAPI profile to use, you can also set a password. In the MAPI Password box, type the 
password to use. If you are not using a MAPI profile, leave the MAPI Password box blank. 

6. Select the Email Protocol to use. Choose SMTP to send voicemail email alerts only or choose MAPI for 
voicemail email, email TTS. The MAPI option requires further email configuration and setup. For more 
information, see Voicemail Email: Overview. 

 Important  
If the protocol is changed, the VoiceMail Pro service must be stopped and restarted. 

7. Click OK. 

8. Click  Save and Make Live and select Yes. 
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Setting Message Deletion Times 
After messages have been played they are automatically deleted from the voicemail server after a specified period 
of time. This also applies to messages that are played via a user's IMS email client. You can set the same time 
delay for all messages or you can adjust the period of time before different types of message are deleted. 

Automatically deleting messages is known as a housekeeping task. Housekeeping is performed after any two hour 
idle period. This means a period during which there are no calls to or from the voicemail server. 

To set message deletion times: 

1. Display the main VoiceMail Pro window. 

2. From the Administration menu, select Preferences > General. 

3. Click the Housekeeping tab. 

 

4. Adjust the settings as required for each type of message. 

5. Click OK. 

6. Click  Save and Make Live and select Yes. 
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Setting the SNMP Alarm 
The IP Office system can be configured to send Simple Network Management Protocol (SNMP) alarms or Simple 
Mail Transfer Protocol (SMTP) emails. When this is configured, the VoiceMail Pro server can tell the IP Office 
system when to send SNMP alarms about available disk space and remaining recording time. 

To set up disk space and recording time alarms: 

1. Display the main VoiceMail Pro window. 

2. From the Administration menu, select Preferences > General. 

3. Click the SNMP Alarm tab. 

 

4. Choose the Alarm Threshold Unit either Disk Space Left (MB) or Recording Time left (minutes). 

5. In the Alarm Threshold Level box, type the number of units (minutes or MB) left at which SNMP alarms 
are to be triggered. The minimum is 11. This value also sets two further SNMP alarm levels which are: 

 Space OK Alarm : This alarm is triggered when the amount of available space returns to above a 
level set at Alarm Threshold Level plus 30. 

 Critical Alarm : This alarm is set at 30 or, when the Alarm Threshold Level is less than 40, at 
Alarm Threshold Level minus 10. Currently the critical alarm value will decrease in accordance with 
the above rule. Note however that it does not increment upwards when the Alarm Threshold is 
increased again. To reset the critical alarm back to 30, click Default Settings. 

6. To return to the default alarm settings, click Default Settings. The Alarm Threshold Level is reset to 60. 
The Space OK level is reset to 90. The Critical Alarm level is reset to 30. 

7. Click OK. 

8. Click  Save and Make Live and select Yes. 
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Setting the Outcalling Preferences 
The preferences in VoiceMail Pro are set for global operation. Mailbox owners can configure their outcalling options 
from their telephone, for example, create their own time profile. Details on how users can configure outcalling is 
found in the Intuity Mailbox guide. 

To set the global outcalling preferences: 

1. Display the main VoiceMail Pro window. 

2. From the Administration menu, select Preferences > General. 

3. Click the Outcalling tab. 

 

4. Select the times that outcalling is active in the System Times section. 

 Prime Times - The time period that outcalling is to be active as default for the system. 

 Peak Times - The busiest working hours. 

5. Set the retry settings in the System Retry Settings section. 

 The Number of Retries can be between 0 and 10. If the message is not collected after the last 
retry, no notification is sent until another new message is delivered in the user's mailbox. 

 The Retry Times are set for each retry attempt. The interval is the length of time between each 
attempt to ring to targeted number again. 

 Double-click a selected retry time to edit the interval between retries. The New interval 
number window opens where the length of time between each attempt to ring the target 
number can be changed. Click OK to save the change and return to the Outcalling 
window. 

6. Click OK. 

7. Click  Save and Make Live and select Yes. 

 

A timeout value can be set by a user. This is how long outcalling will attempt to call a number before giving up. For 
more information, see the Intuity Mailbox guide. 
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Configuring VPNM Preferences 
This option is active only if VPNM was selected during installation and is licensed. VPNM servers can be added 
and then users added to the servers. 

To open the VPN window: 

1. Start the VoiceMail Pro Client. 

2. From the Administration menu, select Preferences > VPNM. The VPNM window opens. 

 

 

To add a VPNM server: 

1. In the VPNM Server(s) section, click Add. 

2. Enter the  fully qualified domain name of the remote VPNM destination (the remote VoiceMail Pro server 
PC or Avaya Interchange). 

3. Enter the two digit access prefix, if these are being used. 

4. Click OK. 

 

To delete a VPNM server: 

1. In the VPNM Server(s) section, select the server that you need to delete. 

2. Click Delete. When a server is deleted, all of the users associated with that server are also deleted. 
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To add a user to VPNM server: 

1. In the Users for VPNM Server(s) section, click Add. The Adding a new user window opens. 

 
  

2. Enter details for the user. All of these details MUST be completed before the user can be added. 

 Select the VPIM server from the listing. 

 Enter the user's full name. The user's full name is used by the local VoiceMail Pro's dial by name 
feature. 

 Enter the user's extension. The local extension number is used as the local mailbox number and 
so should not conflict with any existing local number. 

 Enter the user's remote extension. The remote extension number should be the user's real 
extension number. Typically this and the 'local extension number' are kept the same using a 
unique extension number dial plan for the linked systems. 

 Enter the user's full telephone number. The full telephone number should be a dialable number 
that is routed to the user's extension or mailbox. 

3. Click OK to save the details and return to the VPNM configuration window. 

 



Configuring VoiceMail Pro 

VoiceMail Pro Installation and Maintenance Guide Page 105  
IP Office 4.0 15-601063 Issue 16 (12th December 2006)  

To add a group of users: 

1. (Optional) Check the option Enable WildCard. When this option is selected you can use the question mark 
symbol (?) to represent any number. 

2. In the Users for VPNM Server(s) section, click Add Range. The Adding a range of users window opens. 

 
  

3. Enter details for the users. All of these details MUST be completed before the users can be added. 

 Select the VPNM server to which you want to add the users. 

 Enter the start number of the extension range. 

 Enter the local prefix. 

 Enter remote prefix. 

4. Click OK to save the details and return to the VPNM configuration window. 

 

To change details of a VPNM user: 

1. In the Users for VPNM Server(s) section, select the name of the user whose details need to be changed. 

2. Click Modify. You can change the user's full name, the local extension number and the full telephone 
number. 
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Control Panel Options 
Specifying the Level of IMS Service Logging 
If IMS is installed the Systems Settings tab is available. You can specify the level of service logging for the IMS 
Gateway Server service and the IMS Voice Server service. Four levels of logging are available, with increasing 
level of detail. 

 Typically logging is required only if IMS problems are being experienced and diagnosis is required. The 
information is logged in the Event Viewer application. 

 

To specify the level of IMS service logging: 

1. Open the Windows Control Panel. 

2. Select IP Office VoiceMail Pro. The IP Office VoiceMail Pro window opens. 

3. Click the System Settings tab. 

 

4. In the Logging Level boxes, select the level to use for each of the IMS services. 

 None - No logging recorded. 

 Some - A low level of logging recorded where only errors are logged. 

 Most - A medium level of logging where errors and warnings are recorded. 

 All - All errors, warnings and information are logged. 

5. Click Check to validate the changes that you have made. 

6. Click OK. You are prompted to restart the affected services so that your changes are enabled. 

7. Choose Yes. The services that are affected by your changes are automatically stopped and restarted. 
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Specifying the Name of the Host Server PC for IMS 
If IMS is installed the Path Settings tab is available. You need to specify the computer name of the server PC that 
is hosting the IMS Voice Service. Typically, this is installed on the same server PC as the VoiceMail Pro Server. 

To specify the name of the host server PC for IMS: 

1. Open the Windows Control Panel. 

2. Select IP Office VoiceMail Pro. The IP Office VoiceMail Pro window opens. 

3. Click the Path Settings tab. 

 

4. Type the name of the computer on which the IMS Voice Service has been installed. 

 Alternatively, click Browse and select the name of the computer. 

5. Click Check to validate the changes that you have made. 

6. Click OK. You are prompted to restart the affected services so that your changes are enabled. 

7. Choose Yes. The services that are affected by your changes are automatically stopped and restarted. 
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Configuring Email Settings 
You can configure certain email settings such as the account to use for email and the way in which .wav files are 
transmitted. 

To configure email settings: 

1. Open the Windows Control Panel. 

2. Select IP Office VoiceMail Pro. The IP Office VoiceMail Pro window opens. 

3. Click the Email Settings tab. 

 

4. In the Account Details box, type the name of the MAPI email account to use for email messages. 
Alternatively, select Browse to display a list of available email accounts. 

 If you are setting the account details when using SMTP, it is advisable that the full domain name is 
entered, for example admin@test.com. 

5. Click Check to validate the changes that you have made. 

6. Click OK. 

 

The Message Parameters options are only available if you have installed IMS. For IMS you can specify the way in 
which the .wav files of voicemail messages are to be sent in emails. Sending .wav files across a network creates a 
high loading on the network and networks servers. A one-minute message requires a 1MB .wav file. 

To set the message parameters: 

1. To transmit .wav files, check the Transmit Wave File box. 

2. Choose the option for transmitting the .wav files. Choose either: 

 Attach wave file to message to allow a recipient to copy a .wav file for use elsewhere. 

 Embed wave file in message to allow a recipient to embed a file in a message. An embedded file 
is compressed and therefore smaller than an attached file. 

3. Click Check to validate the changes that you have made. 

4. Click OK. You are prompted to restart the affected services so that your changes are enabled. 

5. Choose Yes. The services that are affected by your changes are automatically stopped and restarted. 
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Configuring SMTP Email Settings 
For SMTP email, you need to define connections to external SMTP Email Servers. You can define your 
connections in the SMTP Email settings tab. Details in the tab vary according to whether IMS or VoiceMail Pro 
Networked Messaging (VPNM) is installed. 

To configure SMTP email settings: 

1. Open the Windows Control Panel. 

2. Select IP Office VoiceMail Pro. The IP Office VoiceMail Pro window opens. 

3. Click the SMTP Email Settings tab. 

 

4. In the Mail Server box, type the name of the SMTP mail server. This should be the fully qualified domain 
name. 

5. In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25. 

6. In the Mail Drop box, type the name of the destination folder for outgoing emails on the SMTP Server. 
This is required if VPNM is installed. Alternatively click the browse button and select the folder to use. 

7. (Optional) To enforce server authentication, check the Server Requires Authentication box. If you check 
it you also need to provide the Account Name and Password that need to be entered. You can also choose 
whether or not to set the Use Challenge Response Authentication option. 

8. Click Check to validate the changes that you have made. 

9. Click OK. You are prompted to restart the affected services so that your changes are enabled. 

10. Choose Yes. The services that are affected by your changes are automatically stopped and restarted. 
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IP Office Configuration 
Overview 
The default IP Office configuration settings allow almost immediate voicemail operation as soon as a voicemail 
server is running on the LAN. Those default settings are: 

 Voicemail running on a PC accessible using a broadcast address of 255.255.255.255. 

 Voicemail on for each user and hunt group on. 

 No Voicemail Code set for any mailboxes. Until a code is entered for a mailbox, it can only be accessed 
from the user's own extension. 

 No Voicemail Email or Voicemail Help operation. 

 No Voicemail Reception numbers set for user mailboxes. 

 Hunt group mailboxes are created and used by default but there is no default message waiting indication or 
method for collecting messages. A method for accessing each hunt group mailbox should be programmed. 
For more information, see Hunt Group Voicemail:Overview. 

Before you start to configure and customize VoiceMail Pro you need to provide the IP Office Manager with details 
of the VoiceMail Pro server PC. For more information see Identifying the Voicemail Server PC and also the IP 
Office Manager help. 

The rest of the sections that follow describe how to configure settings in VoiceMail Pro. 

 

Identifying the Voicemail Server PC 
An IP Office unit must be configured to recognize the PC that is acting as its voicemail server. 

To identify the Voicemail Server PC: 

1. In IP Office Manager, display the details pane for the system. For information about displaying the different 
panes in IP Office Manager, see the IP Office Manager User Guide or help. 

2. Click the Voicemail tab. 

 
3. The default Voicemail Type is VoiceMail Lite/Pro. Make sure that this has not been changed. 
4. Leave the Voicemail Destination box blank as this is not used with VoiceMail Pro. 

5. In the Voicemail IP Address box, change the default address (255.255.255.255) to the IP address of the 
PC on which the voicemail server is running. If there is only one voicemail server on the network, you do 
not need to change this. 

6. Click OK to save any changes. 

By default there are no Voicemail Channel Reservations. Specific  functions can have voicemail channels 
reserved for their use. For more information, see Voicemail Channel Reservations in the appendix. 
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Using Voicemail to Give Error Messages 
Voicemail can be used to give out messages when certain numbers are dialed. For example, if users are barred 
from making international calls, rather than giving users the busy tone a recording similar to "International calls are 
not permitted" could be played instead. 

To create an International Calls are not Permitted error message: 

1. In IP Office Manager create a virtual user. Complete the User tab with the following details: 

 Name: Barred. 

 Full Name: Internal Calls Error Message. 

 Extension: 403. 

2. You need access to the virtual user's extension from any telephone extension attached to the system. A 
voicemail code needs to be added. 

 Select the user Barred. 

 Click the Voicemail tab. 

 Add a Voicemail Code. 

 Click OK. 

3. Add a short code to access the virtual user's voicemail. 

 Code: *95 

 Feature: Voicemail Collect 

 Telephone Number: "?Barred" (include quote marks) 

 Line Group ID: 0 

4. Save the configuration file. 

5. You can now use the virtual user's voicemail to record a greeting message stating that international calls 
are not permitted.  

 Dial *95 from any telephone connected to the system.  

 Enter the extension number 403. 

 Enter the voicemail access code. 

 The first time you enter the mailbox for extension 403 you will be asked to change the 
password and record a user name. 

 Press 3 to record a greeting. 

 Press 1 to change the message. 

 Press 1 to record greeting 1. 

 Speak the new message. In this case it would be similar to "International calls are not permitted"  

 Press # to end the recording. 

 Press 1 to save for all calls. 

 Replace the telephone handset. 

6. A short code needs to be created in IP Office Manager so that when a user dials an international call they 
will be played the error message. 

 Code: 00N 

 Feature: Voicemail Collect  

 Telephone Number: "#Barred" (include quote marks) 

 Line Group ID: 0 

7. Save the configuration file. 

8. Test the error message by trying to dial an international number from any telephone. You should be played 
the message that you have just recorded. 
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Configuring Voicemail for Individual Users 
Voicemail can be configured for each individual user in IP Office Manager. 

To change voicemail configuration for an individual: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  User and select the individual user. 

3. View the Voicemail tab. 

 
  

4. (Optional) Enter a voicemail code between 1-15 digits in the Voicemail Code field. This is required when 
users retrieve voicemail messages remotely, for example from another user's extension or from an external 
telephone. 

 The Voicemail Code must be retyped in the Confirm Voicemail Code field to ensure it has been 
correctly entered. 

5. (Optional) Voicemail can be turned off by unchecking the Voicemail On option. When on, the mailbox is 
used to answer the user's unanswered or busy calls. 

6. (Optional) When a user collects their messages they can hear an additional prompt if the Voicemail Help 
option is checked. The prompt is 'For help at any time press 8'. 

 If Voicemail Help is not selected, users can still press 8 at any time and hear the list of Voicemail 
features. This setting turns on/off the audible help message. It does not disable the actual feature. 

7. (Optional) When a new message is received, the voicemail server can call the user's extension whenever 
the extension returns from off-hook to on-hook. The voicemail server will not ring the extension more than 
once every 30 seconds. Check the Voicemail Ringback option to enable this feature. 

8. (Optional) Voicemail email can be configured for an individual user. When a new message is received, the 
WAV file created can be sent to an email account either by user selection or according to the set Voicemail 
Email Mode. The sending of .wav files across a network creates a high loading on the network and 
networks servers. A one-minute message requires a 1MB .wav file. The option Voicemail Email Reading is 
unavailable in VoiceMail Lite. 

 Voicemail Email - Enter the email address of the user. 

 Select the Voicemail Email Mode from: 

 Off: Voicemail messages or notifications are not automatically sent. 

 Copy: A copy of the message is sent to the email account. 

 Forward: Voicemail messages are sent to the email account and deleted from the 
Voicemail server. 

 Alert: Notification that a new Voicemail message has been received is sent to the email 
account. 
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9. (Optional) When a caller reaches voicemail they can be given the option to be transferred to a different 
extension. The greeting message needs to be recorded telling the caller the options available. The 
extension numbers that they can be transferred to are entered in the fields: 

 Reception/Breakout (DTMF 0) 
The number to which callers are to be transferred if they are directed to voicemail and press 0. 
Usually this is the reception number. 

 Breakout (DTMF 2) 
The number to which callers are to be transferred if they are directed to voicemail and press 2. 
This number might be, for example, the number of a colleague of the mailbox owner whose 
extension was originally dialed. 

 Breakout (DTMF 3) 
The number to which callers are to be transferred if they are directed to voicemail and press 3. 
This number might be, for example, the mobile or cell number of the mailbox owner whose 
extension was originally dialed. 

10. Click OK to save the voicemail changes for the user. 

11. Amend any other user details, then save and merge the configuration changes. 
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Configuring User Source Numbers 
The Source numbers can be changed for individual users in IP Office Manager. The Source Numbers tab gives a 
list of Dial In Source Numbers. Several of these numbers can relate to voicemail operation. The source number 
settings that can be used for Voicemail Lite are: 

 V<Caller's ICLID> = Voicemail Trusted Source Access. 
Strings prefixed with a v indicate numbers from which access to the user's mailbox is allowed without 
requiring entry of the mailbox's voicemail code.  

 When in Intuity mode users will still have to enter their voicemail code if they use the Messages 
button on their telephone. However, If they have a button programmed to collect voicemail they 
can access their mailbox without entering their voicemail code. 

 H<Group Name> = Hunt Group Voicemail Indication.  
Allows the user to receive message waiting indication of new group messages. Enter H followed by the 
group name, e.g. HMain. For more information, see Hunt Group Message Waiting Indication. 

 P<Telephone Number> = Voicemail Ringback Number. 
This entry sets the destination for callback (outbound alert) calls from voicemail. Enter P followed by the 
telephone number including any necessary external dialing prefix, eg. P917325559876. This facility is only 
available when using VoiceMail Pro through which a default Callback or a user specific Callback start point 
has been configured. This feature is separate from voicemail ringback which alerts the user's own 
extension. 

 

To add a source number: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  User and select the individual user. 

3. View the Source Numbers tab. 

4. Click Add. 

 

5. Enter the number in the Source Number field at the bottom of the window. 

6. Click OK and save the configuration file. 
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Setting Up Voicemail Transfer Options for a User 
After a caller has been routed to a mailbox to leave a message, the mailbox owner can offer the option of 
transferring to a different number, for example: 

 To speak to a receptionist callers can dial 0. 

 To speak to a secretary callers can dial 2. 

 To connect to an external number such as the user's mobile or cell phone, callers can dial 3. 

Before a mailbox owner can use this feature, you must set up the numbers that they want to use for their transfer 
options. 

To set up voicemail transfer options for a user: 

1. In IP Office Manager, display the user's Voicemail tab. 

2. (Optional) Enter an internal or external number in the field Reception/Breakout (DTMF 0). When 
connected to a user's voicemail, the caller can press 0 to be transferred to either an internal or external 
number. The user should announce this facility in their greeting message, for example, "John Smith is not 
available today, you may leave a message or press 0 for Reception". 

3. (Optional) Enter an internal or external number in the field Breakout (DTMF 2/3). When VoiceMail Pro is 
running in Intuity mode, a user can select to have two further breakout numbers in addition to the reception 
number. These two additional breakout numbers are triggered by the caller pressing either 2 or 3. These 
additional numbers allow a simple user attendant to be created. The options setup should be included in 
the user's mailbox greeting. 

4. Click OK. 

5. Ask the mailbox owner to record a new greeting message to inform callers that they can press 0, 2 or 3 for 
different transfer options. 

 

When a Leave Mail action is used in a custom call flow to access the mailbox, operation differs.   

 For IP Office mode, the call follows Leave Mail action's Failure or Success results depending on whether 
the caller presses 0 before or after the record tone. 

 For Intuity mode, pressing 0 always follows the mailbox user's Voicemail Reception setting. 
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Configuring Fax Servers 
Overview 
With an IP Office system, fax machines and servers can process fax messages in a number of ways. 

 Fax calls can be handled without the use of VoiceMail Pro 
In IP Office a fax machine can be set up to direct faxes to individual extensions or hunt groups. Faxes can 
be directed to the fax machines or servers based on the DDI or DID numbers of the incoming calls. For 
more information, see the IP Office Manager help and guide. 

 Fax calls detected by VoiceMail Pro 
When a fax message is left in a voicemail mailbox, VoiceMail Pro can detect that the call is a fax call, and 
redirect the call to a fax machine or fax server to receive the fax. The incoming call can be routed to a 
system fax number or, in Intuity Mode, a fax number that the mailbox owner has specified. 

 Fax calls can be sent to a system-wide fax number 
If VoiceMail Pro detects a fax tone, it passes the call to the number that is set as the system fax number. 
This number can be an analog extension that is connected to a fax board in the fax server. For information 
about configuring an analog extension, see Configuring an Analog Extension Number for Fax Use. 

 Fax calls can be sent to a user defined mailbox number 
If VoiceMail Pro detects that the incoming call is a fax and if a system fax number has been specified, 
VoiceMail Pro checks to determine whether the target destination is a user defined fax number. If it is, the 
system fax number is overridden and the incoming call is redirected to the user defined fax number. 
 
If no user defined fax number has been set, the fax is sent to the system fax number. When a system fax 
number is set, any fax calls that are received in user or hunt group mailboxes are directed to this number. 
This applies to both IP Office and Intuity Mailboxes. For more information, see Setting the VoiceMail Pro 
System Fax Number. 
 
Intuity mailbox owners have options available through their telephone handset so that they can forward a 
fax to a preferred fax machine or send a fax to a printer. Intuity mailbox owners can find out how to set a 
mailbox fax number in the IP Office Intuity Mailbox User Guide. 
 
If a fax system, such as a C3000, requires prefix addressing the system fax number is not used. Instead a 
prefix is specified so that a fax message can be identified and forwarded to the extension number of the 
intended recipient. For example if a prefix of 54 is being used, a fax message for extension 201 would have 
the prefix of 54 automatically added so that the complete number would become 54201. The fax server 
then removes  the system prefix and uses the extension number to determine the target destination for the 
fax. For more information, see Setting the VoiceMail Pro System Fax Number. 

 Fax calls can be redirected using a call flow Menu action instead of a system fax number 
If a system fax number is not set up, a menu action can be used instead. The F character can be used as 
one of the touch tone choices of a Menu action to specify the actions that should be applied to fax calls. 
For more information, see Routing Fax Calls Using a Menu Action. 

 

Important 

 By default, VoiceMail Pro fax detection is disabled. To enable fax detection, you must define a system fax 
number. For more information, see Setting the VoiceMail Pro System Fax Number. 
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Fax Server Configuration 
Here is an illustration to show how a fax server can be configured to work with an IP Office system. The illustration 
applies to the following popular fax server applications:  

 Gfi FAXMaker 

 Fenestrae Faxination 

 Equisys Zetafax 

 Captaris RightFax 

   

The fax server is configured to distribute faxes to exchange server mailboxes based on the original (DTMF) fax sub 
address that is passed by VoiceMail Pro. For the fax server and VoiceMail Pro to interact, specific user rights are 
needed. 

If the PC that is being used as the fax server uses an analog fax board, the fax board must be connected to an IP 
Office analog extension (POT) port. 

The sections that follow explain how to configure a fax server to work with VoiceMail Pro. The information provided 
assumes that: 

 The fax server software is installed. 

 The hardware is installed and connected to an IP Office. 

 The Exchange Connector is installed and configured. 

For details of system requirements and information about installing a fax server, refer to the manufacturer 
documentation or visit the manufacturer web site. 

The process for configuring a fax server to work with VoiceMail Pro involves the following key steps: 

1. Set the system fax number. For more information, see Setting the VoiceMail Pro System Fax Number. 

2. If prefixed numbers are being used you can set up a short code so that fax calls are routed to prefixed 
numbers. For more information, see Setting Up a Short Code for Routing Faxes to Prefixed Numbers. 

3. If the chosen mailbox mode is Intuity, inform all mailbox owners that they can set up their own preferred fax 
destinations if they like. For more information, see Setting Up a User Defined Fax Number. 

4. If a system fax number is not being used, you can set up a menu action to route fax calls. For more 
information, see Routing Fax Calls Using a Menu Action. 

5. If the fax server PC uses an analog fax card, configure the extension number to use for faxes. For more 
information, see Configuring an Analog Extension Number for Fax Use. 
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Setting the VoiceMail Pro System Fax Number 
The System Fax Number is used to: 

 Enable fax detection. 
By default fax detection is not enabled when VoiceMail Pro is first installed. When fax detection is enabled, 
any fax calls that are left in a voicemail mailbox, are redirected to the defined system fax number. 

 Define the default destination for fax calls that arrive in a voicemail mailbox and which are to be redirected 
to a fax machine. 

Intuity mailbox owners have the additional option to define their own personal fax number instead of the system fax 
number. Incoming calls are directed to VoiceMail Pro and then VoiceMail Pro redirects fax calls to a mailbox 
owner's personal fax number, if one has been set. For information mailbox owners should read the Intuity Mailbox 
User Guide. 

To set the VoiceMail Pro system fax number: 

1. From the Administration menu, select Preferences. The System Preferences window opens. 

2. Click the General tab. 

 

3. In the System Fax Number box, type the number of the general fax machine to which all incoming faxes 
are to be directed. This number must match the number of the analog extension that is connected to the 
fax board of the fax server PC. 

 Intuity mailbox owners can receive fax messages into their mailboxes and set a preferred fax 
number to use instead of the system fax number. As the administrator you still need to set up a 
system fax number to enable mailbox owners to set their own numbers. A personal mailbox fax 
number overrides the system fax number. Mailbox owners can find out more in the Intuity Mailbox 
User Guide. 

 If your fax system requires prefix addressing, for example the C3000 fax server, do not type a fax 
number In the System Fax Number box. Instead type the number to use as a prefix so that a fax 
message can be identified and forwarded to the extension number of the intended recipient. For 
example if the prefix were 54, a fax message for extension 201 would have the prefix of 54 
automatically added so that the complete number would become 54201. 

4. To use the specified prefix, check the Use as a Prefix box so that the number that you typed in to the 
System Fax Number box is used. If your fax system does not use prefix addressing, leave this box 
unchecked. 
Important 

 For this feature to work, you also need to set up a short code. For more information, see Setting 
Up a Short Code for Routing Faxes to Prefixed Numbers. See also the section Configuring a 
C3000 Fax Server which describes a supported fax server that uses this capability. 
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5. Most fax servers perform fax forwarding based on DTMF signalling received with the fax call. Check the 
Enable Fax Sub-Addressing box so that the DTMF signal is passed to the fax server after the call has 
been answered. This is so that the fax can be forwarded to the email address of the intended recipient. 

6. Click OK. 

7. Click Save & Make Live. 

If prefixed numbers are being used, the next step is to up a short code so that fax calls are routed to prefixed 
numbers. For more information, see Setting Up a Short Code for Routing Faxes to Prefixed Numbers. 

If the chosen mailbox mode is Intuity, you should then inform all mailbox owners that they can set up their own 
preferred fax destinations if they like. For more information, see Setting Up a User Defined Fax Number. 

If a system fax number is not being used, you can set up a menu action to route fax calls. For more information, 
see Routing Fax Calls Using a Menu Action. 

If the fax server PC uses an analog fax card, you need to configure the extension number to use for faxes. For 
more information, see Configuring an Analog Extension Number for Fax Use. 

 

Setting up Fax Forwarding 
VoiceMail Pro is set up to forward faxes when users dial *1. Faxes are forwarded as follows: 

 Gfi FAXMaker faxes are sent to <faxnumber>@faxmaker.com 

 Fenestrae Faxination faxes are sent to <faxnumber>@faxination.com 

 Equisys Zetafax faxes are sent to <faxnumber>@zfconnector.com 

 Captaris RightFax faxes are sent to <faxnumber>@rightfax.com 

Example 
For example, if a GFi FAXMaker user dials *1 and enters the fax number to use followed by # to end 
the fax number and # to confirm, the fax is forwarded to <faxnumber>@faxmaker.com. Therefore if 
the user dials *1 followed by 201# and # to confirm, the fax is forwarded to 201@faxmaker.com. 

 It is the responsibility of the fax server administrator to ensure that exchange connectors are 
configured to receive such messages. 

 

Setting Up a User Defined Fax Number 
If you enable the feature for them, Intuity mailbox owners can set up a preferred personal fax number that is more 
convenient to their location, for example if they are out of the office. 

To set up a user defined fax number: 

1. Complete the steps for setting up the system fax number. For more information, see Setting the VoiceMail 
Pro System Fax Number. 

2. Inform the mailbox owner that they can go ahead and set their preferred fax number. Refer the mailbox 
owner to the IP Office Intuity Mailbox User Guide. 

3. If it has not already been done and the fax server PC is using an analog fax card, the next step is to 
configure the analog fax number to use. For more information, see Configuring an Analog Extension 
Number for Fax Use. 
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Routing Fax Calls Using a Menu Action 
When an incoming call is routed to the auto attendant, the Menu action has the facility to detect and redirect fax 
calls. This capability is enabled by including a number in the system fax number field via the VoiceMail Pro Client, 
and adding 'F' as the tone to detect in the Menu action. From the Menu action, incoming calls presenting a fax tone 
will then follow the 'F' call flow route, which could be a transfer call to a fax server extension or hunt group. 

You can add the F character to the touch tone options of a  Menu action to specify the actions that should be 
applied to fax calls. The corresponding result can then be routed as required for fax calls received by the 
associated call flow. The following example module call flow is using F to redirect incoming fax calls to a specific 
transfer number. 

 

The F result was added to the  Menu action Touch Tones tab using the  icon. 
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Configuring an Analog Extension Number for Fax Use 
If the PC that is being used as the fax server uses an analog fax card, it must be connected to an IP Office analog 
extension (POT) port. You are then ready to configure the analog extension for fax use. 

To configure an analog extension number for fax use: 

1. In IP Office Manager, display the extension details for the extension that you are using for the fax. 

2. View the Extn tab. 

3. In the Caller Display Type field, select DTMFF. 

 

3. View the Analogue tab. 

4. Set up the incoming DDI routing of calls to specific users as required. 

 

 Tip 
If the fax board can support multiple lines, you can configure them as a group. The group number can then 
be used as the fax destination instead of an individual extension number. 

The next step is to set the VoiceMail Pro system fax number. For more information, see Setting the VoiceMail Pro 
System Fax Number. 
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Configuring a C3000 Fax Server 
Overview 
This section explains how to configure a C3000 fax server to work with VoiceMail Pro. Currently this type of fax 
server is used only in Germany. 

The information provided here assumes that: 

 The C3000 fax server software is installed. 

 The Exchange Connector is installed and configured. 

For information about system requirements (hardware and software) and how to install the Exchange Connector, 
refer to the C3000 Installation Manual. 

Configuring a C3000 fax server to work with VoiceMail Pro involves the following key steps: 

1. Set up an IP line so that the fax server can receive faxes from the IP Office. For more information, see 
Setting up an IP Networking Gateway Line. 

2. Set up the routing for incoming calls for each line group. For more information, see Setting up Incoming 
Call Routes. 

3. Set up the least cost routing with a short code. For more information, see Setting Up a Short Code for 
Routing Faxes. 

4. Configure XCAPI settings. For more information, refer to the C3000 Installation Manual and the C3000 
Administration Manual. 
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Setting up an IP Networking Gateway Line 
You need to set up an IP line so that the fax server can receive faxes from the IP Office. 

To set up an IP Networking Gateway Line: 

1. Start IP Office Manager. 

2. In the Navigation pane, select Line. The Line Settings tabs are displayed. 

3. Click Create new record. 

4. Choose IP Line. 

5. View the VoIP tab. In the Line number field, select a line number that is unique to the system. 

6. In the Telephone Number field, type the name of the line, for example C3000. 

7. C3000 uses XCAPI and both are licensed separately from the IP Office. Ensure that the values in the 
following fields correspond to the XCAPI license:  

 Number of channels. 

 Outgoing channels. 

 Voice channels. 

 Data channels. 

8. Leave the following fields empty: 

 Prefix. 

 National prefix. 

 International prefix. 

9. Leave all other default settings unchanged. 

10. On the Short Codes tab, leave the default settings as they are. Do not add or change anything here. 

11. Click the VoIP Settings tab. 

12. In the Gateway IP Address field, type the IP address of the C3000 fax server computer on which XCAPI is 
installed. 

13. From the Compression Mode list, choose G.711 ALAW 64K. This means that compression is not 
allowed, otherwise faxes cannot pass through. 

14. From the H450 Support list, choose H450. 

15. Make sure that the Fax Transport Support box is not checked so that faxes are forwarded to the C3000 
fax server. Otherwise the IP Office intercepts fax transmissions and tries to process faxes internally. 

16. Leave all other options with the default settings unchanged. 

17. Click OK. The next step is to set up the routing for incoming calls. For more information, see Setting up 
Incoming Call Routes. 
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Setting up Incoming Call Routes 
For each line group used, you need to set up the routing for incoming calls so that fax messages are directed to the 
mailbox of the intended recipient.  

To set up incoming call routes: 

1. Start IP Office Manager. 

2. In the Navigation pane, select  Incoming Call Route. 

3. Click Create new record. 

4. Select Incoming Call Route. 

5. View the Standard tab. In the Bearer Capability files, select Any. 

6. In the Line Group ID field, enter the group number of the corresponding line. 

7. In the Incoming Number field, enter the * symbol.  The asterisk means 'at all incoming digits'. 

8. In the Destination field, enter a dot or full stop ( . ). The dot or full stop means all incoming numbers are 
forwarded to the outside 1:1. 

9. Leave all other details with their default settings unchanged. 

 

10. Click OK. 
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Setting Up a Short Code for Routing Faxes 
If prefixed numbers are being used you need to set up a short code so that fax calls are routed to prefixed 
numbers. 

To create Setting Up a Short Code for Routing Faxes to Prefixed Numbers: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  ShortCode. Any existing short codes are listed. 

3. Click Create a New Record in the Group Pane and select ShortCode. 

4. Enter details in the fields. 

 

 Code - Type the number of the tie-line, for example 54XXX. The 54 then corresponds to the tie-line 
to the fax server. The example 54XXX indicates that any 5 digit numbers starting with 54 will be 
handled using this short code. The XXX will be substituted with a three digit extension that the fax 
server can use to identify the associated mailbox. 

 Feature - Select Dial. 

 Telephone Number - Type a full stop or period. The stop or period means that the telephone 
number is forwarded to the fax server as it arrives, for example the tie-line/cross connection is 
forwarded. If the incoming telephone number is 54201, the phone number 54201 is forwarded to 
the fax server. 

 Line Group ID - type the number of the line group, for example 30. 

 Locale - Leave empty. 

 Force Account Code - Leave unchecked. 

5. Click OK. 

6. Click  and send the configuration back to the IP Office. 

7. The next step is to inform Intuity mailbox owners that they can set up their own preferred fax destinations. 
For more information, see Setting Up a User Defined Fax Number. 
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Administration 
Overview 
The VoiceMail Pro Client is used to customize the operation of the VoiceMail Pro server. 

The default operation for VoiceMail Pro is to provide voicemail for all users and hunt groups. When VoiceMail Pro 
is customized there can be alternative actions for users and hunt groups who require facilities differing from those 
provided by a standard mailbox. Voicemail actions can be programmed that are triggered by the dialing of a short 
code. 

Within the Administration section you will find details on how to: 

 Log in and out of the VoiceMail Pro Client, including how to change between working in offline and online 
mode. For more information, see Starting the VoiceMail Pro Client. 

 Mailbox user controls. 

 Configure administrators including resetting passwords and releasing a locked administrator. For more 
information, see the Configuring Administrators section. 

 Route calls to voicemail using short codes and VM: paths as telephone numbers. For more information, 
see Routing Calls to VoiceMail:Overview. 

 Record calls automatically or manually when required. For more information, see Recording 
Calls:Overview. 

 Support callers with impaired vision or hearing by using TTY Prompts. For more information, see Support 
for Callers with impaired Vision or Hearing:Overview. 

 Configure hunt groups. For more information, see Hunt Groups:Overview. 

 Let users access their voicemail messages from locations other than their own extension. For more 
information, see Giving users Remote Access to Voicemail:Overview. 

 Set the language that is used. For more information, see Changing the Language used:Overview. 

 Mobile Twinning. 

 Receive notification of new voicemail messages either at your own extension or when you are away from 
the office. For more information, see Remote VoiceMail Notification:Overview. 

 Play announcements to callers. For more information, see Announcements:Overview. 

 General Administration including: 

 Changing the Inactivity Timeout. 

 Changing Mailbox Operation Mode. 

 Confirm Call Flow Download Window. 

 Changing your Password. 
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Logging In and Out of VoiceMail Pro Client 
Starting the VoiceMail Pro Client 
You can start the VoiceMail Pro Client from the IP Office VoiceMail Pro folder. 

To start the VoiceMail Pro Client: 

1. From the Start menu, select Programs > IP Office > VoiceMail Pro Client. The main VoiceMail Pro Client 
window opens. 

If the Client and Server are installed on the same machine, you do not need to log in. If you are using the Client to 
work on a remote server, you do need to log in. For more information, see Logging in to the VoiceMail Pro Server. 

 Tip 
Alternatively, as with any other Windows application, you can add a shortcut to your desktop and start the 
VoiceMail Pro Client from there. 

 

Logging in to the VoiceMail Pro Server 
You can run the VoiceMail Pro Client in offline mode and you can also use it to connect to a VoiceMail Pro Server. 
To connect to a VoiceMail Pro Server with the VoiceMail Pro Client, you need to log in for authentication purposes. 

By default, the VoiceMail Pro Server does not have any user accounts defined. Therefore no remote VoiceMail Pro 
Clients can connect. You can use a local VoiceMail Pro Client, to add administrator or standard administrator users 
who can then connect using remote VoiceMail Pro Clients. For more information, see Adding an Administrator. 

To log in to the VoiceMail Pro Server: 

1. From the File menu, select Login. The VoiceMail Pro Login window opens. 

 

2. In the User Name field, type a user name. This is the name that the workstation software will use. This 
should already be defined on the VoiceMail Pro Server. 

 If the Voicemail Pro Server and Client are on the same computer, you do not need to enter a user 
name to connect to the VoiceMail Pro Server and perform administration tasks. 

3. In the Password field, enter the password. 

4. In the Unit Name/IP Address field, type the name or the IP address of the server you want to connect to. 
By default the IP address or name that was last used is already filled in. 

 If you are logging in to a different server and do not know the name or IP address, click Browse. 
Select from the list of available VoiceMail Pro servers. 

 If you are logging in across a WAN, you must type in the IP address and not the server name. 

5. Click OK. The main VoiceMail Pro Client window opens. For more information, see The Main VoiceMail 
Pro Window. 
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Changing Between Offline and Online Mode 
It can be useful to connect to a system to get the current system configuration and then disconnect and make 
changes offline. You can then test configuration changes offline before applying them to a live system. If the 
VoiceMail Pro Client and Server are on the same machine, you can switch between online and offline mode without 
having to log out. 

To switch between online and offline mode: 

1. From the File menu, select Select Mode. The Select VoiceMail Pro Client Mode window opens. 

 

2. Select Offline to work offline or Online to connect to the server and work online. If you select Online, the 
VoiceMail Pro Login window opens. 

3. Log in as usual. 

The next time you run the VoiceMail Pro Client, it will start up in the mode that you used previously. When you are 
ready to connect to a server you need to log in. 

 

Continue Offline Message Window 
If your session expires you will be notified that the session has expired. You are then able to continue working in 
offline mode or to close the application. If you select to work in offline mode, you can switch to working online. For 
more information, see Changing Between Online and Offline Mode. 

 Yes - Select to continue working in offline mode. 

 Exit - Select to close VoiceMail Pro. 

 

Logging Out 
It can be useful to connect to a system to download the current system configuration and then disconnect and 
make changes offline. You can then test configuration changes offline before applying them to a live system. 

To log out: 

1. From the File menu, select Log Out.  
You are logged out of the VoiceMail Pro server and placed in offline mode. You can either make 
configuration changes offline and then log back in when you are ready or log on to a different server to 
work. For more information see Logging in to the VoiceMail Pro Server. 

Notes 

 Logging out is not the same as closing down with the Exit option. For more information, see Closing Down. 

 If the Client and Server are installed on the same machine, the Log Out option is not available. 
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Closing Down 
When you have finished working, you can close down the VoiceMail Pro Client. This is not the same as logging out. 
For more information, see Logging Out. 

To close the VoiceMail Pro Client down: 

1. From the File menu, select Exit. 
If you have not made any changes, the VoiceMail Pro Client closes and you are returned to the desktop. If 
you have made changes, a message is displayed to ask whether you want to save them. 

2. If you do not want to save your changes, click No. No changes are saved. If you want to save your 
changes, click Yes. Your changes are saved but not yet made live. 

3. If you are ready to make your changes live, click Save & make Live. For more information, see Saving 
Configuration Changes and Making them Live. 
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Configuring Administrators 
Adding an Administrator 
You can use VoiceMail Pro Client remotely in offline mode. If you want to connect to a VoiceMail Pro Server you 
need to log in. By default, the VoiceMail Pro Server does not have any User accounts defined, therefore no 
Remote VoiceMail Pro Clients can connect. 

If you are an administrator you can add other users as administrators. You can give them the authority to carry out 
standard or more powerful administration tasks using the VoiceMail Pro Client. There are two types of 
administrator: 

 Standard Client user. 
A standard administrator can perform administration of callflows using the VoiceMail Pro Client. A standard 
administrator can change their own password but cannot add or remove Client users or change passwords. 

 Administrator Client user. 
A more powerful administrator who can add and remove Client users and set and change passwords. 

To add an Administrator: 

1. In the Start Points Navigation pane, select VoiceMail Pro Administrators. The name, type and status of 
any existing VoiceMail Pro administrators are displayed in the details pane. 

2. Right-click anywhere in the details pane. 

3. Select Add. The Add Administrator window opens. 

 

4. In the User Name field, type the name that you want to assign to the administrator. 

 The name must be at least 5 characters long and must not contain spaces or any of the following 
characters: \ / : * ? < > | , ; 

5. In the New Password field, type a password for the administrator. 

 A password must be at least 5 characters long and must not contain spaces or any of the following 
characters: \ / : * ? < > | , ; 

6. In the Confirm New Password field, type the password again for confirmation purposes. 

7. In the Type field, click the type of user that you want. 

8. Click OK. 

9. Click  Save and Make Live to save the changes. The user created can now log into the VoiceMail Pro 
Client Server. For more information, see Logging in to the VoiceMail Pro Server. 

 

By default new users are created as Inactive. Their status changes to Active when they connect to a VoiceMail Pro 
server. 
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Changing Administrator Details 
If you are an administrator user, you can change details of a standard administrator or another administrator user. 
You can change the user name, user type and status. You can also reset the password of other administrator 
users. 

You can change the authority level of a standard user to an administrator and vice versa. 

To change the authority level of a user: 

1. In the Start Points Navigation pane, select VoiceMail Pro Administrators. The name, type and status of 
any existing VoiceMail Pro administrators are displayed in the details pane. 

2. Right-click the name of the administrator user whose details you need to change. 

3. Select Modify. The Modify Administrator window opens. 

 

4. (Optional) Edit the name of the administrator user. 

5. (Optional) Change the password and inform the user. For more information, see Resetting a Password  

6. (Optional) In the Type field select the type of user. Choose either Administrator or Standard. By default 
new users are created as Inactive. Their status changes to Active when they connect to a VoiceMail Pro 
server. 

7. Click OK. 

8. Click  Save and Make Live to save the changes. 

 

Deleting an Administrator 
For security it is good practice to delete administrator users as soon as they are no longer required. 

To delete an administrator: 

1. In the Start Points Navigation pane, select VoiceMail Pro Administrators. The name, type and status of 
any existing VoiceMail Pro administrators are displayed in the details pane. 

2. Right-click the name of the administrator user whose details you need to delete. 

3. Click Delete. A message is displayed to confirm whether you want to delete. If not, for example if you have 
chosen the wrong name, click Cancel. If you are sure that you want to delete the selected administrator, 
click Yes. The selected administrator is deleted. 

4. Click  Save and Make Live to save the changes. 
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Resetting a Password 
If you are an administrator you can reset the password of another administrator or standard VoiceMail Pro Client 
user. 

To reset a password: 

1. In the Start Points Navigation pane, select VoiceMail Pro Administrators. The name, type and status of 
any existing VoiceMail Pro administrators are displayed in the details pane. 

2. Right-click the name of the administrator user whose details you need to reset. 

3. Select Modify. The Modify Administrator window opens. 

4. In the Password box, type the new password. 

5. In the Confirm Password box, type the new password again. 

6. Click OK. 

7. Click  Save and Make Live to save the changes. 

 

Releasing a Locked Administrator Login 
If an administrator tries unsuccessfully to log in to the VoiceMail Pro Client 3 times consecutively, their user ID is 
locked and cannot be used for 1 hour. As an administrator you can release a locked ID so that the other person 
does not need to wait. 

To release a locked login: 

1. Display the main VoiceMail Pro window. 

2. In the navigation pane, highlight VoiceMail Pro Administrators. The name, type and status of every 
current VoiceMail Pro administrator user are displayed in the details pane. 

3. Right-click the name of the administrator user whose ID has been locked. 

4. Select Modify. The Modify Administrator window opens. 

 

5. Click the Status arrow and select the status Inactive. 

6. Click OK. 

7. Click  Save and Make Live. 
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General Administration  
Changing the Inactivity Timeout 
While a user is logged in using the VoiceMail Pro Client, other users cannot log in. By default a timeout is set so 
that users are sent a warning message and logged out automatically if they have not been active for 5 minutes. 

When the user receives the warning message they can reset the inactvity timeout so that they are not logged out. 
This is provided that they have not already been logged out and another VoiceMail Pro Client has not already 
connected to the VoiceMail Pro Server. 

As an administrator user you can change the timeout to a period of between 1 and 60 minutes. 

To change the inactivity timeout: 

1. From the Administration menu, select Preferences > General. The General tab is displayed. 

 

2. From the Client/Server Connection Timeout list, select the number of minutes after which an inactive 
user of the VoiceMail Pro Client will receive a warning message and then be automatically logged out. 

3. Click OK. 
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Changing Mailbox Operation Mode 
The features available in VoiceMail Pro mailboxes depend on whether the mailbox is working in IP Office mode or 
Intuity mode. As an administrator you can switch between modes. The title bar of the main VoiceMail Pro window 
shows the current mode (telephony interface) in parentheses. 

To change the mailbox operation mode:  

1. From the Administration menu, click Preferences > General. Alternatively, press F9. The System 
Preferences window opens. 

2. Select the General tab. 

 

3. Click the Default Telephony Interface arrow and select Intuity or IP Office. The change takes effect 
immediately, there is no need to restart. 

 

Confirm Call Flow Download Window 
When you connect to a server across a LAN or WAN to view or modify the call flow on the server, a check is made 
to see if the call flow that is stored locally on the Client machine is the same. The call flow on the server might be 
different to the call flow on the Client because: 

 The local call flow is older than the version on the server, for example if the call flow on the server has 
been modified by another Client connection. 

 The local call flow is newer than the version on the server, for example if the call flow on the server has 
been worked on while the local Client was being used in offline mode. 

 The local call flow is from a different server, for example if you are connecting to a different server to the 
one from which the call flow was previously downloaded. 

If the call flow is the same no data will need to be copied back from the server to the Client. If the call flow is 
different you can chose to download the call flow from the server or to use the local call flow. 

 Download: 
Click to download the call flow from the server. 

 Cancel 
Click this if you do not want to download the call flow from the server. 

To upload the local call flow to the server, use the Save or Save and Make Live options from the File menu. For 
more information, see Saving Changes and Making them Live. 
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Changing Your Password 
If you are a standard user, you can change your own password when you are working in online mode. If you are 
working offline, the Change Password option is not available. 

To change your password: 

1. From the File menu, select Change Password. The Change Password window opens. 

2. In the New Password box, type the new password. 

3. In the Confirm Password box, retype the new password. 

4. Save the changes. 
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Routing Calls to Voicemail 
Overview 
There are different methods by which callers can be transferred to voicemail. The transfer can be used to route the 
caller to a specific mailbox to leave or collect messages or to a particular VoiceMail Pro start point. 

The sections that follow describe the use of Voicemail Collect short codes and VM: paths as telephone numbers. 
These can then be applied to dialing, DSS keys SoftConsole and Phone Manager buttons. 

An example VoiceMail Pro module is included which allows the transferred caller to select the extension to which 
they want to talk or leave a message. 

VM: versus Short Codes? 

The VM: method is easier to deploy. In fact for SoftConsole and Phone Manager it can be used without the need to 
access and change the Manager configuration. However, the disadvantage is that VM: cannot be dialed from a 
physical phone. 

Short codes have the advantage that they can be dialed at any extension once set up through IP Office Manager. 

 

Routing Calls to Voicemail 
If a user has voicemail switched on, calls will be automatically routed to voicemail if either: 

1. The extension is busy and call waiting has not been enabled. 

2. The user has do not disturb set or the extension is not answered within the No Answer Time as set in IP 
Office Manager program (default 15 seconds). 

The caller hears the standard greeting message 'Your call is being answered by IP Office. <Name> is not available. 
To leave a message wait for the tone,'. A user can record their own standard greeting message if required. 

When new messages are received, the user's telephone call display or IP Office Phone Manager application is 
updated to show the number of new messages waiting. 

If Voicemail Ringback is enabled, the Voicemail Server calls the user's extension to attempt to deliver new 
messages when the user next uses the telephone. 

All messages are stored until they have been listened to and are then automatically deleted after a set time period. 
The default time period for IP Office mode is 36 hours. In IP Office mode users can designate a message as saved 
so that it is not automatic deleted. 

A mailbox owner can turn voicemail and voicemail ringback on or off using Phone Manager. The default short 
codes can also be used. The default short codes are: 

 *18 - To turn voicemail on. 

 *19 - To turn voicemail off. 

 *48 - To turn voicemail ring back on. 

 *49 - To turn voicemail ring back off. 

 



Voicemail Pro Installation and Maintenance Guide 

Page 138 VoiceMail Pro Installation and Maintenance Guide 
15-601063 Issue 16 (12th December 2006) IP Office 4.0 

Transferring Calls to Voicemail 
The facility to transfer a call directly to a user's voicemail is available using the SoftConsole or Phone Manager 
applications. For users who are not using these applications, you can create a short code for them. 

For example: 

Field Contains... 
Code *201 
Feature Voicemail Collect 
Telephone Number "#Extn201" 
Line Group Id 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

When creating short codes for use with voicemail, the ? indicates "collect voicemail" and the # indicates "deposit 
voicemail". The telephone number entry must also be enclosed by quotation marks as shown in the example. 

 

Using Short Codes to Access Voicemail 
The short code Voicemail Collect feature can be used to route callers to voicemail. The voicemail service they 
receive is set by the telephone number field which should be enclosed in quote marks. For more information, see 
Voicemail Telephone Numbers. 

 The examples use *80 but any available short code could be used. 

Example 1: Access to the Mailbox Main 
The following short code will access the mailbox for Main. The ? indicates that it is to collect messages. A # is used 
to indicate leave a message in the mailbox. 

Field Contains... 
Code *80 
Feature Voicemail Collect 
Telephone Number "?Main" 
Line Group Id 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

 

Example 2: Access a VoiceMail Pro Module  
If a VoiceMail Pro module has been created and called TimeCheck, the following short code could be used to 
access it. 

Field Contains... 
Code *80 
Feature Voicemail Collect 
Telephone Number "TimeCheck" 
Line Group Id 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

 

The Voicemail Node short code feature can also be used to access short code start points. It uses the short code 
start point name as the telephone number without surrounding brackets. 
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Using VM: to Access Voicemail 
Another method for accessing voicemail is the VM: option, where VM: is followed by the name of the mailbox or 
VoiceMail Pro start point required. 

This can be used in the telephone number field of IP Office applications such as SoftConsole, Phone Manager and 
Manager. 

 Example 1: SoftConsole access to the mailbox Main 
The user wants single click access to check for messages in the hunt group mail box Main (extension ID 
200). 

1. Start SoftConsole. 

2. Click one of the BLF panel tabs. 

3. Right-click and select New > BLF Group Member. 

4. Type a Name, for example Messages. 

5. Type a Number, in this case enter VM:?Main or VM:?200. 

6. Click OK. The operator can now check for messages in that group mailbox with a single click. 

 

 Example 2: Accessing a Module from Phone Manager 
The user wants to access a particular VoiceMail Pro module, for this example one called TimeCheck. 

1. Start Phone Manager. 

2. Click the Speed Dials tab. 

3. Right-click and select New. 

4. Type a Name, for example Time Check. 

5. Type a Number, in this case enter VM:TimeCheck. 

6. Click OK. 

 

 Example 3: Incoming Call Routing  
The VM notation can be used in the Destination field of a Manager Incoming Call Route. This enables you 
to route calls that match the Incoming Call Route's criteria to a particular mailbox or VoiceMail Pro module. 
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Voicemail Telephone Numbers 
This section describes the options that can be used with VoicemailCollect short codes and with VM: to access a 
mailbox or VoiceMail Pro start point. 

VoiceMail Lite and Pro 

In this example we have used a mailbox called Main with extension number 200. 

 Short Code Application Number Field 
?200 VM:?200 Collect Messages 
"?Main" VM:?Main 
#200 VM:#200 Leave Messages 
"#Main" VM:#Main 

A user attempting to collect mail from user mailboxes will be prompted for the voicemail PIN code if not accessing 
from a trusted source. For more information, see Creating a Trusted Location. 

 

VoiceMail Pro Start Points 

The following only apply when a matching start point has been set up. 

If a short burst of ringing is required then # should be inserted before the start point name. This is useful if 
transferring callers as it allows the transfer to be completed before the voicemail prompts begin. 

 Short Code Application Number Field 
User Start Points for examples a user called Extn205. 

Collect "Extn205.Collect" VM:Extn205.Collect 
Leave "Extn205.Leave" VM:Extn205.Leave 
Callback "Extn205.Callback" VM:Extn205.Callback 
Queued - - 
Still Queued - - 

Group Start Points for example a group called Main. 
Collect "Main.Collect" VM:Main.Collect 
Leave "Main.Leave" VM:Main.Leave 
Queued - - 
Still Queued - - 

Default Start Points  
Collect "Default.Collect" VM:Default.Collect 
Leave "Default.Leave" VM:Default.Leave 
Queued - VM:Default.Queued" 
Still Queued - VM:Default.Still Queued" 

for example a shortcode start point called DVM. Short Code Start Points 
(see also Voicemail 
Node) 

"Short Codes.DVM" VM:Short Codes.DVM 

for these examples a module called Attend… Module Start Points 
"Attend" VM:Attend 

Campaigns for example a campaign called Catalogue. 
Leave - VM:Catalogue 
Collect - VM:Catalogue.Collect 

 

The Voicemail Node short code feature can also be used to access short code start points. It uses the short code 
start point name as the telephone number without surrounding brackets. 
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Example Call Flow 
This example creates a VoiceMail Pro module that allows callers to select the extension to which they want to be 
connected. If that extension is busy or does not answer they can then leave a message in the target mailbox. 

 A copy of this module can be found in VoiceMail Pro Example Modules within the help pages. 

 

The VoiceMail Pro Module 

1. In VoiceMail Pro, a module was added named SelfSelect. 

2. A Menu action was added. The properties were set as: 

 On the Touch Tones tab the Wait for a key press for option was set to 5 seconds. This gives the 
action a Timeout result which can be used if the caller does nothing or does not have DTMF 
dialing. 

 Our IP Office has extensions and groups numbered in the 200 to 299 range. The touch tone 
sequence 2?? was added to match any dialing in that range. 

 In Entry Prompts a prompt was recorded along the line of "Dial the number you want or wait for 
reception". 

3. A Transfer action was added. In its properties, on the Specific tab the Destination was set to Main, the 
hunt group containing our receptionists. 

4. A connection was added from the Menu action's Timeout result to the Transfer action. 

5. An Assisted Transfer action was added. In its properties, on the Specific tab  $KEY was added in the 
Mailbox field. 

6. A connection from the Menu action's 2?? result to the Assisted Transfer action was added. 

7. A Leave Mail action was then added. In its properties, on the Specific tab $KEY was again added in the 
Mailbox field. 

8. The Assisted Transfer action's No Answer and Busy result was connected to the leave Mail action. 

9. Connections were then added from the Assisted Transfer action's Next result and the Leave Mail action's 
Success and Failure results back to the Menu action. 

 The Success and Failure results in a Leave Mail action are only used if the caller presses 0 when 
in the mailbox. 

10. The call flow was then saved and made live. 

 



Voicemail Pro Installation and Maintenance Guide 

Page 142 VoiceMail Pro Installation and Maintenance Guide 
15-601063 Issue 16 (12th December 2006) IP Office 4.0 

Creating a Matching Short Code 

A short code was needed that could be used to route callers to the SelfSelect module. 

1. Start IP Office Manager and receive the configuration. 

2. A new system short code was added so that it would be available to all callers. The short code *80 was set 
up as shown in the table. 

Field Contains... 
Code *80 
Feature Voicemail Collect 
Telephone Number "#SelfSelect" 
Line Group Id 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

 The entry “#SelfSelect” indicates the name of the Voicemail start point for the call, in this case the 
VoiceMail Pro SelfSelect module  

 For a module start point the # is optional. Using it provides a short period of ringing before the 
module actions start. This is useful if manually transferring a caller as otherwise they may miss the 
start of the module's entry prompts. 

3. The new configuration was merged. 

4. At any extension the routing can be tested by dialing *80. We can then wait to be transferred to reception 
or dial the extension or group that we want. 

 

Using the Module 

The short code *80 can now be assigned or the path VM:SelfSelect to whichever method the user wants to 
transfer callers to the voicemail service. 

A further suggestion is to provide a system short code to deal with callers who dial an invalid extension number. 
For our example, a short code 2??/./"SelfSelect"/VoicemailCollect would reroute such callers back to the 
SelfSelect module. 
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Giving Users Access to Voicemail 
Overview 
By default, a user can dial *17 to access their voicemail from their own extension.  

A user mailbox cannot be accessed from any other location (internal or external) until a voicemail 
code has been set for the mailbox. This access code is set in the IP Office Manager. Voicemail can be 
configured for each individual user in IP Office Manager. For more information, see Configuring Voicemail for 
Individual Users. 

If IP Office Manager has been configured, users can also collect their voice messages by using one 
the following methods. 

 Using the Messages button on their telephone.  

 If their extension is a trusted extension they can access their messages without entering a 
voicemail code by pressing the Speaker button and then the Messages button. For more 
information, see Creating a Trusted Location. 

 Using a Voicemail Collect button.  
A button can be programmed to allow a user to collect voice messages from their telephone. If their 
extension is a trusted extension they can access their messages without entering a voicemail code  For 
more information, see Giving Users Button Access to Voicemail. 

 Using Visual Voice 
A user can be given a display menu to user for access to their mailbox. The menu provides the user with 
options to listen to messages, send messages, change their greetings and password. For more 
information, see Giving Users Button Access to Voicemail. 

 Using a short code. 
Short codes can be created so a user can be given access to their mailbox from locations other than their 
office desk. When they call the mailbox, they will be prompted to enter the access code. For more 
information, see Giving Users Access from Any Extension and Voicemail Telephone Numbers. 

If direct access is required a specified location can be set up as a trusted location. The caller then does not need to 
enter an access code. Access can be from the users own extension or another location. For more information, see 
Creating a Trusted Location.  

If users need to access their voicemail messages when they are away from the office, you can set up an Incoming 
Call Route in IP Office Manager with the destination as Voicemail. Giving Users Access from an External Location. 

Users can also receive notification of new voicemail messages at either their own extension or at another location. 
To receive notification of new messages a user needs to configure their outcalling. For more information, see 
Outcalling:Overview. 
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Giving Users Button Access 
A user's telephone can have buttons programmed to allow access to voicemail. Not all telephones support this 
feature, refer to the relevant guide for more information. 

Buttons can be programmed for: 

 Visual Voice 

 Voicemail Collect. 

 

Voicemail Collect Button 

Users can collect their voice messages from their own extension using a button programmed for voicemail collect. 
If their extension is a trusted extension they will not need to enter their voicemail code. For more information, see 
Creating a Trusted Location. 

To add a voicemail collect button: 

1. Start IP Office Manager and receive the IP Office configuration. 

2. Click  User to display the list of existing users. 

3. Click the required user. 

4. Click the Button Programming tab. 

5. Click the button line that you want to change. 

6. Right-click in the Action field. 

7. Select Advanced > Voicemail > Voicemail Collect. 

8. Click OK to save the button details for the selected user. 

9. Repeat for any other users. 

10. Click  to merge the changes back to the IP Office system. 

A button on the user's telephone will display the label VMCol. The extension number or voicemail code do not need 
to be entered if the extension is a trusted extension. 

 

Visual Voice Button 

A VoiceMail Pro user can be given a display menu for access to their mailbox. The menu provides the user with 
options to listen to messages, send messages, change their greetings and password. 

 The Visual Voice feature is not available on all telephones. Please refer to the user's telephone guide for 
more information. 

 Visual voice is only available when in Intuity mode. 

To give a user access to Visual Voice: 

1. Start IP Office Manager and receive the IP Office configuration. 

2. Click  User to display the list of existing users. 

3. Click the required user. 

4. Click the Button Programming tab. 

5. Click the button line that you want to change.  

6. Right-click in the Action field. 

7. Select Emulation > Visual Voice. 

8. Click OK to save the button details for the selected user. 

9. Repeat for any other users. 

10. Click  to save the changes back to the IP Office system. 
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Giving Users Access from Any Extension 
Access to voicemail from any extension can be given to either: 

 An individual user 
So that a specified user can log in to their voicemail from any extension, you need to set up a short code 
and associate it with the user's extension number. For example, a short code *90  could be associated with 
extension number 201. The user with extension 201 can then dial *90 from any extension and enter their 
voicemail code to collect their voicemail messages. 
 
To give a specific user access from any extension: 

1. Open IP Office Manager. 

2. Set up a short code, for example *90:  

Field Contains... 
Code *90 
Feature Voicemail Collect 
Telephone Number "?Extn201" 
Line Group ID 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

 

 All users 
To give all users access to voicemail from any extension you need to set up a short code. When a user 
dials the short code from any extension they will be prompted for their mailbox number (extension number) 
and voicemail code. 
 
To give all users access from any extension: 

1. Open IP Office Manager. 

2. Set up a short code, for example *98:   

Field Contains... 
Code *98 
Feature Voicemail Collect 
Telephone Number ?Anonymous 
Line Group ID 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

 

Giving Users Voicemail Access from an External Location 
If users need to access their voicemail messages when they are away from the office, you can set up an Incoming 
Call Route in IP Office Manager with the destination as Voicemail. For more information, see the IP Office Manager 
help or guide. 

To give users access from an external location: 

1. Open IP Office Manager. 

2. In the Navigation pane, click Incoming Call Route and add a new call route. 

3. In the destination field, select the option Voicemail. When an incoming call is matched the call is passed to 
voicemail to enable remote mailbox access. Callers are asked to enter the extension ID of the mailbox 
required and then the mailbox access code. 

4. Click OK to save the changes. 

5. Click  to merge the configuration back to the IP Office. 
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Creating a Trusted Location 
If a user regularly accesses their voicemail messages from another extension or a number that presents a CLI, 
such as their mobile or home number, this extension or number can be set up as a trusted location. 

To configure a trusted location: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  User and select the individual user. 

3. View the Source Numbers tab. 

4. Add a V source number. 

 Enter the users extension number.  
For example, a user whose extension number is 214 wants to be able to collect their voicemail 
without entering their voicemail code. A source number V214 would be entered. 

 Enter a different extension number. 
For example, a user whose extension is 214 wants to be able to collect their voicemail from 
extension 204. A source number V204 would be entered. From now on when the user of extension 
214, dials a short code from extension 204 they will not be prompted for their voicemail code. Not 
supported for Intuity mailbox users. 

 Add a V source number containing the external telephone number. 
For example, V01923 38383 would be entered if the external number was 01923 38383.When the 
user dials the number set up as the Incoming Call Route to Voicemail from the "trusted location", 
they will not be prompted for their mailbox number or Voicemail Code. For more information, see 
Giving Users Voicemail Access from an External Location. Not supported for Intuity mailbox users. 

5. Click OK to save the changes. 

6. Click  to merge the configuration back to the IP Office. 
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Mailbox User Controls 
Overview 
With IP Office mailbox owners can control their mailbox and messages in a number of ways after they have logged 
in to the mailbox. 

 Standard IP Office Mailbox Mode  
This is the only mode for VoiceMail Lite. VoiceMail Pro can also be set to run in this mode. For more 
information, see the IP Office Mailbox User Guide. 

 Intuity Mailbox Mode  
This is the default mode for VoiceMail Pro. It provides an IP Office emulation of many of the Avaya Intuity 
features. For more information, see the Intuity Mailbox User Guide. For information about switching 
between IP Office and Intuity mailbox mode, see Changing Mailbox Operation Mode. 

 Phone Manager  
The Phone Manager application enables a user to switch voicemail and voicemail ringback on/off. Phone 
Manager Pro also provides full visual access to a user's voicemail and allows messages to be played back 
and controlled through their PC. For more information, see the Phone Manager User Guide or help. 

If a mailbox does not have a recorded name greeting, when that mailbox is accessed to collect messages, the 
caller is asked to record their name before proceeding to collect messages. The name greeting is used for 
functions such as Dial by Name actions and Intuity mode name lookup (**6). 

Tip 

 As VoiceMail Pro system administrator, you should ensure that mailbox owners have the help and user 
guide for their type of mailbox available to them. There is an IP Office User Guide and an Intuity Mailbox 
User Guide. Both are available in PDF and online help formats. You can find them on the IP Office 
Documentation CD or you can download them from the Avaya knowledge base at 
www.avaya.com/ipoffice/knowledgebase. 
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Telephony Operation Mode 
All users should be made aware that messages may be automatically deleted after a period of time. If a user does 
not want a message to be automatically deleted the message can be saved. Mailbox owners can find out about 
saving messages in the user guide for their type of mailbox. 

After a user has logged into their mailbox, the VoiceMail Pro Server offers two sets of mailbox controls. 

 IP Office  
This is the default mode used and matches the features of VoiceMail Lite. 

 Intuity  
This is IP Office Intuity emulation mode. Intuity is a mailbox interface used on a range of Avaya voicemail 
systems. In Intuity emulation mode, VoiceMail Pro supports a range of Intuity features but not all Intuity 
features. For full details of those Intuity features supported by VoiceMail Pro, refer to the IP Office Intuity 
Mailbox User Guide. 

 If the Regional Setting of the server onto which VoiceMail Pro is installed is "English (United 
States)", VoiceMail Pro defaults to Intuity mailbox operation. 

The prompts provided to a mailbox user are determined by the user's Locale setting as set through the IP Office 
Manager. Note that on some phones users can change their language setting themselves. Mailbox owners should 
refer to the user guide for their type of mailbox. For information about supported languages, see Supported 
Languages. 

All users can use the following default short codes: 

 *17 - Access their mailbox from their own extension. 

 *18 - Turn voicemail on. 

 *19 - Turn voicemail off. 

 *48 - Turn voicemail ringback on. 

 *49 - Turn voicemail ringback off. 

For information about changing to Intuity or IP Office mailbox operation mode, see Changing Mailbox Operation 
Mode. 
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Automatic Message Deletion 
Messages are automatically deleted from the voicemail server after being played (including those played via the 
users IMS email client) after a set delay. This delay can be adjusted for different message types. 

The process of housekeeping is performed after any two hour idle period, that is a period with no call into or from 
the voicemail server. 

1. Click the preferences  icon. 

 Alternatively, from the Administration menu, select Preferences and then choose General. 

2. Select the Housekeeping tab. 

 

3. Adjust the settings as required for the different message types. 

4. Click OK. 

5. Click  Save and Make Live and select Yes. 

 

Personal Distribution Lists 
Personal distribution lists (also known as mailing lists) are available to mailbox users when the system is in Intuity 
mode. 

Each mailbox can accommodate up to 20 lists. Each list can contain up to 360 mailbox numbers. Lists can then be 
used or forwarding or sending messages from the mailbox. 

Each list can be marked as private or public. Public lists can be used by other mailbox users when forwarding or 
sending messages. A user can also import the contents of a public list into one of their own lists. 

If VoiceMail Pro Networked Messaging (VPNM) is installed, lists can include mailboxes on remote systems. The 
only difference in presentation is that, where the mailbox user name is used to identify local mailboxes in a list, 
remote mailboxes are listed by number only. 

Lists are maintained either through the mailbox or through Phone Manager Pro version 3.0 or higher. Lists cannot 
be viewed or controlled from the VoiceMail Pro Client. For more information about mailing lists, mailbox owners can 
refer to the Intuity Mailbox User Guide. 
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Hunt Groups 
Overview 
Hunt groups must first be set up in IP office. You can then use VoiceMail Pro to configure the way in which 
voicemail works for a hunt group. 

Voicemail provides a number of services for hunt groups. 

 Announcements  
If a caller is waiting to be answered, queuing or the hunt group is in out-of-hours mode, the voicemail 
server can provide appropriate greetings to callers. These greetings can be changed through the normal 
mailbox controls. Mailbox users can find out more in the IP Office or Intuity Mailbox user guides. For more 
information, see Out of Hours Operation. For more information, see Configuring Announcements. 

 VoiceMail Pro allows the actions available to a queued caller to be customized as well as the 
greeting messages. 

 VoiceMail Pro does not control the queuing of calls. Queuing is controlled by the IP Office switch 
that presents queued and still queued calls at the appropriate times and provides the queue 
position and ETA data. 

 Messaging  
If voicemail for a hunt group is on (the IP Office default), calls to the hunt group are automatically routed to 
voicemail if all available extensions have been called for the number of seconds defined in the IP Office No 
Answer Time parameter. The default time setting is 15 seconds. 

 Message Waiting Indication 
By default there is no indication on the handset when a hunt group mailbox contains messages and no 
direct access method to a hunt group mailbox. 

 For hunt group members to receive message indication, an appropriate H source number entry 
needs to be added. For more information, see Configuring Hunt Group Message Waiting 
Indication. 

 For access by other users an access short code can be used. For more information, see Enabling 
Access to Hunt Group Voicemail with a Short Code. 
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Hunt Group Configuration in IP Office 
Voicemail can be configured for each hunt group in IP Office Manager. 

To change voicemail configuration for a hunt group: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  HuntGroup and select the hunt group. 

3. View the Voicemail tab. 

 

4. (Optional) Enter a voicemail code between 1-15 digits in the Voicemail Code field. This is required when 
users retrieve voicemail messages for the hunt group remotely, for example from an extension that is not a 
member of the hunt group or from an external telephone. 

 The Voicemail Code must be retyped in the Confirm Voicemail Code field to ensure it has been 
correctly entered. 

5. (Optional) Messages for the hunt group can be sent to an email account.  

 Voicemail Email - Enter the email address of the user. 

 Select the Voicemail Email Mode from: 

 Off: Voicemail messages or notifications are not automatically sent. 

 Copy: A copy of the message is sent to the email account. 

 Forward: Voicemail messages are sent to the email account and deleted from the 
voicemail server. 

 Alert: Notification that a new voicemail message has been received is sent to the email 
account. 

6. (Optional) Voicemail can be turned off by un-checking the Voicemail On option. When on, the mailbox is 
used to answer the hunt groups unanswered or busy calls. 

7. (Optional) For voicemail systems running in IP Office Mode, this option controls whether users hear an 
additional prompt when they retrieve messages. The prompt is 'For help at any time press 8'. 

 This option does not affect Intuity emulation mailbox mode where the prompt "For help at any time 
press *4" is played. 

 Even if voicemail help is set to off, IP Office Mode users can still press 8 at any time and hear the 
list of voicemail features. This setting turns on/off the audible help message. It does not disable the 
actual feature. 

8. (Optional) Select the option Broadcast if you want any voicemail messages left for the hunt group 
forwarded to the mailboxes of the individual group members. The original message in the hunt group 
mailbox is deleted. 

9. Click OK and save the configuration. 
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Configuring Message Waiting Indication 
By default no message waiting indication (MWI) is provided for hunt groups. If required indication can be enabled 
for specific users including users who do not belong to the hunt group. If the user is not a member of the hunt 
group, a voicemail code is also required. This is entered in the Voicemail Code field on the Hunt Group > 
Voicemail tab in the IP Office's configuration. Alternatively the user can be made a member or the group but have 
their membership set to disabled. This allows them to access the group mailbox without receiving group calls. 

Depending on the type of telephone phone or IP Office application they are using, users who receive hunt group 
message waiting indication can choose any of the following methods to collect messages. 

 Phone Manager 
If Phone Manager is used, the group name and number of new messages is displayed in the Messages 
tab. Users click the Messages tab to access the group mailbox. 

 4400 Series Phones 

On phones with a Menu button, press Menu  | Menu  | Msgs | Voice. The group name is 
shown along with the number of new messages. Press the display button to access the group mailbox. 

 Voicemail Ringback 
If a user has voicemail ringback enabled, ringback will occur for new group messages as well as new 
personal messages. Ringback for personal messages takes place before any ringback for new group 
messages. 

 

This method of configuring hunt group message waiting indication allows individuals, including users who are not 
members of the group, to receive hunt group message waiting indication. 

To configure message waiting indication: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  User and select the individual user. 

3. View the Source Numbers tab. 

4. Click Add. 

 

5. In the Source Number field, enter H followed by the hunt group name. For example, to receive message 
waiting indication from a hunt group called Main, enter HMain. 

6. Click OK. 

7. Click  to merge the configuration change back to the IP Office. 
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Configuring Group Broadcast 
If the Broadcast option is enabled, a message for a hunt group is copied to the individual user mailboxes of each 
hunt group member. A call flow can be created that includes the Generic Action. For more information, see Generic 
Action. If messages need to be forwarded to the same group a Personal Distribution List could be created. For 
more information, see Personal Distribution Lists. 

To configure Group Broadcast: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  HuntGroup and select the required group. 

3. Click the Voicemail tab.  

 

4. Check Broadcast. 

5. Click OK. 

6. Click  to merge the configuration change back to the IP Office. 
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Using a Short Code to Collect Voicemail 
To access messages for a hunt group, a short code can be created. For example, for a group called Main a short 
code can be added with the following properties. 

Field Contains... 
Code *99 
Feature Voicemail Collect 
Telephone Number "?Main" 
Line Group Id 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

For systems running in Intuity mode, the above will work only if the user is a member of the group and a custom 
call flow has also been set up for the collect start point to that hunt group. 

  

Members of the hunt group Main can now dial *99 from their own extensions to access hunt group messages. In IP 
Office mode, to use this short code for access from an extension that is not a member of the hunt group, a 
voicemail code should be configured for the group. 

 

Out of Hours Operation 
Voicemail provides a number of greetings for groups. One of these is an Out of Hours Greeting. 

Through IP Office Manager or using a short code a hunt group can be taken in or out of service. When the group is 
Out of Service, callers are played the group's "Out of Hours" greeting and can then leave a message. Alternatively, 
if an Out of Service Fallback Group has been configured, callers are passed to that group. 

Similarly, a group can be taken in or out of Night Service by using Manager, short codes or an associated time 
profile. When the group is in Night Service, callers are played the group's "Out of Hours" greeting and can then 
leave a message. Alternatively, if an Out of Hours Fallback Group has been configured, callers are passed to that 
group. 

 



Administration 

VoiceMail Pro Installation and Maintenance Guide Page 155  
IP Office 4.0 15-601063 Issue 16 (12th December 2006)  

Configuring Announcements 
When a caller is waiting to be answered or queuing, announcements can be played to the caller. The 
announcements are activated in IP Office Manager. 

To configure your announcements: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  HuntGroup and select the hunt group. 

3. View the Announcements tab. 

4. Check Announcements On. Announcements will be played to a caller who is in a queued or waiting for 
the hunt group. 

 

5. Select the amount of time for the caller to be queued or waiting before they hear the first announcement. 
The Wait before 1st announcement (seconds) default is 10. 

6. Select the Post announcement tone. The options are Ringing, Music on Hold or Silence. The default 
selection is Music on hold. 

7. (Optional) Check 2nd announcement to play another message to the caller. 

8. (Optional) Select the amount of time between the first and second announcements. The default time is 20 
seconds. 

9. (Optional) If the second announcement is to be repeatedly played to the caller until their call is answered, 
check Repeat last announcement. 

10. Click OK to save the changes. 

11. Click  to merge the configuration back to the IP Office. 

The standard announcements used are: 

Announcement 1 - I am afraid all the operators are busy at the moment but please hold and you will be 
transferred when somebody becomes available. 

Announcement 2 - I am afraid all the operators are still busy but please hold and you will be transferred when 
somebody becomes available. 

You can record your own announcements using VoiceMail Pro. For more information, see Customizing 
Announcements.  
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Customizing Announcements 
With VoiceMail Pro, the announcements and actions provided to a caller held in a group's queue can be 
customized using the Queued and Still Queued start points for that group. 

 The Queued start point replaces the default Announcement 1. 

 The Still Queued start point replaces the default Announcement 2. 

 

It is important to note that unconnected results in Queued and Still Queued call flows will return the caller to the 
queue rather than disconnect them. An attempt to return the caller using a Transfer or similar action places the 
caller at the back of the queue as a new call. 

To customize announcement 1 for a specific group: 

1. In the Start Points Navigation pane, select Groups. 

2. Select the required group and click  to edit the start point. 

3. Select the entry point Queued. 

4. Click OK to add the Queued entry point. 

5. Double click the Queued Start Point action to open the properties. 

6. Select the Entry Prompts tab. 

7. Click  to open the Wave Editor window. Select the WAV file to be used as announcement 1, or record a 
new file. For more information, see Using the Wave Editor. 

8. Click Close to return to the Entry Prompts window. 

9. Click OK to save the changes. 

10. Click  Save and make live. Any caller queuing for the selected group will hear the new announcement 
when they first join the queue. 

 

To customize announcement 2 for a specific group: 

1. In the Start Points Navigation pane, select Groups. 

2. Select the required group and click  to edit the start point. 

3. Select the entry point Still Queued. 

4. Click OK to add the Still Queued entry point. 

5. Double click the Still Queued Start Point action to open the properties. 

6. Select the Entry Prompts tab. 

7. Click  to open the Wave Editor window. Select the WAV file to be used as announcement 2, or record a 
new file. For more information, see Using the Wave Editor. 

8. Click Close to return to the Entry Prompts window. 

9. Click OK to save the changes. 

10. Click  Save and make live. Any caller queuing for the selected group will hear the new announcement. 
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Hunt Group Queuing 
If hunt group queuing options are enabled, a call will be held in a queue when all available extensions in the hunt 
group are busy. Using VoiceMail Pro you can define custom actions and prompts for the queuing sequence. 

 The Still Queued message is not played if the hunt group name exceeds 13 characters. 

Queuing is configured for each hunt group in IP Office Manager. 

To configure queuing for a hunt group: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  HuntGroup and select the hunt group. 

3. View the Queuing tab. 

 

 Queuing On : Default = On  
If selected, queuing will be available for the hunt group. 

 Queue Length: Default = No Limit  
This feature sets the number of calls that will be held in the queue at any one time. If this number is 
exceeded the caller will receive the busy tone or be passed to voicemail. 

 Normalize Queue Length: Default = Blank 
This facility selects whether to include calls that are ringing but not answered in the queue length. 

 

When queuing is selected, announcements can be played to the queued caller. For more information, see 
Configuring Queue Announcements. 
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Customizing a Hunt Group Call Flow 
VoiceMail Pro allows for customization of queuing operation through the use of Queued and Still Queued start 
points, either specific to a particular hunt group or default for all groups. 

The  Queue ETA and Queue Position actions can be used to provide callers with queue information and 
then place them back in the queue. Within a Queue or Still Queued start points call flow, the default action for any 
unlinked results is to place the caller back in to the queue rather than disconnect the caller. 

 Note in Incoming Call Route 'Priority' 
The IP Office supports a configurable Priority setting (1, 2 or 3) on Incoming Call Routes. Calls assigned a 
high priority are moved up any call queue ahead of those with a lower priority. The use of this feature is not 
compatible with Queue ETA and Queue Position messages as the spoken queue positions and ETA for 
some callers may be overridden by calls with a higher priority. For example, a caller might hear that their 
queue position is 5. If a call is received on an Incoming Call Route with a higher priority, the next time the 
queue position is heard their queue position could be 6, further back in the queue. 

Further customization can be applied using actions such as a  Menu action to let the caller select, for example, 
to leave a message, be transferred to another number or return to the queue. 

The two VoiceMail Pro variables, $ETA and $POS, can be used to further customize the Queued and Still 
Queued call flows. 

 $ETA: Queued Callers Estimated Time to Answer  
If used in a prompt list, will speak the callers ETA, for example, "Your estimated time to answer is 5 
minutes." If used elsewhere, such as in a condition, returns the ETA in minutes as a numeric value. 

 $POS: Queued Callers Queue Position  
If used in a prompt list, will speak the caller's queue position, for example, "You are in queue position 2." If 
used elsewhere, such as in a condition, returns the caller's queue position as a numeric value. 

The importance of these two variables is that, instead of or in addition to customizing the queue call flow for all 
queued callers, you can customize the actions for callers whose ETA or position match selected criteria. 

The screen below shows an example of a queued call flow that uses a condition to test the value of $POS for the 
queued caller. 

 

 When the caller is in queue positions 1 to 4, they are passed to a Queue Position action and hear their 
queue position before returning to the queue. 

 When the caller is in queue position 5, they are asked to leave a message. 

 Instead of using a Leave Mail action, the caller could be taken through a Voice Question or Campaign 
action to collect required information and the caller's responses could be saved as a message. 
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Recording Calls 
Overview 
As well as providing messaging services, VoiceMail Pro can provide a call recording service. Call recording can be 
turned on manually. For more information, see Starting Manual Call Recording. Alternatively, call recording can be 
configured to take place automatically for specified users, hunt groups, Incoming call routes or out going calls with 
account codes. For more information, see Automatic Call Recording:Overview. 

 By default, automatic call recording records a call from start to finish, even if it is transferred. The exception 
is for hunt groups where the recording continues only if the transfer is within the hunt group. 

 If a conference call is being recorded, recording continues when a new party joins the conference. 

 If a call that is being recorded is put on hold or parked, the recording will pause. When the call is 
reconnected the recording resumes. 

 By default, a recording is placed in a user's own mailbox but this location can be changed. 

 A recording by an agent that is intruding on to a call will keep recording after the intruded call has ended. 
This is to allow the recording to be annotated. 

 Agent recording and hunt group recording produce two separate recordings. 

 

Conference Capacity 
Call recording uses conferencing capacity and so is subject to the available conferencing capacity of the IP Office 
system. 

IP Trunks and Extensions 
When the direct media path option is used with IP trunks and or an extension, it is not possible to guarantee call 
recording. 

Call Recording Warning  
In many locations, it is a local or national requirement to warn those involved in a call that they are being recorded. 
The VoiceMail Pro does this by playing an Advice of Call Recording prompt which can be switched off. On 
automatically recorded call, some telephones may also display a recording symbol. For more information, see Call 
Recording Warning. 

Recording Duration 
Call recording is limited to the maximum length of 1 hour. For more information, see Changing the Recording Time. 

Voice Recording Library (VRL) 
Recordings are normally placed into standard mailboxes. VRL operation allows recordings to be transferred to a 
specialist archiving application. This allows both longer recording and the sorting and searching of recordings. For 
more information, see Voice Recording Library (VRL). 
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Call Recording Warning 
In many locations, it is a local or national requirement to warn those involved in a call that they are being recorded. 
One method for doing this is to enable the Advice of Call Recording (AOCR) message provided by the VoiceMail 
Pro server. 

 The 'advice of recording' will always be played if the Advice of Call Recording message is enabled. 

 It can not be guaranteed that a caller will hear an 'advice of recording' announcement when the call is using 
analogue trunks. Analogue trunks do not support call status signalling so the 'advice of recording' 
announcement is played as soon as the trunk is seized even if the call is ringing and has not been 
answered. 

 The Play Advice on Call Recording option is on by default. 

 

The Advice of Call Recording Message 
This message is provided in the file aor_00.wav. For each language installed on the VoiceMail Pro server, a copy 
is located in the sub-folders of c:\Program Files\Avaya\IP Office\Voicemail Server\WAVS. 

To switch the recording warning on or off: 

1. From the VoiceMail Pro Client, click  or select Administration > Preferences > General. 

2. Click Play Advice on Call Recording to switch this option on (checked) or off (unchecked). 

3. Click OK. 

4. Click Save & Make Live. 

 

In addition to the audible advice of call recording prompt , some Avaya terminals display REC to show that the call 
is being recorded. The display can be suppressed. 

To hide the auto record indication: 

1. Open IP Office Manager and load the configuration from IP Office. 

2. In the Navigation pane, click System. 

3. In the System Configuration window, click the System tab. 

4. Check Hide auto recording. The terminal display REC will be suppressed. 

5. Save the configuration back to the IP Office system. 

 

Changing the Recording Time 
For recordings being placed into a VoiceMail Pro mailbox, the maximum recording time is 1 hour. 

To change the recording length: 

1. Start the VoiceMail Pro Client. 

2. Click  or select Administration > Preferences > General. 

3. The Max. VRL Record Length (secs) setting is used only for calls being recorded to VRL. The maximum 
record length is 3600 seconds (60 minutes). 

4. Click OK. 

5. Click Save & Make Live. 
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Voice Recording Library (VRL) 
Voice Recording Library (VRL) operation allows the VoiceMail Pro to transfer specific users who are automatically 
or manually recording calls to a third-party application. It can also be selected as the destination for calls recorded 
via a Leave Mail action in a call flow. 

Currently this mode of operation is only supported with Avaya IP Office ContactStore. This application provides 
tools to sort, search and playback recordings. It also supports the archiving of recordings to DVD. 

 Installation and configuration of VRL with IP Office ContactStore is documented separately. 

 VRL is a licensed feature. It requires entry of a valid Voice Recording Administrators license into the IP 
Office configuration. 

 The VRL application must be configured to store recording on a separate partition, drive or PC from the 
VoiceMail Pro. This is necessary to ensure that the long term storage or recording archives and space 
available for mailbox messages do not conflict. 
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Manual Call Recording 
Starting Manual Call Recording 
There are several ways to start manually recording a telephone call. 

Phone Manager Pro 
Users can initiate call recording using Phone Manager Pro when they are working in Agent Mode. The recording 
feature is active during a telephone call and when call recording is available. 

To manually record a telephone call: 

 Press  on the toolbar to start recording. Press  on the toolbar to stop the recording. 

 Select Actions > Start Recording. The call will be recorded. Press Actions > Stop Recording to finish 
recording the call. 

 

SoftConsole 
The SoftConsole operator can manually record all or part of a current telephone call  

To manually record a telephone call: 

 Press the  button on the toolbar. The button acts as a toggle. Press the button again to stop recording. 

 Select Actions > Record Call. This action toggles and so is also used to stop recording. 

 Press F5 to start recording. Press F5 again to stop the recording. 

 

4400 Series 
Telephones in the 4400 Series with a Menu key can manually trigger call recording by: 

 Press Menu  | Menu  | Func| Recor. 

 

Using DSS Keys 

The call record function can be programmed against a DSS key. When a DSS key has been programmed it can be 
pressed during a call to record the conversation. 

To set a DSS key for manual recording:  

1. Open IP Office Manager and load the configuration from IP Office. 

2. In the Navigation pane, click  User and select the individual user. 

3. Select the Button Programming tab. 

4. Select the required DSS key and click Edit. 

5. Click  browse for the Action. The Button Programming window opens. 

6. Select Advanced > Call > CallRecord. Click OK. 

7. In the Action Data field, enter a description that will appear on the telephone display. 

8. Click OK. 

9. Click  to save the configuration file. 

A call is recorded if the user presses the programmed DSS key during any call. The caller will hear an 
announcement that the call is being recorded if the mandatory call recording warning is active. For more 
information, see Call Recording Warning. 
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Using Short Codes 

The short code feature "CallRecord" can be used to trigger recording of calls into the user's designated mailbox. 
The example shortcode (*95) can be set up as a user short code or a system shortcode. In either case it will trigger 
recording  

Field Contains... 
Code *95 
Feature Call Record 
Telephone Number [Leave blank] 
Line Group Id 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

 

To use the short code: 

1. During a call, put the caller on hold. 

2. Dial the short code. The call is automatically reconnected and recording begins.  

 

The following is an example short code for recording a call involving a specific extension. You do not have to be in 
conference with or part of the call This short code should only be set up as a user short code for trusted users. 

Field Contains... 
Code *96*N# 
Feature Call Record 
Telephone Number N 
Line Group Id 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

 

To use the short code: 

1. Check that the extension is in use. 

2. Dial the short code with the number of the extension that you want to record. Using the example short code 
you would dial *96*123# to record a call connected to extension 123. 
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Setting Manual Recording Options 
The IP Office Manager can be used to specify where recordings triggered by a user are placed: 

To configure a user's recording options: 

1. Open IP Office Manager and load the configuration from IP Office. 

2. In the Navigation pane, click  User and select the individual user. 

3. Select the Voice Recording tab. 

 

4. In Manual Recording Mailbox, select from the list the mailbox that  is to be used to contain recordings 
triggered by the user. 

 The Voice Recording Library options can be used only if a VRL application has been installed 
and licensed. For more information, see Voice Recording Library. 

6. Click OK. 

7. Click  to merge the configuration change back to the IP Office. 
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Customizing Manual Recording 
Normally recording is performed by the VoiceMail Pro server as a default task. However, a module named Record 
can be used to customize the operation of auto-recording. 

Notes 

 If a Record module is created, it overrides the default record operation. Therefore it must at minimum 
emulate the default manual recording process of placing recordings into the mailbox of the user who 
triggered recording. For example, in the module call flow shown below, the Listen action is set to $UUI. 

 Whenever recording is triggered, $UUI contains the user name of the user who that triggered the recording 
process. 
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Automatic Call Recording 
Overview 
The IP Office system can be configured to automatically record particular users, hunt groups, incoming call routes 
or outgoing calls associated with a particular account code. 

 Only incoming calls can be automatically recorded for a hunt group. Outgoing calls from a hunt group can 
not be automatically recorded. 

 An agent with recording set answering a call to a hunt group with recording set, will result in two recordings 
being made. One in the hunt group mailbox the other in the agent's recordings mailbox. 

 Multiple recordings of the same call use multiple voicemail channels. 

 If an account code is used with an out bound call the account code table is checked to see if the call should 
be automatically recorded. If the call is recorded the recording is saved in the user's automatic recording 
mailbox. If a call is transferred to another user, the call recording will be terminated. 

 If a call is being automatically recorded in a hunt group the recording continues if the call is transferred to 
another user in the hunt group or overflow group. The recording ends if the call is transferred outside the 
hunt group. 

 A user's external calls can be automatically recorded. If a recorded call is transferred the recording will 
stop. 

 A time profile can be used for hunt groups and incoming call routes to specify when automatic call 
recording is used. 

 For inbound calls, recording will not take place if the call also goes to normal voicemail. 

 Different frequency settings, set in percentage terms, can be applied to the automatic recording of inbound 
and outbound calls. 

 A mandatory setting can be used to return a busy tone when call recording is required but not available.  

 Where calls have been answered using a Line appearance button, the call recording goes to the mailbox 
setting of the original call route destination. 

 The mailbox used to store the automatic recording can be selected for incoming call routes, groups and 
users. 

 



Administration 

VoiceMail Pro Installation and Maintenance Guide Page 167  
IP Office 4.0 15-601063 Issue 16 (12th December 2006)  

Setting Automatic Recording Options 
Automatic recording can be configured for: 

 Calls received and/or made by a user. 

 Calls on a specific incoming call route. 

 Calls to a specific hunt group. 

 Outgoing calls associated with a specific account code. 

The calls that are to be auto-recorded are selected through IP Office Manager. 

To set automatic call recording for a user: 

1. Open IP Office Manager and load the configuration from IP Office. 

2. In the Navigation pane, click User. 

3. Select the required user. 

4. Select the Voice Recording tab.  

 

5. From the Record Inbound and Record Outbound drop-down lists select the recording frequency 
required. 

 None: Do not record. 

 On: Record all calls if possible. 

 Mandatory: Record all calls. If recording is not possible, return busy tone to the caller. 

 xx%: Record calls at intervals matching the set percentage, eg. for every other call for 50%. 

 For inbound calls, recording will not take place if the call also goes to normal voicemail. 

6. Specify the destination for the recordings. By default, this is a user's own mailbox. 

 The Voice Recording Library options can be used only if a VRL application has been installed 
and licensed. For  more information, see Voice Recording Library. 

7. Click OK. 

8. Click  to send the configuration back to the IP Office. 
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To set automatic call recording for a hunt group: 

1. Open IP Office Manager and load the configuration from IP Office. 

2. In the Navigation pane, click HuntGroup. 

3. Select the required hunt group. 

4. Select the Voice Recording tab.  

 

5. From the Record Inbound drop-down lists select the recording frequency required. 

 None: Do not record. 

 On: Record all calls if possible. 

 Mandatory: Record all calls. If recording is not possible, return busy tone to the caller. 

 xx%: Record calls at intervals matching the set percentage, eg. for every other call for 50%. 

 For inbound calls, recording will not take place if the call also goes to normal voicemail. 

6. (Optional) Select the required time profile. 

7. Click OK. 

8. Click  to send the configuration back to the IP Office. 
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To set automatic call recording for an incoming call route: 

1. Open IP Office Manager and load the configuration from IP Office. 

2. In the Navigation pane, click Incoming Call Route. 

3. Select the required incoming call route. 

4. Select the Voice Recording tab.  

  

5. From the Record Inbound drop-down lists select the recording frequency required. 

 None: Do not record. 

 On: Record all calls if possible. 

 Mandatory: Record all calls. If recording is not possible, return busy tone to the caller. 

 xx%: Record calls at intervals matching the set percentage, eg. for every other call for 50%. 

 For inbound calls, recording will not take place if the call also goes to normal voicemail. 

6. (Optional) Select the required time profile. 

7. Specify the destination for the recordings or select the option to place the recordings in the voice recording 
library. 

 The Voice Recording Library options can be used only if a VRL application has been installed 
and licensed. For  more information, see Voice Recording Library. 

8. Click OK. 

9. Click  to send the configuration back to the IP Office. 

 



Voicemail Pro Installation and Maintenance Guide 

Page 170 VoiceMail Pro Installation and Maintenance Guide 
15-601063 Issue 16 (12th December 2006) IP Office 4.0 

To set automatic call recording for an outgoing account call: 

1. Open IP Office Manager and load the configuration from IP Office. 

2. In the Navigation pane, click Account Code. 

3. Select the required account code. 

4. Select the Voice Recording tab.  

  

5. From the Record Outbound drop-down lists select the recording frequency required. 

 None: Do not record. 

 On: Record all calls if possible. 

 Mandatory: Record all calls. If recording is not possible, return busy tone to the caller. 

 xx%: Record calls at intervals matching the set percentage, eg. for every other call for 50%. 

 For inbound calls, recording will not take place if the call also goes to normal voicemail. 

6. (Optional) Select the required time profile. 

7. Select the option to place the recordings in the voice recording library. 

 The Voice Recording Library options can be used only if a VRL application has been installed 
and licensed. For  more information, see Voice Recording Library. 

8. Click OK. 
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Customizing Auto Recording 
Normally auto-recording is performed by the VoiceMail Pro server as a default task. However, a module named 
AutoRecord can be used to customize the operation of auto-recording. If an AutoRecord module is created, it 
overrides the default auto-record operation. 

Whenever auto recording is triggered, $UUI contains either the account code, user name or hunt group name that 
triggered the auto recording. 

 

The value of condition Account1 is checked using a  Test Condition action. 

If found True, the call is recorded using a Listen action, which specifies the mailbox for the recording.  

If found False, the next condition test is tried. 

The conditions, created within the  Condition Editor, compare the variable $UUI against possible account 
code values. 

 

The final  Listen action, used if none of the condition tests are True, has its Mailbox set to $UUI. If $UUI hasn't 
matched any account code being used for auto recording, then its value will be either the user name or hunt group 
name that triggered the auto recording. 

 A copy of this module can be found in VoiceMail Pro Samples within the help pages. 
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Announcements 
Overview 
Announcements can be played when: 

 Callers are waiting to be answered or queued against a hunt group 
With VoiceMail Pro, the announcements and actions provided to a caller held in a group's queue can be 
customized using the Queued and Still Queued start points for that group. The call can be answered at any 
stage of the announcement. For more information, see Configuring Announcements. 

 Calls are going to be recorded 
In many locations, it is a local or national requirement to warn those involved in a call that they are being 
recorded. For more information, see Call Recording Warning. 

 Calls enter a call flow 
For more information, see Using the VoiceMail Pro Client:Overview. 

 Calls are received 
A call flow containing an announcement can be created so that all callers hear a mandatory 
announcement. The announcement is played before the call is answered. For more information, see 
Mandatory Announcement Example. 

 Calls are queuing against an user's extension 
User's can configure their personal announcements. When the user's extension is busy any new calls are 
held in a queue against the busy extension until the No Answer Time is reached. The caller will hear the 
user's personal announcement before being transferred to voicemail, if available. For more information, 
see Personal Announcements. 

 

Mandatory Announcement Example 
The screen below shows an example of a call flow that plays an announcement to any caller to the sales hunt 
group. Callers entering at this start point can not bypass the announcement. 

 

The Entry Prompt of the transfer action contains the announcement. After the announcement is played the caller is 
transferred to the sales hunt group as specified in the Specific tab. For more information, see Transfer Action. 

Once the call flow has been created, IP Office needs to be configured so that callers are transferred to the call flow. 

In IP Office Manager the destination for the incoming call route is entered as VM:Sales. The incoming call route 
targets the voicemail module 'Sales'. As the call flow module name is the same as the hunt group name, if 
voicemail is unavailable the call will automatically be routed to the hunt group. The calls will not be lost but the 
callers will not have heard the announcement. 

If call are required to only be answered after they have heard the announcement, make sure that the call flow 
module name is different from the hunt group name. If voicemail is unavailable the call will not be transferred to the 
target hunt group. 
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Personal Announcements 
Personal announcements can be played when a caller is queuing against a user's extension number. A call will be 
held in a queue when the user's extension is busy before passing to voicemail, if voicemail is available. 

 If the user requires announcements only, voicemail should be turned off for the user. 

 Start points can be amended to include other actions. For example, a menu action could be added 
to the Still Queued start point giving users the option to continue to hold for the caller or to transfer 
to reception. 

 If voicemail is on the announcements are played until the No Answer Time is reached. The caller is then 
transferred to the user's voicemail. The system default setting for No Answer Time is 15 seconds, however 
it can be set for individual users. 

Using VoiceMail Pro start points are defined for the user. Each start point contains the default announcement that 
is played to the caller and should be personalised. The start points Queued and Still Queued can be used, or just 
the Queued start point. 

 The Queued start point plays Announcement 1.  
The default announcement 1 is 'I am afraid all the operators are busy at the moment but please hold and 
you will be transferred when somebody becomes available'. 

 The Still Queued start point plays Announcement 2. 
The default announcement 2 is 'I am afraid all the operators are still busy but please hold and you will be 
transferred when somebody becomes available'. 

Personal announcements should be recorded to replace the default announcements used in the start points. When 
the start points have been configured in VoiceMail Pro, the user details need to be configured in IP Office Manager. 

 

To configure personal announcements: 

1. Open VoiceMail Pro. 

2. In the Start Points Navigation pane, select  Users. 

3. Select the required user and click to edit the start points. 

 If the user is not listed they need to be added.  
To add a user: 

1. Click . The Adding a new user window opens. 

2. Enter the user's name and click OK. 

4. In the Edit start point window, check Queued and Still Queued. 

5. Click OK to add the start points. 

6. Select the Queued start point. 

 

7. Double click the Queued start point to open the properties. 

8. Select the Entry Prompts tab. 

9. Click  to open the Wave Editor window. Record a new announcement to replace the default 
announcement 1. For more information, see Using the Wave Editor. 
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10. Click Close to return to the Entry Prompts window. 

11. Double click the Still Queued start point to open the properties. 

12. Click  to open the Wave Editor window. Record a new announcement to replace the default 
announcement 2. 

13. Click Close to return to the Entry Prompts window. 

14. Click OK to save the changes. 

15. Click  Save and make live.  

16. Open IP Office Manager and load the configuration. 

17. In the Navigation pane click  User and select the user. 

18. (Optional) View the Telephony tab. and amend the No Answer Time value. If the field is blank, the system 
default value of 15 seconds is being used. 

19. View the Announcements tab and check the option Announcements On.  

 

20. Select the amount of time for the caller to be queued before they hear the first announcement. The Wait 
before 1st announcement (seconds) default is 10. 

 The default no answer time of the system is 15 seconds. The no answer time can be set for each 
user. When the no answer time is reached the caller is transferred to voicemail, if available. 

21. Select the Post announcement tone. The options are Ringing, Music on hold or Silence. The default 
selection is Silence. 

22. (Optional) Check 2nd announcement to play another message to the queued caller. 

23. (Optional) Select the amount of time between the first and second announcements. The default time is 20 
seconds. 

24. (Optional) If the second announcement is to be repeatedly played to the caller until their call is answered, 
check Repeat last announcement. 

25. (Optional) View the Voicemail tab. Un-check Voicemail On if only announcements are required. 

26. Click OK to save the changes. 

27. Click  to merge the configuration back to the IP Office. 
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Support for Callers with Impaired Hearing 
Overview 
TTY is a method of sending and receiving text messages within the speech path of telephone calls. The text is 
entered and displayed through a TTY device, such as a text phone, connected in parallel with the user's normal 
telephone. Due to its widespread usage and support it has become the standard used by devices for the users with 
impaired hearing or vision. 

VoiceMail Pro 1.4 and higher supports the addition of TTY prompts for leaving messages in and collecting 
messages from Intuity mode mailboxes. Callers with a TTY device can see the TTY prompts and leave TTY format 
messages. The mailbox user, also with a TTY device, can collect and display those messages by following the 
prompts that are displayed on the TTY device. 

 

The TTY device and associated analog telephone (linked either by a pass-through port on the TTY device or a 
telephone splitter) are connected to an analog extension port (POT) on the IP Office system. During calls the TTY 
can be used to display and send TTY messages. The analog telephone can be used to send dialing digits and 
provide a speech path during calls. 

 

Installing VoiceMail Pro TTY (Textphone) Prompts 
You can select TTY prompts from the list of language options when you install VoiceMail Pro. For more 
information, see Installation Overview. When the prompts have been installed, the user settings must be configured 
so that the IP Office recognizes the TTY device. 

There are two ways to configure a user so that they can use a TTY device with VoiceMail Pro. 

1. The simplest method is to change the user locale in IP Office Manager. This method requires no 
customization of a user's mailbox. For more information, see Changing User Locale or refer to the IP Office 
Manager help or User Guide. 

2. An alternative to changing the user locale to TTY is to change the language setting in the VoiceMail Pro 
call flows for the user who needs TTY prompts. For more information, see Changing the Language Setting 
for a Text Phone. 
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Changing User Locale 
The locale setting tty is not actually recognized by IP Office Manager. Therefore all aspects of a user's telephony 
operation on the IP Office will default to the system's locale setting (System > System > Locale). However, the user 
locale setting is transferred to the VoiceMail Pro server during mailbox access and so will affect the prompts that 
are provided. 

To change the user locale: 

1. Open IP Office Manager. 

2. In the Navigation pane, click  User and select the individual user. 

3. Select the User tab. 

4. Select the option Teletype (Textphone) in the Locale field. 

5. Click OK. 

6. Click  to merge the configuration change back to the IP Office. 

 

Advice for Mailbox Users Owners Using a TTY Device 
To log into their mailbox with a TTY device, such as a text phone, mailbox owners must dial *17 and then take the 
analog telephone handset off hook. 

When they are connected, users see prompts on the display of the text phone. 

For requests such as "Press 1 for …" users should dial from the keypad of the telephone. For messages followed 
by GA (go ahead) users are required to type text using their text device. 

For more information, refer to the document "User Guide for Audix TTY Interface" (555-300-710). 
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Changing the Language Setting for a TTY Device 
An alternative to setting the user locale as TTY is to change the user's language setting in the VoiceMail Pro call 
flows for that user. Here are two examples. 

 

An Example of Customizing a Simple Mailbox Call Flow 

The  Select System Prompt Language action can be used to change the prompt language used by 
subsequent actions in a call flow. Once the TTY Maintenance Patch has been installed, TTY is one of the 
selectable languages provided by the action. 

In the simplest form, a  Select System Prompt Language action set to TTY, would be added to the user's 
Collect start point and followed by a Get Mail action. 

 

 

Similarly, a  Select System Prompt Language action set to TTY, would be added to the user's Leave start 
point and followed by a Leave Mail action. 
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An Example of Customizing a Complex Mailbox Call Flow 

If required, more complex call flows can be configured. For example, the call flow below allows callers to press * to 
receive spoken language prompts or to wait a few seconds for the timeout and then receive TTY prompts. 

 

In this case, messages are left in the same mailbox,  but callers can select to have spoken prompts or default to 
TTY prompts. 

For hearing impaired users who cannot handle spoken messages, the call flow for callers who select spoken 
prompts could have place those messages into an alternate mailbox of a hearing user. These could then be 
collected and transcribed for the user. 
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Changing the Language 
Overview 
VoiceMail Pro can be used in a wide range of languages. For external callers, the VoiceMail Pro tries to match the 
Locale setting of the IP Office system. For internal callers, if they have a different user locale in their user setting, 
VoiceMail Pro tries to match that language. 

With centralized VoiceMail Pro, the default locale is that of the central IP Office. If users on the remote IP Office 
want different language prompts, each of their user locales must be changed separately. 

If prompts for a required language are not installed, VoiceMail Pro has a set of rules that it follows to find the best 
alternate language. For example if prompts are not available for users with their locale set to French Canadian, 
VoiceMail Pro looks for French prompts instead. If French prompts are not installed, it looks for English US and 
finally English UK. For more information, see Supported Languages. 

The language played to a caller can be changed during a call. This is achieved using a Select System Prompt 
action. For more information, see Changing the Language of System Prompts. 

 

Supported Languages 
The voicemail system provides prompts to callers and mailbox users based on the Locale that is set in the System 
form of IP Office Manager.  

If the necessary set of language prompts is not available, the nearest available match is used. The list shows the 
first choice language prompts that VoiceMail Pro will try to use, followed by the second choice and so on. For 
example, if prompts for users with their locale set to French Canadian are not available, VoiceMail Pro looks for 
French prompts instead, then English US and finally English UK. The abbreviations shown in the table indicate the 
language prompt folder used in order of precedence. 

Individual users can have their own Locale setting. Voicemail then provides them with the appropriate language 
prompts if they are available. This is set either through the IP Office Manager User form or through the language 
choice on some telephones. For more information, see the appropriate telephone User Guide. 

The availability of a language in voicemail does not necessarily indicate support for IP Office in a country that uses 
that language. Contact your local Avaya office for details of which countries support IP Office. 

 The VoiceMail Pro Server prompts are available in both Chinese Mandarin and Chinese Cantonese. The 
Voicemail installation process, VoiceMail Pro Client and Control panel applet are available in Chinese 
Mandarin only. 

VoiceMail Pro server prompts can be installed in the following languages: 

Brazilian Portuguese: ptb > pt > en.  Italian: it > en. 

Chinese PRC: zzh > en > enu. Korean: ko > en. 

Chinese Traditional: ch > en > enu. Latin Spanish: eso > es > enu > en. 

Danish: da > en. Norwegian: no > en. 

Dutch: nl > en. Polish: pl > en. 

English UK: en. Portuguese: pt > ptb > en. 

English US: enu > en. Russian: ru > en. 

Finnish: fi > en. Spanish: es > eso > en. 

French: fr > frc > en. Swedish: sv > en. 

German: de > en.  French Canadian: frc > fr > enu > en. 

Greek: el > en.  

Hungarian: hu > en. TTY (see note) 

 

Note 
TTY is included in the list of installable languages even though it is not a language. TTY is a text-based system that 
is used to provide service to users with impaired hearing or vision. For more information, see Support for Callers 
with Impaired Hearing:Overview. 
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Changing the Language of System Prompts 
With the  Select System Prompt action you can change the language that is used in a call flow from that of the 
IP Office system or the mailbox user's locale. 

A step by step example that illustrates how to use the Select System Prompt action is provided here. 

 The Select System Prompt action changes the default language prompts but not any custom prompts. To 
change the custom prompts you need to use the $LOC variable in the path to the custom prompt files. For 
more information, see Changing the Language of Custom Prompts. 

 

Example 

In a small hotel, VoiceMail Pro is providing mailboxes for rooms. To assist the room users, we want to start 
message collection by letting them indicate their preferred language for voicemail prompts. 

1. First a module for language selection was created. 

 
The module contains a Menu action with a Select System Prompt action set to the required language for 
each key press. 

 For the Menu action an Entry Prompt was recorded asking the user to indicate their language 
choice; "Press 1 for English, 2 por Español, 3 pour Français". 

 The Select System Prompt actions were all connected Module Return actions. 

2. Next the default start point for message collection was altered. The Language Select module and a Get 
Mail action were inserted.  

 

3. The actions for language selection could have been inserted directly into the call flow. However, by doing it 
as a module the language selection process can be reused in other start points. 
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Changing the Language of Custom Prompts 
Instead of using multiple return points from a Language Select module (one for each language) and linking to 
separate Get Mail actions (each with an Entry Prompt in the required) language, you can use a single Get Mail 
action. 

To change the language of custom prompts: 

1. Through the Get Mail action's properties, record an Entry Prompt for US English users and save it as 
enu\custom\getmail.wav. 

2. Record a similar prompt for French Canadian users and Latin Spanish users. You need to use the same 
file name each time and save each file in a different language folder. 

 
3. Delete all except one of the entry prompt entries. That this does not delete any of the  recorded prompts. 

4. For the remaining entries, change the file path by inserting $LOC in place of the language folder name, for 
example  $LOC\custom\getmail.wav. 
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Mobile Twinning 
Overview 
Mobile Twinning is a licensed feature. If Mobile Twinning is enabled in IP Office, a user can send internal and 
external calls to an external number, for example, their mobile telephone. 

 Both the internal and external telephones ring when a call is received. The call can be answered from 
either telephone. 

 If the feature Do Not Disturb (DND) is active for the user, any callers to the to the internal extension 
number will hear the busy tone and the external telephone will not ring. If a caller is entered in to the DND 
exception list, for example using the application Phone Manager, only the internal telephone will ring. 

 If any of the forward options are active, both the external and the telephone where the calls are forwarded 
to will ring. 

 If the Follow Me option is active, only the telephone that the calls are forwarded to will ring. The external 
telephone number will not ring. 

Within VoiceMail Pro you can administer the mobile twinning features using call flows. Mobile twinning can be 
turned on or of and the external twinning number entered. 

In a call flow the Generic action is used to control Mobile twinning. Within the Generic action details are entered in 
the specific tab. In the generic 'free format' field, the following syntax can be added. 

 CFG:Set MattR twinning_type Mobile 
Used to turn the Mobile twinning on for the named extension MattR. The extension number can be entered 
instead of the named extension. If mobile twinning has been previously used and then turned off, the 
previous mobile twinning number will become active. 

 CFG:Set MattR twinning_type Internal 
Used to turn the Mobile twinning off for MattR. 

 CFG:Set MattR mobile-twinning-number $KEY 
Used to set the mobile twinning number. 
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Example Call Flow for Mobile twinning 
This example creates a VoiceMail Pro module that allows a user to turn Mobile Twinning on or off. They can also 
set their mobile number. The example sets the mobile twinning for extension 203. 

 

To create the example call flow: 

1. Create a new module called Mobile Twinning. 

2. Add a menu action with the menu options 1,2 and 3. Add a prompt to tell the caller the options available. 

3. The option to turn mobile twinning on needs to be added. 

 Click the  Basic Actions icon and select  Generic. 

 Change the token name to Enable Mobile Twinning. 

 Click the Specific tab. 

 Enter the command CFG:Set 203 twinning_type Mobile. 

 Click OK. 

4. The option to turn mobile twinning off needs to be added. 

 Click the  Basic Actions icon and select  Generic. 

 Change the token name to Disable Mobile Twinning. 

 Click the Specific tab. 

 Enter the command CFG:Set 203 twinning_type Internal. 

 Click OK. 

5. The ability to enter the mobile number needs to be added. 

 Click the  Telephony Actions icon and select  Alphanumeric Collection. 

 Change the token name to Collect New Mobile Twinning No. 

 Record an Entry Prompt to tell the user to enter their mobile twinning number. 

 Click OK. 
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6. An action needs to be added to set the mobile number. 

 Click the  Basic Actions icon and select  Generic. 

 Change the token name to Set Mobile No. 

 Click the specific tab. 

 Enter the command CFG:Set 203 mobile_twinning_number_$KEY. 

 Click OK. 

7. The actions need to be connected and then the changes need to be made permanent. 

 

Create a short code to test the call flow. 

1. In IP Office Manager, add the following short code. This example uses *90 but any short code can be used. 

Field Contains... 
Code *90 
Feature Voicemail Collect 
Telephone Number "Mobile Twinning" 
Line Group ID 0 
Locale [leave blank] 
Force Account Code [leave blank] 

2. Save and merge the configuration to the IP Office unit. 

3. Test the short code by dialing *90 from extension 203. 

 Press 1 to turn mobile twinning on for extension 203. 

 Press 2 to enter a new mobile twinning number for extension 203. 

 Press 3 to turn mobile twining off for extension 203. 
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Remote Voicemail Notification 
Overview 
A user can be set up to receive notification of new voicemail messages when they are away from their main 
extension. There are two ways that notification can be implemented. 

 Voicemail Callback  
A service whereby the VoiceMail Pro calls a specified number whenever the user receives a new voicemail 
message. Callback requires a callback start point to be created in VoiceMail Pro and a callback number 
entered in IP Office Manager. For more information, see Setting up Callback Overview. 

 Voicemail Outcalling. 
A service where voicemail notification can be configured to specific external numbers and the notification 
escalated if the message is not listened to. Outcalling can be configured by any user of voicemail in Intuity 
mode. For more information, see Outcalling Overview. 

Note 

 Both the Callback and OutCalling features are separate from voicemail ringback. Ringback alerts the user's 
own extension whilst Callback and OutCalling will provide voicemail notification to an external location, for 
example a mobile telephone or pager. 
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Callback 
Overview 
Voicemail callback is a service whereby the VoiceMail Pro calls a specified number whenever the user receives a 
new voicemail message. When the callback is answered, the system announces the outbound alert and waits for a 
key press for confirmation before continuing with the associated call flow. For more information, see Setting Up 
VoiceMail Pro Callback. 

This service requires configuration of a callback start point in VoiceMail Pro and entry of a callback number through 
IP Office Manager. For more information, see Using a Play Configuration Menu Action. 

 

Setting Up Callback 
The call flow created below is a very simple example. In practice you could include a menu that allows the user 
access to other features. For example access to a Play Configuration Menu action would allow the user to remotely 
change various mailbox settings including their callback number. For more information, see Using a Play 
Configuration Menu Action. 

 

To set up the callback: 

1. Under  Specific Start Points, right-click  Users and select Add. 

2. In the Name field, enter the user's mailbox name. Select the Callback entry point and select OK. 

3. Within  select  Callback. 

4. Add a  Get Mail action and under the Specific tab, in Mailbox enter the user's name again or 
extension number. 

 Important 
Record an entry prompt for the first action in the callback call flow. Experience with connection to 
some cell phone systems has revealed that this entry prompt may need to be up to 20 seconds in 
length. 

5. Connect the  Start Point and the  Get Mail action. 

6. Click  Save and Make Live and select Yes. 

 

The Default Callback Start Point 

In the example above a callback call flow was created for an individual users. The Default Callback start point can 
be used to create a default callback call flow for all users. 

If the Default Callback start point is used, it must be designed so that users have to indicate which mailbox they are 
accessing. In the simple call flow used above, this can be done by entering ? in the Mailbox field of the Get Mail 
action. 

The callback number is initially set through IP Office Manager. 

To set the user's callback number: 

1. In IP Office Manager, open the system's configuration. 

2. Click User to display a list of existing users. 

3. Double-click the user for whom callback is being set up. 

4. Select the Voicemail tab. 

 In Voicemail Code, enter a pin code and confirm this in Confirm Voicemail Code. 
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5. Select the Source Numbers tab. Right-click and select add to add a new number. 

 Callback Number 
Enter P followed by the destination telephone number. If you system requires an external dialing 
then that prefix must be included, for example P901923555456. If connecting to a cell phone or 
pager system that expects digits in separate sets, use , (comma) characters to add pauses to the 
telephone number dialing. 

 Trusted Source 
If calls from the callback number include ICLID, you can set that number as a trusted source. In 
that case no request for the user's voicemail code is made following the callback. Enter V followed 
by the CLI displayed on calls from the callback number, for example V01923555456. 

6. Click OK. 

7. Click  to send the configuration back to the IP Office. If the only changes made were to user settings, 
select Merge Config. 

 

Using a Play Configuration Menu Action 
The callback call flow below is more advanced than the previous example. It allows the user to check messages, 
transfer themselves to another extension and to alter several aspects of their mailbox configuration. 

 

Of main interest to a callback user is the  Play Configuration Menu action. This action allows the remote user to 
alter their extensions forwarding and voicemail operation. Option 9 in the menu played to the caller allows them to 
change the callback number. 

To exit a Get Mail or Play Configuration Menu action and follow the call flow to the next action, the user should 
press 0 (not supported for Get Mail in Intuity mode). 
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Outcalling 
Overview 
The Outcalling feature is only available when using VoiceMail Pro in Intuity mode. 

VoiceMail Pro can be configured to send notification that a new voice message has been received in a user's 
mailbox to a specified telephone number. When notification is received the new voice message can be collected. 
This facility is known as outcalling. The notification can be sent for: 

 Any new voice messages. 

 Any new priority voice messages. 

If the message is not collected notification can be sent to another telephone number. There can be up to 5 
destinations defined. The destinations selected in the escalation list are called in sequence. The possible 
destinations are: 

 Desk. 

 Home. 

 Mobile. 

 Delegate.(May be shown as Secretary in some locales). 

 Other. 

Mailbox owners can configure their outcalling options using their telephone, for example, entering their destination 
telephone numbers. Details on how to configure outcalling for individuals can be found in the Intuity Mailbox guide. 

Options that are set for global operation are entered in VoiceMail Pro. For more information, see Setting the 
Outcalling Preferences. 
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Setting the Outcalling Preferences 
The preferences in VoiceMail Pro are set for global operation. Mailbox owners can configure their outcalling options 
from their telephone, for example, create their own time profile. Details on how users can configure outcalling is 
found in the Intuity Mailbox guide. 

To set the global outcalling preferences: 

1. Display the main VoiceMail Pro window. 

2. From the Administration menu, select Preferences > General. 

3. Click the Outcalling tab. 

 

4. Select the times that outcalling is active in the System Times section. 

 Prime Times - The time period that outcalling is to be active as default for the system. 

 Peak Times - The busiest working hours. 

5. Set the retry settings in the System Retry Settings section. 

 The Number of Retries can be between 0 and 10. If the message is not collected after the last 
retry, no notification is sent until another new message is delivered in the user's mailbox. 

 The Retry Times are set for each retry attempt. The interval is the length of time between each 
attempt to ring to targeted number again. 

 Double-click a selected retry time to edit the interval between retries. The New interval 
number window opens where the length of time between each attempt to ring the target 
number can be changed. Click OK to save the change and return to the Outcalling 
window. 

6. Click OK. 

7. Click  Save and Make Live and select Yes. 

 

A timeout value can be set by a user. This is how long outcalling will attempt to call a number before giving up. For 
more information, see the Intuity Mailbox guide. 
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Using the VoiceMail Pro Client 
Overview 
This section describes how you can customize the operation of the VoiceMail Pro server using the VoiceMail Pro 
Client. The VoiceMail Pro Client enables you to work on several servers remotely. You do not need to visit each 
one on site. For more information, see Starting the VoiceMail Pro Client. 

The default operation for VoiceMail Pro is to emulate VoiceMail Lite by providing voicemail for all users and hunt 
groups. VoiceMail Pro Client is used to program actions for users and hunt groups who require facilities that differ 
from those provided by a standard mailbox. With VoiceMail Pro you can also program a series of voicemail actions 
triggered by dialing a short code. 

The main sections of VoiceMail Pro Client are: 

 Actions 
Individual actions can be used within a VoiceMail Pro call flow. For more information, see VoiceMail Pro 
Actions:Overview. 

 Modules 
Modules are a sequence of pre-programmed actions used to simplify VoiceMail Pro programming. For 
more information, see Creating Modules:Overview. 

 Conditions Editor 
The Conditions Editor is used to amend voicemail operation according to factors such as the time of day. 
For more information, see The Condition Editor:Overview. 

 Campaigns 
VoiceMail Pro campaigns can be created that ask callers a series of questions. A callers response can be 
recorded, either spoken or through the telephone keypad. For more information, see Creating 
Campaigns:Overview. 

Preferences can be changed using the VoiceMail Pro Client. Details about changing the preferences are covered in 
the Configuring VoiceMail Pro section. For more information, see Changing Preferences. 
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The Main VoiceMail Pro Window 
The VoiceMail Pro Client is a Windows interface used to customize the VoiceMail Pro Server. 

 

The parts of the VoiceMail Pro Client window are: 

 Title Bar 
The title bar indicates the telephony interface that is being used, namely IP Office or Intuity. If you are 
working offline, the title bar displays Offline. If you are working online, the name of the connected server is 
displayed. For more information, see Logging in to the VoiceMail Pro Server. 

 Toolbar 
The toolbar across the top of the window provides access to the Voicemail Pro options via icons instead of 
the menus. For more information, see Toolbar Icons. 

 Start Points Navigation Pane 
The upper left Navigation pane contains an expandable/collapsible list of customizable voicemail start 
points. For more information, see Start Points:Overview. 

 Modules Navigation Pane 
The lower left Navigation pane contains a library of voicemail modules. For more information, see Creating 
Modules:Overview. 

 Details Pane 
The details pane shows either:  

 Columns of information for the user or group specific start point selected or for the VoiceMail Pro 
Administrator selected. You can click a column heading to sort the content. For more information, 
see Start Points:Overview. 

 Visual representation of a call flow from either default start points or a module. For more 
information, see Creating Modules:Overview. 
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Toolbar Icons 
The VoiceMail Pro screen includes the following icons. These may be grayed out according to which area of the 
VoiceMail Pro screen is currently active. 

 
Save as. For more information, see Saving Changes and Making them Live. 

 
Save & Make Live. For more information, see Saving Changes and Making them Live. 

 Cut: Removes currently highlighted text and copies it to the Windows clipboard. 

 Copy: Copies currently highlighted text to the Windows clipboard. 

 Paste: Pastes the contents of the Windows clipboard to the current cursor position if 
appropriate. 

 Add Start Point. For more information, see Using Start Points. 

 
Edit Start Point. For more information, see Using Start Points. 

 
Delete Start Point. For more information, see Using Start Points. 

 Preferences. For more information, see Changing Preferences. 

 User Defined Variables. For more information, see User Defined Variables. 

 
Conditions Editor. For more information, see The Conditions Editor:Overview. 

 Campaigns. For more information, see Creating Campaigns:Overview. 

 Connection. For more information, see Connections. 

 
Basic Actions. For more information, see Basic Actions:Overview. 

 
Mailbox Actions. For more information, see Mailbox Actions:Overview. 

 Configuration Actions. For more information, see Configuration Actions:Overview. 

 Telephony Actions. For more information, see Telephony Actions:Overview. 

 Miscellaneous Actions. For more information, see Miscellaneous Actions:Overview. 

 
Condition Actions. For more information, see Condition Actions:Overview. 

 Database Actions. For more information, see Database Actions:Overview. 

 
Queue Actions. For more information, see Queue Actions:Overview. 

 

Saving Changes and Making them Live 
VoiceMail Pro settings, such as call flow details, are stored in a database file (Vmdata.mdb). To be used by the 
Voicemail Server they must be saved as a Root.vmp in the voicemail server folder. To find out how to set the 
location of this folder, see Setting the Location of Voicemail System Files. 

To save configuration changes without making them live: 

1. Choose Save as to save the database as a .vmp file with the name that you specify. You can then copy 
the file to other systems. 
  

To save configuration changes and make them live: 

1. Choose  Save & Make Live to save the settings in a file called Root.vmp in the voicemail server folder.  

If you are working remotely in Offline mode ,you are prompted to select whether to save your changes to the local 
database or to the remote server. 
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Importing and Exporting Call Flows 
You can import or export all VoiceMail Pro settings at once (in database file .mdb file) or as individual modules. A 
module file (.mod) can contain one or several modules. Importing and exporting might be useful when you are 
upgrading a system so that you do not need to recreate the settings or modules. 

Important 

 Importing and exporting does not apply to prompts. Prompts must be moved as separate items or re-
recorded. 

 When you import a database file the contents of the existing database are replaced. 

 

To export a file: 

1. From the File menu, select Import or Export. 

2. Select Export call flows. 

3. Click Next.  

4. Enter the name of the file that you want to export. 

 Alternatively, click Browse, select the type of file to export either the entire database or a module 
and click Open. 

5. Click Next.  

6. Module files can contain several modules, select the module required. 

7. Click Next. 

8. Click Finish. The selected file is exported. 

9. Click Close. 

 

To import a file: 

1. From the File menu, select Import or Export. 

2. Select Import call flows. 

3. Click Next. 

4. Enter the name of the file that you want to import.  

 Alternatively, click Browse, select the type of file to export either the entire database or a module. 
If a module of the same name already exists it is overwritten by the imported module. 

 Click Open. 

5. Click Next. 

6. Module files can contain several modules, select the module required. 

7. Click Next. 

8. Click Finish. The selected file is imported. 

9. Click Close. 

10. Click  Save & Make Live before you close the VoiceMail Pro Client to apply the imported file. The 
existing database is overwritten and a backup copy is saved in the folder DB Backup. 
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Including Other Files 
In some special circumstances it may be necessary to include the settings of an existing .vmp file into the 
VoiceMail Pro settings. 

To include other files: 

1. From the File menu, select Includes. The Configuration Includes window opens. 

 

2. Click , the New Include File opens. 

3. Select a file to include. 

4. Click Open. 

5. Click Update to update the Voicemail Pro file settings. 

Notes 

 If you use included files, the VoiceMail Pro database contains only a pointer to the name and location of 
the files and not the actual files. Therefore you should not move or rename an included file. It is strongly 
recommended that before you include a file, you place it in the same folder as Root.vmp. 

 Click  if you need to remove an included file. The highlighted file is removed but not deleted. 
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Start Points 
Overview 
VoiceMail Pro consists of a number of start points. When the voicemail server receives a call, it looks for a 
matching start point and if it finds one it then provides a series of actions linked to that start point. If no match is 
found then it provides standard voicemail functions to the call. 

 

The Navigation pane contains an expandable and collapsible list of start points. These can be start points for 
individual users, hunt groups, short codes and default start points. 

Specific Start Points - This folder contains the start points for users, groups and short codes. 

Users  
This folder contains start points set up for individual users. When selected a list is shown in the details pane 
containing the mailbox owners names and the names of any call flows that have been assigned to the 
selected mailbox. Other details shown include: 

 The extension number associated with the mailbox. 

 The size of the mailbox measured by the amount of space, in KB, that is taken up by the .wav files 
in the specified user’s mailbox folder. 

 The number of new, old and saved messages in the mailbox. 

 The date when anyone last logged into the mailbox. 

This is a user who has one or more start points configured. It can be expanded to show the 
different start points. 

 Collect - Used when the user rings voicemail. 

 Leave - Used for calls to the user that are redirected to voicemail. 

 Callback - Used when voicemail rings a user to inform them of messages in the user's 
mailbox. For more information, see Setting up VoiceMail Pro Callback. 

 Queued & Still Queued - Used when calls to the user are queued. For more 
information, see Personal Announcements. 
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Groups 
This folder contains start points set up for hunt groups. When selected a list is shown in the details pane 
containing the mailbox owners names and the names of any call flows that have been assigned to the 
selected mailbox. Other details shown include: 

 The extension number associated with the mailbox. 

 The size of the mailbox measured by the amount of space, in KB, that is taken up by the .wav files 
in the specified user’s mailbox folder. 

 The number of new, old and saved messages in the mailbox. 

 The date when anyone last logged into the mailbox. 

This is a group that has one or more start points configured. It can be expanded to show the 
different start points. 

 Collect - Used when someone accesses the group's mailbox. 

 Leave - Used when calls to the hunt group are redirected to voicemail. 

 Queued & Still Queued - Used when calls to the group are queued. For more 
information, see Customizing a Hunt Group Call Flow. 

Short Codes  
This folder contains any start points set up for particular short codes. Short code start points require the 
Telephone Number entry of the matching short code in the IP Office Manager to be set up in a particular 
way. For example, if a Start Point for short code *88 is set up, the settings for short code *88 in the IP Office 
Manager application must be as follows: 

 Short Code: *88 

 Telephone Number: *88 

 Feature: Voicemail Node. 

The above will allow internal callers to access the start point. To allow external callers access, an Incoming 
Call Route should be set up with the destination *88.  

 An individual short code on the IP Office. This requires a matching special short code to 
be set up in Manager. 

 

Default Start Points  
Rather than set up individual start points for every user and group, you can also program actions against the 
default start points. These will then be used for all calls received by the Voicemail Server that don't match a specific 
start point. For more information, see Default Start Points. 

 

Voicemail Pro Administrators 
When the VoiceMail Pro Administrators folder is selected a list is displayed in the details pane. The list contains the 
name, type and status of the administrators. Details can be added, amended or deleted. For more information, see 
Adding an Administrator. 

 

Modules  
Modules are reusable sets of actions. They allow you to create a sequence of actions that you can then use within 
any other start point's call flow. Any changes to the module will affect all the start points using that module. This 
simplifies the programming of actions if a number of start points use the same sequence of actions. Using modules 
also reduces the size of the call flow. For more information, see Creating Modules Overview. 
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Default Start Points 
The default start points can be used to create a sequence of actions that will be applied to all suitable calls unless a 
specific start point exists. 

 Collect - Used when a caller attempts to access a mailbox. 

 Leave - Used when a caller is redirected to voicemail. 

 Callback - Used when the voicemail calls a user to inform them about messages in a mailbox. For more 
information, see Setting up Callback. 

 Queued  - Used for callers queuing for a hunt group or user. For more information, see Customizing 
Queue Announcements. 

  Still Queued - Used for callers queuing for a hunt group or user. For more information, see 
Customizing Queue Announcements. 

 

When a default start point is used, the following actions can attempt to recognize who the presumed user is (the 
internal user calling or being called) and access the matching mailbox for that user (unless the action specifies 
another mailbox). 

 Get Mail Action. For more information, see Mailbox Actions, Get Mail Action. 

 Leave Mail Action. For more information, see Mail Box Actions, Leave Mail Action. 

 Play Configuration Menu. For more information, see Configuration Actions, Play Configuration Menu. 

 Listen Action. For more information, see Mailbox Actions, Listen Action. 

 Record Name Action. For more information, see Configuration Actions, Record Name Action. 

 Edit Play List Action. For more information, see Configuration Actions, Edit Play List Action. 

 

The following actions will automatically recognize who the presumed user is and then use that user's voicemail 
reception settings (unless the action specifies another mailbox). 

 Transfer Action. For more information, see Telephony Actions, Transfer Action. 

 Assisted Transfer Action. For more information, see Telephony Actions, Assisted Transfer Action. 

 Whisper Action. For more information, see Telephony Actions, Whisper Action. 
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Using Start Points 
Start points can be for individual users, hunt groups, short codes or default start points. All start points can be 
added, edited, renamed or deleted. 

To add a start point for a User or Group: 

1. Either click Users or Groups and then . The Adding a new window opens. 

 Alternatively, right-click Users or Groups and select Add. 

2. Select the name that matches the user or group on the telephone system. 

 To add all users or groups check the option Add all users. 

3. Select the types of start points required. 

 The start points Collect, Leave, Callback, Queued and Still Queued are available for both users 
and groups. 

4. Click OK. 

 

To add a start point for a short code: 

1. Click Short Codes and then . The Adding a new short code window opens. 

 Alternatively, right-click Short Codes and select Add. 

2. Enter the short code. 

 Short code start points require the telephone number entry of the matching short code in the IP 
Office Manager application to be set in a specific way. For example, if a start point for short code 
*88 is set up the settings for short code *88 in the manager application must be as shown below. 
The short code will allow internal callers to access the start point. To allow external callers access, 
an Incoming Call Route should be setup with the extension *88. 

 Short code: *88 

 Telephone number: *88 

 Feature: Voicemail Node. 

3. Click OK. 

 

Any start point can be edited. However, if you de-select an existing start point, you will delete all actions associated 
with it. 

To edit a start point: 

1. In the Navigation pane of the main VoiceMail Pro window, select the start point to edit and click . The 
Editing start point window opens. 

 Alternatively, right-click the start point and select Edit. 

2. Make the required changes. 

3. Click OK. 
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To delete a start point: 

1. In the Navigation pane, select the start point to delete and click . 

 Alternatively, right-click the start point and then select Delete. 

2. You are asked if you are sure that you want to delete the selected start point. 

 Click Yes to delete the start point. 

 Click No to cancel the deletion. 

 

To rename a user, group or short code start point: 

1. In the Navigation pane, right-click the user, group or short code and select Rename. The New start point 
name window opens. 

2. Type the new name. 

3. Click OK. The start point is renamed. 

 

Viewing Call Flows as Text 
For support calls and diagnostic purposes it can be useful to view VoiceMail Pro modules and start points as text 
files. You can then display the contents of the text file on the screen. The file can be changed as you would change 
any other text file. 

To view a start point or module as text: 

1. Select File menu > View as Text. A Notepad window opens. The txt file contains information of all 
Conditions and Campaigns as well as all call flow details. 
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VoiceMail Pro Actions 
Overview 
When a start point has been added, it can be linked to an action. Each action can have one or several results, 
depending on the type of action, and each result can be linked to a subsequent action. In this way you can build up 
a call flow. 

Each action can have a number of results (true, false, no answer, busy). The types of results depend of the type of 
action, most actions having just a 'Next' result. Each result can be used as a connection point to another action. For 
more information, see Connections. 

A set of actions and connections can be combined and reused as a module. Modules are reusable sets of actions. 
They allow you to create a sequence of actions that you can then use within any other start point's call flow. 
Changes to the module will affect all start points using that module. This simplifies the programming if a number of 
start points need the same sequence of actions. For more information, see Creating Modules:Overview. 

You can double-click an action to display the properties in a series of tabs. Many actions share the same standard 
tabs but each usually also has a specific tab that contains options unique to that action's function. 

The standard tabs of an action are: 

 General. For more information, see General Tab. 

 Entry Prompts. For more information, see Entry Prompts Tab. 

 Reporting. For more information, see Reporting Tab. 

 Results. For more information, see Results Tab. 

 

To add an action: 

1. Select the start point to which you want to add an action. 

2. Click in the Details pane. 

3. Click Actions and select the type of action that you want to add from the list, for example Basic Actions. 

4. From the submenu, select the required action. For example, if you selected Basic Actions, you might 
choose Speak Text. The cursor changes to show that you have selected an action to add. 

 Alternatively on the toolbar, click the icon for the required type of action and then select an action 
from the submenu. 

5. Click in the details pane, where you want to place the action. The new action is added. You can now edit 
the action and add connections to it. 

 

You can change the properties of an action. For example, If you selected the Speak Text action you can specify the 
actual text to be spoken when an action is taken. 

To edit an action: 

1. Double-click the action in the details pane or right-click it and select Properties. The Properties window 
opens. Details of the selected action are contained in a set of tabs. 

2. Select a tab and change the action properties as required. 

3. Click OK when you have finished. 

 

If an action is no longer required, you can delete it from a start point call flow. 

To delete an action: 

1. In the Details pane where the actions are displayed, click the action to delete. 

2. From the Edit menu, select Delete or right-click the action and select Delete. 

3. The selected action is deleted. 

 

For more information about the actions that are available for use in call flows, see Available Actions:Overview. 
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Connections 
The actions that are added to a start point must be connected before they can be used. The sequence of the 
connections determines how the call is routed through voicemail. 

Each action can have a number of results (True, False, No Answer, Busy). The types of results depend of the 
type of action. For each result, a connection can be added. 

 Most actions only have a Next result, i.e. a single connection to the next action. 

 Other actions may have two results, for example True or False. Each of these results represents a 
connection point for different following actions. 

 Some actions may have multiple results. For example, the Assisted Transfer action has results for Next, 
No Answer and Busy. Each of these results represents a connection point for different following actions. 

 If a result occurs, for which no connection to a following action has been set, either the call is disconnected 
or, if it came from a hunt group queue, it is transferred back to the queue. 

 Within modules, all connections should end in another action or in a Module Return action. 

 

To add a connection: 

1. Click the icon. 

2. Click and drag the cursor from action's result that triggers the connection to the action that should follow 
the connection. 

 

To delete a connection: 

1. Click the connection to delete. It is displayed in red. 

2. Press Delete. The connection is removed. Alternatively, either select Edit and then Delete or right-click 
and then select Delete. 
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Standard Action Tabs 
General Tab 
The General tab contains the action name. You can also enter notes about the action and protect a call flow by 
adding an access code. 

 Token Name  
The name of the action, for example, the token name for the action Menu is 'Menu'. The token name can 
be changed so the use of the action can be indicated. It could also be confusing having two actions within 
a module with the same name. 

 Description  
(Optional) Use this field to enter notes about why the action is being used or other information that may be 
needed. 

 Pin  
(Optional) Each action can be protected by a PIN number. The PIN number can be the voicemail code of 
the presumed user. To do this enter a $ symbol. For example, entering $ would force the caller to dial their 
voicemail code, entering 104$ would force the caller to dial 104 followed by their voicemail code. 
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Entry Prompts Tab 
The Entry Prompts tab is used to select the prompts to be played before the action performs its main role. Multiple 
prompts can be added and the order in which they are played adjusted. 

  Add Prompt  
Clicking  or double-clicking an existing listed prompt starts the VoiceMail Pro Wave Editor. This tool 
allows you to record and play prompts through the VoiceMail Pro server PC or through an extension on the 
IP Office system. The dialogue that appears allows the selection of an existing prompt or the ability to 
specify a new file name and then record the new prompt. For more information, see Using the Wave Editor. 

  Edit Prompt  
Edit the details of the currently highlighted prompt. 

  Delete Prompt  
Delete the currently highlighted prompt from the play list. Note that the actual prompt file is not deleted from 
the server. 

  Move Prompt  
Move the position of the currently highlighted prompt in the play list. 

 Allow prompts to be interrupted by Tones:  
Allow the caller to press tone keys to make selections during the playing of the actions entry prompts. 

 

 

The Edit Play List action can be used in call flows to re-record a specified prompt. This allows the creation of call 
flow options where the voicemail user can record prompts themselves to reflect changes in operation. For more 
information, see Edit Play List action. 
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Using the Wave Editor 
The Wave Editor is used by VoiceMail Pro to select, record and play prompts. It can be used to select existing 
prompts or to record new prompts. 

The Entry Prompts tab of each call flow action allows prompts to be played before the action performs its main role. 

Clicking  or double-clicking a listed prompt starts the VoiceMail Pro Wave Editor. This tool allows you to record 
and play prompts through the VoiceMail Pro server PC or through an extension on the IP Office system. 

 

To record a new prompt: 

1. Select the media device to use, either Telephony Handset or PC Multimedia. 

 If Telephony Handset is selected, enter the extension of the telephone to be used. 

2. Enter a file name for the recording. 

3. Click the  record button to record the message. If the media type selected is Telephony Handset, the 
telephone extension will ring. When the handset is picked up a message will be heard saying Record at the 
tone. 

4. Speak the message, click  stop button when finished. 

5. To listen to the recording, press the  play button. If there is no media device attached, the recorded 
message will be heard from the telephone extension. 
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To select a prompt.  
There are a large number of standard prompts that can be used. Enter the name of the prompt or use the  
button to browse to the required file. For a sample listing of these prompts see US English Intuity Prompts and 
English Non-Intuity Prompts.  

Useful files are: 

 en\MC_00 - Plays a bleep. 

 en\MC_01 - Plays 1 second of silence. 

 Entering 1234.wav will play "one two three four" (unless a file called 1234.wav has been recorded). 

 

Some system variable can be played as prompts. For example: 

 $NAM - Plays the user name. 

 $CLI - Speaks the caller's CLI. 

 $RES - Plays the current result if it is a .wav file. 

 $VAR - Plays the variable as a list of digits. 

 

Specific Tab 
The contents of this tab vary according to the type of action. In some cases this tab may have a different name, for 
example Touch Tones for the Menu action.  Not all actions contain the Specific or Touch Tones tab. Details of the 
specific tab are covered in the section that describes the available actions. 
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Reporting Tab 
The Reporting tab provides information that is then used to classify the call details within the reports produced by 
the CCC products (a separate product from VoiceMail Pro). 

 Flag the current call has been answered by Voice Mail. 
The system user may not want the CCC to report a call as answered until it has reached a certain action 
within the sequence of actions. For example, to not regard a call as answered until the caller has left a 
message, made a selection from a menu or has been transferred to a user or group. 

 Request to call back the current caller. 
If this option is selected, the CCC will keep a record of the caller's CLI if provided. This is then used within 
the CCC product to arrange a callback call by an agent. 

 Send reporting information. 
If selected, this option allows information to be associated with the call. The information is set in the Group 
name, Topic and Annotation fields. The CCC product uses the information within it's call reports. 
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Results Tab 
This tab shows the results available from an action. For the majority of actions the results are fixed and appear 
grayed out, i.e. they cannot be changed. For some actions the results are variable. 
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Available Actions 
Overview 
Once a start point has been added, it can be linked to an action. The available actions are divided into the following 
groups: 

 Start Point Action - The first action in any sequence. 

 Module Action - An inserted module of actions. 

 
Basic Actions - For more information, see Basic Actions:Overview. 

 
Mailbox Actions - For more information, see Mailbox Actions:Overview. 

 Configuration Actions - For more information, see Configuration Actions:Overview. 

 Telephony Actions - For more information, see Telephony Actions:Overview. 

 Miscellaneous Actions - For more information, see Miscellaneous Actions:Overview. 

 
Condition Actions - For more information, see Conditions Actions:Overview. 

 Database Actions - For more information, see Database Actions:Overview. 

 
Queue Actions - For more information, see Queue Actions:Overview. 
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Basic Actions 

Overview 
  Basic Actions 

These actions are chiefly used to control the routing of a call between actions. 

 
Generic Action: can be used to simply play a prompt to the caller through its Entry Prompts tab. It 
can also be used to enter custom commands for the voicemail server. For more information, see 
Generic Action. 

 
Speak Text Action: allows text to entered and then played to the caller. Requires TTS to be installed 
and licensed. For more information, see Speak Text Action. 

 
Menu Action: branch according to touch tone selection. For more information, see Menu Action. 

 Goto Action: go to another start point. For more information, see GoTo Action. 

 
Disconnect Action: disconnect the call. For more information, see Disconnect Action. 

 
Home Action: return to the start point. For more information, see Home Action. 

 Module Return Action: return to the start of a module. For more information, see Module Return 
Action. 
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Generic Action 
The Generic action can be used to play a prompt to the caller. It can also be used to enter custom commands 

for the voicemail server. 

To add a Generic action: 

1. Click the  Basic Actions icon and select  Generic. The Generic action only has a Next result.  

 

Example of playing a prompt 

Callers can be given an option to hear a specific message, for example details about the latest sales offer. The 
Entry Prompts tab is used to record a message or select a pre-recorded message. 

A looped connection can be added to continually repeat the recording. A connection would be from the result Next 
back to Generic, as shown in the example. 

 

 

Example of a Custom String 

Custom commands for the voicemail server are entered into the ??? field in the specific tab. The maximum length 
for the string is 128 characters. 

For example, using the command FWD:201#202#203#204#205## a message can be forwarded to multiple 
mailboxes. The message is recorded by a preceding Voice Question or Edit Play List Action. The 128 character 
length limit restricts a single generic action to 31 three-digits extensions, 24 four-digits extensions and so on. 
However multiple generic actions can be connected in a chain to bypass this limitation. 

 

A voice message can also be sent to multiple mailboxes by creating a Personal Distribution List or to each member 
of a hunt group by using the broadcast feature. For more information, see Configuring Group Broadcast. 

 

For examples of the action being used in a call flow, see 

 Example Call Flow for Mobile Twinning  

 IVR Database Connection Example, Entering Details in to the Database. 
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Speak Text Action 

The Speak text action allows any text to be spoken to the caller. To be able to use the Speak Text action you 
require TTS (Text to Speech) to be installed and licensed. For more information, see Text to Speech:Overview. 

To add a Speak Text action: 

1. Click the  Basic Actions icon and select Speak Text. 

2. Select the Specific tab. 

 

3. Enter the text to be spoken in the Text to speak field. 

 The text can include System Variables such as $CLI and variables obtained by database actions 
such as $DBD[1]. In the example, the contents of the database query field are spoken. The action 
has additional text added so that the currency can be spoken. In this example pounds are used. 

 The text can include SAPI XML tags to modify how it is spoken, see TTS SAPI Controls. 

 

The Speak Text action only has the result Next which needs to be connected to a suitable action. 
For example, the text spoken could confirm an option choice. The next action could be a Return action to take the 
caller to another callflow. For more information, see Return Action. 

For examples of the action in a call flow, see: 

 Entering Details in to the Database. 

 Returning Data from the Database. 
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Menu Action 
The Menu action allows you to specify DTMF tones for which you want to create connections to following 

actions. For example, a menu can be created that gives callers a choice of transfer locations. Each Menu action 
supports a maximum of 15 branch options. 

To add a Menu action: 

1. Click the  Basic Actions icon and select  Menu. 

 

Entering Touch Tones 

In the Menu Action the Specific tab is replaced with the Touch Tones tab.  

 

Use the check boxes to indicate the DTMF tones for which connections are required. The numbers 0 - 9 are 
available as well as * & #. 

 

You can add a sequence of tones to the menu.  

1. Click  Add a Sequence of Tones in the Touch Tone tab. The Add Touch Tone Sequence window opens. 
Enter the sequence required. 

 ? = Any Digit:  
The ? character can be used to represent any digit (except * and #). For example 123??? can be 
used for any six digit string starting with 123. See Example Call Flow: SelfSelect Module. 

 $ = Any Sequence of Digits 
The $ character can be used to match any sequence of digits for which there is no other match. 
Key press entry is ended either by the caller pressing # or 5 seconds after the last digit dialed. 

 F = For Fax Calls 
The F letter can be used to automatically detect any incoming fax calls. Once detected the calls 
can be routed to another number. See Routing Fax Calls Using a Menu Action.  

If a sequence is added, ensure that the associated box is checked before you select OK. The sequence must be 
unique. For example, if 5 is selected, no other sequence that begins with 5 can be used.  
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You can set the amount of time to wait until transferring the caller to another action if no suitable key match is 
entered  

1. Check the option Wait for a key press for up to.  

2. Enter the number of seconds to wait before transferring the caller. 

 

You can use the Entry Prompts tab to record a suitable message to inform the caller of the transfer options 
available. 

When the action is saved it is updated with the transfer options selected. If a Timeout option was selected it will 
appear at the top of the Menu action. 

In the example the transfer options 1 and 2 were selected. The results 1 and 2 need to be connected 
to suitable transfer locations.  

For examples of the action being used in a call flow, see: 

 Using a Play Configuration Menu Action. 

 Example Call Flow for Mobile Twinning. 

 Routing Calls to Voicemail, Example Call Flow.  

 Changing the Language of System Prompts. 

 Changing the Language Setting for a TTY Device 
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Goto Action 
The GoTo action will transfer the caller to another start point. 

To add a Goto action: 

1. Click the  Basic Actions icon and select  GoTo. 

 

The GoTo action needs to contain details of where to transfer the caller to. 

1. Select the Specific tab. 

 

2. In the field Please select a node to go to, click  to browse to select a start point, module or system 
defined variable. For short codes, the browse method does not work. Instead enter "Short Code.xxx" 
where xxx is the short code key sequence. 

 Select the option Start point or module. Select from the available options. 

 Users - all the users with specific start points are listed. 

 Groups - all the Groups with specific start points are listed. 

 Any default start point. 

 Any available modules. 

 Select the option System defined variables to browse the available call variables. You can also 
type the name of the start point directly. 

 

When details of the transfer location, the GoTo action does not need to be connected to another 
connection. If you do connect this action to a following action, the connection will not be used. 
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Disconnect Action 
The Disconnect action disconnects the caller. 

To add a Disconnect action: 

1. Click the  Basic Actions icon and select  Disconnect. 

 

The caller will be disconnected when they reach this point of a call flow. 

 

Home Action 
The Home action returns the caller to the start point of the calls entry into voicemail. The PIN option in the 

General tab is not used for this action. 

To add a Home action: 

1. Click the  Basic Actions icon and select  Home. 

 

Connect an action to the Home action. The caller will be returned to the start point of the call entry into 
the voicemail. For an example of the action being used in a call flow, see Using a Play Configuration Menu Action. 

 

Module Return Action 
The Module Return action is used within modules only. It creates a connection point from the module to 

subsequent actions within any call flow that uses the module. A module can use several Module Return actions if 
necessary. The Module Return action has no properties. 

To add a Module Return action: 

1. Click the  Basic Actions icon and select  Module Return. 

 

Connect an action result to the Module Return action. For examples of the action being used in 
a call flow, see Changing the Language of System Prompts and User Defined Variables. 
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Mailbox Actions 

Overview 
  Mailbox Actions 

These actions relate to the leaving and collecting of messages from a mailbox. 

 Get Mail Action: Collect messages in a mailbox. For more information, see Get Mail Action. 

 Leave Mail Action: Leave message in a mailbox. For more information, see Leave Mail Action. 

 
Listen Action: Record to a mailbox. For more information, see Listen Action. 

 
Voice Question Action: Record response to a prompt. For more information, see Voice Question 
Action. 

 Campaign Action: Access a campaign to read or leave messages. For more information, see 
Campaign Action. 
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Get Mail Action 
The Get Mail action allows access to the messages in the caller's mailbox or a specified mailbox. The caller 

then has access to the standard mailbox features setup for that mailbox. If the extension is a trusted extension, the 
user does not have to enter their mailbox number and code. For more information, see Creating a Trusted 
Location. 

To add a Get Mail action: 

1. Click the  Mailbox Actions icon and select  Get Mail. 

2. The Specific tab is used to select either the caller's mailbox or mailbox option. 

 

 Caller's mailbox:  The mailbox matching the start point of the call. 

 Mailbox:  Select or enter the name of the target mailbox. If ? is entered, Voicemail will prompt 
caller's to enter the mailbox number required. 

 

The Get Mail action has a Next result. Add a connection from the Next result to another action.  

For examples of the action being used in a callflow, see: 

 Using a Play Configuration Menu Action. 

 Setting Up Callback. 

 Changing the Language of Custom Prompts. 

 Changing the Language of System Prompts. 

 Enabling Access to Hunt Group Voicemail. 

 Changing the Language Setting for a TTY Device. 

 

The following conditions apply, based on which mailbox mode the VoiceMail Pro server is using. 

 IP Office mode 
Users who press 0 while they are logged into their mailbox will be routed to the Next result. 

 Intuity mode 
Users who press *0 whilst in their mailbox will be routed to their Voicemail Reception number if set. The 
Next result is not used. 
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Leave Mail Action 
The Leave Mail action allows the caller to leave a message in the start point's mailbox or in a specified mailbox. 

To add a Leave Mail action: 

1. Click the  Mailbox Actions icon and select  Leave Mail. 

2. The Specific tab is used to select either the Caller's mailbox, Mailbox or VRL option. 

 Caller's Mailbox:  The mailbox matching the start point of the call. 

 Mailbox:  Select or enter the name of the target mailbox. 

 VRL:  If selected, specifies that the message should be transferred to a third-party Voice 
Recording Library (VRL) application. For more information, see Voice Recording Library. 

 

The Leave Mail action has Success and Failure results. The use of these depends on which 
mailbox mode the VoiceMail Pro server is using. 

 IP Office mode: Callers in the mailbox follow the Failure or Success results depending on whether they 
press 0 before or after the leave a message tone respectively. This overrides the mailbox user's Voicemail 
Reception setting set in the IP Office configuration. 

 Intuity mode: The results cannot be accessed. Callers pressing 0 will always follow the mailbox user's 
Voicemail Reception setting set in the IP Office configuration. 

For examples of the action in a call flow, see: 

 Routing Calls to Voicemail, Example Call Flow. 

 Hunt Group Queuing, Example Call Flow using $POS. 

 Changing the Language Setting for a TTY Device. 

 Example Call Flow: Dial by Name. 
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Listen Action 
The Listen action allows the caller to leave a message in the start point's mailbox or in a specified mailbox. The 

caller can only leave a message and cannot access any other mailbox features. 

To add a Listen action: 

1. Click the  Mailbox Actions icon and select  Listen. 

2. In the Specific tab, select either the Caller's mailbox or Mailbox option. 

 Caller's Mailbox: The mailbox matching the start point of the call. 

 Mailbox: Select or enter the name of the target mailbox. 

3. Make any changes as required to the General, Entry Prompts, Reporting and Results tab pages. 

4. Click OK. The Listen action is updated. 

 

Connect the result Next to a relevant action. For examples of the action in a call flow, see Customizing 
Manual Recording and Customizing Auto Recording. 
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Voice Question Action 
The Voice Question action allows you to create a play list where the caller hears a sequence of prompts and 

their responses are recorded. 

If the play list is completed, a single file containing the recorded responses is created. That file can then be placed 
into a specified mailbox or passed to an eMail action. 

To add a Voice Question action: 

1. Click the  Mailbox Actions icon and select  Voice Question. 

2. In the  Specific tab questions need to be added to the play list.  

 

3. Click  Add a Prompt. The Wave Editor window opens. 

 (Optional) Specify a new file name and then record the new prompt. For more information, see 
Wave Editor. 

 (Optional) Select an existing prompt. 

4. Click Close. You return to the Specific tab. 

5. Click  Record a Response. The New action name window opens. 

6. Specify the length in seconds of the recorded response. 

7. Click OK. You return to the Specific tab. 

 A mailbox needs to be specified into which the recorded file of responses are stored. If no mailbox 
is specified the file can be passed to an eMail action. 

 Edit: - Edit the settings of the currently highlighted item. 

 Delete: - Deletes the currently highlighted item from the play list. This does not delete the actual 
prompt file. 

 Shuffle: - Move the currently highlighted item within the play list. 

8. Click OK. The action is updated. 

 

The Next result needs to be connected to an eMail action if no mailbox is selected in the 
Specific tab. 
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Campaign Action 
The Campaign action can be used to either route a caller into a campaign or to allow an agent to access any 

messages left for a campaign. See VoiceMail Pro Campaigns. 

To add a campaign action: 

1. Click the  Mailbox Actions icon and select  Campaign. 

2. You need to enter the campaign and select whether to leave or collect campaign information in the 
Specific tab. 

 

 In the Please select a campaign field, enter the campaign that you want to use. 

 Select either: 

 Leave campaign information (e.g. customers) - Select if the action should start the 
campaign to collect the caller's responses. 

 Pick up campaign information (e.g. agent) - Select if the action should start playing 
back the response left by callers to the campaign. 

Connect the result Next to a relevant action. 

 



Using the VoiceMail Pro Client 

VoiceMail Pro Installation and Maintenance Guide Page 223  
IP Office 4.0 15-601063 Issue 16 (12th December 2006)  

Configuration Actions 

Overview 
  Configuration Actions 

These actions allow a caller to change the settings of a user or hunt group mailbox. 

 
Edit Play List Action: Re-record a prompt. For more information, see Edit Play List Action. 

 
Record Name Action: Re-record a mailbox name. For more information, see Record Name Action. 

 
Play Configuration Menu Action: Change user or group settings. For more information, see Play 
Configuration Menu Action. 

 Select System Prompt Language Action: Change the prompt language. For more information, see 
Select System Prompt Language Action. 
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Edit Play List Action 
With the Edit Play List action a caller can record a specified prompt file held on the voicemail server PC. This 

means that they can re-record prompts other than those for their own mailbox. 

To add a Edit Play List action: 

1. Click the  Configuration Actions icon and select  Edit Play List. 

2. In the Specific tab, select the prompt file held on the voicemail server. 

 

 Click  to select which prompt file the action accesses for re-recording. The Wave editor window 
opens. 

 Select an existing prompt. 

 Click Close. 

3. Click OK. The action is updated. 

 

Connect the result Next to a relevant action. 

 

Record Name Action 
The Record Name action is used to allow the caller to record the mailbox name of their mailbox or a specified 

mailbox. An example of a call flow using the Record Name action is given in the VoiceMail Pro Dial by Name 
section. 

To add a Record Name action: 

1. Click the  Configuration Actions icon and select  Record Name. 

2. In the Specific tab the mailbox to record that the name is to be recorded for is selected. 

 Caller's mailbox: The mailbox matching the start point of the call. 

 Mailbox: Select or enter the name of the target mailbox. 

 

Connect the result Next to a relevant action. For an example of the action in a call flow, see 
Adding a Record Name Module. 
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Play Configuration Menu Action 
The Play Configuration action allows various users or hunt group settings to be altered. Because of the nature 

of this action it should always be protected by a PIN code in its General tab. An example of a call flow using the 
Play Configuration Menu action is given in the Remote Voicemail Notification section. 

The options given when a caller accesses this action are: 

For a user: 

1. Edit forwarding number. 

2. Edit follow me number. 

3. Set call forwarding. 

4. Set voicemail on/off. 

5. Set do not disturb. 

6. Edit voicemail code. 

7. Edit voicemail reception. 

8. Set voicemail email mode. 

9. Edit voicemail callback number. 

For a hunt group:  

1. Set voicemail on/off. 

2. Edit voicemail code. 

3. Set voicemail email mode. 

4. Set service mode. 

Any changes made using this type of action are written to a file called "AuditTrail.txt" on the Voicemail Server PC. 
The file includes the time, date, details of the change and the CLI of the caller making the change. 

To add a Play Configuration Menu action: 

1. Click the  Configuration Actions icon and select  Play Configuration Menu. 

2. In the Specific tab, select the mailbox to play the configuration menu for: 

 

 Caller's mailbox: The mailbox matching the start point of the call. 

 Mailbox: Select or enter the name of the target mailbox. 

3. In the General tab, enter a PIN code in the PIN field. 

 

Connect the result Next to a relevant action. For an example of the action being used in 
a call flow, see Using a Play Configuration Menu Action. 
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Select System Prompt Language Action 
The Select System Prompt Language action is supported on Voicemail Pro 1.2.6 or higher. It allows the system 

to alter the language spoken during a call flow. An example of a call flow using the Select System Prompt 
Language action is given in the Changing the Language used by VoiceMail Pro section. 

To add a select system prompt language action: 

1. Click the  Configuration Actions icon and select  Select System Prompt Language. 

2. In the Specific tab select the language that the system prompts are to be played in. If a language is 
selected which is not loaded on the Server, the system will automatically select the most appropriate 
language. 

 

 Possible system prompts: - List of all prompt languages that could be installed on the system. 

 Installed on the Server: - Displays if the prompts for a particular language are installed on the 
server. 

 

Connect the result Next to a relevant action. For examples of the action being 
used in a call flow, see Changing the Language of System Prompts and Changing the Language Setting for a TTY 
Device. 
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Telephony Actions 

Overview 
  Telephony Actions 

These actions relate to telephony functions such as call transfers. 

 
CLI Routing Action: Route on a CLI match. For more information, see CLI Routing Action. 

 
Route Incoming Call Action: Route a call depending on whether the call is internal or external. For 
more information, see Route Incoming Call Action. 

 
Route by Call Status: Calls route is determined by why the reason the call was routed to voicemail. 
For more information, see Route by Call Status Action. 

 Transfer Action: A blind transfer. For more information, see Transfer Action. 

 Whisper Action: Screened transfer. For more information, see Whisper Action. 

 
Call List Action: Transfer to a user selected choice. For more information, see Call List Action. 

 Dial by Name Action: Select user/group by keypad letters. For more information, see Dial by Name 
Action. 

 
Conferencing Center: provides a route for callers to enter the conference ID and their conference 
PIN code. IP Office Conferencing Center needs to be installed. For more information, see 
Conferencing Center Action. 

 Assisted Transfer Action: A transfer with assistance for callers. For more information, see Assisted 
Transfer Action. 

 
Alphanumeric Action: allows the caller to input text and numeric values. For more information, see 
Alphanumeric Action. 

 



Voicemail Pro Installation and Maintenance Guide 

Page 228 VoiceMail Pro Installation and Maintenance Guide 
15-601063 Issue 16 (12th December 2006) IP Office 4.0 

CLI Routing Action 
The CLI Routing  action has two results for which connections to following actions can be made. The results are 

True and False, based on whether the caller's CLI matches that specified by the action. 

To add a CLI Routing action: 

1. Click the  Telephony Actions icon and select  CLI Routing. 

2. In the Specific tab, click . The Add a new CLI route window opens. 

 

 In the Add a new CLI route field, enter the required CLI number against which the caller's CLI is 
checked. 

 

The CLI Routing action results for a match and no match need to be connected to relevant 
actions. 
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Route Incoming Call Action 

The Route Incoming Call action has two results for which connections to following actions can be made. The 
results are Internal or External. 

To add a Route Incoming Call action: 

1. Click the  Telephony Actions icon and select  Route Incoming Call. 

There is no specific tab for this action. 

The Route Incoming Call action results for a match and no match need to be connected to 
relevant actions. 

 

Route by Call Status Action 

The Route by Call Status action has four results for which connections to following actions can be made. 

To add a CLI Routing action: 

1. Click the  Telephony Actions icon and select  Route by Call Status. 

There is no specific tab for this action. 

The Route by Call Status action results No Answer, Busy, Out of Hours and Default need 
to be connected to a relevant action. 

The result route used is determined by why the reason the call was routed to voicemail. For example, calls to a 
hunt group follow either the No Answer route or, when in night service, the Out of Hours route. Calls to users 
would follow either the No Answer or Busy routes. 

Where the cause for the call being routed to voicemail cannot be determined or does not fit the criteria above, the 
Default route is used. 
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Transfer Action 
The Transfer action transfers the caller to the extension that matches the mailbox selected. This is a blind 

transfer; if the call returns to the voicemail server again, for example if unanswered, it will be treated as a new call. 

More advanced transfers are done using either a Call List Action or Assisted Transfer Action. 

To add a Transfer action: 

1. Click the  Telephony Actions icon and select  Transfer. 

2. In the Specific tab, type of select the target extension or group that you want to ring in the destination 
field. 

 

 

The Transfer action contains no results. The caller is transferred directly to the specified extension. 
In the example the caller would be transferred to the Sales group. For examples of the action being used in a call 
flow, see Mandatory Announcement Example and Routing Calls to Voicemail, Example Call Flow. 
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Whisper Action 
The Whisper action plays a recording to an extension. That extension can then either accept or reject the call. 

Normally the recording played is the result of a preceding Voice Question action though a Listen action can also 
be used. 

To add a Transfer action: 

1. Click the  Telephony Actions icon and select  Whisper. 

2. Select the Specific tab.  

 

3. Enter details in the fields: 

 Play recording to 
Enter the extension that is rung with the caller's recording. 

 Source of transfer 
Select the number to display on the target phone. 

 Description 
Enter a call description to display on the target phone. 

 No answer timeout 
Select how long the voice mail server should wait for an answer before following the No Answer 
connection. The whisper action will not go to the target extension voicemail. 

 Prompts played before the recording and Prompts played after the recording  
Click . The Wave Editor window opens. Select the prompts that are to be played to the target 
extension when they answer the call. The prompts played after the caller's recording should 
include the instruction "Press 1 to accept or hang up to reject". 

The Whisper action can be connected to a number of following actions according to whether the 
call is answered, rejected, gets busy or no answer tones. 
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Call List Action 
With the Call List action a caller can indicate the extension to which they want to be transferred. If selected the 

caller can be restricted to selecting an extension within a particular group. The transfer in this case is not blind, if 
unanswered the action can link to actions for no answer, busy and no answer timeout. 

To add a Call List action: 

1. Click the  Telephony Actions icon and select  Call List. 

2. Select the Specific tab. Complete the fields with relevant details. 

 

 In the Transfer to group field enter a group name if you want to restrict the caller to a particular 
group. 

 Check the Prompt user with a list of group members option if you want the voicemail server to 
list the group members for the caller. 

 In the Source of transfer field, select the number to display on the target telephone. 

 In the Description field, enter a call description to be displayed on the target telephone. 

 Set the No answer timeout value. The value selected is how long the voicemail server waits for 
an answer before following the No Answer connection. 

 

The Call List action results need to be connected to relevant actions. 
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Dial by Name Action 
The Dial by Name action enables callers to enter the name of the person and/or group they want to contact by 

dialing on a keypad with ITU standard alphabet markings. The caller is then played a list of available name 
matches from which they can select. An example of a call flow using the Dial by Name action is given in the 
VoiceMail Pro Dial by Name section. 

The action should prompt the caller to dial the name they require and then press #. Callers can also press *# to exit 
without making a selection. 

 If no matches are found, the caller is given the option to retry. 

 If 10 or less matches are found, the matching mailbox name greetings are played as part of a selection list, 
i.e. "Press 1 for …, press 2 for …, …". 

 If more then 10 matches are found, the caller is prompted to either press # to hear the first 10 or to dial 
more characters to reduce the number of matches. If they select to play the list, after each set of 10 
matches they can either make a selection or follow the prompts for other options. 

For a user to be included in the dial by name list, they must: 

 Have recorded a mailbox name. 

 Not be marked as ex-directory. 

 

To add a Dial by Name action: 

1. Click the  Telephony Actions icon and select  Dial by Name. 

2. In the Specific tab you can select from three types of names that will be included in the list. Users set to 
ex-directory through the Manager application are not included. You can also select how the names will be 
sorted. 

 

The action has True and False connection results. If the caller does not make a selection, the 
False result connection is used. If the caller does make a selection, the selection is stored as the $KEY variable 
and the True result connection is used. $KEY should be entered in the mailbox field of the following action. This 
method allows a Dial by Name action to be used to set the destination for a following action such as Get Mail, 
Leave Mail, Listen, etc. 

For an example of the action in a call flow, see Example Call Flow: Dial by Name. 
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Conferencing Center Action 

The Conferencing Center action is used in conjunction with the Avaya IP Office Conferencing Center if installed. 
It provides a route for callers to enter the conference ID and their conference PIN code. 

To add a Conferencing Center action: 

1. Click the  Telephony Actions icon and select  Conferencing Center. 

2. Select the Specific tab.  
 

 

 If the caller is to be asked for conference ID and then the PIN, check the option Gather 
conference and pin information before validation. The results are collected and then verified. If 
either entry is invalid the caller is notified but not told which entry is incorrect. If this option is not 
selected then the entries are validated as they are entered. 

 The number of times that a conference ID can be entered is controlled by the option Allow the 
delegate to try and enter the conference ID a total of. Up to 10 re-tries can be allowed. If the ID 
is entered incorrectly the result failure is returned.  

The action also provides a number of results which act as failure options if 
conference access is unsuccessful. These are Invalid Conference or Password, Conference Not Started, 
Conference Finished, Conference Full, and Failure. 
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Assisted Transfer Action 
The Assisted Transfer action transfers the caller to a specific mailbox's extension. The caller hears either 

silence or music on hold if installed. The transfer is not blind, if the call receives busy or no answer then it returns to 
follow the appropriate connection. 

 

To add an Assisted Transfer action: 

1. Click the  Telephony Actions icon and select  Assisted Transfer. 

2. Select the Specific tab. Complete the fields with relevant details. 

 

 In the Mailbox field enter or select the target mailbox whose extension you want rung. 

 In the Source of transfer field select the number to display on the target telephone. 

 In the Description field enter text to be displayed on the target telephone. 

 Set the No answer timeout value. The value selected is how long the voicemail server waits for 
an answer before following the No Answer connection. 

The Assisted Transfer action results need to be connected to relevant actions. For examples 
of the action being used in a call flow, see: 

 Using a Play Configuration Menu Action. 

 Routing Calls to Voicemail, Example Call Flow. 

 Example Call Flow: Dial by Name. 
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MS-CRM Call Data Tagging 

The Assisted Transfer action can be used to pass data to MS-CRM users and pop matching MS-CRM records 
based on that data. This is done by entering <MSRM-ACT>=, followed by a VoiceMail Pro system variable, in the 
action's Description field. By default, this will be matched against the MS-CRM account number field. For more 
information, see System Variables. 

For example, a preceding Menu action could be used to ask the caller to enter a number. The string <MSCRM-
ACT>=$KEY in the Assisted Transfer action would pop MS-CRM records with an account code matching the 
number dialed by the caller. 

Matching against other custom fields in the MS-CRM database can also be specified. For example, if the database 
contains a field called Pager, <MSCRM-ACT=Pager>$KEY can be used to match call data to that field. 
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Alphanumeric Action 

The Alphanumeric action allows the caller to input text and numeric values directly from the telephone keypad 
with ITU standard alphabet markings. The action following the DTMF Data result can use $KEY to access the 
alphanumeric characters. 

 

Users enter data by pressing the key marked with the character required. For keys with multiple marking several 
key presses are required. For example, to enter C the user must press the 2 key three times. After each key press, 
the associated letter or number is spoken. 

To move on to entering the next character, the user should press whichever other key is marked with the required 
character or first press # if the required character is on the key just used. 

Controls available are: 

# - Accept last character and begin entry of next character if the required character is on the key just used. 

*1 - Hear characters entered so far. 

*2 - Delete all characters entered so far. 

*3 - Delete last character entered. 

*# - Accept the set of characters entered and go to next call flow action. 

 

To add an Alphanumeric action: 

1. Click the  Telephony Actions icon and select  Alphanumeric. 

2. Select the Specific tab.  

 

 Check the option Play Help if you want instruction to be given to the caller explaining how to enter 
information. 

 If you want to use a timeout result from the action, check the option Wait for a key press for up to 
and set the number of seconds for the timeout period. 
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The Alphanumeric Collection action has three results that can be connected to relevant 
actions. 

 Timeout - This result connection is used if no key press occurs within the period specified by the action. If 
the option Wait for a key press for up to in the Specific tab is not selected the Timeout result is not 
available. 

 DTMF Data - This result connection is used if the caller enters some data (ending each character with #) 
and then presses *#.  

 No DTMF Data - This result connection is used if the caller presses *# without entering any data. 

For an example of the action being used in a call flow, see Example Call Flow for Mobile Twinning. 
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Miscellaneous Actions 

Overview 
  Miscellaneous Actions 

 
eMail Action: Email a recording. For more information, see eMail Action. 

 Open Door Action: Open and/or close a door relay. For more information, see Open Door Action. 

 
Alarm Set Action: Set an alarm call time. For more information, see Alarm Set Action. 

 
Clock Action: Play the time to the caller. For more information, see Clock Action. 

 
Post Dial Action: Play a recording to an extension. For more information, see Post Dial Action. 

 
VB Script Action: Allows Visual Basic to be used to script call flow events. For more information, see 
VB Script Action.  

 Remote Call Flow: Allows call flows developed elsewhere to be included in an existing call flow. For 
more information, see Remote Call Flow. 
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eMail Action 
The eMail action is used to send a recording to a specific email address. 

To add an eMail action: 

1. Click the  Miscellaneous Actions icon and select  eMail. 

2. Select the Specific tab. Complete the fields with relevant details. 

 

 In the Send e-mail to field, type the email address of the recipient. 

 In the Subject field, type the subject line for the email. 

 In the Content field, type the text to be placed in the email. 

 In the Attach file to email field the recorded file to be attached to the email needs to be selected. 
If just $ is entered then the action will use the recording collected by a preceding Leave Mail action 
or Voice Question action. For more information, see Leave Mail Action and Voice Question 
Action. 

Connect the result Next to a relevant action.  
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Open Door Action 
The Open Door action activates either of the door entry relays provided on the IP Office Control Unit. 

To add a Open Door action: 

1. Click the  Miscellaneous Actions icon and select  Open Door. 

2. In the Specific tab, check either of the two door relay options. 

 

 

Connect the result Next to a relevant action. 

 

Alarm Set Action 
The Alarm Set action prompts the caller to specify the time at which they want an alarm call and to record a 

message for the alarm call. The voicemail server will then call the user at that time. A user can set up multiple 
alarms to occur at different times. Once an alarm has occurred it is deleted. 

To add an Alarm Set action: 

1. Click the  Miscellaneous Actions icon and select  Alarm Set. 

2. You need to record a message for the alarm call in the Entry Prompts tab. 

Connect the result Next to a relevant action. 

 

Clock Action 
The Clock action plays the current time on the Voicemail Server PC. A short code can then be used to have this 

action replace users making external calls to a 'speaking clock' service. 

To add a Clock action: 

1. Click the  Miscellaneous Actions icon and select  Clock. 

 

Connect the result Next to a relevant action. 
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Post Dial Action 
The Post Dial action can be used to connect another extension to a specified call flow start point or to play a 

recording to that extension. 

To add a Post Dial action: 

1. Click the  Miscellaneous Actions icon and select  Post Dial. 

2. In the Specific tab, complete the fields with relevant details. 

 

 Post wave file 
Plays a selected wav file. When Post wave file is selected there are two options which can be 
selected. 

 Play out a looped wave file - The wav file will be played in a continuous loop. 

 Delete the wave file after completion - The wav file will be deleted after it has been 
played. 

 Post the following action 
Enter the name of the required start point or use the browse button to select the start point. To play 
a recording, enter c:\mywavs\hello.wav (substitute the appropriate file path and file name for the 
.wav file you want played). 

 To extension 
Enter or select the extension to which the call should be made. The voicemail server will attempt to 
make the call every 5 minutes for the next hour until successful. 

 Page Calls - The Post Dial action can be used to page a .wav file to an extension number, 
including group extension numbers. This is done by entering PAGE: followed by the target 
extension number. In this case the wav file will not loop if selected. 

Connect the result Next to a relevant action. 
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The VB Script Action 

The VB Script action allows an administrator to construct additional call flow logic using VBScript commands. A 
number of predefined methods and system variables are available. Any scripting added can be verified by pressing 
the Syntax Check button. Details of the properties and methods supported are given in the VBScript section. For 
more information, see VBScript Properties:Overview. 

 Use of VBScript requires entry of a valid VM Pro VBScript license in the IP Office configuration. 

 

To add a VB Script action: 

1. Click the  Miscellaneous Actions icon and select VB Script. 

2. Select the Specific tab.  

 

 Enter VBScript:  
In the Script area enter the VBScript as required. Details of the System variables and COM 
methods that are supported are accessible by right clicking in the VBScript area. This script can 
contain a maximum of 1000 characters. 

 Expand 
Check Expand to view a larger script area. 

 Syntax Check 
Click the Syntax Check button to check your input for any errors. 

 

This action has two results for which connections to following actions can be made. The results are 
based on the Scripting entered in the Specific tab. 
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Remote Call Flow 
The Remote Call Flow action allows a call flow, in the form of a .vmp file, developed elsewhere to be included in 

an existing call flow. The aim of this action is to allow call flows developed by other applications, such as the IP 
Office Wizard, to be placed on the VoiceMail Pro server and included in its customized call flows. 

To add a Remote Call Flow action: 

1. Click the  Miscellaneous Actions icon and select  Remote Call Flow. 

2. In the Specific tab, the field Remote Call Flow will show a list of remote call flow files downloaded to the 
VoiceMail Pro server.  

 

 

The Remote Call Flow action has no results. Any follow on call handling is determined by the 
actions in the remote call flow. 

 



Using the VoiceMail Pro Client 

VoiceMail Pro Installation and Maintenance Guide Page 245  
IP Office 4.0 15-601063 Issue 16 (12th December 2006)  

Condition Actions 

Overview 
  Condition Actions 

These actions are used to create branches in the call routing according to whether a value is true or false. 

 
Test Condition Action: Test whether a condition is true or false. For more information, see Test 
Condition Action.  

 Set User Variable Action: Set a variable to a particular value. For more information, see Set User 
Variable Action. 

 Test User Variable Action: Test the value of a variable. For more information, see Test User 
Variable Action. 

 Check Digits Action: Check if user dialing matches set digits. For more information, see Check 
Digits Action.  
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Test Condition Action 
The Test Condition action has following connections for true and false. Conditions are set through the 

Conditions Editor. For more information, see The Condition Editor:Overview. 

To add a Test Condition action: 

1. Click the  Conditions Actions icon and select  Test Condition. 

2. In the Specific tab, complete the fields with relevant details. 

 

 Return the results of the following condition: Allows a selection to be made from the conditions 
currently setup. 

Enter the connections for the results. For examples of the Test Condition action in a call flow, 
see: 

 Customizing a Hunt Group Call Flow. 

 Example Call Flow using $POS. 

 User Defined Variables. 
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Set User Variable Action 
The Set User Variable action sets a variable to a particular value. Other call flows may then use the Test User 

Variable action to check whether the variable has a particular value. 

 The variable must first be created using the User Defined Variable menu. 

To add an Set User Variable action: 

1. Click the   Conditions Actions icon and select  Set User Variable. 

2. Select the Specific tab. Complete the fields with relevant details. 

 

 Assign the following user variable: The name for the user variable. 

 With the following value: The value of the variable. 

We strongly recommend that this action type is followed by another action (if necessary a 
Disconnect action), whose entry prompt confirms to the caller that the value has been set. In some situations, 
such as where the Set User Variable action is accessed by the user dialing a short code, if the user hangs-up too 
quickly the variable may not actually be set. Having a following action with a confirmation message encourages 
users not to hang up too quickly. 

For an example of the action in a call flow, see User Defined Variables. 
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Test User Variable Action 
The Test User Variable action has true and false connections that are followed according to whether a user 

variable matches a particular value. The Set User Variable action can be used in other calls to set the value of the 
variable. 

To add an Test User Variable action: 

1. Click the  Conditions Actions icon and select  Test User Variable. 

2. In the Specific tab, complete the fields with relevant details. 

 

 This action will return "TRUE" if the following variable: The name of the user variable to be 
checked. 

 Matches the value below: The value of the variable that will return a true result. 

This action has two results for which connections to following actions can be made. For an 
example of the action in a call flow, see User Defined Variables. 
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Check Digits Action 
The Check Digits action is supported on Voicemail Pro 1.2.6 or higher. It requires the caller to enter a specific 

sequence of DTMF digits. 

To add a Check Digits action: 

1. Click the  Conditions Actions icon and select  Check Digits. 

2. In the Specific tab, complete the fields with relevant details. 

 

 What key sequence will the caller have to match?:  Enter the key sequence that callers must 
dial to follow the true result connection. The user's entry should be followed by pressing # to 
indicate completion. This should be mentioned in the entry prompt. 

 Timeout after:  Used when a caller doesn't enter any digits or doesn't complete entering matching 
digits within a set time. When this occurs the action's Timeout result connection is used.  

The action has True, False and Timeout results. The True result connection is used if the caller 
dials the matching key sequence. The False result connection is used if the callers dials a non-matching digit. The 
Timeout result connection is used if the caller does not complete dialing the matching key sequence within the set 
timeout period. 
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Database Actions 

Overview 
  Database Actions 

These actions relate to retrieving and adding data to a database. 

 
Database Open Action: Open a database. For more information, see Database Open Action. 

 
Database Execute Action: Perform an action on a database. For more information, see Database 
Execute Action. 

 Database Get Data Action: Get information from a database. For more information, see Database 
Get Data Action. 

 
Database Close Action: Close a database. For more information, see Database Close Action. 

The database actions can be used in a call flow to create an automated order process. Details can be played to 
callers from a database and answers recorded. Examples of using the database actions are given in the IVR 
Database Connection section. For more information, see Database Scenario. 

Note 

 The use of database actions with VoiceMail Pro requires entry of a VMPro Database Interface license in 
the IP Office configuration. 
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Database Open Action 

The Database Open action opens a link to a third party database. If connection to the database succeeds, the 
result is OK, otherwise the result is FAIL. If there is a connection to the database already then the current 
connection is closed and the new one requested will be opened. 

To add a Database Open action: 

1. Click the  Database Actions icon and select  Database Open. 

2. Select the Specific tab. The connection string to open the database can be entered directly into the field. 

For help on constructing the connection string, click . The Data Link Properties window opens. 

 Provider Tab 
Select the OLE DB Provider of the data that is to be connected to. Click Next to move to the 
Connection Tab. 

 Connection Tab 
Specific information relating the Database provider needs to be completed. Help of the information 
required for each of the fields can be obtained by clicking the Help button. Fields available will be 
dependant on the type of provider. Test that the information entered will allow entry into the 
database, click the Test Connection button. A message Test Connection Succeeded will show if 
successfully connected to the database. 

 Advanced Tab 
Network Settings & other settings e.g. Access permissions. Fields showing will be dependant on 
the type of provider selected. Click help for specific information about any of the fields. 

 All 
The properties that have been selected on the previous tabs are shown in the All Tab. 
Amendments can be made as required by selecting the Name and click Edit Value. 

The Database Open action results can only be Success or Failure. Add connections to 
relevant actions. For an example of the action in a call flow, see IVR Database Connection Example, Retrieving 
Data From the Database. 
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Database Execute Action 
The Database Execute action performs an SQL query on a database opened on a preceding Database Open 

action. An SQL query that is generated by the Database Execute Action does not support spaces in field or table 
names. To avoid problems in a Microsoft Access database, it is advisable to avoid using a field name that has the 
same name as its field type. For example, you should avoid using the name Number for a number field. 

To add a Database Execute action: 

1. Click the  Database Actions icon and select  Database Execute. 

2. Select the Specific tab. The SQL Wizard window opens. Use the wizard to construct the SQL query. 

The Database Execute action results can only be Success or Failure. Add connections to 
relevant actions. For an example of the action in a call flow, see IVR Database Connection Example, Retrieving 
Data From the Database and Entering Details in to the Database. 
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Database Get Data Action 
Once a query has been made against a database (see Database Execute Action), either a single result or a set 

of results are returned. The Database Get Data action will allow access to the data items if a set of results are 
returned. 

To add a Database Get Data action: 

1. Click the  Database Actions icon and select  Database Get Data. 

2. Select the Specific tab. Select the way to retrieve the data. 

 Retrieve the next item in the list:- Allows the call flow to facilitate the stepping through of a list of 
results returned by the Database Execute action. 

 Retrieve the previous item in the list: - Allows the call flow to facilitate the stepping through of a 
list of results returned by the Database Execute action. 

 Retrieve the first item in the list: - Allows the call flow to facilitate jumping to the start of the list 
therefore returning all the items in the list. 

 Retrieve the last item in the list: - Allows the call flow to facilitate jumping to the end of the list 
therefore returning all the items in the list. 

The Database Get Data action has four results. 

 Success: - The current record has successfully been assigned to the $DBD variable. 

 At End: - You have reached the end of the list, the $DBD variable contains no information. 

 Empty: - The execute method returned no data, the $DBD variable contains no information. 

 Failure: - There was a problem trying to retrieve the next data record, the $DBD variable contains no 
information. 

Examples of using the database actions are given in the IVR database Connection section. For an example of the 
action in a call flow, see IVR Database Connection Example, Retrieving Data From the Database. 

 

Database Close Action 

The Database Close action will close the current database connection. If the database is open when a call 
terminates then a Database Close action is run automatically. 

To add a Database Close action: 

1. Click the  Database Actions icon and select  Database Close. 

2. There is no specific tab. 

The Database Close action results can only be Success or Failure. Add connections to 
relevant actions. 
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Queue Actions 

Overview 
  Queue Actions 

These actions are associated with hunt group queues and are not available to user and short code start points.  

 The option Synchronise calls to announcements in IP Office Manager should not be used when using 
the queue actions. For more information, see the IP Office Manager guide. 

 Queue ETA Action: Speak the caller's expected time to answer. For more information, see Queue ETA 
Action. 

 Queue Position Action: Speak the caller's queue position. For more information, see Queue Position 
Action. 
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Queue ETA Action 
The Queue ETA action plays the estimated time to answer (ETA) to a queued caller. The ETA is calculated 

based on the queued time of the last 5 queued and answered calls. The ETA is always rounded up to the nearest 
minute. For an example, see Customizing Queuing. 

The ETA is calculated and supplied by the IP Office when it requests a queue or still queued message is played to 
a caller. 

 In Incoming Call Route 'Priority' 
The IP Office supports a configurable Priority setting (1, 2 or 3) on Incoming Call Routes. Calls assigned a 
high priority are moved up any call queue ahead of those with a lower priority. The use of this feature is not 
compatible with Queue ETA and Queue Position messages as the spoken queue positions and ETA are for 
some callers may be overridden by calls with a higher priority. 

To add a Queue ETA action: 

1. Click the  Queue Actions icon and select  Queue ETA. 

2. Select the Specific tab. This tab may include any further prompts to be played to the caller after they hear 
their ETA. 

 

3. The Entry Prompts tab should include any prompts to play to the caller before they hear their ETA. For 
more information, see Entry Prompts Tab. 

Connect the result Next to a relevant action. 
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Queue Position Action 
The Queue Position action plays the caller their position within the queue of calls for the group. The queue 

position is supplied by the IP Office when it requests a queue or still queued message is played to a caller. 

 In Incoming Call Route 'Priority' 
The IP Office supports a configurable Priority setting (1, 2 or 3) on Incoming Call Routes. Calls assigned a 
high priority are moved up any call queue ahead of those with a lower priority. The use of this feature is not 
compatible with Queue ETA and Queue Position messages as the spoken queue positions and ETA are for 
some callers may be overridden by calls with a higher priority. 

To add a Queue ETA action: 

1. Click the  Queue Actions icon and select  Queue Position. 

2. The Entry Prompts tab should include any prompts to play to the caller before they hear their position. For 
more information, see Entry Prompts Tab. 

3. Select the Specific tab. This tab may include any further prompts to be played to the caller after they hear 
their position. 

 

Connect the result Next to a relevant action. For an example of the Queue Position action in a 
call flow, see Customizing a Hunt Group Callflow. 
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Using Variables 
System Variables 
A number of system variables exist which can be used to perform tasks. For example, $NAM can be used to speak 
the user's name within an action's entry prompt. System variables can also be checked by the compare element in 
a condition and then branch the call flow according to the variables value. 

Unless otherwise stated, variables are session based. This means that  the data is specific to a particular call within 
VoiceMail Pro and does not persist between calls. Some system variables can be played as prompts, for example: 

 $NAM - Plays the user name. 

 $CLI - Speaks the caller's CLI. 

 $RES - Plays the current result if it is a .wav file. 

 $VAR - Plays the variable as a list of digits. 

 

Speaking Variables to Callers 
System variables can be entered in the place of a wav file name in the Wav Editor. The value of the system 
variable will then be spoken. This applies to $NAM, $POS and $ETA in queuing call flows and to any variable that 
contains numeric values. Numbers are spoken as a series of single digits, for example 123 is spoken as "one two 
three". To speak 123 as "one hundred and twenty-three" requires TTS to be installed and a Speak Text action 
used. 

Here is a list of the system variables that are available in VoiceMail Pro. 

Variable Description 

$CLI Holds the CLI of the caller if available. 

$CP The 16 variables $CP0 to $CP15 are used to store values (call parameters) for the duration of a 
call. Values can be written into these variables using the Generic action command CPx:<value> 
where x is 0 to 15 and <value> is the value to be stored. 

$DBD A set of 6 system variables $DBD[0] to $DBD[5]. These represent the fields of the currently 
selected database record in a call flow where database actions are being used. 

$ETA  Holds the expected time to answer in minutes for a queued caller. Can be used to speak the value 
as a prompt or to test the value in a condition. Only available when using Queued and Still 
Queued start points. 

$KEY  Holds the last DTMF key series entered. For more information, see Example Call Flow. 

$LOC Holds the current locale setting of the IP Office system or the user if different. For more 
information, see Changing the Language of Custom Prompts. 

$NAM  Holds the name of the mailbox user (blank for short codes). 

$RES  Holds the value of the result of the previous action. For example when a call flow has been 
branched by an action that has True and False results, on one branch the value of $RES is 
"True", on the other "False". 

$POS  Holds the position of a queued caller. Can be used to speak the position as a prompt or test the 
value in a condition. Only available when using Queued and Still Queued start points. 

$SAV  Holds the last saved result. This can be entered using the following entry in a Generic action, 
Save:<value>, for example Save:$KEY or Save:1234. 

$UUI  Available when a recording is triggered by auto-recording. Holds the user name, hunt group name 
or account code that triggered the auto-recording process. For more information, see Customizing 
Auto Recording. 

$VAR  A general variable which can hold amongst other things DTMF key sequences. 
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User Defined Variables 
You can create user variables, the value of which can be set using a  Set User Variable action within a call 
flow. For more information, see Set User Variable Action. The options presented to a caller can also be branched 

using a  Test User Variable action to check the current value of the variable. For more information, see Test 
User Variable Action. 

 

To add a user defined variable: 

1. Click  or press F8. The User defined variables window opens. 

 

2. Click . The Add user defined variable window opens. 

3. Type a name for your new variable. 

4. Click OK. The new variable is added to the list. 
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Example: 

1. Add a variable called Reception. 

2. Two start points need to be created, one for indicating when the reception is open, the other for when the 
reception is closed. When completed the call flows will look similar to the examples shown. 

 Create a start point called ReceptionOpen and connect it to a Set User Variable action. The Set 
User Variable action needs to have the user variable Reception assigned with the value Open. 

 

 Create a start point called ReceptionClosed and connect it to a Set User Variable action. The Set 
User Variable action needs to have the user variable Reception assigned with the value Closed. 

 

3. Create the matching short codes on the telephone system. 

4. For calls using another start point, you can now use the Test User Variable action to test whether the 
value of reception is open. The action has true and false results which you can link to the appropriate 
following actions, for example transferring calls to the reception desk or to a mailbox. 
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Creating Modules 
Overview 
Modules are reusable sets of actions. They allow you to create a sequence of actions that can be reused in another 
call flow. 

Any changes to a module will affect all other start points that are using that module. This simplifies the 
programming of actions if a number of start points use the same sequence of actions. Using modules also reduces 
the size of a call flow. 

 To create connections from a module to other actions you must use the Module Return action within the 
module, see Module Return Action. 

To create a module: 

1. Click Modules and then . The Adding a new start point window opens. 

 Alternatively, right-click Modules and select Add. 

2. Enter a name for the module. This should not match any user or group name on the IP Office. 

3. Click OK. You can now add actions and connections to the module in the same way as for any start point. 

 

To add a module to a start point: 

1. Select the start point to which you want to add the module action and then click the right-hand panel. 

2. Click and drag the module required from the Navigation pane to the Details pane. 

 

For support calls and diagnostic purposes it can be useful to view VoiceMail Pro modules and start points as text 
files. For more information, see Viewing Call Flows as Text. 

 

Running a Module  
Modules can be run internally using short codes or can be configured for external calls. 

Run a module from a short code: 

You can use modules directly in conjunction with short codes. The short code must call the name of the module. 
This example short code will run the module called Special when a user dials *97. The service that the user 
receives will depend on the actions in the module. 

 Short code: For example *97 

 Telephone Number: "Special" (include quotation marks) 

 Line Group ID: 0 

 Feature: Voicemail Collect 

 

Run a module for an external call 

A module can be applied directly to an incoming (external) call from within the IP Office Manager 
application. Within the appropriate IncomingCallRoute entry, set the Destination to the module name prefixed 
with "VM:". 

For example, enter VM:AutoAttend to route a call to a module called AutoAttend. Note that the maximum entry 
length is 15 characters. This means that the module name is limited to 12 characters. 

 If there is a hunt group on the system whose name matches the module name, calls will be routed to that 
group when the voicemail server is not running. 
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The Condition Editor 
Overview 
Conditions are constructed from a set of basic elements. These elements can be combined within a single 
condition to create complex rules. For example, the week planner can be used to define a company's standard 
working hours, and then combined with the calendar to define exception days such as public holidays. 

Within the voicemail call flow, conditions can be checked by a test condition action and, according to whether the 
condition is currently true or false, callers can be routed to different actions. For more information, see Test 
Condition Action. 

Logic settings can be applied to both the whole condition and to the elements in a condition. These can alter when 
a condition is true or false. 

 AND - The condition is true when all the elements are true, for example both A and B are true. 

 OR - The condition is true when either element is true, for example if the day is Monday or Tuesday. 

 NOT - This logic element can be used to reverse the value (e.g. return false when true) of individual 
elements or of the whole condition. 
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Using the Condition Editor 
You can add elements to existing conditions, change the logic of a condition and delete elements and conditions. 
  

To start the Condition Editor:  

1. Click the  icon. 
You can also open the Condition Editor by pressing F6 or click Administration > Condition Editor. 

2. When the Condition Editor is started, any existing conditions are shown. In the example there are no 
conditions. 

 

To add a new condition: 

1. Click the  icon in the toolbar. The New Condition window opens. 

2. Enter the name for the condition and then click OK. 

3. The new condition is placed in the Condition Editor window. The condition is represented by the icon  
followed by the condition name. 

 

When a condition has been created, elements can be added and altered. A condition can consist of multiple 
elements, including several elements of the same type. In the example there are conditions added complete with 
elements. 
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To add elements to a condition: 

1. Click the  Element List icon in the toolbar. 

2. Click the type of element required. 

 Calendar - For more information, see Calendar. 

 Week Planner - For more information, see Week Planner. 

 Compare - For more information, see Compare. 

 Condition - For more information, see Condition. 

3. Click  Condition Name in the Condition Editor window. The element icon is added. 

4. You can now edit the element's settings. 

 

To edit elements: 

1. Select the element, click  Edit icon in the toolbar. The element's properties window opens.  
Alternatively, double click the element to open the properties window. 

2. Make any changes. 

3. Click OK to save the changes and close the properties window. 

 

To change the logic setting of a condition: 

1. Click Logic icon in the toolbar. 

2. Select the required logic. 

 x|| (OR) 

 x+ (AND) 

 x! (NOT). 

3. In the Condition Editor window, click the element to apply the logic to. The logic indicator changes. 

By default the logical X+ (AND)  setting is applied to new condition elements. For the week planner and calendar 
elements, if more than one day is set this will never return true. Therefore we recommend that the X|| (OR) logical 
setting is applied to all week planner and calendar elements. 

 

To change the name of a condition: 

1. Select the condition, click  Edit icon in the toolbar. The Rename condition window opens. 

2. Amend the condition's name. 

3. Click OK. 

 

To delete elements and conditions: 

1. Select the condition or element to be deleted. 

2. Click  icon in the toolbar. The selected condition or element is deleted. 
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Available Condition Elements 
Calendar  

The Calendar element is used to indicate which days of the year return true. Double-click a day to select or 
deselect the day. 

Selected days are shown with a shaded background, e.g. . Note that  indicates weekend days but not 
whether the day is selected. The element returns 'true' if the current day is a selected day. 

 Apply Logical OR X|| if more than one day selected 
By default the logical AND X= is applied to this condition element. If more than one day is selected then 
element cannot return true. For example it cannot be the 3rd March and the 4th March at the same time. 
When multiple days are selected the OR X|| settings should be applied. In our example the element will 
then be true if it is the 3rd March or 4th March. 

 

To add a calendar element: 

1. Click the  Element List icon in the toolbar. 

2. Click  Calendar. 

 

Example: 

The conditions for a call flow can be altered so that calendar dates such as public holidays can be accounted for. 

1. Click the  Conditions Editor icon. The Conditions Editor window opens. 

2. Click the  New Condition icon in the toolbar. The New Condition window opens. 

3. Type a name for the new condition. 

4. Click OK. The icon Condition Name is placed in the Condition Editor window. 

5. Click the  Elements icon. select  Calendar. 

6. Click  Holidays in the Condition Editor window. The Calendar  icon is added. 

7. Double-click the  Calendar to open the Calendar window. 

8. To set a date as being a holiday, double-click the date. If the date chosen is the 17th, the date will be 

highlighted, similar to  indicating it as a holiday. 

9. Click OK. The condition can be added to a Test Condition action. For more information, see Test Condition 
Action. 
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Week Planner 
The Week Planner element is used to set which time periods during a normal week return 'true'. It consists of 

an entry for each day of the week and a start and end time for the 'true' period on each day. 

 Apply Logical OR X|| if more than one day selected 
By default the logical AND X= is applied to this condition element. If more than one day is selected then 
element cannot return true. For example it cannot be the Monday and Tuesday at the same time. When 
multiple days are selected the OR X|| settings should be applied. In our example the element will then be 
true if it is Monday or Tuesday. 

 

To add a Week Planner element: 

1. Click the  Element List icon in the toolbar. 

2. Click  Week Planner. 

 

Example: 

The conditions for a call flow can be altered so that calls received between 09:00 and 18:00, Monday to Friday are 
treated differently to calls received outside of these hours. 

1. Click the  Conditions Editor icon. The Conditions Editor window opens. 

2. Click the  New Condition icon in the toolbar. The New Condition window opens. 

3. Type a name for the new condition. 

4. Click OK. The icon Condition Name is placed in the Condition Editor window. 

5. Click the  Elements icon, select  Week Planner. 

6. Click  Condition Name in the Condition Editor window. The Week Planner icon is added. 

7. Double-click the  Week Planner to open the Week Planner window. 

8. Check the days Monday through to Friday. The start and end times for the days do not need to be 
changed. 

9. Click OK. The symbol before the condition Week Planner indicates the logic 'AND' is used. Working 
hours are Monday or Tuesday or … or Friday so the logic needs to be changed to 'OR'. 

 Click the  Logic icon in the toolbar, select  OR. 

 Click the condition Week Planner in the Condition Editor window. The logic setting to is changed 
to  representing the logic 'OR'. 

10. Click OK. The condition can be added to a Test Condition action. For more information, see Test Condition 
Action. 
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Condition 

The Condition element is used to combine the value of an already existing condition. For example, using the 
week planner a working week is created, the week being 09:00 to 18:00, Monday to Friday every week. The 
condition element can be used to alter the condition so that we can account for calendar dates such as public 
holidays by combining the week planner element and the calendar element. 

When selected the element displays a list of the other conditions from which to select. 

To add a condition element: 

1. Click the  Element List icon in the toolbar. 

2. Click  Condition. 

3. Click the condition in the Condition Editor window. 

4. Open the properties of the condition element by double-clicking . 

5. Select the condition result that you want to include. 

6. Click OK. 

 

Example: 

Two conditions have been created: 

 Using the week planner element a condition is created so that calls received between 09:00 and 18:00, 
Monday to Friday are treated differently to calls received outside of these hours. For more information, see 
the example for the Week Planner condition element. 

 Using the Calender element a condition is created so that calendar dates such as public holidays can be 
accounted for. For more information, see the example for the Calendar condition element. 

The two conditions need to be combined so that the call flow treats calls during working hours differently to calls 
received outside working hours and on bank holidays. 

1. Click the  Element List icon in the toolbar. 

2. Click  Condition. 

3. Click the Week Planner in the Condition Editor window. The  condition is placed in the Condition Editor 
window. 

4. Open the properties of the condition element by double-clicking . 

5. Select the Calendar condition result. 

6. Click  logic options and select a NOT action. Click  Condition to apply the logical option. 

7. Click OK. The condition is now true when it is between 09:00 and 18:00, Monday to Friday and not a 
holiday. 

 

Compare 

The Compare element is used to add a variable that will be used to determine the call flow to be presented to 
the caller. You can compare VoiceMail Pro system variables, for example $POS or $ETA, against each other or 
against a value you enter. 
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Campaigns 
Overview 
A campaign is a series of questions and answers. Callers to a campaign hear the questions and give their 
responses, either by speaking or using the telephone keypad. 

Call processing agents can access a campaign to hear caller answers which they can then transcribe into a 
database or other records. For more information, see Granting Access to a Campaign. 

 The directory in which campaign files should be stored is specified in the system preferences directory tab. 
For more information, see Setting the Location of Voicemail System Folders. 

A Web Campaign Component is installed as part of a typical VoiceMail Pro installation. If the Web Campaign was 
not installed it can be added by doing a custom installation. For more information, see Installing Typical VoiceMail 
Pro Server and Client or Installing Custom VoiceMail Pro Server and Client. 
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Managing Campaigns 
A Campaign Wizard is used to manage campaigns. You can create new campaigns, modify existing campaigns 
and delete campaigns. 

To start the campaign Wizard: 

1. Press F7 or click  Campaign Editor. The Campaign Wizard Introduction window opens. 

2. Select the required activity. 

 Create a new Campaign 
This option takes you through a series of campaign wizard menus to set the campaigns settings. 
For more information, see To create a new campaign. 

 Modify an existing Campaign 
This option displays a list of existing campaigns from which you can select the one you wish to 
modify. You will then be taken through the campaign wizard menus for the campaign settings. For 
more information, see To modify a campaign. 

 Delete an Existing Campaign 
This option displays a list of existing campaign from which you can then select the campaign to 
delete. For more information, see To delete a campaign. 

 

To create a new campaign: 

1. Select the option Create a new Campaign from the Campaign Wizard Introduction page. 

2. Click Next. The Campaign Wizard Customer Prompts window opens. 

 Click  . The Please Edit the Campaign action window opens. For more information, see Customer 
Prompts. 

3. Click OK when you have entered the customer prompts. You return to the Campaign Wizard Customer 
Prompts window. 

4. Adjust the prompts as required. 

 Edit action: - Edit the currently highlighted campaign action. 

 Delete action: - Delete the currently highlighted campaign action. 

 Move action: - Move the position of an action in the sequence of campaign actions. 

5. Click Next. The Campaign Wizard Customer Menu window opens. 

 Select which options are available after the prompt is played. For more information, see Customer 
Menu. 

6. Click Next. The Campaign Wizard Campaign Identification window opens. 

 Enter the details on identifying the campaign. For more information, see Campaign Identification. 

7. Click Next. The last campaign wizard window opens confirming that a new campaign will now be produced. 

8. Click Finish to create the campaign. 
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To modify a campaign: 

1. Select the option Modify an existing Campaign from the Campaign Wizard Introduction page. 

2. Click Next. The Campaign Wizard Select an existing Campaign to modify window opens. 

3. Click the required campaign and click Next. The Campaign Wizard Customer Prompts window opens. 

 Amend the prompts as required. For more information, see Customer Prompts. 

4. Click Next. The Campaign Wizard Customer Menu window opens. 

 Amend which options are available as required. For more information, see Customer Menu. 

5. Click Next. The Campaign Wizard Campaign Identification window opens. 

 Amend any details on identifying the campaign. For more information, see Campaign Identification. 

6. Click Next. The last campaign wizard window opens confirming that the campaign will now be updated. 

7. Click Finish to update the campaign. 

 

To delete a campaign: 

1. Select the option Delete an existing Campaign from the Campaign Wizard Introduction page. 

2. Click Next. The Campaign Wizard Select an existing Campaign to delete window opens. 

3. Click the required campaign and click Next. The last campaign wizard window opens confirming that the 
selected campaign will be deleted. 

4. Click Finish to delete the selected campaign. 
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Customer Prompts 
The Customer Prompt window of the Campaign Wizard is used to set the sequence of questions that are played to 
callers and to record their responses. 

 Add action 
To add a new campaign action, click Add action. The Please edit the Campaign action window opens. 

 Edit action 
Select the prompt or recording to edit then click Edit action. The Please edit the Campaign action 
window opens. 

 

 

The Please edit the Campaign action window can be completed with the following information. 

 Play a prompt to the customer 

Select this option to play a prompt to the caller. Click  to specify which prompt to play or create a new 
prompt in the Wave Editor window. For more information, see Using the Wave Editor. 

 Allow the customer to input information 
Select this option to if you want the action to record the caller's response. 

 What type of input do you want 
This option sets whether the voicemail server should Record voice or Record key presses. 

 Please enter the maximum recording length or Please enter the maximum number of key 
presses. 
The field name depends on the type of input chosen. The time specified in seconds sets the 
maximum length of recording or the maximum number of key presses to record before the next 
action. 

 Please enter a unique name that will describe the input 
A name to associate with the action. The name should be a single word with no spaces. 

 The following prompt will be played to an agent when the above data is reviewed 
This option allows you to select or create a prompt that is played to agents before hearing the 

caller's response. Click  to specify which prompt to play or create a new prompt in the Wave 
Editor window. For more information, see Using the Wave Editor. 



Using the VoiceMail Pro Client 

VoiceMail Pro Installation and Maintenance Guide Page 271  
IP Office 4.0 15-601063 Issue 16 (12th December 2006)  

Customer Menu 
After completing the sequence of questions and responses, the caller can be offered a menu of options. The 
Customer Menu window of the Campaign Wizard is used to select the options available. 

 

 Please select the prompt to be played after the customer has made their recordings 
You can select or create a prompt that is then played to callers after completing the sequence of questions 
and answers. The prompt should inform the customer of which actions selected from the list they can use. 

Click  to specify which prompt to play or create a new prompt in the Wave Editor window. For more 
information, see Using the Wave Editor. 

 Please select which options will be available to the customer after the above prompt has played 
Check the boxes to select the options that will be available to the customer. The customer then needs to 
press the corresponding key. 

 Save the Campaign (and then quit) - Saves caller responses and then disconnects the caller. 

 Play back response to the Campaign - Plays back the customers responses to them and then 
repeats this customer menu. 

 Restart the whole Campaign - Delete the customers responses and restarts the sequence of 
questions and answers. 

 Quit the Campaign (without saving) - Disconnects the customer without saving their responses. 

 Move options 
You can move the currently highlighted option so that the key presses associated with the options differ. 

 Timeout 
Sets how long the voicemail server should wait for an answer before following the No Answer connection. 

 

Campaign Identification 
The Campaign Identification window of the Campaign Wizard is used to set a park location for the campaign and to 
name the campaign. 

 Where should this Campaign be parked - Enter a park slot number for the campaign. This number can 
be programmed under a DSS key. That key can then be used by agents to access the campaign. If the 
DSS key also incorporates a BLF lamp, that lamp is lit when new campaign messages are left. 

 The name of the Campaign is - Enter a name for the campaign. 
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Granting Access to a Campaign 
A campaign can be accessed by: 

 Using the Campaign Action. 
The Campaign action is used to route calls into a campaign after those calls have been routed to an 
appropriate start point on the voicemail server. The action's properties set whether the call is treated as a 
caller to the campaign or an agent processing the campaign messages. For more information, see 
Campaign Action. 

 Using the Park Slot number. 

 Through a Web Browser. 
For more information, see Using the Web Campaign. 

When an agent accesses the messages waiting in a campaign using either if the first two methods, they have a 
number of telephone controls available. 

1 Go to the start of the call. 

2 Rewind. 

3 Stop processing the message. 

4 Mark call as processed and delete. 

5 Mark call as processed and save. 

7 Previous response. 

8 Start of response. 

9 Next response. 

0 Pause. 

# Fast forward. 

* Rewind. 

 

The Park Slot number assigned to the Campaign can be used with programmable buttons. The advantage is that if 
the telephone has a message waiting lamp, the lamp will be lit when there are campaign messages waiting to be 
processed. 

 Phone Manager park slot keys cannot be used for this function. 

To assign a campaign to a programmable button: 

1. In IP Office Manager, receive the IP Office configuration.  

2. Open the required  User form. 

3. Select  the Button Programming tab. 

4. Select a free button  

 Right-click in the Action field. 

 Select Emulation > Call Park. 

 Right-click in the Action Data field. Enter the campaign's park slot number. 

5. Save the configuration back to the IP Office and reboot. 

6. Wait until voicemail services have restarted.  

7. The programmable button on the user's telephone will flashing red when there are new messages in the 
campaigns park slot. 

 Press the button to display the campaign name and number of messages. 

 Press the button again to start processing those messages.  

 

The UnPark Call function can also be used to collect the calls, but this method does not provide any visual 
feedback when messages are present.  
To use the UnPark Call function: 

1. Select a free programmable button  

2. Right-click in the Action field. 

3. Select Advanced > Call > UnPark Call. 
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Using the Web Campaign 
The Web Campaign Component allows access to play and change the status of campaign messages through a 
Web browser. 

 Anyone who wants to use the web campaigns must have Microsoft Internet Explorer 5.0 or higher (not 
Netscape). Their PC must also have multimedia sound capabilities. The Web campaign user must also 
have a voicemail mailbox. The name of their mailbox is requested when the user browses the campaign 
messages. 

 During installation of the Campaign Web Component, the root address of the web server is requested. A 
folder called campaign is then added to that root. The web address for browsing will normally be set up as 
a link from a page within a company intranet rather than typed directly by users. 

 Access must be via http: and not network file routing. 

 

To view open the Campaign Web Campaign: 

1. Open your internet browser. 

2. Type the address http://<server address>/campaign/campcgi.html. The log in window opens. 

 

3. (Optional) To change the language click the language Continue button. A menu containing the countries 
flag is shown. If you place your mouse cursor over a flag, the language that it represents in indicated.  

 Click the required flag to change the language. 

4. (Optional) To change the sound preferences click the Sound Prefs Continue button.  

 Select the playback type of either the browser default or as background. The option background is 
the default selection. 

 Click Back to continue. 

5. Enter your mailbox box name in the User Name field.  
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6. Click Continue. The Campaign Web interface opens. 

 

7. Select the campaign results that you want to view. 

8. Select the type of results that you want to view.  
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9. Click Submit to view the results. The details are listed in the main part of the window. 
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VoiceMail Pro Dial by Name 
Overview 
The Dial by Name action allows callers to indicate the user or group that they require by dialing the name on their 
telephone keypad and then making a selection from the matches found. 

To use this feature the caller must use a telephone with DTMF dialing and with ITU alphabet letter keys as shown 
here. 

 

 

The main pre-requisites before a Dial by Name action can be used are: 

1. User Names  
The user names are set through the IP Office Manager. Either the user's Name or Full Name field can be 
used for Dial by Name. If the Full Name field is set then it takes precedence over the Name field. 

 Changing Names  
VoiceMail Pro mailboxes are created to match existing user Name's. If a user Name is changed, 
VoiceMail Pro will create a new mailbox to match the new Name. Therefore care must be taken to 
ensure that Name field entries are as accurate as possible when first setting up users. Using the 
Full Name field for Dial by Name is recommended as the Full Name entry can be changed without 
affecting the existing mailbox entries. 

2. User Name Recordings  
Each mailbox to be included by the Dial by Name action needs to have had a user name recorded. This 
can be done in two ways: 

 Intuity Mailbox Mode  
By default when the user first enters their mailbox, they will be asked to set their voicemail code 
password and then to record their name. 

 IP Office Mailbox Mode 
In this mode you need to set up a call flow that allows users to record their name. In this document 
we have included an example module that can be used for that purpose. The same module can 
also be used by Intuity mode mailbox systems to let users re-record their names. For more 
information, see Adding a Record Name Module. 
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Example Call Flow: Dial by Name  
In this example, after selecting a name using the Dial by Name service, the caller is transferred to the matching 
extension. If that extension doesn't answer or is busy the caller is transferred to leave a message. 

 A copy of this module can be found in VoiceMail Pro Examples. 

 

 

1. In VoiceMail Pro a new module was added called Dial by Name. 

2. From  Telephony Actions the Dial by name action was added. 

3. From  Telephony Actions an Assisted Transfer action was also added. In its properties Specific tab 
the Mailbox was set as $KEY. 

4. The Dial by name action's True result was connected to the Assisted Transfer action. 

5. From  Mailbox Actions a Leave Mail action was added. 
Again in its Specific tab the Mailbox was set as $KEY. Links were added from the Assisted Transfer 
action's No Answer and Busy results to this action. 

 

To add a short code: 

1. In IP Office Manager, a new system short code was added. For this example we chose *75 and then 
entered the details as shown below. 

Field Contains... 
Code *75 
Feature Voicemail Collect 
Telephone Number "Dial by Name" 
Line Group Id 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

2. After merging this back into the IP Office, users can dial *75 to access dial by name. They can also transfer 
callers to this call flow. 

3. The short code can be added a SoftConsole or DSS button. In addition, an Incoming Call Route could be 
used to direct specific external calls direct to the function, for example if you had a specific external number 
used by employees to ring in when off site. 
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Adding a Record Name Module 
This module allows users to record/re-record their mailbox name. This, or a similar module, is necessary if 
VoiceMail Pro is using IP Office mailbox mode. However it is still useful if the VoiceMail Pro is using Intuity mailbox 
mode as it gives users quick access to re-record their name. 

 

 

1. In VoiceMail Pro, a new module called Record Name was added. 

2. A Record Name action was added. 

3. In the General tab of the Record Name action's properties we set the Pin as $. The $ means that caller's 
must enter their voicemail code in order to use the action. 

 
The Specific tab was left set to the Caller's Mailbox. 

4. The module was saved and made live. 

 

To add a Shortcode: 

1. In IP Office Manager, a new system short code was added. In this example, we chose *74 and then 
entered the details as shown in the table. 

Field Contains... 
Code *74 
Feature Voicemail Collect 
Telephone Number "Record Name" 
Line Group Id 0 
Locale [Leave blank] 
Force Account Code [Leave blank] 

2. After merging this back into the IP Office, users can dial *74 at their extension to record their mailbox 
name. 
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Using the Name Table 
It is possible to create a service that will allow access to re-record the name of any mailbox. The NameWavsTable 
does this by requesting an extension number and then allowing you to play, re-record and submit a name recording 
for that extension. It then allows another extension number to be entered and so on. 

Naturally if this option is used it should be behind suitable PIN code and other security protection as it allows the 
recording of names for any mailbox. 

To use the Name table: 

1. In VoiceMail Pro, create a new module. 

2. Add a Goto action and open its properties. 

3. In the General tab, enter a unique number in the Pin. 

4. In the Specific tab, in Please select a node to go to enter NameWavsTable. 

5. Click OK. 

6. Using a short code or other method, create a route to the new module. 

 

Changing Full Names 
Users with DS port display phones can set and change the way in which their full name is displayed through their 
telephone. This name will then be used for the text matching part of Dial by Name. 

To changing your name using a telephone with a menu  Key: 

1. Press Menu  twice. 

2. Press  and select ProgA. 

3. Press  and select Name. 

4. Enter the new name. Use the dialing keys and Rotat to enter characters. For example, to enter an L, press 
the 5 key and then press Rotat until an L is displayed. You can use the top-left display key to backspace. 

5. When the text is as you require, press Done. 

6. Press Exit . 
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Using VB Script 
The VB Script Action 

The VB Script action allows an administrator to construct additional call flow logic using VBScript commands. A 
number of predefined methods and system variables are available. Any scripting added can be verified by pressing 
the Syntax Check button. Details of the properties and methods supported are given in the VBScript section. For 
more information, see VBScript Properties:Overview. 

 Use of VBScript requires entry of a valid VM Pro VBScript license in the IP Office configuration. 

 

To add a VB Script action: 

1. Click the  Miscellaneous Actions icon and select VB Script. 

2. Select the Specific tab.  

 

 Enter VBScript:  
In the Script area enter the VBScript as required. Details of the System variables and COM 
methods that are supported are accessible by right clicking in the VBScript area. This script can 
contain a maximum of 1000 characters. 

 Expand 
Check Expand to view a larger script area. 

 Syntax Check 
Click the Syntax Check button to check your input for any errors. 

 

This action has two results for which connections to following actions can be made. The results are 
based on the Scripting entered in the Specific tab. 
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VBScript Properties 
Overview 
The following properties can be accessed within VBScripts. Note that unless otherwise stated they are session 
based. The data is specific to a particular VoiceMail Pro call and does not persist between calls.  

Voicemail contains various state variables that are associated with a specific interaction with voicemail. The system 
variables listed map to properties associated with the object: 

 $NAM – (read-only). For more information, see Name Property. 

 $CLI – (read-only). For more information, see CallingParty Property. 

 $RES – (read-write). For more information, see Result Property. 

 $VAR – (read-write). For more information, see Variable Property. 

 $SAV – (read-write). For more information, see SavedResult Property. 

 $LOC – (read-write).For more information, see Locale Property. 

 

The following properties are specific to queued and still queued call flows only. 

 $QPOS –  (read-only).For more information, see PositionInQueue Property. 

 $QTIM –  (read-only). For more information, see EstimatedAnswer Property. 

 

The following properties are related to the messages within the mailbox. 

 NewMsgs Property – Returns the count of new messages within the session’s mailbox. For more 
information, see NewMsgs Property. 

 OldMsgs Property – Returns the count of old messages within the session’s mailbox. For more 
information, see OldMsgs Property. 

 SavedMsgs Property – Returns the count of saved messages within the session’s mailbox. For more 
information, SavedMsgs Property. 

 LastAccessedMsg Property – Returns the name of the last recorded or accessed message. For more 
information, see LastAccessedMsg Property. 

Note: VB Scripting will only support variant types. 

 

Internal Variables 

Some of the variables that exist within VoiceMail Pro can be split into smaller sections using a delimiter. 

 Example:  
A CLI contains the number 01707364143.  If the call flow references the variable as CLI@0,4 then the 
value 01707 will be returned as they are the first five numbers. 
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CallingParty Property 
The CallingParty property returns the caller id associated with the voicemail session used for VBS interaction with 
Voicemail (equivalent to $CLI system variable). 

 Owning object: vmprov5.voicescript 

 String: 

 Set: This property is read-only. 

 Get: A String object containing the name of the calling party (or $CLI). For example:  

 String = Voice.CallingParty 

 Remarks: The CallingParty property is only valid for the current session to Voicemail. 

 Example 

Sub Main (dlgid) 
dim registration 
Set Voice = CreateObject("vmprov5.voicescript") 
registration = Voice.Register(dlgid) 
if registration Then 
           dim callerid 
           callerid = Voice.CallingParty 
end if 
End Sub 

 

EstimatedAnswer Property 
The EstimatedAnswer property returns the $QTIM voicemail system variable. This is the user’s estimated time to 
answer within the queue in seconds and is only available for queued and still queued call flows. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: This property is read-only. 

 Get: A long containing the current value for $QTIM. For example:  

 Long = Voice.EstimatedAnswer 

 

LastAccessedMsg Property 
The LastAccessedMsg property returns the name of the last recorded message. If the IP Office TUI is used then 
this will also contain the name of the last played message. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: This property is read-only. 

 Get: A string object containing the fully qualified name of the last played or recorded message. For 
example:  

 String = Voice.LastAccessedMsg 
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Locale Property 
The Locale property gets and sets the $LOC voicemail system variable. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: A string object that contains the new value for the $LOC variable. For example:  

 Voice.Locale = String 

 Get: A string object containing the current value for $ LOC. For example:  

 String = Voice.Locale 

 Example 

Sub Main (dlgid) 
dim registration 
Set Voice = CreateObject("vmprov5.voicescript") 
registration = Voice.Register(dlgid) 
if registration Then 
           dim locale        
           DO SOME PROCESSING. 
            locale = Voice.Locale 
            Rem NOW SET LOCALE TO FRENCH 
            Voice.Locale = “fr” 
            DO SOME PROCESSING. 
            Rem NOW SET LOCALE BACK TO WHAT IT WAS 
            Voice.Locale = locale 
end if 
End Sub 

 

Name Property 
The Name property returns the name of the mailbox associated with the voicemail session used for VBScript 
interaction with Voicemail (equivalent to $NAM system variable). 

 Owning object: vmprov5.voicescript 

 String: 

 Set: This property is read-only. 

 Get: A String object containing the name of the associated voice mailbox. for example:  

 String = Voice.Name 

 

NewMsgs Property 
The NewMsgs property returns the number of new messages contained within the session mailbox. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: This property is read-only. 

 Get: The number of new messages within the mailbox. For example:  

 Number = Voice.NewMsgs 
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OldMsgs Property 
The OldMsgs property returns the number of old messages contained within the session mailbox. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: This property is read-only. 

 Get: The number of old messages within the mailbox. For example:  

 Number = Voice.OldMsgs 

 

PositionInQueue Property 
The PositionInQueue property returns the $QPOS voicemail system variable. This is the user’s current position in 
the queue and is only available for queued and still queued call flows. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: This property is read-only. 

 Get: A string object containing the current value for $QPOS. For example:  

 String = Voice.PositionInQueue 

 

Result Property 
The Result property gets and sets the $RES voicemail system variable. The $RES variable contains the result 
property of a call flow action. The result is action-specific, for example OK, FAILED, BUSY and so on. The call flow 
action is able to use the variable to determine logic to be based upon the Result of a preceding Action, or as a 
temporary variable in the VB-Script. However the variable will be overwritten after the VB Action is completed. If the 
values from the VB action icon need to be passed to subsequent actions, it is advisable to use user variables. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: A string object that contains the new value for the $RES variable. For example:  

 Voice.Result = String 

 Get: A string object containing the current value for $RES. For example:  

 String = Voice.Result 

 Example 

Sub Main (dlgid) 
dim registration 
Set Voice = CreateObject("vmprov5.voicescript") 
registration = Voice.Register(dlgid) 
if registration Then 
           dim result  
           dim success  
            DO SOME PROCESSING. 
            if success Then 
                        Voice.Result = TRUE 
            else 
                        Voice.Result = FALSE 
end if 
End Sub 
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SavedMsgs Property 
The SavedMsgs property returns the number of saved messages contained within the session mailbox. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: This property is read-only. 

 Get: The number of saved messages within the mailbox. For example:  

 Number = Voice.SavedMsgs 

 

SavedResult Property 
The SavedResult property gets and sets the $SAV voicemail system variable. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: A string object that contains the new value for the $SAV variable. For example:  

 Voice.SavedResult = String 

 Get: A string object containing the current value for $SAV. For example:  

 String = Voice.SavedResult 

 

Variable Property 
The Variable property gets and sets the $VAR voicemail system variable. 

 Owning object: vmprov5.voicescript 

 String: 

 Set: A string object that contains the new value for the $VAR variable. For example:  

 Voice.Variable = String 

 Get: A string object containing the current value for $VAR. For example:  

 String = Voice.Variable 
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VBScript Methods 
ForwardMsg Method 
The ForwardMsg method is used to forward a file or message to other mailboxes. 

Voice.ForwardMsg( 
          file As String, 
          mailboxes As String, 
          ident As String 
) 

 Parameters 

 file - This contains the name of the message file to be forwarded. The following formats are 
allowable: 

 [GREETINGS]\greeting 
Forwards the greeting stored within the greetings directory (the .WAV extension is 
automatically appended).  

 [ACCOUNTS]\mailbox\message 
Forwards the message stored within the specified mailbox (the .WAV extension is 
automatically appended). 

 [CAMPAIGNS]\campaign\message 
Forwards a campaign message stored within the specified campaign (the .WAV extension 
is automatically appended). 

 If the fully qualified path is specified (drive:\path\file) then the full specified pathname is 
used otherwise the file is relative to the WAVS directory. 

 mailboxes - The list of mailboxes to forward the message to (separated by non digits, e.g. 202 203 
204). 

 ident - The CLI to be associated with the message. 

 Return Value  
This method does not return a value. 
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ForwardMsgToMailbox Method 
The ForwardMsgToMailbox method is used to forward a file or message to another mailbox. 

Voice.ForwardMsgToMailbox( 
          file As String, 
          mailbox As String, 
          ident As String 
) As String 

 Parameters 

 file - This contains the name of the message file to be forwarded. The following formats are 
allowable: 

 [GREETINGS]\greeting 
Forwards the greeting stored within the greetings directory (the .WAV extension is 
automatically appended).  

 [ACCOUNTS]\mailbox\message  
Forwards the message stored within the specified mailbox (the .WAV extension is 
automatically appended). 

 [CAMPAIGNS]\campaign\message  
Forwards a campaign message stored within the specified campaign (the .WAV extension 
is automatically appended). 

 If the fully qualified path is specified (drive:\path\file) then the full specified pathname is 
used otherwise the file is relative to the WAVS directory. 

 mailbox - The mailbox to forward the message to. 

 ident - The CLI to be associated with the message. 

 Return Value 
The name of the new message. 

 

FullFilename Method 
The FullFilename method is used to translate the shortcut filename to the equivalent fully qualified pathname for 
the file. 

Voice.FullFilename( 
            file As String 
) As String 

 Parameters 

 file - This contains the name of the file to be translated: 

 [GREETINGS]\greeting 
The file is relative to the greetings directory.  

 [ACCOUNTS]\mailbox\message 
The file is relative to the accounts directory. 

 [CAMPAIGNS]\campaign\message 
The file is relative to the campaigns directory. 

 If the fully qualified path is specified (drive:\path\file) then the full specified path name is 
used otherwise the file is relative to the specified locale within the WAVS directory. 

 Return Value  
The equivalent fully qualified path name for the specified file. 
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GetCallingParty Method 
The GetCallingParty method is used to obtain the $CLI session variable. 

Voice.GetCallingParty( 
             [dlgid As Long = 0] 
) As String 

 Parameters 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The value of the $CLI session variable associated with the specified voicemail session. 

 

GetDTMF Method 
The GetDTMF method is used to return user’s DTMF input. 

Voice.GetDTMF( 
          [digits As Long = 1], 
          [timeout As Long = 30], 
          [dlgid As Long = 0] 
) As String 

 Parameters 

 digits - The maximum number of DTMF digits to capture. 

 timeout - The maximum time to wait for DTMF input. 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The DTMF keys that were pressed. 

 

GetEstimatedAnswer Method 
The GetEstimatedAnswer method is used to obtain the $QTIM session variable. 

Voice. GetEstimatedAnswer ( 
             [dlgid As Long = 0] 
) As String 

 Parameters 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The value of the $QTIM session variable associated with the specified voicemail session. 
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GetExtension Method 
The GetExtension method is used to obtain an extension. 

Voice.GetExtension( 
            index As Long, 
) As String 

 Parameters 

 index - The extension to return. Note: The actual extension number should not be entered as 
index refers to the offset number of the extension in the listing. 

 Return Value 
The extension at that position within the list (an empty string if end of list). 

 

 Example 

Sub Main (dlgid) 
dim registration 
Set Voice = CreateObject("vmprov5.voicescript") 
registration = Voice.Register(dlgid) 
if registration Then 
         dim index  
         dim ext  
          index = 0 
          Do 
                      ext = Voice.GetExtension(index) 
                      index = index + 1 
          Loop Until Len(ext) = 0 
end if 
End Sub 

 

GetLocale Method 
The GetLocale method is used to obtain the $LOC session variable. 

Voice.GetLocale( 
           [dlgid As Long = 0] 
) As String 

 Parameters 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The value of the $LOC session variable associated with the specified voicemail session. 

 

GetMailbox Method 
The GetMailbox method is used to obtain a mailbox. 

Voice.GetMailbox( 
            index As Long, 
) As String 

 Parameters 

 index - The mailbox to return.  
The actual mailbox number should not be entered as index refers to the offset number of the 
mailbox in the listing. 

 Return Value 
The mailbox at that position within the list (an empty string if end of list). 
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GetMailboxMessage Method 
The GetMailboxMessage method is used to obtain a message within a mailbox. 

Voice.GetMailboxMessage( 
            mailbox As String, 
            msgtype As String, 
            index As Long, 
) As String 

 Parameters  

 mailbox - The mailbox to return messages for. 

 msgtype - The type of messages to return.  
This can start with an N for new messages, O for old messages and S for saved messages. 

 index - The message to return. 

 Return Value 
The message at that position within the list (an empty string if end of list). 

 

GetMailboxMessages Method 
The GetMailboxMessages method is used to obtain the count of specific messages within a mailbox. 

Voice.GetMailboxMessages( 
            mailbox As String, 
            msgtype As String 
) As Long 

 Parameters 

 mailbox - The mailbox to return message counts for. 

 msgtype - The type of messages to return counts for. 
This can start with an N to obtain the number of new messages, O for old messages and S for 
saved messages. 

 Return Value 
The number of messages of a particular type within the mailbox. 

 

GetMessagePriority Method 
The GetMessagePriority method is used to determine whether the message was left with priority. 

Voice.GetMessagePriority( 
            mailbox As String, 
            message As String 
) As Boolean 

 Parameters 

 mailbox - The mailbox that the message belongs to. 

 message - The message to query. 

 Return Value 
True if the message was left with priority, otherwise False. 
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GetMessagePrivate Method 
The GetMessagePrivate method is used to determine whether the message was left with privacy. 

Voice.GetMessagePrivate( 
          mailbox As String, 
          message As String 
) As Boolean 

 Parameters 

 mailbox - The mailbox that the message belongs to. 

 message - The message to query. 

 Return Value 
True if the message was left with privacy, otherwise False. 

 

GetMessageStatus Method 
The GetMessageStatus method is used to obtain the state of the message within a mailbox. 

Voice.GetMessageStatus( 
          mailbox As String, 
          message As String 
) As String 

 Parameters 

 mailbox - The mailbox that the message belongs to. 

 message - The message to query. 
The message name format should be [Accounts]\mailbox\message.  for example,. 
[Accounts]\Extn247\MSG00004. 

 Return Value 
The state of the message within the mailbox. N for new, O for old, S for saved. 

 

GetName Method 
The GetName method is used to obtain the $NAM session variable. 

Voice.GetName( 
             [dlgid As Long = 0] 
) As String 

 Parameters 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The value of the $NAM session variable associated with the specified voicemail session. 

 

GetNewMsgs Method 
The GetNewMsgs method is used to obtain the number of new messages contained within the session’s mailbox. 

Voice.GetNewMsgs ( 
             [dlgid As Long = 0] 
) As Long 

 Parameters 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The number of new messages contained within the session’s mailbox. 
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GetOldMsgs Method 
The GetOldMsgs method is used to obtain the number of old messages contained within the session’s mailbox. 

Voice.GetOldMsgs ( 
             [dlgid As Long = 0] 
) As Long 

 Parameters 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The number of old messages contained within the session’s mailbox. 

 

GetPositionInQueue Method 
The GetPositionInQueue method is used to obtain the $QPOS session variable. 

Voice. GetPositionInQueue ( 
             [dlgid As Long = 0] 
) As String 

 Parameters 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The value of the $QPOS session variable associated with the specified voicemail session. 

 

GetRegister Method 
The GetRegister method is used to retrieve a string stored in one of the session sixteen data variables. ($CP0 to 
$CP15). 

Voice.GetRegister( 
            regnum As Long, 
            [dlgid As Long = 0] 
) As String 

 Parameters  

 regnum - Data register to use for storage (0-15). 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The data stored within the specified register. 

 

GetResult Method 
The GetResult method is used to obtain the $RES session variable. 

Voice.GetResult( 
             [dlgid As Long = 0] 
) As String 

 Parameters  

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The value of the $RES session variable associated with the specified voicemail session. 
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GetSavedMsgs Method 
The GetSavedMsgs method is used to obtain the number of saved messages contained within the session’s 
mailbox. 

Voice.GetSavedMsgs ( 
             [dlgid As Long = 0] 
) As Long 

 Parameters 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The number of saved messages contained within the session’s mailbox. 

 

GetSavedResult Method 
The GetSavedResult method is used to obtain the $SAV session variable. 

Voice.GetSavedResult( 
             [dlgid As Long = 0] 
) As String 

 Parameters  

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The value of the $SAV session variable associated with the specified voicemail session. 

 

GetVariable Method 
The GetVariable method is used to obtain the $VAR session variable. 

Voice.GetVariable( 
           [dlgid As Long = 0] 
) As String 

 Parameters 

 dlgid - The connection ID as passed in to the script. 

 Return Value  
The value of the $VAR session variable associated with the specified voicemail session. 

 

MessageCLI Method 
The MessageCLI method is used to obtain the CLI of the caller that left the message within a mailbox. 

Voice.MessageCLI( 
          mailbox As String, 
          message As String 
) As String 

 Parameters 

 mailbox - The mailbox that the message belongs to. 

 message - The message to query. 

 Return Value  
The CLI of the caller that left the message. 
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MessageDisplay Method 
The MessageDisplay method is used to obtain the display field associated with the message within a mailbox. 

Voice.MessageDisplay( 
          mailbox As String, 
          message As String 
) As String 

 Parameters  

 mailbox - The mailbox that the message belongs to. 

 message - The message to query. 

 Return Value  
The display string associated with the message. 

 

MessageLength Method 
The MessageLength method is used to obtain the length of a message within a mailbox. 

Voice.MessageLength( 
          mailbox As String, 
          message As String 
) As Long 

 Parameters  

 mailbox - The mailbox that the message belongs to. 

 message - The message to query. 

 Return Value  
The length of the message in milliseconds. 

 

MessageTime Method 
The MessageTime method is used to obtain the date and time the message was left within a mailbox. 

Voice.MessageTime( 
          mailbox As String, 
          message As String 
) As String 

 Parameters 

 mailbox - The mailbox that the message belongs to. 

 message - The message to query. 

 Return Value  
The time the message was left in the format: YEAR/MONTH/DAY HOUR:MINUTE. For example 
2003/09/23 13:26. 
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PlayDigits Method 
The PlayDigits method is used to play the digits specified through voicemail to the active connection. 

Voice.PlayDigits( 
            digits As String, 
            [wait As Boolean = True], 
            [interruptables As String = “Any”], 
            [dlgid As Long = 0] 
) As String 

 Parameters  

 digits - This contains the digits to be played (e.g. “12345” plays “one two three four five”). 

 wait - This is an optional parameter specifying whether voicemail should return immediately or wait 
until the digits have been played first. 

 interruptables - This is for future development and should be left as default. 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The key press that was used to terminate the playback. 

 Example 

Sub Main (dlgid) 
dim registration 
Set Voice = CreateObject("vmprov5.voicescript") 
registration = Voice.Register(dlgid) 
if registration Then 
           dim key 
            key = Voice.PlayDigits(“12345”); 
end if 
End Sub 
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PlayLocaleWav Method 
The PlayLocaleWav method is used to play a wave file through voicemail to the active connection taking into 
account the system locale. 

Voice.PlayLocaleWav( 
            wav As String, 
            [wait As Boolean = True], 
            [interruptables As String = “Any”], 
            [dlgid As Long = 0] 
) As String 

 Parameters  

 wav - This contains the name of the wave file to be played and is of the following format: 

 [GREETINGS]\greeting  
Plays out the greeting stored within the greetings directory (the .WAV extension is 
automatically appended).  

 [ACCOUNTS]\mailbox\message  
Plays out the message stored within the specified mailbox (the .WAV extension is 
automatically appended). 

 [CAMPAIGNS]\campaign\message  
Plays out a campaign message stored within the specified campaign (the .WAV extension 
is automatically appended). 

 If the fully qualified path is specified (drive:\path\file) then the full specified path name is 
used otherwise the file is relative to the specified locale within the WAVS directory. 

 wait - This is an optional parameter specifying whether voicemail should return immediately or wait 
until the wave file has been played first. 

 interruptables - This is for future development and should be left as default. 

 dlgid - The connection ID as passed in to the script. 

 Return Value  
The key press that was used to terminate the playback. 
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PlayWav Method 
The PlayWav method is used to play a wave file through voicemail to the active connection. 

Voice.PlayWav( 
            wav As String, 
            [wait As Boolean = True], 
            [interruptables As String = “Any”], 
            [dlgid As Long = 0] 
) As String 

 Parameters 

 wav - This contains the name of the wave file to be played or the name of a system parameter to 
be spoken. The following formats are allowable: 

 $NAM 
Plays the recorded name for the mailbox if one has been recorded. If a name has not been 
recorded then optional TTS can be used (providing it has been licensed). 

 $TIME:hh[:mm[:ss] [ Y][ dd[/mm[/yy]]]]  
Plays out the specified time and date. The hours to speak must always be specified and 
optional the number of minutes, seconds, day, month and year.  
For example: 

 $TIME:11 
Speaks  AT ELEVEN HOUR HUNDRED 

 $TIME:11:55 
Speaks  AT ELEVEN HOUR FIFTY FIVE 

 $TIME:11:55:13 
Speaks  AT ELEVEN HOUR FIFTY FIVE 

 $TIME:11:55 Y 
Speaks  YESTERDAY AT ELEVEN HOUR FIFTY FIVE 

 $TIME:11:55:13 Y 
Speaks  YESTERDAY AT ELEVEN HOUR FIFTY FIVE 

 $TIME:11:55 21/09/03 
Speaks  AT ELEVEN HOUR FIFTY FIVE [1SEC PAUSE] DATE TWENTY FIRST 
SEPTEMBER  

 $QPOS [:position]  
This plays out “You are at queue position” position “in the queue”. 

 $QTIM [:eta]  
This plays out “Estimated time to answer is” eta “minutes”. 

 $MSGN:msgs  
Plays out the specified number of old messages (e.g. $MSGN:10 = “You have ten new 
messages”.  

 $MSGO:msgs  
Plays out the specified number of old messages (e.g. $MSGN:0 = “You have no old 
messages”.  

 $MSGS:msgs  
Plays out the specified number of old messages (e.g. $MSGS:5 = “You have five saved 
messages”.  

 $CID, $CLI, $CP, $DATE, $DBD, $DLG, $ETA, $KEY, $LOC, $POS, $SAV, $TIME, 
$UUI, $VAR 
Plays out the contents on one of the system variables. 

 If the string just contains numbers, then the digits are played, for example 12345 plays 
"one two three four five". 

 [GREETINGS]\greeting 
Plays out the greeting stored within the greetings directory (the .WAV extension is 
automatically appended).  
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 [ACCOUNTS]\mailbox\message 
Plays out the message stored within the specified mailbox (the .WAV extension is 
automatically appended). 

 [CAMPAIGNS]\campaign\message 
Plays out a campaign message stored within the specified campaign (the .WAV extension 
is automatically appended). 

 If the fully qualified path is specified (drive:\path\file) then the full specified pathname is 
used otherwise the file is relative to the WAVS directory. 

 wait - This is an optional parameter specifying whether voicemail should return immediately or wait 
until the wave file has been played first. 

 interruptables - This is for future development and should be left as default. 

 dlgid - The connection ID as passed in to the script. 

 Return Value  
The key press that was used to terminate the playback. 

 Example 

Sub Main (dlgid) 
dim registration 
Set Voice = CreateObject("vmprov5.voicescript") 
registration = Voice.Register(dlgid) 
if registration Then 
         dim key 
          key = Voice.PlayWav(“test”, True, “Any”, dlgid); 
end if 
End Sub 
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RecordMsg Method 
The RecordMsg method is used to record a user’s speech input to the specified file. 

Voice.RecordMsg( 
            recording As String, 
            maxtime As long, 
            [interruptables As String = “Any”], 
            [appendtofile As Boolean = False], 
            [dlgid As Long = 0], 
            [playbeep As Boolean = False] 
) As String 

 Parameters  

 recording - This contains the name of the file for the recording to be stored to and can be in the 
following formats: 

 [GREETINGS]\greeting 
Stores the recording in the specified file within the greetings directory.  

 [ACCOUNTS]\mailbox\message  
Stores to the specified message within the specified mailbox. 

 [CAMPAIGNS]\campaign\message  
Stores to the specified message within the specified campaign. 

 If the fully qualified path is specified (drive:\path\file) then the full specified pathname is 
used otherwise the file is relative to the specified locale within the WAVS directory. 

 maxtime - The maximum recording length specified in seconds. 

 interruptables - This is for future development and should be left as default. 

 appendtofile - Set to true if the recording should be appended to the file, false to clear the file first. 

 dlgid - The connection ID as passed in to the script.  

 playbeep - This flag sets whether a beep is played before the start of recording.  

 Return Value 
The key press that was used to terminate the recording. 

 

RecordRegister Method 
The RecordRegister method is used to record a user’s speech input to the specified file stored in the specified 
register. 

Voice.RecordRegister( 
          regnum As Long, 
          [maxtime As Long = 60], 
          [interruptables As String = “-1”], 
          [dlgid As Long = 0], 
          [playbeep As boolean = False] 
) As String 

 Parameters 

 regnum - Data register containing file to store recording to. 

 maxtime - The maximum recording length specified in seconds. 

 interruptables - This is for future development and should be left as default. 

 dlgid - The connection ID as passed in to the script.  

 playbeep - This flag sets whether a beep is played before the start of recording.  

 Return Value  
The key press that was used to terminate the recording. 
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Register Method 
The Register method is used to determine whether the voicemail session that was used to launch the VB script is 
still active. 

Voice.Register( 
          dlgid As Long 
) As Boolean 

 Parameters  

 dlgid - An ID that is associated with the Voicemail connection. This is passed as a parameter to 
the VB script. 

 Return Value  
A Boolean variable indicating whether the specified voicemail session is still active. 

 Example 

Sub Main (dlgid) 
dim registration 
Set Voice = CreateObject("vmprov5.voicescript") 
registration = Voice.Register(dlgid) 
if registration Then 
            do something. 
end if 
End Sub 

 

SetLocale Method 
The SetLocale method is used to set the $LOC session variable. 

Voice.SetLocale( 
            locale As String, 
             [dlgid As Long = 0] 
) 

 Parameters  

 locale - The new value for the $LOC variable. 

 dlgid - The connection ID as passed in to the script. 

 Return Value  
This method does not return a value. 

 

SetMailboxMessage Method 
The SetMailboxMessage method is used to modify a message within a mailbox. 

Voice.SetMailboxMessage( 
            mailbox As String, 
            message As String, 
            msgtype As String, 
) 

 Parameters 

 mailbox - The mailbox that the return message belongs to. 

 message - The message to modify. The message name format should be 
[Accounts]\mailbox\message.  For example [Accounts]\Extn247\MSG00004. 

 msgtype - The new statue type for the message. This can start with an N for new, O for old and S 
for saved. 

 Return Value 
This method does not return a value. 
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SetRegister Method 
The SetRegister method is used to store a string in one of the sixteen session data variables ($CP0 to $CP15). 

Voice.SetRegister( 
          regnum As Long, 
          data As String, 
          [dlgid As Long = 0] 
) 

 Parameters 

 regnum - Data register to use for storage (0-15). 

 data - The data to store within this register. 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
This method does not return a value. 

 

SetResult Method 
The SetResult method is used to set the $RES session variable. 

Voice.SetResult( 
            result As String, 
             [dlgid As Long = 0] 
) 

 Parameters 

 result - The new value for the $RES variable. 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
This method does not return a value. 

 

SetSavedResult Method 
The SetSavedResult method is used to set the $SAV session variable. 

Voice.SetSavedResult( 
          result As String, 
           [dlgid As Long = 0] 
) 

 Parameters 

 result - The new value for the $SAV variable. 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
This method does not return a value. 
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SetVariable Method 
The SetVariable method is used to set the $VAR session variable. 

Voice.SetVariable( 
          variable As String, 
           [dlgid As Long = 0] 
) 

 Parameters 

 variable - The new value for the $VAR variable. 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
This method does not return a value. 

 

Speak Method 
The Speak method is used to speak out the specified speech provided TTS has been licensed. 

Voice.Speak( 
            text As String, 
            [wait As Boolean = True], 
            [interruptables As String = “Any”], 
            [dlgid As Long = 0] 
) As String 

 Parameters 

 text - This contains the text to be spoken.  

 wait - This is an optional parameter specifying whether voicemail should return immediately or wait 
until the wave file has been played first. 

 interruptables - This is for future development and should be left as default. 

 dlgid - The connection ID as passed in to the script. 

 Return Value 
The key press that was used to terminate the playback. 
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IVR Database Connection 
IVR: Connecting VoiceMail Pro to a Database 
VoiceMail Pro call flows can interact, read and write data, with almost any Windows database that supports ODBC 
(Open Database Connectivity) and SQL (Structured Query Language) format. 

 Requirements for VoiceMail Pro Database Operation 
To use the Database actions within VoiceMail Pro, a VM Pro Database Interface must be added to the IP 
Office configuration. 

The  Database Actions that can be used in a call flow are: 

 Database Open 
Opens the required database, including any necessary permissions and security options. 

 Database Execute 
Defines a SQL query to either read matching records from the database or to write data to the database. 
Up to 6 fields can be defined to be returned in matching database records. 

 Database Get Data 
Selects the current record from the matches returned by the preceding Database Execute action. The 
record fields are then placed into VoiceMail Pro variables DBD[0] to DBD[5]. The Database Get Data 
allows selection of the first, next, previous or last record. 

 Database Close 
Closes the database connection. This also occurs automatically if the caller disconnects. 

 

Example 
Database Scenario 
In this call flow example, an auto-attendant has been created to allow callers to order books. The book details are 
held within a Microsoft Access database. Callers will be able to enter either the ISBN or Author's name. The title 
and cost of the item will be looked up allowing the caller to purchase the item if they wish to. If the caller purchases 
the book they will be able to enter their credit card details and a contact number. 

Example of the database used in the call flow. 

 

Note 

 A copy of this database, the VoiceMail Pro database and the wav files used can be found in Example 
VoiceMail Pro Modules. 
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Retrieving Data from the Database 
The Bookshop_Welcome module allows callers to choose to search the database by either the books ISBN 
number or the author's name. The screen below shows the call flow module used when a search by ISBN is 
selected. The database actions that have been used are shown below the call flow diagram, with details on the 
following pages. 
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Database Open Action 

The Database Open Action is used to link to the bookshop database. 

 

The specific tab of the action contains the location of the database. Click the browse button to view the Data Link 
Properties dialog. The details entered into these screens will depend upon the type of database used. This 
example uses a Microsoft Access Database. The example shown below shows the connection to the database. If 
the database is available the callers move through the call flow to a menu action that will capture the ISBN number 
entered. 
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Database Execute Action 

The Database Execute Action contains a query against the open database, in this example it concerns the ISBN 
captured in the previous menu action. 

 

If the sequence of numbers entered by the caller matches an ISBN entry in the database, then the Author's name, 
cost, ISBN and book title details are captured. This query is entered into the Database Execute Action via the 
specific tab. 

When entering information into the specific tab for the first time you are taken through a series of steps. 

1. Select the Database Open Icon required. In this example the 'Make sure Database still active' icon was 
selected. 

2. At the SQL Function window the option to 'Select …From' was chosen as information from the database is 
required. 

3. Details are then entered into the SQL Wizard, as shown below. 
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4. When the query has been entered the SQL wizard is closed. The specific tab of the action will contain the 
entered query, see example shown below. 

 

 

Database Get Data Action 

The Database Get Data Action is used to return details of any matching entries following a search against a 
database. 

 

To retrieve the results an option is selected on the specific tab to select how the data is retrieved from the 
database. In this example the option 'retrieve the next item in the list' was selected to allow the caller to step 
through the results, if more that one match ISBN occurred. 

 

If a matching ISBN has been found the call flow is routed to another module called 
'Bookshop_CurrentBookSpeakDetails'.  
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Returning Data from the Database 
The Bookshop_CurrentBookSpeakDetails module tells the caller the book title, the author's name and the cost 
of the book matching the ISBN that they entered. 

 

 

The information from the database is conveyed to the caller using the 'Speak Text Action'.  

 To use the Speak Action, the IP Office must be licensed for and have installed Text to Speech. 
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Speak Book Title 

The Speak Book Title action is used to tell the caller the book title associated with the ISBN that was entered. 

 

The fields selected in the 'Request ISBN from DB' action contain the information retrieved from the bookshop 
database. The fields selected were Author, Cost, ISBN and Title.  

 

Any fields selected in a query will appear in alphabetical order. 

 $DBD[0] would return details from the field Author  

 $DBD[1] would return details from the field Cost 

 $DBD[2] would return details from the field ISBN 

 $DBD[3] would return details from the field Title.  

 

Each Speak Text action in the call flow returns the values from a different field selected within the database 
query. The 'Speak Book Cost' action has additional text added so that the currency can be spoken. In this example 
pounds are used. 
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Entering Details into the Database 
The caller is given an option to buy the book. If they select to buy the book, the call flow module 
Bookshop_CurrentBookBuy operates. The call flow immediately checks that access to the bookshop database is 
still available via a Database Open action. 

 

 

Confirm Book Details 

Generic actions are used to store the ISBN number and cost. The example below shows how the ISBN number is 
stored in the system variable CP0. 

 

When the details have been stored the book title and cost are spoken to the caller using a Speak Text action. See 
the example below. 
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Collect Callers Details 

Details can be entered into a database by a caller. In this example we collect the caller's credit card number, expiry 
date and telephone number. All these details are collected and then the database is updated. The example below 
shows the Specific tab entry used to collect the caller's telephone number and assign it to the system variable CP4. 

 

When all the details have been collected, the database needs to be updated. The database Execute Action is used. 
When entering information into the specific tab for the first time you are taken through a series of steps. 

1. Select the Database Execute icon. 

2. At the SQL Function window the option to 'Insert …values' was chosen as information needs to be added 
to the database. 

3. Details are then entered into the SQL Wizard, as shown below. When the Database table is selected, the 
list of fields contained within the table is inserted. 

 

4. When the details have been entered the SQL wizard is closed. The specific tab of the action will contain 
the command to execute, see example shown below. 
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Appendix 
Number of Simultaneous Voicemail Users 
All connections between the voicemail server and the IP Office are via the LAN using data channels. The maximum 
number of data channels that can be used for voicemail operation at any moment are shown below. Specific 
functions can have voicemail channels reserved for their use. For more information, see Voicemail Channel 
Reservations. 

IP Office Maximum for VoiceMail 
Lite 

Maximum for VoiceMail Pro 

IP406 V2 4 20 

IP412 4 30 

IP500 4 30 

Small Office Edition 4 10 

 

 VoiceMail Pro Licenses  
The actual number of ports available on VoiceMail Pro is controlled by license keys entered through IP 
Office Manager. For more information, see VoiceMail Pro Licenses. 

 The VoiceMail Pro license enables 4 ports. 

 Additional VoiceMail Pro licenses can be added to enable further ports up to the maximum 
shown in the table. 

 VoIP/VCM Channels 
Though linked to the IP Office via a LAN connection, voicemail does not use VoIP VCM channels. The 
Voicemail Server is seen as a device on the IP Office's TDM telephony interface. 

 Calls to/from voicemail involving non-IP trunks and extensions do not use VCM channels. 

 Calls to/from voicemail from IP trunks and extensions do use a VCM channel. 
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Voicemail Channel Reservations 
By default there are no reserved channels. Specific functions can have voicemail channels reserved for their use. 
IP Office manager is used to reserve channels. For more information, see IP Office Manager help. 

Voicemail channel reservations can be made for: 

 Auto Attendant 

 Announcements 

 Voice recording 

 Mailbox access 

 Mandatory voice recording 

 Outcalling. 

 

It is worth checking the voicemail channel reservations if there are problems. If insufficient voicemail channels are 
available: 

 Internal calls to an auto attendant are queued. The call will queue until a resource becomes available. 

 Announcements are not heard by the caller, but the call is routed correctly. 

 Manual voice recording is activated but no recording is made. The call will continue. 

 Users are placed in a queue when trying to access their mailbox access. 

 A user with mandatory recording on outgoing calls (internal and external) gets a busy tone. 

 A call on a line with mandatory recording set will be barred. 

 A delay in Outcalling. The Outcalling notification is postponed until there are sufficient resources available. 

 

To change voicemail channel reservations: 

1. Open IP Office Manager and the load the configuration. 

2. In the Navigation pane click  System and select the system. 

3. Click the Voicemail tab. 

 

4. Amend the channel reservations as required. By default the values are 0. For more information, see IP 
Office Manager help. 
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To view the utilisation of voicemail channels: 

1. Open the System Status Application. 

2. Click Resources. The System Resources summary is displayed. The following details are displayed: 

 The number of voicemail channels available. 

 The number of channels in use. 

 Congestion information  

For more information about the system resources, see the System Status Application guide. 
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Troubleshooting 
Starting the VoiceMail Pro Service 
If VoiceMail Pro has been installed successfully, the voicemail service is started automatically. From time to time it 
might be necessary to start the voicemail service manually, for example if you encounter problems during the 
installation or need to investigate problems at a later stage. 

This process consists of two stages: 

1. Ensuring that the VoiceMail Pro server restarts automatically every time the server PC is restarted. 
The VoiceMail Pro server installs a service, using the user name and password of the account specified 
during installation. The service is set to automatically restart each time the PC restarts. 

2. Initializing the default call flow. 

 

The steps that follow apply to Windows NT4, 2000, XP and 2003. 

To start the VoiceMail Pro Service: 

1. Open the Windows Control Panel. 

2. Select Administrative Tools > Services. 

 

3. The VoiceMail Pro Server service should be visible. Its Status should be Started and the Startup Type 
should be set to Automatic. 

4. Close Services. 

 

To Initialize the VoiceMail Pro Call Flow:  

1. Select Start > Programs > IP Office > VoiceMail Pro. The VoiceMail Pro Client starts and the main 
window opens. 

2. Click the  Save and Make Live icon. 

3. Select Yes. The file root.vmp is created and made available to the VoiceMail Pro server. This is the 
compiled version of the editable call flow. 

4. Voicemail operation can now be tested from an extension by dialing *17. 
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The Voicemail Console 
On Windows 2000, 2003 and XP, VoiceMail Pro installs as a service that starts automatically.  

The server program provides a console window that enables you to see messages between the voicemail server 
and the IP Office. The nature of the messages may be useful in diagnosing problems. The VoiceMail Pro Service 
can be run in console mode if required for testing and diagnostics purposes. 

 IMS and MAPI email activity is not supported when running the VoiceMail Pro service in this way.  

To run the service as a console: 

1. Open the Windows Control Panel. 

2. Select Administrative > Services.  

3. Locate the Voicemail Pro Service. 

 

4. Double-click the service to display its properties.  

5. Click the Log On tab.  

5. Under Log on as:, select Local System Account and then select Allow service to Interact with 
desktop. 

6. Click OK.  

7. Stop and restart the service using the  icon. After the service restarts the Voicemail Professional Server 
console window opens.  

8. Click Run.  

9. At an extension dial *17. Details of the VoiceMail Pro activity should be displayed in the console window. 
To return to normal operation, repeat the above process and set the VoiceMail Pro Service back to its 
specific user account. 
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The console provides a number of commands. These commands affect only the display of messages within the 
console window and do not alter the voicemail server operation in any way. 

 

 Freeze  
Halt the display of further messages. This is the default condition of the console when started. 

 Run  
Start the display of messages.  

 Clear  
Clear the display of messages. 

 Campaigns  
Displays messages relating to campaigns.  
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VoiceMail Pro User Log 
User authentication failures are logged in the event viewer, under VMPro User Log. The following details are 
logged: 

 UserID 

 Tool name 

 IP address of the Client trying to log in.  

 

 

To view the log details: 

1. From the Control Panel, select Administrative Tools > Computer Management. The Computer 
Management window opens. 

2. In the System Tool directory, view the Event Viewer. 

3. Click VMPro User Log to view the details. 
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SMTP Errors 
Errors may be returned from the SMTP third party component used by Voicemail. The error value and their 
meanings are listed for Voicemail Pro 2.1 or higher. 

Value Meaning 

1 An exception has occurred. 

3 The process has run out of memory. 

4 An error has occurred due to a problem with the message body or attachments. 

5 There was a problem initiating the conversation with the mail server. Ensure the setting of the 
Domain property is correct. 

6 There was an error terminating the conversation with the SMTP mail server. 

7 The address was not formatted correctly or was rejected by the SMTP mail server. Some SMTP 
servers will only accept mail from particular addresses or domains. SMTP mail servers may also 
reject a from address if the server can not successfully do a reverse lookup on the from address. 

8 An error was reported in response to recipient address. The SMTP server may refuse to handle 
mail for unknown recipients. 

9 There was an error connecting to the SMTP mail server. 

10 There was an error opening the file. If you have specified file attachments, ensure that they exist 
and that you have access to them. 

11 There was an error reading a file. If you have specified file attachments, ensure that they exist and 
that you have access to them. 

15 No mail server specified. 

16 There was a problem with the connection and a socket error occurred. 

17 Could not resolve host. 

18 Connected but server sent back bad response. 

19 Could not create thread. 

20 Cancelled as a result of calling the Cancel() method. 

21 The operation timed-out while the host was being resolved. 

22 The operation timed-out while connecting. 

24 ESMTP Authentication failed. 

25 The selected ESMTP Authentication mode is not supported by the server. 

26 ESMPT Authentication protocol error. 

27 Socket Timeout error. 

105 Invalid license key. 
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Prompts 
US English Intuity Prompts 
The following a list of the numbered .wav files used by VoiceMail Pro for US English. These are predominately, 
though not exclusively, used for Intuity mailbox features. 

All files are Microsoft WAVE file format (.wav) 8kHz, 16 bit mono. 

Important 

 It is important to note that the corresponding .wav file in other languages is not the same prompt. 

WAV File Intuity Prompt 

2 "at". 

4 "Not private". 

8 "To record a new message press 4". 

13 "To record press 1 after recording press 1 again". 

14 "To make private press 1, to make public press 2". 

15 "And is". 

18 "To forward with comment press 2". 

19 "To review from beginning press *1, if finished press *#". 

21 "To listen press 0". 

24 "To delete press *D". 

27 "To attach original, press y for yes or n for no.". 

30 "To change press 1". 

35 "Login incorrect". 

41 "To forward message with comment at beginning, press 2". 

43 "Your call is being answered by IP Office". 

44 "Is not available to leave a message wait for the tone". 

45 "Is busy, to leave a message wait for the tone". 

46 "To access your mailbox press *R". 

49 "No operator defined". 

56 "Thank you for leaving you message". 

58 "For name addressing press *A". 

60 "Changed". 

61 "To modify status, press 9 for yes, or 6 for no". 

63 "New". 

65 "Contains". 

67 "To create another list". 

70 "Unopened". 

71 "To leave a message wait for the tone". 

73 "You have". 

74 "Deleted". 
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75 "To skip press # to delete press *D". 

77 "Deleted". 

80 "To have system wait press *W if finished please hang up or to disconnected IP Office press **X". 

84 "Entry". 

85 "Erased". 

86 "Extension". 

87 "This call is experiencing difficulties". 

88 "Cannot use the guest password". 

89 "First message". 

91 "At end". 

94 "Goodbye". 

95 "Please disconnect". 

96 "For help press *H". 

97 "For help at anytime press *H". 

100 "Invalid entry". 

105 "To restart at the activity menu press *R". 

108 "You are recording a message". 

109 "Later". 

110 "List". 

111 "Please enter list ID". 

112 "Otherwise for assistance press Zero now". 

113 "You already have a list". 

114 "To replace list renter ID and # sign, to create a new list enter new list ID". 

115 "To transfer using names instead press *2". 

117 "To reach the covering extension press *Zero". 

118 "Enter last name". 

119 "You wish to call". 

120 "Too large to include". 

124 "No more list space". 

125 "Must be six or fewer numerals". 

126 "To forward message with comment at end press 3". 

127 "Return to previous activity". 

130 "Because there were no entries". 

134 "You can store your list or delete members but you cannot add members". 

141 "No more lists". 

142 "To list to the header press 3". 
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143 "To set back again press 2". 

145 "List has no entries". 

146 "To continue press #". 

147 "Review completed". 

148 "For extension addressing press *2". 

150 "Members". 

156 "Maximum length recorded". 

159 "Member". 

160 "Message". 

161 "Midnight". 

163 "To call sender press zero". 

164 "Category". 

165 "Returned to getting messages". 

166 "At end to play back press 23". 

167 "To approve press #, to record from here press 1, to play back press 23". 

168 "Messages". 

170 "Delivery scheduled". 

173 "Please enter new password". 

175 "Please note only IP Office subscribers can be specified by name". 

178 "No addresses identified". 

180 "Nothing to approve". 

182 "Nothing to delete". 

185 "Not found". 

188 "Passwords do not match, please re-enter new password". 

191 "No more messages". 

192 "No messages". 

193 "No name recorded". 

194 "No new messages". 

197 "Cannot step back". 

198 "Partial name deleted". 

201 "Noon". 

202 "Not valid". 

208 "Is not a public list". 

209 "Cannot modify another subscriber's list". 

210 "Please enter a new password". 

211 "To 15 digits". 
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212 "Please enter password again for confirmation, to delete the password you just entered press *D". 

213 "Re-enter password". 

214 "Approved". 

219 "Owned by". 

220 "Enter password". 

223 "Please enter extension". 

224 "And # sign". 

226 "Private". 

227 "Public". 

228 "Record at the tone". 

232 "Recording stopped". 

233 "Previous login incorrect please re-enter extension". 

234 "To respond or forward press 1". 

235 "To restart at the activity menu press *R, to transfer to another extension press *T". 

236 "Try again". 

238 "To review another list". 

240 "To skip press # to listen press zero". 

242 "Returned to the". 

243 "Rewound". 

244 "Rewound to previous message". 

252 "To respond to this message press 1". 

253 "Please enter month, day". 

255 "To delete this message press *D". 

256 "At beginning to re-record press 1 to playback press 23". 

262 "Received". 

272 "Contact administrator for help". 

274 "Please make entry soon or be disconnected". 

275 "Cannot get your messages now due to multiple logins to your mailbox". 

277 "To exit directory press #". 

282 "To have system wait press *W, to access the names or numbers directory press **N. If finished 
please hang up or to disconnect IP Office press **X". 

285 "To add a member enter extension". 

286 "To add a member enter last name". 

287 "Welcome to IP Office". 

288 "You are in the main directory. To find a subscribers extension, enter the last name followed by 
the # sign. To enter the letter Q press 7, for z press 9. To lookup by extension instead press *2". 
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290 "If you wish to specify a non IP Office subscriber, first change to extension addressing by pressing 
*A". 

291 "To transfer to another extension press *T". 

292 "Louder press 4, softer press 7, faster press 9, slower press 8". 

294 "To add entries press 1". 

295 "To renter list press *5". 

298 "To specify owner by name press *2". 

300 "AM". 

301 "PM". 

305 "You are at the activity menu". 

306 "You are changing your password". 

310 "January". 

311 "February". 

312 "March". 

313 "April". 

314 "May". 

315 "June". 

316 "July". 

317 "August". 

318 "September". 

319 "October". 

320 "November". 

321 "December". 

322 "You are in the numbers directory. To find a subscribers name, enter the extension followed by 
the # sign. To lookup by name instead press *2". 

323 "You are responding to a piece of incoming mail". 

325 "You are administering your lists. To create a mailing list press 1, to play a summary of all your 
lists press 2, to review a particular list press 3". 

327 "You are creating a mailing list". 

328 "To delete the previous entry, press *3. To add a mailing list you have already created or a public 
list owned by others, press *5. To review or modify the list you are creating, press *1. To approve 
the list you are creating and move on to the next step, press #". 

329 "You have not yet entered enough characters to identify a specific subscriber. To enter the letter 
Q press 7, for Z press 9". 

330 "Or enter just the # sign if it is your phone". 

332 "System greeting used". 

333 "To add entries to the list or to change status of the list press 1". 

334 "When finished addressing press #". 

335 "When finished press #". 
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339 "To replay the last few seconds press 5, to advance a few seconds press 6.". 

347 "You are adding a list". 

348 "You are specifying a mailing list to review". 

350 "Sunday". 

351 "Monday". 

352 "Tuesday". 

353 "Wednesday". 

354 "Thursday". 

355 "Friday". 

356 "Saturday". 

357 "You are choosing between subscribers whose names match your entry. To indicate no 
subscribers match, delete entry by pressing *3. To change to extension addressing and delete 
your entry press *2". 

358 "You are identifying a list as private or public". 

360 "You are scanning mailing lists, to review list members press 0, to rewind to previous list press 2, 
to continue scanning lists press 3". 

361 "To skip to next list press #, to delete list press *3". 

362 "If you own the list press #, if some else owns the list". 

363 "To approve the list you are creating press #". 

364 "Enter owner's extension". 

367 "To specify a different owner by name press *3". 

368 "You are entering the number for a new list. Please enter a number up to 6 digits long". 

369 "To replace an existing list, enter that list's number". 

370 "These are entries in your list". 

371 "To rewind to current entry press 2, to rewind to previous entry press 2 as many times as 
necessary, to continue playback of list press 3". 

372 "To skip to next entry press #, to delete current entry press *D". 

373 "You are choosing whether to attach a copy of original message to your reply. To include the 
original press y for yes, to send only your reply press n for no". 

376 "To skip the next header press the # sign to listen to the header rewind by pressing 2 then play by 
pressing 3 to skip to the next category press *#". 

377 "To delete message press *D". 

380 "Please wait". 

381 "To listen to the message press 0, to re record message before delivery press 1". 

388 "To skip press the # key". 

390 "O" (Oh) 

391 - 450 "One" to "sixty". For zero see 585.wav 

451 "Seventy". 

452 "Eighty". 
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453 "Ninety". 

454 "Hundred". 

455 "Thousand". 

456 "Million". 

464 "Enter extensions". 

468 "To continue playing press 3". 

471 "If it's your list press #". 

472 "To approve press #, to record from here press 1". 

477 "Press 1 to select". 

478 "2 to select". 

479 "3 to select". 

484 "Enter more characters followed by the # sign. If you just completed entering the last name enter 
the first name". 

485 "Has". 

486 "To reply to sender by voicemail press 1". 

493 "You are requesting a transfer". 

499 "When finished recording press # to approve or 1 to edit your message". 

556 "To exit press *# now". 

561 "You addressing your message". 

562 "Enter the". 

563 "Digit extension". 

569 "To modify press 1, if finished press *#". 

577 "To hold the message in its current category press **H". 

578 "To skip to the next category press *#". 

579 "Password must be". 

585 "Zero". 

587 "You are reviewing a list". 

601 "Priority". 

604 "As you use IP Office, your name will be included in system announcements that you and other 
people will hear. Press 1 and at the tone please speak your name. After speaking your name 
press 1 again". 

606 "To re-record you name press 1, to approve press #". 

608 "At the tone please speak your name. After speaking your name press 1". 

610 "You are recording your name. After you record your name, you can access other IP Office 
features. As you use IP office your name will be included in system announcements that you and 
other people will hear. Press 1 and at the tone please speak your first and last name as you 
would like others to hear it. After speaking your name press 1 again". 

611 "You are recording your name. To record your name, press 1. After recording press 1 again. To 
play back name press 23, to approve press #". 
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612 "To make private press 1". 

613 "To make priority press 2". 

617 "To remove private status press 1". 

618 "To remove priority status press 2". 

622 "Not priority". 

643 "You are choosing options for this message there are no options currently set". 

644 "You are choosing options for this message with the current settings". 

645 "Private messages cannot be forwarded by the recipients". 

646 "A priority message will be delivered before other messages and will be flagged for special 
attention in the recipients mailbox". 

647 "The message will be private". 

648 "The message will be priority". 

651 "The message will be private and priority". 

681 "Sorry cannot leave a message now because this users mailbox is full". 

700 "To administer mailing lists press 1". 

701 "To change your password press 4". 

702 "To record your name press 5". 

703 "You are at subscriber administration". 

704 "To create lists press 1, to scan lists press 2, to review and modify lists press 3". 

707 "If finished press *#". 

708 "If finished adding entries press #". 

736 "You are recording your name. As you use IP office your name will be included in system 
announcements that you and other people will hear". 

744 "For all calls". 

745 "Active". 

747 "For internal calls". 

748 "For external calls". 

749 "For busy calls". 

750 "For no answer". 

751 "For out of hours calls". 

752 "To listen to a greeting press 0, to create change or delete a greeting press 1, to scan all your 
greetings press 2, to activate a greeting press 3, to administer call types press 4, if finished press 
#". 

753 "Enter greeting number". 

754 "Greeting". 

755 "Not recorded". 

756 "To listen to greeting". 

757 "To re-record, press 1". 
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759 "To review status, press 2". 

760 "Press 0". 

764 "To use this greeting for all calls press 0, for internal calls press 1, for external calls press 2". 

765 "Recorded but not active". 

766 "To use this greeting for all calls press 1". 

767 "To use this greeting for all calls press 0, for busy calls press 1, for no answer calls press 2". 

770 "Recorded and active". 

771 "Approved and active". 

772 "Again". 

773 "To activate for out of hours call press 3". 

775 "To record messages press 1 to get messages press 2 to administer personal greetings press 3". 

776 "The system greeting". 

777 "Cannot listen to system greeting". 

778 "Cannot modify system greeting". 

779 "No greetings recorded". 

780 "Personal greetings review completed". 

781 "To skip to the next greeting press the # sign". 

782 "To activate a greeting enter greeting number, to de-activate a greeting activate a different 
greeting in its place". 

783 "To activate another greeting enter greeting number to de-activate a greeting activate a different 
greeting in its place". 

784 "To activate system greeting enter 0". 

785 "Same greeting used for all calls". 

786 "To identify calls as internal and external press 1". 

787 "To identify calls as busy and no answer press 2". 

788 "To identify calls as out of hours press 3". 

790 "Calls identified as internal and external". 

791 "Calls identified as busy and no answer". 

792 "Calls identified as out of hours". 

793 "Calls not identified as out of hours". 

797 "To use the same greeting for all calls press 5". 

810 "External". 

812 "No answer". 

814 "Calls". 

815 "You are administering your personal greetings". 

816 "You are listening to a personal greeting". 

817 "You are recording a personal greeting". 
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818 "You have just recorded". 

819 "You are scanning your personal greetings". 

820 "You are selecting which greeting to activate". 

821 "You administering call types". 

822 "As you use IP Office, your name will be included in system announcements that you and other 
people will hear. At the tone please speak your name, after speaking your name press 1". 

823 "For all calls". 

825 "For internal". 

826 "For external". 

827 "For busy". 

828 "For no answer". 

829 "For out of hours". 

830 "You must approve your recording". 

832 "Please enter extension and # sign". 

839 "To rewind to the previous greeting press 2". 

843 "To scan headers and messages press 1, to scan headers only press 2, to scan messages only 
press 3". 

844 "End of message". 

845 "Next message". 

846 "You are selecting an option for automatic message scan". 

847 "You are automatically scanning your incoming messages. To listen to the message press 0, to 
respond to or forward the message press 1". 

848 "You are automatically scanning your incoming messages. To listen to the message press 0 to 
respond to the message press 1". 

849 "To skip the next message press the # sign, to the listen to the header rewind by pressing 2, then 
play by pressing 3, to skip to the next category press *#". 

850 "Broadcast and login message services are not available". 

852 "To rewind to the current entry press 2, to rewind to previous entry press 2 as many times as 
necessary". 

868 "Mailbox id must be less than or equal to less than 16 digits". 

869 "If the extension entered belongs to a casual subscriber you will be prompted for a mailbox id". 

905 Short silence.  

907 2 seconds of silence. 

913 "If finished press #". 

915 "No options menu available". 

916 "To send message press # or enter an option to hear a list of options press 0". 

924 "Seconds". 

925 "Minutes". 

926 Beep 
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928 "New messages". 

929 "Old messages". 

935 "Unopened messages". 

936 "Partial entry deleted". 

937 "Sorry you are having difficulty please get help and try again later". 

938 - 968 Ordinal numbers "1st" to "31st". 

971 "To send press #". 

972 "To reach the covering extension press Zero". 

973 "If you are finished please hang up or press **X". 

977 "Name not found". 

987 "Enter last name of the person". 

990 "To record and send voicemail messages press 1". 

992 "To get messages press 2". 

1001 "To scan incoming messages automatically press 7, to relogon press **R". 

1006 "To record or change the greeting heard by callers press 3". 

1010 "With priority". 

1011 "With fax". 

1020 "No message to send". 

1028 "Page". 

1029 "Pages". 

1041 "There are no new faxes". 

1048 "Nothing to print". 

1052 "To specify your fax preferences press 3". 

1061 "Your default print destination is...". 

1071 "Fax message from..". 

1073 "To print press *1". 

1075 "To change the default print destination press 1". 

1087 "To print to destination". 

1088 "Press #". 

1089 "To specify destination, enter digits followed by the # key". 

1091 "You are specifying where your documents will be printed". 

1092 "A default print destination has not been assigned". 

1093 "To assign a default print destination press *7 then 53". 

1098 "To approve press #". 

1118 "You are specifying the default print destination for fax items". 

1141 "When finished recording press # for more options". 
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1144 "To specify whether a message can be addressed before it is recorded press 6". 

1145 "To administer call answer options press 7". 

1152 "Address before record turned on". 

1153 "To turn off press 1". 

1154 "Address before record turned off". 

1155 "To turn on press 1". 

1157 "You are administering addressing options". 

1158 "To prevent callers from leaving messages press 1". 

1159 "Call answer messages will not be accepted". 

1160 "To allow callers to leave messages press 1". 

1161 "You are administering call answer options". 

1162 "Sorry the mailbox you have reached is not accepting messages at this time". 

1163 "Is not available". 

1164 "Call answer messages will be accepted". 

1219 "To review or change your reach options press 7". 

1305 "Please enter an outcalling option to hear a list of options press 0". 

1430 "To following message was restored". 

1431 "No message to restore". 

1432 "To undelete last deleted message press **U". 

1434 "To return to getting messages press #". 

1440 Beep 

1443 "Voice file system is out of space". 

1444 "Please contact the administrator". 

1457 "Old and new passwords cannot be the same". 

1461 "You are getting your incoming messages". 

1462 "To listen to the message press Zero". 

1463 "To reply to sender by voicemail press 17". 

1464 "To forward with comments press 12". 

1465 "To record a new message press 14". 

1466 "To respond to or forward the message press 1". 

1467 "The return address for this message is not a mailbox on this system". 

1469 "To reply to sender by voicemail press 7". 

1964 "The ability for callers to leave messages in your mailbox is turned off". 

1965 "To allow callers to leave messages press 571". 

1970 "Invalid password please enter new password and # sign". 

2007 "With text". 
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2008 "With other media". 

2010 "Zero". 

2011 "bytes". 

2012 "Byte". 

2013 "Kilobyte". 

2014 "Kilobytes". 

2015 "Megabyte". 

2016 "Megabytes". 

2018 "And". 

2019 "Message from". 

2021 "Private". 

2022 "Private priority". 

2023 "Priority". 

2025 "Call from". 

2026 "Call received". 

2029 "This is a ". 

2030 "Voice". 

2031 "Fax". 

2032 "Text". 

2033 "Attached file". 

2035 "To advance to the end of the message press *6". 

2038 "Rewound". 

2039 "Component". 

2040 "To listen press 3". 

2041 "To customize your mailbox, for example to create or edit your mailing lists or change your 
password, press 5". 

2042 "To administer your media preference for sorting messages, press 8". 

2043 "You are administering your preferred media type for sorting incoming messages. Messages with 
a primary media type matching your preference will be presented before other messages, 
regardless of the order in which they have been received". 

2044 "No media preference for sorting incoming messages has been specified". 

2045 "For voice press 1, for fax press 2, for text press 3, for binary files press 4". 

2046 "To retain your current preference press the # key". 

2047 "You media preference for sorting incoming messages is". 

2048 "For no preference press zero". 

2049 "Will be your preferred media type". 

2051 "Your password cannot be the same as your extension number consecutive digits or a single 
repeated digit. Please enter new password and the # key". 
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2052 "At beginning of message to step back to previous message press *2 to listen press Zero". 

2053 "Approximately". 

2057 "At beginning of message". 

2061 "To enter the telephone number of a fax machine press **5". 

2063 "Enter the telephone number of a fax machine followed by the # sign". 

2065 "The telephone number of a fax machine should be entered as it would be dialed from the location 
of your messaging system. It can contain a maximum of 23 digits including trunk access, long 
distance or international access codes if necessary and is subject to administrator restrictions". 

2071 "You are specifying the telephone number of a fax machine". 

4409 -
4434 

Alphabetic characters "A" to "Z". 

G0000 - 
G0009 

"Press zero" through to "Press 9" 

G0010 - 
G0019 

"Press *zero" through to "Press *9". 

G0020 "Press ** zero". 

G0029 "Press **9". 

G0031 "Press the # key". 

G0032 "Press *#". 

G0040 "You are changing your Outcalling options". 

G0041 "System not administered for Outcalling". 

G0042 "You are not authorised for Outcalling". 

G0043 "When finished please hang up or ". 

G0044 "You are selecting which messages will receive out calls". 

G0045 "For instructions on entering your outcalling number". 

G0046 "For instruction on configuring outcalling". 

G0047 "You are not authorised to input a number". 

G0051 "To return to the activity menu". 

G0052 "Subject to administrator restrictions". 

G0053 "To change times". 

G0054 "To turn off" 

G0055 "To turn on" 

G0061 "To de-activate". 

G0062 "To activate". 

G0063 "To activate for all calls". 

G0064 "To activate for external calls only". 

G0065 "To activate for internal calls only". 

G0071 "For all calls". 
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G0072 "For internal calls". 

G0073 "For internal calls only". 

G0074 "For external calls". 

G0075 "For external calls only". 

G0076 "For other calls". 

G0080 "To use this greeting". 

G0081 "For the temporary greeting" 

G0082 "For number engaged calls" 

G0083 "For no reply calls". 

G0084 "For the default greeting". 

G0085 "When finished". 

G0086 "Please enter a number between". 

G0087 "Where zero will set the temporary greeting to not expire". 

G0088 "Please enter the number of days you wish this greeting to be active for". 

G0089 "Your temporary greeting". 

G0090 "For the next". 

G0091 "Days". 

G0092 "For today". 

G0099 "Not configured". 

G0100 "Turned off". 

G0101 "Inactive". 

G0102 "Desk". 

G0103 "Home". 

G0104 "Mobile". 

G0105 "Temporary". 

G0106 "Delegate". 

G0107 "Secretary". 

G0108 "Other". 

G0109 "SMS". 

G0110 "Voicemail". 

G0111 "Escalation". 

G0112 "An escalation list". 

G0113 "Extension". 

G0120 "For none". 

G0121 "For internal". 

G0122 "For desk". 
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G0123 "For home". 

G0124 "For mobile". 

G0125 "For temporary". 

G0126 "For delegate". 

G0127 "For secretary". 

G0128 "For other". 

G0129 "For SMS". 

G0130 "For voicemail". 

G0131 "For escalation". 

G0140 "Currently". 

G0141 "For help". 

G0142 "For help at any time". 

G0143 "To leave". 

G0144 "To change". 

G0145 "To reject". 

G0147 "Time". 

G0148 "The time out is". 

G0149 "To change the time out". 

G0150 "To configure outcalling". 

G0151 "Your escalations have not been configured". 

G0152 "Your escalations are configured to call the following locations in the listed order". 

G0153 "To repeat list". 

G0154 "To repeat list with numbers". 

G0155 "To review the list". 

G0156 "You are selecting locations for the escalation list". 

G0157 "To input the list again". 

G0158 "You have completed inputting the escalation list". 

G0159 "To select a destination". 

G0160 "Where the following destinations will be called in order". 

G0161 "To configure escalations". 

G0162 "Please input your". 

G0163 "Location". 

G0185 "To". 

G0186 "Where". 

G0187 "Between". 

G0188 "Invalid time". 
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G0191 "Is active". 

G0192 "Is inactive". 

G0193 "Is set to". 

G0194 "Is not set". 

G0195 "To repeat". 

G0200 "And". 

G0201 "Your outcalling is". 

G0202 "Your outcalling is set". 

G0203 "Your outcalling destination is set to". 

G0204 "The number is". 

G0205 "Number is". 

G0206 "Number". 

G0207 "To change numbers". 

G0208 "To input a number". 

G0209 "For instructions on entering your outcalling number". 

G0210 "For instructions on configuring outcalling". 

G0211 "To change the number". 

G0212 "There is no number defined for the selected destination". 

G0213 "You are configuring outcalling destination". 

G0214 "To configure outcalling". 

G0215 "To re-configure outcalling". 

G0216 "To change outcalling". 

G0217 "To change outcalling destination". 

G0218 "To change destination". 

G0219 "To change". 

G0220 "Destination". 

G0221 "You have selected". 

G0222 "There is no number defined". 

G0223 "To select an alternate destination". 

G0224 "To select another location". 

G0225 "You have selected the option to configure your telephone numbers". 

G0226 "To exit". 

G0227 "To accept". 

G0228 "To disable". 

G0229 "To enable". 

G0230 "To turn outcalling off". 
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G0231 "To turn outcalling on". 

G0232 "To turn outcalling on for all new messages". 

G0233 "To turn outcalling on for new priority messages only". 

G0234 "To turn outcalling on for new private messages only". 

G0235 "To turn outcalling on for new priority private messages only". 

G0236 "The destination is set to". 

G0237 "To change the destination". 

G0238 "To set a number". 

G0240 "Outcalling is turned off". 

G0241 "Outcalling is turned on". 

G0242 "Outcalling is turned on for all new messages". 

G0243 "Outcalling is turned on only for new priority messages". 

G0244 "Outcalling is turned on only for new private messages". 

G0245 "Outcalling is turned on only for new priority private messages". 

G0251 "Outcalling is turned on between". 

G0252 "Outcalling is turned on for all new messages between". 

G0253 "Outcalling is turned on only for new priority messages between". 

G0254 "Outcalling is turned on only for new private messages between". 

G0255 "Outcalling is turned on only for new priority private messages between". 

G0260 "Outcalling is turned off". 

G0261 "Outcalling is turned on". 

G0262 "Outcalling is turned on for all new messages" 

G0263 "Outcalling is turned on only for new priority messages". 

G0264 "Outcalling is turned on only for new private messages". 

G0265 "Outcalling is turned on only for new priority private messages". 

G0272 "For all new messages". 

G0273 "For all new priority messages". 

G0274 "For all new private messages". 

G0275 "For all new priority private messages". 

G0278 "Enter the time in second and #". 

G0279 "Enter the new number and #". 

G0280 "To input a new number". 

G0281 "To input an outcalling number". 

G0282 "Enter the number followed by #". 

G0283 "Anything entered will be interpreted as part of the called number". 

G0284 "No global commands, such as *4 will be accepted at this time". 
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G0285 "A * or # entered as the first character will result in the * or # being output". 

G0286 "A * entered as part of the digit string will be interpreted as a pause of one and a half seconds. 

G0287 "If a longer pause is required, use multiple stars in a row". 

G0288 "To return to outcalling administration". 

G0289 "Enter outcalling number and #". 

G0290 "To exit press *# now". 

G0301 "Your destination is currently configured to". 

G0306 "For system outcalling schedules". 

G0307 "You are specifying your outcalling time period". 

G0308 "For outcalling during peak time". 

G0309 "If not press *3 and re-enter time". 

G0310 "To specify your times". 

G0311 "To delete own time". 

G0312 "Peak time is". 

G0313 "For outcalling ant time press 1". 

G0314 "The time you specify will be restricted by the times allowed by the system administrator". 

G0315 "Outcalling specified to any time subject to administrator restrictions". 

G0316 "For outcalling during prime time press 2". 

G0317 "The system allows outcalls from". 

G0318 "To change outcalling information press 6. 

G0319 "Outcalling specified for". 

G0320 "If correct press #". 

G0321 "From time". 

G0322 "To time". 

G0350 "There is a message for". 

G0351 "Based on an outcalling time profile which is currently configured as follows". 

G0352 "Your outcalling time profile is currently configured as follows". 

G0353 "Your outcalling time profile is not configured". 

G0360 "You are specifying the time for outcalling time profile". 

G0361 "To leave the current time profile". 

G0362 "To change the time profile". 

G0363 "Is set to". 

G0364 "Please enter the time". 

G0365 "The time should be entered as follows: hour, hour, minute, minute, where the hours are given in 
24 hour format. For example, 5 past 1 in the afternoon would be entered as 1305". 

G0366 "You are configuring outcalling time profile". 
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G0367 "The end time should be greater than the start time". 

G0400 "You are modifying your personal settings". 

G0401 "You are modifying your callback options". 

G0402 "You are modifying your do not disturb options". 

G0403 "You are modifying your email mode options". 

G0404 "You are modifying your follow me forward options". 

G0405 "You are modifying your mobile twinning options". 

G0406 "You are modifying your voicemail transfer options". 

G0410 "To modify your personal settings". 

G0411 "To modify your callback options". 

G0412 "To modify your DND options". 

G0413 "To modify your email mode options". 

G0414 "To modify your follow me forward options". 

G0415 "To modify your mobile twinning options". 

G0416 "To modify your reception transfer options". 

G0417 "To modify your follow me feature setting". 

G0418 "To modify your forward unconditional setting". 

G0419 "To modify your forward on busy and on no answer setting". 

G0421 "Your follow me feature". 

G0422 "Your forward unconditional feature". 

G0423 "Your forward on busy and on no answer is set to". 

G0424 "Your forward on busy is set to". 

G0425 "Your forward no answer is set to". 

G0426 "Your forward on busy and on no answer are inactive". 

G0427 "Your do not disturb feature". 

G0428 "Your email mode feature". 

G0429 "Your mobile twinning feature". 

G0430 "Your callback option". 

G0450 "To modify your voicemail transfer on zero". 

G0451 "To modify your voicemail transfer on 1". 

G0452 "To modify your voicemail transfer on 2". 

G0453 "To modify your voicemail transfer on 3". 

G0460 "Your voicemail transfer on zero". 

G0461 "Your voicemail transfer on 1". 

G0462 "Your voicemail transfer on 2". 

G0463 "Your voicemail transfer on 3". 
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G0501 "A". 

G0502 "B". 

G0503 "C". 

G0504 "D". 

G0505 "E". 

G0551 "The first". 

G0552 "The second". 

G0553 "The third". 

G0554 "The fourth". 

G0555 "The fifth". 

G0680 "Second". 

G0681 "Seconds". 

G0682 "Star". 

G0683 "Hash". 
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English Non-Intuity Prompts 
Here is a list of the named .wav files used by VoiceMail Lite and VoiceMail Pro for US and UK English. These are 
predominately, though not exclusively, used for IP Office mode mailbox features and VoiceMail Pro custom call 
flow actions.  

All files are Microsoft WAVE file format (.wav) 8kHz, 16 bit mono. 

WAV File Non-Intuity Prompt 

a60 "Please enter extension and # sign". 

aa_01 "Good morning and thank you for calling. Please key in the required extension number or hold 
the line for other options". 

aa_02 "Good afternoon and thank you for calling. Please key in the required extension number or 
hold the line for other options". 

aa_03 "Good evening and thank you for calling. Please key in the required extension number or hold 
the line for other options". 

aa_04 "Please hold while we try to connect you". 

aa_05 "An operator is currently unavailable". 

aa_06 "Please key in the extension number you would like to leave a message for". 

aa_07 "Good bye and thank you for calling". 

alpha_01 "Press # to accepted data, *1 to hear the data, *2 to delete the data, *3 to delete the last 
character, *# to accept the data and continue". 

alpha_02 "Data has been deleted". 

alrm_1 "You have an alarm call set for". 

alrm_2 "Alarm has been deleted press 1 to continue or * to quit". 

alrm_3 "Please enter the time for the alarm call in 24 hour clock notation". 

alrm_4 "You have set an alarm call for". 

alrm_5 "Press 1 to validate press 2 to add a message to the end press # to cancel". 

alrm_6 "Your alarm has now been set". 

alrm_7 "Press 1 to verify this alarm or press 2 to delete it". 

alrm_8 "This time is invalid please try again". 

alrm_9 "This is an alarm call please hang up". 

AM "AM". 

aor_00 "Warning: your call is being recorded". 

cmp_01 "The current campaign message has been marked as deleted". 

cmp_02 "The current campaign message has been marked as completed". 

cmp_03 "The current campaign message has been abandoned". 

cmp_04 "Press 1 to start again, press 2 to rewind, press 3 to abandon, press 4 to delete, press 5 to 
complete, press 7 for previous field, press 8 for start of current field, press 9 for next field, 
press # to forward, press 0 to pause, press * to rewind". 

conf_01 "A conference is not currently scheduled". 

conf_02 "There was a problem transferring you into the conference". 

conf_03 "Please enter your conference id and press # to finish". 

conf_04 "Please enter your PIN and press # to finish". 
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conf_05 "Your conference ID or PIN is not valid". 

conf_06 "Your conference ID is not valid". 

conf_07 "Your PIN is not valid". 

conf_08 "Please try again". 

conf_09 "To be announced into the conference please speak your name and press # when you have 
finished". 

conf_10 "Your name is too short please try again". 

conf_11 "Has invited". 

conf_12 "To join them in an immediate conference press 1 to accept, 2 to decline and 3 if the delegate 
is not available". 

conf_13 "Has requested". 

conf_14 "To join in an ad-hoc conference press 1 to accept, 2 to decline and 3 if the delegate is not 
available". 

conf_15 "Has declined the offer to attend the conference". 

conf_16 "Is not available". 

conf_17 "Has just entered the conference". 

conf_18 "Has just left the conference". 

conf_19 "An unknown caller". 

conf_20 "Has been invited". 

conf_21 "No conference selected, thank you and good bye". 

conf_22 "Transferring you to the conference now". 

conf_23 "Conference not accessible". 

conf_24 "You have been invited to a conference". 

dbn_01 "There are". 

dbn_02 "Press # to play list". 

dbn_03 "To select". 

dbn_04 "# for next". 

dbn_05 "*# for previous". 

dbn_06 "And #". 

dbn_07 "Press **2". 

dbn_10 "For selection by group". 

dbn_11 "For selection by first name". 

dbn_12 "For selection by last name". 

dbn_13 "For selection by extension". 

dbn_14 "Entries that match your selection". 

dbn_15 "*3 to clear the list and restart". 

dbn_16 "Or enter more characters followed by a # to reduce the size of the list". 
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dbn_17 "To change name format entry to". 

dbn_18 "First name last name". 

dbn_19 "Last name first name". 

dbn_20 "Enter group name". 

dbn_21 "Enter first name". 

dbn_22 "Enter last name". 

dbn_23 "Enter extension". 

dom_01.wav... 
dom_31.wav 

Day of month ordinal numbers "1st" to "31st". 

dow_01 "Sunday". 

dow_02 "Monday". 

dow_03 "Tuesday". 

dow_04 "Wednesday". 

dow_05 "Thursday". 

dow_06 "Friday". 

dow_07 "Saturday". 

EOC_1 "Warning, your conference will end in". 

EOC_2 "Your conference will end in". 

int_na "Service not supported". 

ivr_01 "The time according to the IVR server is". 

ivr_02 "Directory wave table. Enter the number of the caller you want to edit". 

ivr_03 "Name wave table. Enter the number of the extension you want to edit". 

ivr_04 "Enter form entries with the # sign to terminate each line. Press # at the end to complete the 
form". 

ivr_05 "Form verified". 

ivr_06 "Form entry is complete". 

ivr_07 "Press * to abort # to accept or 0 to listen again". 

ivr_08 "Do not disturb". 

ivr_09 "Voicemail mode". 

ivr_10 "Call forwarding". 

ivr_11 "Forward number is set to". 

ivr_12 "Follow me number is set to". 

ivr_13 "Voicemail reception number is set to". 

ivr_15 "Parameter is set to". 

ivr_16 "Parameter is enabled". 

ivr_17 "Parameter is disabled press 1 to enable". 

ivr_18 "Parameter is disabled". 
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ivr_19 "Parameter is enabled press 2 to disable". 

ivr_20 "Press 1 to change press # to cancel". 

ivr_21 "Enter new number after the tone". 

ivr_22 "Repeat new number after the tone". 

ivr_23 "Sorry the numbers you have entered are different". 

ivr_24 "Email options". 

ivr_25 "Alert email on incoming message". 

ivr_26 "Copy messages to email". 

ivr_27 "Forward messages to email". 

ivr_28 "Email turned off". 

ivr_29 "Service mode". 

ivr_30 "In service". 

ivr_31 "Out of service". 

ivr_32 "Night service". 

mc_00 Beep. 

mc_01 Short silence. 

mc_02 One seconds silence. 

misc_24 "Is on holiday until". 

misc_25 "Is unavailable until".  

misc_26 "Is at lunch until".  

misc_27 "Is away on business until".  

misc_28 "And will be picking up messages regularly".  

misc_29 "And will not be contactable until their return".  

misc_30 "List length exceeded".  

misc_31 "*, cannot access private list".  

misc_32 "*, list length exceeded".  

mnu_1 "You have four greeting options. For standard greeting press 1, for after hours greeting press 
2, for you are in a queue greeting press 3, for you are still in a queue greeting press 4". 

mnu_2 "To hear your greeting message press 1, to change your greeting message press 2, to save 
your greeting message press 3, to save your message for playing as a continuous loop press 
4". 

mnu_2a "To hear your greeting message press 1, to change your greeting message press 2, to save 
your greeting message press 3, to save your message for playing as a continuous loop press 
4, to return to the previous menu press 8". 

mnu_3 "When playing a message to delete the message press 4, to save the message press 5, to 
forward the message to email press 6, to repeat the message press 7, to skip the message 
press 9, at the end of your messages to play old messages press 1, to play saved messages 
press 2, to edit your greeting press 3, to direct all messages to email press *01, to turn off 
email redirection press *02". 
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mnu_4 "When playing a message to delete the message press 4, to save the message press 5, for 
forwarding options press 6, to repeat the message press 7, to skip the message press 9, to 
call back the sender press ** at the end of your messages, to play old messages press 1, to 
play saved messages press 2, to edit your greeting press 3, to direct all messages to email 
press *01, to send email notifications press *02, to turn off email functions press *03, to 
change your access code press *04". 

mnu_5 "To forward message to email press 1, to forward message to other extensions press 2, to 
add a header message press 3, to send message into your saved messages list press 4, to 
skip this forwarding press #". 

mnu_6 "User configure options. To edit forwarding number press 1, to edit follow me number press 2, 
to set call forwarding press 3, to set voicemail press 4, to set do not disturb press 5, to edit 
voice mail access code press 6, to edit voicemail reception press 7, to set voicemail email 
mode press 8, to edit voicemail call back number press 9". 

mnu_7. "Hunt group configure options. To set voicemail press 1, to edit voicemail access code press 
2, to set voicemail email mode press 3, to set service mode press 4". 

mnu_8 "Invalid entry please try again". 

mnu_9 "That destination is unavailable". 

MNU_10. "To play your old messages, press1. To play your saved messages, press 2. To edit your 
greeting, press 3. To delete the current message, press 4. To save the current message, 
press 5. To change your access code, press *04. For help at any time, press *4". 

mo_01 "January"  

mo_02 "February"  

mo_03 "March"  

mo_04 "April"  

mo_05 "May"  

mo_06 "June"  

mo_07 "July"  

mo_08 "August"  

mo_09 "September"  

mo_10 "October"  

mo_11 "November"  

mo_12 "December"  

no_ "Number". 

no_00.wav ... 
no_59.wav 

"Zero" to "Fifty-nine". 

no_24p "More than 24". 

noon "Noon". 

out_01 "To administer Outlook based greetings, press 5".  

out_02 "You are administering Outlook based greetings". 

out_03. "Outlook based greetings are active for all calls". 

out_04 "Outlook based greetings are used for the following call types". 

out_05 "Outlook based greetings are currently inactive". 
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out_06 "To deactivate Outlook based greetings". 

out_07 "To activate Outlook based greetings". 

out_08 "They will be out of the office until". 

out_09 "They will be busy until". 

out_10 "Due to". 

outb_01 "This is an IP Office outbound alert". 

outb_04 "Press any key to accept". 

pg_0001 "To use this greeting for all calls press 1". 

pg_0002 "To use this greeting for all calls press 0". 

pg_0003 "For internal calls press 1". 

pg_0004 "For external calls press 2". 

pg_0005 "To activate for out of hours call press 3". 

pg_0006 "If the number is busy press 4". 

pg_0007 "For no reply calls press 5". 

pin_01 "Enter your current access code after the tone". 

pin_02 "Now enter your new access code after the tone". 

pin_03 "Now repeat your new access code after the tone". 

pin_04 "Your access code has now been changed". 

pin_05 "It has been possible to change your access code at this time". 

pin_06 "Press # when you have finished". 

pin_07 "Access code must contain 4 or more digits". 

PM "PM". 

que_01 "You are at queue position". 

que_02 "In the queue". 

que_03 "Call per". 

que_04 "Estimated time to answer is". 

que_05 "Your call will be answered in". 

rec_01 "Warning: this call is being recorded". 

RECNAM_01 "As you use IP Office, your name will be included in system announcements that you and 
other people will hear. At the tone please say your name. After saying your name, press 1". 

RECNAM_02 "To re-record your name press 1, to confirm press #". 

RECNAM_03 "Record at the tone". 

PressHash "To continue, press #". 

sac_01 "Cannot retrieve your messages now due to multiple logins to your mailbox". 

sac_02 "Please disconnect". 

seconds "Seconds". 
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ssb_00 "O" (Oh). 

ssb_01 "O'Clock". 

ssb_02 "No". 

ssb_03 "None". 

ssb_04 "Midnight". 

ssb_05 "And". 

ssb_06 "Date". 

ssb_07 "Deleted". 

ssb_08 "T number". 

ssb_09 "For". 

ssb_10 "Forwarded". 

ssb_11 "Item". 

ssb_12 "Press". 

ssb_13 "Quantity". 

ssb_14 "Saved". 

ssb_15 "Yesterday". 

ssb_16 "Hundred". 

ssb_17 "Hour". 

ssb_18 "O" (oh). 

ssb_19 "At". 

ssb_20 "1" (Down tone). 

ssb_21 "1" (Up Tone). 

ssb_22 "1" (Level Tone). 

ssb_23 "Function failed to complete". 

ssb_29 "Minutes". 

svm_02 "Calls have been forwarded to email. New calls will also be forwarded to email until turned 
off". 

svm_03 "Caller was". 

svm_04 "Thank you for leaving a message. Mailbox has now stopped recording". 

svm_05 "Please enter your mailbox number". 

svm_06 "Please enter your access code". 

svm_07 "There is no one available to take your call at the moment so please leave a message after 
the tone". 

svm_08 "For help at anytime press 8". 

svm_09 "That was the last message". 

svm_10 "New message". 

svm_11 "New messages". 
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svm_12 "Old message". 

svm_13 "Old messages". 

svm_14 "Saved message". 

svm_15 "Saved messages". 

svm_16 "Remote access is not configured on this mailbox". 

svm_17 "Email is not enabled on this mailbox". 

svm_18 "I am afraid all the operators are busy at the moment but please hold and you will be 
transferred when somebody becomes available". 

svm_19 "Message was recorded". 

svm_20 "You're being transferred". 

svm_21 "You have". 

svm_22 "Unknown caller". 

svm_23 "Forwarding to email is now turned off". 

svm_24 "Start speaking after the tone and your message will be inserted before the message prior to 
forwarding". 

svm_25 "To hear the recording press 1, to change the recording press 2, to save the recording press 
3". 

svm_26 "Enter the extension to which you wish this message to be forwarded, separating each 
extension using the # sign. Press # at the end to complete the list". 

svm_27 "Message has not yet been recorded". 

svm_28 "Start speaking after the tone and press 2 when you have finished recording". 

svm_29 "There are no messages". 

tim_m00 "Minute". 

tim_m01 "One minute". 

tim_m02 "Minutes". 
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Web component....................................................3 

Campaign action ....................................................222 
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